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Unit-1 Concept of 2D Animation 

Introduction 

       This subject is useful for all individuals who wish to make a career in sound, animators, 

filmmakers, game developers, educators for creating various content like TV shows, video games, 

commercials, explainer videos, and educational materials. 

       The process of making an illusion of motion is known as animation. The illusion or 

apparition is created by the change in rapid series of sequential images that actually differ 

from each other. Let us discuss about the different types of animations. Generally, there are 

2D animation, 3D animation, stop motion, computer animation, sand animation, etc. 

      The 2D animation follows the traditional animation method and it has been in existence 

since late 1800s. Today, most of the 2D animations are created by computer software and 

every frame is slightly different from each other based on its colour, its 

preceded frame. 
 
 
 
 
 
 
 
 
 

 

 

 

Outcomes 

 

 
 
This unit is about exploring the 2D animation. You 

will learn the definition of animation, its history 

and different kinds. The unit covers 12 core 

principles and concepts of animation. You will 

learn how to apply the principles of animation to a 

character in order to create it. 

 

 

 

Upon completion of this unit you will be able to: 

• Explain about the concepts of animation 

• Elucidate about the history of animation  

• Categorize the various types of animation  

• Explain how animation works 

• Apply the 2D animation principle  

Terminology 

FPS: A film projected at 24 frames for every second and video projected at 25 frames per 

second. 

Cel and Cel setup: A picture is drawn on a unique place of plastic. This plastic is called as 

Cel. If at least one Cel overlays on a base it is known as Cel setup. 

Model sheet: It is the drawing of a character, in an assortment of states of mind and  

 

 

https://en.wikipedia.org/wiki/Illusion
https://en.wikipedia.org/wiki/Motion_(physics)


 

 

 
 

 

 

expressions, made as a source of perspective guide for an artist. 

Character models: Animator prepares a model sheet of the character. The model sheet 

contains the character in an assortment of outward appearance and stances. 

Maquette: It is a sculpted preliminary model or sketch in view of the real/final character in the  

Model Sheet. 

Time out: This is a liveliness key. It includes matching all the on-screen activity to its 

correct beats, including music and sound impact. 

Lead artist: This artist in charge of making and animating one specific character in the film.



 

 

 
 

 

Meaning of animation 

         We all have an idea of what animation is. We think of Disney‘s classic animated films 

but have you ever thought about what actually makes animation film. The term animation has 

originated from Greek word 'Any moss' and Roman 'enema'. This basically means ―bring to 

life‖, so there is a sense of evolution over time that is what we capture through animation. 

Conventional animation has been there for a long time and the primary concern of animation 

techniques has been to create the illusion of movement. It basically has the aspect of 

movement, which could be just an illusion, without simulating the motion in its physical 

sense. It involves creating a series of photographs as frames and run those sequentially over 

time. This aspect of illusion of life has been used by various commercial setups. 

History of animation 
 

The animation is the way towards making the deception of action and the illusion of 

progress by methods for the quick progression of consecutive images that negligibly vary 

from each other. The animation is possible because of the persistence of vision discovered by 

Peter Rajat in 1820. The persistence of vision causes images to look like they are there longer 

than they actually are causing the drawings of animation to blur together. Animations started 

with the phenakistoscope, created in 1872. The phenakistoscope is an optical illusion toy with 

rotating disks to make it look like a moving picture. In the year of 1898, stop- motion 

animation was invented. Stopmotion animation is the method of taking many pictures and 

putting them together to create an animation. Humpty Dumpty was the first animated feature 

film to use stop-motion animation in 1914. It is when Gertie the train dinosaur was created. It 

was one of the first cel- animated films. A Cel (celluloid) is a transparent sheet of paper used 

for traditional hand drawn animation. Cel animation is when the background is drawn 

separately from the characters, the background is put in a clear box and the characters are 

placed on top of it, in their own separate box and then photographed. This saves a lot of time 

of the animator because they do not have to redraw the background every time. In 1915, Max 

Fleischer patented the route a scoping process. Tracing a live footage is called Rotoscoping. 

In 1923, Walt and Roy formed Disney Brothers cartoon studio. In 1928, Steamboat Willie, 

the first animation with sound, was created by the Disney Brothers. In 1930, Warner Bros 

 

 
 



 

 

 
 

 

cartoons were created, and the first CGI animation was made by Charles Sri and James 

Schaffer in 1967. CGI stands for computer- generated imagery. CGI is normally associated 

with 3D computer effects but CGI is any picture that is generated by a computer and not 

drawn by a human. There are many movies such as Star Wars, Tron Legacy, Alien Series and 

The Matrix that have seen use of CGI animation for certain effects. The first feature-length 

animation that used CGI was Toy Story. Today, many cartoons on TV still use traditional 

animation but computers have become a big part of the animation process. 

Types of animation 
 

1. Traditional animation 
 

Cel animation is generally recognized as traditional animation. This is the 

grownup forms of animation. In traditional animation, every frame is hand drawn for 

creating an animation image sequence. It consists of large numbers of hand drawings 

called ―Frames‖. In the past, the drawing occurred on a big light table. It was a drafting 

table with a big light section in the central point of it. The animator drew the image 

sequence on it, and the light allowed the animator to see his earlier drawings all the way 

through the paper to get a better look of his animation. This is called Onion Skinning. 

Even now, traditional animations are mostly done on PC with a Pentab alike the Wacom 

Pentab. The 2D or traditional animation is generally animated at 12 frames per second 

with more frequent and rapid animated actions at 24 frames per second. 

 

2. 2D Animation 
 

Vector-based animation is referring to 2D animation. This is all around preferred 

configuration from most recent couple of years with the expanding clients. 2D animation 

software is easy to use as it is for entry level and has a user-friendly interface. 

Illustration: Flash animation products are the modest and simple to utilize vector-

based animation program. An artist has an alternative option of making rigs for the 

character at the joints for the moving body parts and movement can be provided 

separately as per the requirement of the character in the drawing. The character having 

more than one eventual outcome can be achieved as it permits complex rigs for 

animations or by utilizing the manikin apparatus to drag and move the body parts around. 

These types of adaptabilities give more choices. While moving ahead in the process of



 

 

 
 

 

 

animation, particularly, if the drawing is not solid, it would not match at all for which 

drawing abilities are mandatory like traditional animation. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Title : Animated Horse 

Attribution : Janke 

Link : https://commons.wikimedia.org/wiki/File:Animhorse.gif 

 
 
 

3. Computer Animation 
 

Computer animation is also known as 3D animation or just animation. It is the 

common form of animation. 3D animation works in a totally extraordinary manner from 

traditional animation, all the animators are considered to be associated with a standard 

organization and has certain level of creative development, yet there are some specialized 

experts in particular fields of work who are different from each other. In 3D animation, 

the artist moves the character in a 3D program by manipulating controllers, which are 

associated with each body part, for example, hands, elbows, lips and etc. Like 2D 

animation, an animator in 3D program doesn't have draw to move every frame. Animators 

set the key frame on the timeline when the models are ready to animate. Proceed to move 

forward in timeline and move all those controllers again to create another key frame in 

the 3D program. Then the program calculates and animates the frames between those two 

key frames. Animators take maximum time to clean the curves for a detailed and smooth 

animation, which helps for the development of various body parts later on. Another huge 

distinction with 3D animation is that it‘s not at all like traditional animation. The body 

parts are constantly present and contemplate. In 2D animation, the character draws for 

each edge. 

 

 

 



 

 

 
 

 

 

 

At the point when the character is seen from the side portion of its body is not 

appearing and in this manner not drawn. 

The significant distinction with 3D animation is the edge rate like traditional 

artists. Generally, a shot is taken at twos, which implies they draw another drawing each 

having two edges and in this manner making them draw less for two edges. 3D 

animation's movement is constantly smooth with the exception of adapted pieces, which 

deliberately attempt to appear as unique. Having a character stop totally resembles a mix-

up in 3D. Notwithstanding when the character is stopping, there ought to dependably be a 

few indications of life. This is something which 2D animation can escape with a great 

deal by more effectiveness than 3D. 

4. Motion Graphics 
 

Motion graphics is considered as a type of graphics animation. Motion graphics is 
 

somewhat not quite the same as alternate part of animation. Unlike any animation, it is 

not character- or story- driven. It is the craft of imagination of moving realistic 

components or content which is mainly used for business or promotional purposes, 

enlivened logos, introduction recordings, TV promos or even film opening titles. The 

abilities for motion graphics do not vitally means alternate sorts of animation since, they 

don't require information of body mechanics or acting. However, they do have a few 
 

characteristics in similar manner. For example: Presenting great arrangement and 

extremely imperative camera motion. 

     

 

 

 

 

 

Title : Motion Graphic Attribution : 

Source : Little Visuals 

Link : https://www.pexels.com/photo/lights-abstract-curves- 

long-exposure- 1944/ 
 

5. Stop Motion 

 
 

A standout amongst the most well-known structures is clay animation. Working 

with mud or play-doh characters can undoubtedly be controlled for animation. The 

animation process is similar to 2D animation, creating poses of movements and moving it 

https://www.pexels.com/photo/lights-abstract-curves-long-exposure-%20%20%20%201944/
https://www.pexels.com/photo/lights-abstract-curves-long-exposure-%20%20%20%201944/
https://www.pexels.com/photo/lights-abstract-curves-long-exposure-%20%20%20%201944/


 

 

 
 

little step by step while taking pictures of each movement. Then the pictures are used to 

 

 

 

play sequentially, which creates illusion of motion. Propelled clay animation as found in the 

Neverhood or Armikrog utilizes metal skeletons on which the dirt is shaped for more durable 

rigs. A few illustrators would utilize normal manikins rather than dirt ones, generally 

likewise based upon some kind of skeleton rig. The characteristics of the characters can be 

supplanted in light of the articulations or be controlled inside the rig. 

Another mainstream type of stop-motion is cut-out. Utilizing development paper 

or cardboard characters and putting them on paper, while shooting the animation from 

above. That is the means by which South Park was originally made before they exchanged 

the PCs. Like cut-out animation, outline animation utilizes cardboard or some sort of level 

material, yet the items are for the most dim parts and the shot is portrayed with outlines as 

it were. This is one of the most established types of stop-motion and is once in a while 

utilized today. 

 
     
 
 
 
 
 
 
 
 
 
 
 
 
 

Title : Stop Motion 

Attribution : Cogdogblog 

Source : https://www.flickr.com/photos/cogdog/5560633224/ 

Link : 

https://en.wikipedia.org/wiki/File:Stop_the_Motion_(5560633224).jpg 
 
 

Pixilation, is a type of stop-motion that utilizations genuine individuals and genuine 

conditions to make unbelievable recordings. It utilizes the stop-motion technique for taking a 

still photograph, moving things around and taking another photograph. However, the topic is 

normally used for genuine individuals rather than manikins. 

12 principles of animation 

 
           Walt Disney Studio‘s animators developed the twelve principles of animation in 1930. 

Frank Thomas and Ollie Johnston distributed them in their book "The Illusion of Life" 

https://www.flickr.com/photos/cogdog/5560633224/
https://en.wikipedia.org/wiki/File:Stop_the_Motion_(5560633224).jpg


 

 

 
 

Disney Animation, in 1981. Those standards came due to their goals to make sensible 

animations, through the development and articulation of the character. The standards taken 

after the essential laws of material science additionally manage more issues which are 

conceptual.  

 

 

These principles were utilized as rules to make toons and are still used today in numerous 

animation studios. The book "The Illusion of Life‖ has been considered by some as the 

―Bible of animation‖. Principles are: 

 

1. Squash and stretch  

          This is the rule that defines speed, energy, weight and mass of any animated subject. 

This is the most important principle of animation. Squash and stretch also use too 

exaggerated facial expressions and when you are animating dialogue you can apply it in any 

simple objects. For example, bouncing balls and very difficult creations like characters face 

muscles. It is the principal strategy for artists. 

2. Anticipation 

           This is the point when a character gets ready for action guiding audience what is 

going to happen next. It makes the activity seem more sensible. When a character is going to 

hop, before jumping into the air he needs to get ready for the activity by hunching down. To 

fabricate the vitality, it is resembled with a spring that loops up before discharging. A 

character‘s hopping with no anticipation is extremely unreasonable, in light of the fact that 

the vitality to bounce appears unexpectedly. You will see this in many toons, before running 

a character will pull back and takes a running pose holding for a second before taking off. 

Anticipation also utilizes rather than quickly extending up the face squashes initially to 

anticipate the extent and give it more power anticipation imparts activities to the group of 

onlookers by setting them up for the following activity. This can occur from numerous points 

of views. In the event that a character is going to remove something from their pocket, they 

arrange the position of their hand exceptionally obvious and not yet decided before going 

into the pocket. Something else, the gathering of people may miss it and think about how 

they got that protest in any case. The most important thing is that the viewer notices the hand 

and the pocket so the character cannot perform any competing actions. 

3. Staging 

 

          Staging is the introduction of guiding the gathering of people's thoughtfulness 

regarding what is essential in the scene. The extreme expansive guidelines are totally 

unmistakable as they cover a large number of zones of animation. It can apply to acting, 

timing, camera edge position and setting. During animation, you need to be in full control of 

where people are looking at. You are basically saying to take a gander at this, the control is 



 

 

 
 

accomplished through staging, the majority of the components of the scene cooperate to 

move the watcher's eyes around the scene. For instance, of awful staging, an animation of 

Tom chasing Jerry inside a house there are props like sofa, TV, carpets, vases and many 

more. 

 

 

          A character often gets obstructed by props used and a watcher does not know which 

one to take a gander at. The camera has a great deal to do with this. It‘s critical to know 

when to shut everything down or when to go, which is useful for an enormous scale of 

activity like showing a nuke blasting. The primary activity of the scene ought to be clear and 

basic. It can't be upstaged by various things that are going on which removes consideration 

from the principle point. It has to be a legitimate planning by allowing one activity to get 

completed before the other individual begins their activity, thereby avoiding overlapping. 

Now and then, you have to embed delays if there is something on the screen that is 

necessary to be handled by the watcher before proceeding 

onward. 

 

4. Straight ahead and pose to pose animation 
 

          This rule portrays two strategies used to animate drawings. The main technique is 

drawing the principal drawing and then moving on to the second drawing and so on. Then, 

sequentially arrange them by outlining from the beginning. The second technique is ‗pose to 

pose‘ in which you draw the starting and end of every principle pose and later on fill in the 

drawings at the middle called in-between poses. There are advantages to these two strategies 

but ‗pose to pose‘ is by far better for most activities since it gives the maximum control to 

what the activity will resemble. Utilizing straight ahead animation can prompt the character 

evolving size, or being on an alternate level from start to finish whereas pose to pose 

technique spares a considerable measure of work. On the off chance, animate an entire 

grouping straight ahead and then understand that one pose is off. You would need to change  

few drawings to settle that one pose. In pose-to-pose technique, you would do the 

fundamental poses to check whether it feels right and if you can get issues at an opportune 

time straight ahead animation. It is also useful for animation, which is flighty. A few cases 

of this incorporates fire, water, particles, dust and storms blasts explain the motivation 

behind straight ahead functions, which admirably is on the grounds that there are laws of 

material science that work at a steady rate and it is difficult to foresee them. Another method 

is animate using pose to pose, then going through, and adding the years using straight ahead. 

This is good because you can focus on the figures‘ movements without the distraction of 

having to do it and you can focus on the physics of the particular movement without the 

distraction of his body's movement. 



 

 

 
 

 

5. Follow through and overlapping action 
 

              This is the strategy of having body parts and different parts behind, whatever 

remains of the body and keeps on moving, a few sections of the body lead the action, and 

others follow the development. Drag is another mainstream method where the following 

parts of the body take a couple of more casings to get the primary lead parts.  

 

 

At the point when the body stops follow through, an overlapping action is regularly 

connected with another method called follow through. Follow-through alludes to the route 

parts of the body and keeps on moving after the body stops. Overlapping action depicts the 

counterbalance between the planning of the primary body and its different parts. Each of the 

three of these is depicting distinctive parts of a similar thing. Follow through is an 

overlapping action that includes a lot of authenticity to a character. Overlapping action when 

the fundamental body moves the tip of the limb ought to be the last to make up for lost time 

and when the body stops the tip ought to follow through the furthermost before settling back 

this is valid for extremities as well as the entire body too. When grinding to a halt regularly 

the body will follow through and then returned just, as a character needs to anticipate. 

6. Slow in and slow out 
 

            This rule alludes to the way practically all development begins gradually; constructs 

speed and completes gradually. This stands out amongst the most imperative procedure of 

accomplishing life like a motion without moderate in and moderate out feel mechanical. It is 

in light of the fact that robots are one of the main things that really move their parts at a 

consistent speed to utilize. 

           This principle in 2D animation is your extraordinary poses that attract a solitary 

between and then just in the middle of the drawings nearest to the extremes until the point 

that you're happy with the measure of moderate in and moderate out. With 3D animation and 

motion graphics having moderate in and moderate out issue, can be solved by changing the 

motion bends from straight to spline, modifying the Bezier handles to create a smooth curve 

in graph as time advances, the protest begins moderate gets quick. 

7. Arcs 
 

          Every action follows an arc, either you swing arm, throw a ball or chew a food. Curves 

make the animation feel normal and realistic. Arc in motion helps to define momentum too. 

Any object not following its natural arc will not look fluidic but erratic for example you 

cannot make sharp turn in a speeding vehicle rather than a slow-moving vehicle. 

8. Secondary Action 
 

          It implies something altogether, different secondary action portraying helps the 

fundamental action to add more measurement to the character animation. The secondary 



 

 

 
 

action commands the essential action. Secondary action helps in characterisation or 

expressing emotion like a tensed man is walking left and right with hands in his pocket, 

joyful person walking with swinging hands and whistling, a horse is running so its tail is 

waving fast following the movement of body. The principle of staging is also very vital in 

secondary action. 



 

 

 
 

 

 

9. Timing 
 

           This principle expresses that the identity and nature of an animation is incredibly 

influenced by the quantity of casings embedded between every primary action. Timing 

means the speed of action which gives the quantity of in-betweens i.e. between two keys. It 

includes picking the quantity of edges that will be used to animate a scene. The quantity of 

edges demonstrates the speed of the action on the film. The less casings and action the 

animation has, the speedier and crisper it will get. On the off chance that an action has many 

edges, it will be moderate and smooth. Timing adds surface and enthusiasm to the 

development of your characters. A decent approach to rehearse this method would be 

considering the acting and development of on-screen characters and entertainers in front of 

an audience and utilize it as reference while animating. 

10. Exaggeration 
 

            Each action poses and articulations are taken to the following level to build the 

measure of effect on the watcher. The early artists at Disney would get confounded on the 

grounds that Walt would instruct them to, which includes more authenticity yet when they 

transformed it. He would ensure the outcome since it was not overstated enough. 

           More sensible did not mean you would make the material science and extents steadier 

with reality but instead make the thought or embodiment of the action more evident.  

Exaggeration a decent manage to follow is to push the exaggeration level until the point that it 

really turns out to be excessive. Along these lines, you see the entire range beforehand as 

opposed to shooting oblivious right. Illustrators need to utilize determination and information 

and shield it from winding up plainly excessively showy animated. 

11. Solid drawing 
 

          This principle is tied with ensuring that structures feel like they are in three-

dimensional space with volume and weight. Adjusting one thing that makes animating 

simpler is having the capacity to draw a figure from all points. This requires learning of 

three- dimensional drawing. For instance, when drawing a line on a circle, it must follow the 

shape of the circle‘s surface. A straight line right away makes the circle look levelled when 

drawing blocks abstain from making parallel lines. Lines are ought to be twisted towards the 

vanishing point, otherwise it will resemble a level. Illustrators need to take craftsmanship 

class and genuinely draw is vital. 

12. Appeal 
 

           The last principle of animation is appeal. Characters that you animate ought to be some 

degree satisfying to take a look at. They should have some sort of magnetic angle about them  

to be liked. A character‘s appeal doesn't generally mean attractiveness, it may be based on its  

 



 

 

 
 

 

 

look or characteristics such as a scalawag ought to resemble to have an intriguing look. 

Everybody has an alternate standard for what is appealing; however, recently giving your 

character a dynamic plan can enormously support its appeal. Here are three stages for doing 

in order to start with: utilizing an assortment of shapes as opposed to, utilizing a similar shape 

for each character and experiment with various shapes on the grounds. There is no restriction 

to the range of insane arrangements that characters can have. Secondly, play with the extents. 

Visual artists regularly amplify the things, discover intriguing and contract the things. For 

instance, they may broaden the head and eyes, shrivel the body and make the hands bigger. 

Finding that part of a character, that characterizes his/her identity. Third, one is to keep it 

straight forward as a lot of data can over muddle the character and make it harder to control 

animation. 

Stages of creating an animation movie 
 

    The stages for creating an animation film, it has to go through phase‘s like:  

• Pre- production 

• Production 
 

• Post-production 

 

     These stages are sub-divided into parts and the animators execute their work as decided. 

Pre-production: 
 

            Pre-Production is the period of time during which work is done on a show prior to the 

first rehearsal. During pre-production, you make decisions that dictate how the rest of the 

production comes together. During pre-production, following things are finalized so that all 

the obstacles are removed to get a smooth production. 
 

• Writing the story 
 

• Production plan 
 

• Character development 
 

• Story board 
 

• Creating premises 
 

• Scene planning 
 

• Sound track 
 

• X-sheet 

 

Production: 
 

This is the most challenging stage of creating an animation film. At the stage, you get to see the 

actual result of the treatment given to the story and the visual achievement of the director‘s 

imagination. 



 

 

 
 

 

 

 

 

• Recording the dialogue 

• Layout designing  

• Background designing  

• Animating   

Post Production: 
 

            Post Production is the process of compositing and editing both the pictures into an 

organized matter. 

• Compositing 
 

• Digital compositing  

• Computer effects 

• Sound  

• Editing 

• Mixing audio-video  

• Final mixing 

 

Summary 
 

In this unit, you have learned about animation. It would introduce and expand the 

knowledge, understanding and skills for a diverse range of different types of animation by 

exploring relevant techniques and processes. Also, it explains the history of animation. You 

should be able to apply the 12 principles of animation and production processes to create an 

animation film. 

Assignments 
 

•  Explain what is animation 

• Examine the basic types of animation 

• List various steps for creating a 2D animation 

• Explain basic techniques used in 2D animations   

• Describe animation process 

• List principles of animation 

• Explain stop motion animation  

• What is layout design 

• List the types of colour use in inking and colouring



 

 

 
 

Resources 
 

•  http://resumbrae.com 
 

•    https://upload.wikimedia.org 

• https://cdn.pixabay.com 

•    https://google.com 
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Unit 2 
 

Drawing Concept 

Introduction 

Drawing is a form of visual art in which a person uses various drawing instruments to 

mark paper or another two-dimensional medium. Instruments include graphite pencils, pen 

and ink, inked brushes, wax color pencils, crayons, charcoal, chalk, pastels, various kinds of 

erasers, markers, various metals and electronic drawing. 

In this unit, we learn how to draw an image with basic concepts and techniques. To 

shade with different pencils, you will start out by using pencil to do a light touch on the paper 

and then push down harder to create a darker shade. Use different pencils to get long and 

wider lines from the shading. 4B and 6B pencil will have lines that look the same, but they are 

different in the way they apply graphite to the paper. Practice using all of your pencils to get 

an idea of how they write, then you can choose which will be the best for your drawing with 

an educated decision. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• Introduction to drawing 

• History of drawing 
 

• Understand the different types of art forms 

• Basics drawing categories 

•     Drawing methods 

•     Types of drawing 

Terminology 
 

Background: The most distant zone of space in a drawing which creates a three-dimensional 

illusion. It is helpful to give a sense of depth and balance of perspective in a drawing.  

Chalk: A wide variety of easily crumbled drawing materials produced in either round or 

square sticks ranging from coarse to fine, hard to soft, or dry to greasy. It is originally 

obtained from natural coloured limestone. 

Charcoal: Carbonized wood; willow (or sallow, a species of willow) twigs heated with a 

state of carbon in sealed chambers excluding oxygen in order that the wood doesn't burn and 

gets reduced to ashes. 

Conte Crayon: Semi-hard chalks of fine texture and various sizes containing a sufficient oil 
 



 

 

 
 

in the binder to adhere more or less permanently to smooth paper—available in black, white, 

brown, and sanguine (Venetian red), and three degrees of hardness. 

Floor Plane: The interior horizontal plane that the viewer stands on which extends to the 

horizon. 

Gesture: The essential line or depicted state of movement of a live or still 

form. 

Ground Plane: A smooth plane on which the viewer stands, it extends to the horizon marks. 

Life Drawing: Drawing from live forms in order to gain visual understanding of the 

movements, gestures, and physical capabilities of live bodies as aesthetically pleasing art 

forms. 

Sketch: A quick rough drawing with minimum outlines to understand the basic objects. 

Vine Charcoal: The highest quality stick charcoal—named for plant vines from which it is 

extracted through heating and carbonization. 

Drawing Concept 
 

Drawing as a verb describes the act of pulling, pushing or dragging a marking tool 

across a 2D surface. The line remarks that remain serve as a document of the action. These 

marks can vary depending on the type of marking tool used or the method of applying the 

image that results from this marking process is then referred to as a drawing. 

Drawings are basically broken down into two categories: 

1. Receptive 

2. Projective 

Receptive drawing is when an artist attempts to capture the appearance of something 

observed from our physical world, for this reason and he was about representational drawing 

observed from life is also an example of receptive drawing. Spanish artist Pablo Picasso 

serves as a good example of receptive drawing. Picasso was enrolled in the Royal Academy 

of San Fernando in Madrid as with most academies of the time Picasso was taught the strict 

mimetic tradition of drawing from live models and plaster casts, the idea was that drafting is 

a skill that any artist could master by following a series of strict rules as his career 

progressed. Picasso began abandoning the receptive drawing practice entirely, instead of 

drawing from the world around him. 

Picasso began drawing from his imagination; this type of drawing is referred to as 

projective drawing compared to a receptive drawing. The projective drawings usually have to 

make generalizations about the subject being depicted, even if Picasso had drawn images of 

hundreds of bowls from life. The moment he drew one from memory it could only be an 

approximation of what a bowl looks like. Due to this limitation projective drawings are often 



 

 

 
 

drawn in exaggerated or distorted ways to acknowledge the limitations of this method. For 

this reason, abstract drawings are often projective in nature and of course non-objective 

drawings are also projective because, they come straight from the artists imagination with no 

reference to the observable world. 

Documentation 
 

First, a drawing can be a form of documentation. In this way, a drawing concerned is a 

notation sketch for record. This notation can be about something that an artist observes, 

remembers or imagines. Visual artists often want to record their thoughts and they do this by 

keeping sketchbooks. 

Sketchbooks 
 

Sketchbooks are generally kept from the artist‘s reference and serve a similar role to 

that of a writer‘s journal. Italian Renaissance artist Leonardo DaVinci was renowned for the 

large number of sketchbooks he kept. Leonardo took a great interest in the study of human 

proportions as illustrated in his sketch the Vitruvian man. To learn more about human 

anatomy, he would also take part in medical dissections as illustrated in these sketches from 

observations of the human heart. He also sketched images of Great machines from his 

imagination even though the technology did not exist at the time Leonardo is credited for 

coming up with the concepts of modern machinery such as the tank and the helicopter. 

Preparations 

Drawings can also function as studies or preparations for a larger or more complex 

work. One very traditional form of this preparation is sketched for Paintings Michelangelo 

needed to create many studies first painted fresco on the ceiling of the Sistine Chapel because 

Buon fresco is such a fast drying process. Michelangelo did not have the leisure to work 

through the final orientations of his figures and arranged as he painted them, the more 

preparation you could do, the more successful the outcome and the less frustration would 

result for his powerful black and white painting entitled Guernica. Pablo Picasso made at least 

45 preliminary studies, each drawing serves a sketch for the next drawing until the artist felt 

he was better prepared to depict the tragic events of 1937. The subject of this painting was the 

Nazi bombing of the Spanish town Guernica that killed hundreds of unarmed civilians in the 

case of the contemporary installation team. 

Sketch 
 

The drawings also serve as sketches for architecture because buildings cost so much to 

erect, investors want to see finished plans before any ground is broken. Architectural 

drawings are usually drawn in perspective, including things like trees, cars and people to 



 

 

 
 

display the building scale. Even architectural renderings need to start somewhere. Believe it 

or not, this is a loose sketch served as the inspiration for Frank Gehry's Guggenheim Museum 

in Bilbao spinning after going through many other renderings and modelled. 

It was transformed into the complex 3D structure that stands today filmmakers often 

use drawings called storyboards to plan out the seeds of their films like building fills take a lot 

of money and labour to complete. Scenes having planned for pre-production prevent any 

unnecessary confusion or wasted funds although most directors hire artists to draw their 

storyboards for them. 

The Basics of Other Artforms 
 

Most of the drawings have given inspirations to different kinds of art. Drawing is, as a 

general rule, the premise of every single visual art. For instance, a structural drawing helps in 

building development, and markings on a stone piece give foundation for the sculpture that 

rises. Most paintings are in the first place a sketch and as the works continue, they are merged 

into coloured surfaces. Moreover, researches show that drawings shape the premise of the 

wall painting, board, book paintings, statues, and numerous other types of art.  

Drawing Media: 

Drawings are produced using instruments such as pen and ink, graphite point, chalks, 

pastels, charcoal, silverpoint, coloured crayons, metalpoint, graver, burin or etching needle 

for incised types of drawing. Other alternatives inlcude graphite sticks, wax or conte crayons, 

markers and various types of inked pens. Paper gives the most usual support but other options 

are card, board, cardboard, canvas, papyrus, leather, vellum (calfskin), textiles. Also, even 

plastic or metal will help, and mixed-media drawings are executed using a combination of 

these materials. 

History 
 

The history of the oldest art we know of is about 40,000 years old. The art was found 

on cave walls or sculpted from rocks, which comprises people who killed animals or each 

other. But there is an exception: the famous woman from willendorf, an abstract sculpture of a 

faceless obese lady who wears just a shower cap. Later, people began to note down things, 

and then starts a proper history with civilizations developing in Egypt, Persia, Mesopotamia, 

Greece, Rome, India and China. This historic time in art gave the world pots earthenware, 

crumbling temples and more. Then arrived warriors, warriors on pots, gods on pots, among 

other things. In the middle ages, the West was dominated by the church that disputed the 

validity of all the old gods to claim there was in fact only one god. Art could not feature 

unrealistic things such as dances of an elephant having more than one limbs or a man with 

winged beard but had to be about things that happened in the Bible. This more realistic,  

 

 



 

 

 
 

 

 

down-to-earth approach gave us morose men in yellow hats, morose men in pink shawls and 

lots of glowing babies. Then came the Renaissance and the material world real life places 

were rendered in three dimensions. Convincing use of perspective became widespread and the 

human body was shown as it really is in many images. However, some remain religious in 

nature, which also featured a flying wing man with laser beam eyes and has been done 

realistically too. Eastern art continued to develop in its own way -- showing scenes from 

nature or the everyday world like mountain people kissing or men dressing gowns, getting 

angry at others. Then came the modern art and the dawn of the ‗isms‘ such as impressionism, 

expressionism, cubism, dadaism and surrealism. The experiences of global war, the march of 

technological progress and the popularization of theories about the universe and the human 

mind as espoused by the likes of Einstein and Freud left their indelible mark on our species. 

The artistic gloves were off and it was time to experiment shapes, splats, blocks of colour, 

ghosts pokes, weeping women, fluorescent lights, urinals and unmade beds. All could be 

considered art in this brave new world people argued the point saying some modern art was 

shit and some of it really was watered art. Art today is part of the human condition and desire, 

which is as old as our species and quite probably embedded in our DNA as innate to us as 

eating, fighting and laughing at other people's misfortune. But it's also big business you're 

likely to see the famous artwork on a mug, a T- shirt or in a boardroom as in a gallery. The 

rise of cinema, television and the Internet has led to a dissemination of a common visual 

culture into every corner of the globe. While the Gideon pace of Technology and ceaseless 

progress has democratized the entire means of artistic production. 

Categories of Drawing: 
 

Drawing consists of three basic categories: 
 

• Casual drawing (portraying, doodling): This indicates incomplete and generally 

basic creations. These drawings don‘t have the continuous capacity. 

• Preparatory drawing: This indicates the production of a particular image or 

arrangement of images, shaping the entire thing or part of a creation the artist 

wants to finish by including colour (paints, coloured inks and so on). 

• Finished drawing: This indicates a finished remain of a solitary, independent 

work, for example, an illustration, a cartoon or visual art. 

Drawing Methods 
 

      Tools and equipments can be utilized to draw, including slate pencils, metal style, 

charcoal and chalks, and in addition, traditional pens, pencils, and brushes, wellspring pens, 
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ball-point pens, and felt pencils; even etches and jewels are utilized for drawing. 

• Line drawing 

• Stippling 

• Shading 

The surrealist technique for entopic graphomania (in which dots are made at the 

destinations of contaminations in a clear sheet of paper, and lines are then made between the 

dots), and tracing (drawing on a translucent paper, for example, tracing paper, around the 

blueprint of previous shapes that show through the paper). 

A fast and untreated drawing might be known as a sketch. 
 

In fields outside art, specialized drawings or arrangements of structures, hardware and 

different things are normally called "drawings" in spite of when they have been exchanged to 

another medium by printing. 

Charcoal 
 

Charcoal is the result of heating or charring an organic substance such as wood at a 

very high temperature, and the dense and dark substance results are primarily composed of 

carbon. A drawing medium charcoal is generally available in two type‘s compressed charcoal 

and vine charcoal. Compressed charcoal is the heavier of the two types. It is found in stick or 

pencil form with a clay binder added. Compressed charcoal is a relatively unforgiving 

medium and it gets dark very quickly. Once it is applied to the paper, it tends to be very 

difficult to erase because this medium is so soft and dark. It‘s almost impossible to erase the 

white of the paper. A firm rubber eraser is best for erasing the thickest areas and an eatable 

eraser works better for erasing wider applications. Some artists even use an eatable eraser too 

soft and smudge the heavy medium around the surface of the paper. A German drafts person 

lost children and friends in the two world wars in Europe. Her later life self-portraits were 

psychologically charged studies of a woman nearing the end of a difficult life. These 

emotionally bare drawings are made all the more powerful by the darkness and moodiness of 

the medium. Tis drawing entitled the call of death serves as an allegory to the literal hand of 

death coming to claim the sole of the weary artist. 

Vine charcoal 
 

Vine charcoal is both harder and physically lighter than compressed charcoal. For this 

reason, it is much lighter in value, if compressed charcoal can be applied to a 100-percent 

black, vine charcoal may only reach a sixty or seventy percent gray. Vine charcoal is much 

more forgiving than compressed charcoal because it can be easily erased by any of the 

aforementioned erasers, charcoal is also available in a fine powdered form and like vine 

charcoal. Charcoal powder goes on the support much lighter than compressed charcoal. For 



 

 

 
 

this reason, artists will often use vine or powdered charcoal as the under layer of a drawing 

with compressed charcoal on top white chalk can also be applied to the surface of a charcoal 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

drawing to create areas of highlight. 
 
 

Title : 

Charcoal Stic 

Attribution : 

Mrs 

Scarborough 

Source : Own 

work 

Link : 

https://commons.wikimedia.org/wiki/File:Charcoal_sticks_051907.jpg 

Graphite 
 

Graphite is apparently the most widely recognized drawing medium. It often comes as 

pencils, powder or filled sticks and is the thing that a large number of people essentially 

allude to as "pencil". Each one makes a scope of qualities relying upon the hardness or 

softness of the material. Hard graphite tones territory from light to dark gray, while softer 

graphite permits a range from light gray to almost dark black for that reason a considerable 

measure of graphite drawings is basically called pencil drawings. 

Graphite drawing strategies are for all intents and purposes interminable. In any case 

that you apply graphite to a surface will deliver some kind of results. French sculptor Gaston 

Lachaise's Standing Bare with hanging cloth is a pencil drawing that fixes the vitality and 

feeling of development of the figure to the paper in only a couple strokes. Steven Talasnik's 

contemporary extensive scale drawings in graphite, with their whirling, natural structures and 

architectural structures are a demonstration of the energy of pencil on paper. 

Dry Media 
 

Dry Media incorporates with charcoal, graphite, chalks and pastels. Each of these 

mediums gives the artist an extensive variety of stamp making capacities and impacts, from 

thin lines to huge areas of colour, shading and tone. The artist can control the application of  

 

 



 

 

 
 

 

material by applying required pressure to accomplish required impacts from multiple points 

of view, including similar individual weights on the medium against the drawing's surface, or 

by eradication, smearing or rubbing. 

This procedure of drawing can immediately exchange the feeling of character to an 

image. From vigorous to normal, these behaviors are clear in the least not easy works: the 

quick and unalloyed strength of the artists thought. You can observe this in the self-portraits 

of two German artists; Kathe Kollwitz and Ernst Ludwig Kirchner. Injured in the middle of 

the main world war, his Self-portraits under the influence of Morphine from around 1916 

presents us with a dreadful vision of him wrapped in the mist of sedative medications. His 

empty eyes and the realistic brokenness of his imprints confirm the energy of his drawing. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title : Portrait of Carl 

Sternheim. Lithographie 1916 

Attribution : Ernst Ludwig 

Krichner 

Source : http://www.kunsthaus-luebeck.de/sites/lagerkatalog-122/seiten/kirchner-el.html 

Link : 

https://commons.wikimedia.org/wiki/File:Ernst_Ludwig_Kirchner_Bildnis_Carl 

_Sternheim_1916.jpg 

Pastels 
 

Significantly more prominent color refinement is conceivable with pastel colored 

pencils, produced using powdered shades blended with a base measure of non-oily cover. At 

the point colors are out on paper, they perpetually look new and bright, despite the fact that 

they should be safeguarded from scattering by being kept under glass. Pastel colors are 

connected in straight method with the pastels, or to a region of the paper specifically with the 

fingers. Pastels originated in the north of Italy amid the 16th century, and were utilized by 

Jacopo Bassano (1515-92) and Federico Barocci (1526-1612). Pastel drawings were known 

http://www.kunsthaus-luebeck.de/sites/lagerkatalog-122/seiten/kirchner-el.html


 

 

 
 

to the Accademia degli Incamminati no later than the 17th century, in spite of the fact that as 

a work of art it didn't achieve its pinnacle until the 18th century, eminently in France (with 

Jean Marc Nattier, Maurice Quentin de La Tour, Jean-Baptiste Perronneau and Jean Chardin) 

and in Venice (with Rosalba Carriera). 

Oil Pastels 
 

Oil pastels are a relative of the wax crayons that you may remember from childhood. 

They are composed of pigment suspended in non-drawing oil and wax binder the oil and wax 

as binders make the colours of oil pastels much more vibrant than those of chalk pastels like 

oil paint. Oil pastels can be layered in a way that chalk pastels cannot, while powdery chalk 

pastels never get far from the surface of a drawing. Oil pastels apply much thicker and can 

create instances of actual texture for this reason. Though oil pastels are much more difficult to 

erase, your racers will often just smear the medium or smudge the pigment into the paper. 

Beverly Buchanan is a contemporary African-American artist who uses oil pastels to explore 

aspects of her southern rural tradition. Her work has a playfulness that embraces the inherent 

messiness of the media like Yoshimoto Nara. She adopts a children's art aesthetic that 

attempts to view the world through the fresh eyes of youth. 

Spray fixative 
 

The use of aerosol spray fixative when applied in thin coats, it holds dry media from 

smudging, smearing or rubbing off of the surface like varnishes for paintings. Spray fixative 

also protects the media from moisture, sunlight and time, even after fixing their drawing, 

artists will often store their work sandwiched between clean sheets of acid-free paper. This 

helps to further ensure that the delicate work will not be damaged or altered in any way. 

Graphite Point 

When 16th century was drawing to a close, another drawing medium showed up and 

quickly traded metal point for outlining and initial drawing. Due to its weak stability, it was 

utilized basically for beginning sketches, instead of independent drawings. The graphite point 

appropriately brought forth the lead pencil, after the revelation in 1790 by Nicolas-Jacques of 

an assembling procedure utilized as a part of the creation of artificial chalk. Cleaned and 

washed, graphite could from this time forward be fabricated in any level of hardness. The 

pencil focuses with their solid, clear, thin strokes, and was especially suited to the reasons for 

Neoclassicist artists. Among the best types of pencil designers was the intellectual painter J-

A-D Ingres, who utilized deliberate pencil drawings as the reason for his oil works of art. 

Chalk 

Chalk generally uses inert chalk as a binder told powdered pigments into a solid stick. 
 
 



 

 

 
 

Chalk pastel has a similar powdery softness to compress charcoal. It can be erased more 

easily than impressed charcoal but not as easily as vine charcoal. The chalk and chalk pastel 

gives the pigment a slightly muted or matted appearance. This is why certain muted colors are 

referred to as being pastels. French impressionist Edgar Daga made many chalk pastel studies 

in the late 19th century. His intimate drawings were often related to subjects like ballerinas. 

There's the matted pastel colors help convey the softness of early morning light.  

Liquid media/ Wet Media 

The term liquid media refers to any drawing medium that is wet during application 

rather than dry. India ink is a traditional liquid drawing medium that dates back to India in the 

4th century BCE. It is composed of a carbon black pigment water. India ink is usually applied 

with either a brush or with a nib pen. ink and wash is a drawing technique used in traditional 

Japanese culture where India ink is applied with a brush and water. thinning the ink with 

water, it is a way to create numerous and subtle values of gray. 

This process can be used to create very sumptuous and smooth gradients of tonality. 

There are many Western fine artists who borrow the Japanese tradition of ink and wash in 

their work. The study of a fountain by Vincent van Gogh serves as a good example, the quick 

sketch by Rembrandt Van Rhyn displays all the delicacy on this application of hair, even the 

dress of his sleeping subject. 

The reason that ink and wash is considered drawing rather than painting is due to the 

fact that art uses tonality rather than colour. As we know before, drawings have been 

historically viewed as being inferior in some ways to paintings. Paintings are generally larger 

and more complex and concentrated on colour rather than value because of this many Western 

fine artists have used ink and wash as a sketching medium. India ink also be applied precisely 

with a metal tipped nib pen, the tip or nib has a grooved channel that allows the ink to flow to 

the paper, the nib must be constantly dipped in the equal to ensure the desired flow of ink 

working with an ink pen more even lines than the ink and wash technique. The predecessor to 

the new pen was a sharpened bird feather called a quill. Today artists don't need to dip pens or 

quills into an inkwell unless they really want. 

Ink Pens 
 

Now many different types of ink pens are available, with ink and a cartridge, built 

right into the shaft of the pen. Different types of ink pens will create different kinds of lines, 

fountain pens which resemble the shape of nip pens are known for the fluidity of their mark. 

Ballpoint pens have crisper more even lines and felt tip pens can be used to create broader 

types of marks. The American draftsperson Andrew gory used ink pens to create his twisted 

take on children's book illustrations even though his work looks like a style from a century 24



 

 

 
 

ago. He was indeed living in the late 20th century these pieces may even seem innocuous 

unless you read their captions B is for Basel assaulted by bears. Graphic media like cartoons 

and comic books will often be drawn using ink pens graphic artists appreciate the clean crisp 

lines that these tools can create. Older cheaper forms of printing were also unable to print 

variations in value beyond black and white. This is why artists who use ink pens to imply a 

volume need to utilize a form of hatching or stifling. 

Felt tip 
 

Felt tip pens are viewed as a type of wet media. The ink is immersed into felt strips 

inside the pen, at that point discharged onto the paper or other help through the tip. The ink 

rapidly dries, leaving a perpetual stamp. The colored marker drawings of Donnabelle Casis 

have a streaming natural character to them. The unique nature of the topic gathers body parts 

and viscera. 

Different fluids can be added to drawing media to upgrade impacts – or make new 

ones. Craftsman Jim Dine has sprinkled pop onto charcoal drawings to make the surface rise 

with bubbling. The outcome is a visual surface not at all like anything he could make with 

charcoal alone, in spite of the fact that he is well known for his solid control and work. Dine‘s 

drawings regularly utilize both dry and fluid media. His topic incorporates creatures, plants, 

figures and instruments, commonly swarmed together in thick, dimly sentimental pictures. 

 

Types of Drawing: 

Portraits 

 
 
 
 
 
 
 
 
 
 

Title : Portrait of Maximilian  

I Elector of Bavaria 

Attribution : Joachim von  

Sandrart 

Source : Extract of de:Bild:MaximilianI.jpg 

Link : https://commons.wikimedia.org/wiki/File:MaximilianI-Bayern.jpg 

 

Portrait drawings normally include the perfect profile and three- quarter profile. Cases 

incorporate 15th century portraits by Pisanello or Jan van Eyck, and in addition Durer's 

drawing of the superior Maximilian. Works of Jean and Francois Clouet in France and of 

https://commons.wikimedia.org/wiki/File:MaximilianI-Bayern.jpg


 

 

 
 

Hans Holbein in Switzerland and later in Britain have given an exceptional self-rule on 

portrait drawing, particularly when finished in chalk of different colours. In the 18th century, 

Quentin de La Visit, Francois Boucher, and Jean-Baptiste Chardin were noted types of chalk. 

Portraits were more attractive for the psychological parts of portrait art. Late 19th and 20th 

century portraitists supported the soft pastels that all the more rapidly mirrored their 

masterful skills. 

Landscapes 
 

By the 15th century, landscape drawings had turned into a satisfactory subject for 

individual drawing too, as showed by Jacopo Bellini‘s 15th century sketchbooks. Still, not 

until the approach of Durer toward the finish of the century was landscape completely 

regarded as its very own subject without reference to similar works. Drawings of his two 

Italian adventures -- of the area of Nuremberg and his trip to the Netherlands -- reflect the 

first flawless landscape drawings. Hundreds of years were to go before such flawless 

landscape drawings happened once more. Landscape components additionally showed up in 

sixteenth century German and Dutch drawings and illustrations, eminently those by 

individuals from the Danube School like Albrecht Altdorfer and Wolf Huber. Netherlandish 

Renaissance painter Pieter Bruegel - The Senior drew geographical perspectives and free 

landscape structures too, in both the cases as an autonomous works. In the 17th century, the 

landscape drawings of the Accademia Degli Incamminati, blended classic and legendary 

topics with courageous landscapes. What's more, Rome-based French classicists Claude 

Lorrain and Nicolas Poussin additionally created romanticized Arcadian landscape drawings. 

In the 18th century Italy, the geographically correct landscape drawing accomplished a high 

point with the approach of the Vedutisti, the view painters like the Venetians Canaletto 

(1697-1768) and Bernardo Bellotto (1720-80), and the Roman Giambattista Piranesi (1720-

78).landscape drawings achieved a moment blooming in Britain amid the mid-nineteenth 

century on account of works by JMW Turner and Alexander Cozens, while in France the 

convention was exemplified by Camille Corot and, later, VanGogh. 

Figurative Genre Works 
 

Of far less significance to independent drawing than portraiture and landscape, figure 

drawings are normally tightly associated with what was going on to painting as a rule. In this 

way, for instance, drawings of kind scenes were moderately common amid the 17th century 

Dutch realism School, in 18th century France and Britain, and in 19th century France. 

Still Life 
 

Still life drawings, outstandingly the portrayals of blooms, similar to those of the 
 

Amsterdam artist Jan van Huysum (1682-1749), have been well known as far back as the 26



 

 

 
 

17th century. In some of these works, the equality to painting is close; take for instance, the 

pastels of the nineteenth century French artist Odilon Redon (1840-1916), or the work of the 

twentieth century German Expressionist Emil Nolde (1867-1956), both of which cross the 

separating line amongst drawing and painting. 

Fantasy Drawings 
 

Drawing portraying is unbelievable, extraordinary or visionary subjects, for example, 

the incredible compositions of Hieronymus Bosch, have for quite some time been prevalent. 

See similarly the grotteschi of Raphael in the 16th century, the symbolic manual worker 

scenes by Pieter Bruegel, and the festival etchings of the 17th century French artist Jacques 

Callot. Other specialists whose drawings fall outside scene and likeness include the eighteenth 

century Italian engraver Giambattista Piranesi, the English Swiss artist Henry Fuseli (1841-

1925), the nineteenth century English illustrator artist Walter Crane (1845-1915), the 

compelling French Symbolist artist Gustave Moreau (1826-98) and the 20th century 

surrealists. 

Illustrations 
 

The illustrative drawing does not possibly go past a basic pictorial clarification of a bit 

of content, yet even it might in any case fulfill the most elevated creative requests. 

Repeatedly, awesome artist have illustrated scriptural messages and in addition writing of 

numerous types. Popular cases, the 18th century German sculpture Daniel Nicholas 

Chodowiecki (1726-1801), the nineteenth century caricaturist Honore Daumier (1808-79), the 

nineteenth century visual artist Wilhelm Busch (1832-1908) best known for his rhyming 

picture stories (Max und Moritz), and the twentieth century Austrian Blaue Reiter painter and 

artist Alfred Kubin (1877-1959). 

Caricatures 
 

Related with illustrative drawing is the art of personification/caricature, which, by 

misrepresenting the visual qualities of a man or circumstance, makes a capably suggestive 

picture. This kind of symbolic drawing is exemplified by such illuminating presences as 

Annibale Carracci (1560-1609) - who initially start the word caricatura - Leonardo daVinci, 

Durer, and the Extravagant artist Bernini, and by social reporters like the 18th century Italian 

artist Wharf Leone Ghezzi (1674-1755), the 18th century English artist William Hogarth 

(1697-1764), the English caricaturist Thomas Rowlandson (1756-1827) who worked 

fundamentally in ink and watercolor wash, the nineteenth century Frenchman Jean-Ignace-

Isidore Gerard, known as Grandville (1803-47), and possibly the best caricaturist of all, 

Honore Daumier. 

 



 

 

 
 

Types of Ground 
 

One can draw on practically anything that has a plane surface - level or not -including 

papyrus and material, fabric, skin, wood, metals, and glass. In any case, since the mid-

fifteenth century, the paper has been the most well-known and most prevalent ground. 

The technique for paper production remained intact for all intents and purposes, 

unaltered as far back as 2,000 years. A strong thick remainder of mulberry bark, bast, hemp, 

and linens pressed and dried in level molds. The presentation of wood mash in the mid-

nineteenth century was not gone for art paper, since paper with a substantial wood content 

yellows rapidly and is in this manner ill- suited for drawing purposes. Initially, to give the 

paper an adequately smooth and even surface for composing or drawing, it was rubbed with a 

bone feast or gypsum chalk in a thin arrangement of paste and gum. Be that as it may, since 

the late 15th century, a similar impact has been accomplished by plunging the paper in a 

paste or alum shower. Shades and colors are as well added to the mash, with blue "Venetian 

papers" being particularly prominent. The 17th century supported half tints of blue - or gray, 

dark brown, and green assortments; the eighteenth favored warm colours like beige or ivory, 

alongside blue. Since the eighteenth century, drawing papers has been created in practically 

every possible colour and shade, while quality has additionally incredibly expanded. 

Granulated and softer drawing actualizes, for example, chalk, charcoal, and graphite 

are not as reliant on a specific sort of paper (as, watercolors, pastels or pen, and ink); yet, in 

light of their slight glueyness, they regularly require a more grounded bond with the 

establishment and also some sort of surface security. 

Unit Summary 
 

In this unit you were introduced to basic types of drawing. You must be able to 

identify and use these techniques correctly, neatly and accurately. You find and build up a 

remarkable association with a wide range of drawing mediums -- from primitive charcoal to 

contemporary computerized drawing. The aim of the lessons is to give major of drawing and 

to likewise move you past the crucial ideas, to enable you to investigate the unlimited 

potential outcomes of check making and to create both one of a kind ways to deal with 

materials and your stylish basic leadership. The fundamental point of this unit is simply the 

longing to venture outside and find new imaginative ways. These drawing units are intended 

for all levels of drawing knowledge, in any case you approach central drawing procedures. 

 

 

 

 

 
 



 

 

 
 

 

Assessment 
 

1. Explain the concept and meaning of drawing 

2. Explain what is art 

3. Who are the best history painters 
 

4. Classify different types of drawing media 

5. When "modern art" begin 

6. Describe contemporary art. 
 

7. Who are the greatest portrait artists 

8. What is fine art 

9. Describe art Deco 
 

10. What is figure drawing 

11. Describe "fresco" 

12. Define and apply the art vocabulary associated with pen and ink 

13. State the benefits of using water colours 

14. Describe the advantages of using oil paint 

15. Define portrait 

Resources 
 

• https://s-media-cache-ak0.pinimg.com 

• http://mexicounexplained.com 

• https://google.com 
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Unit 3 
 

Basics of Color Theory 

Introduction 

This unit is about the exploration of color theory. You will learn what color theory is, 

its history, different kinds of colors. However, essentially, the unit is concerned with the core 

principles and concepts of color theory, and understanding how to apply them to a character in 

order to create the animation. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• Know about color theory 

• Introduction to color visonprinciples 

• Elucidate about the history ofcolor 

• Understand about Interaction of colors 

• Color expressions 

Terminology 
 

Hue: The apparent value of a color, the color itself. 
 

Saturation ofChroma: The general power or splendour of a color. 

Value: The delicacy or haziness of a color. 

Tone: Addition of dim to an immaculate hue or color. 

Shade: Addition of dark to an unadulterated hue or color. 

Primary Color: The primary colors are Red, yellow, blue. 

Secondary Color: The secondary colors are Cyan, Magenta, Yellow and Black. 
 

Triadic: The three colors equidistant from each other on the color wheel (illustration: red, 

yellow and blue). 

Optical Color: Color that individuals really see additionally called neighbourhood color. 

Arbitrary Color: Colors picked by the craftsman to express emotions or state of mind. 

Introduction to color theory 

With colors you can set a disposition, draw in consideration, or create an impression. 

You can utilize color to invigorate, or to cool down. By choosing the correct color plan, you 

can make an atmosphere of style, warmth and serenity or you can pass on a picture of fun 

loving energy. Color can be your most capable component when you figure out how to utilize 

it viably. 



 

 

 
 

Colors influence us from numerous points of view, both rationally and physically. A 

solid red color has been appeared to raise the circulatory strain, while a blue color has a 

calming impact. Having the capacity to utilize colors deliberately and concordantly can enable 

you to make fabulous outcomes. 

History of color theory 
 

The main color wheel was invented by Sir Isaac Newton. He split white sunlight into 

red, orange, yellow, green, cyan, and blue shafts. At that point, he joined the two closures of 

the color range together to demonstrate the normal movement of colors. Newton connected 

each color with a note of a melodic scale. 

A century after Newton, Johann Wolfgang Goethe started studying mental impact of 

colors. He saw that blue delivers a feeling of coolness and yellow has a warming effect. 

Goethe made a color wheel showing the mental impact of individual color. He partitioned 

every one of the colors into two gatherings - the "in addition to" side (from red through 

orange to yellow) and the minus side (from green through violet to blue). Colors of the "in 

addition to" side create energy and brightness. Colors of the "minus side" are related with 

shortcoming and unsettled feelings. 

The present form of color theory was produced by Johannes Itten, a Swiss color and 

craftsmanship theorist who was teaching at the School of Applied Arts in Weimar, Germany. 

Johannes Itten created 'color chords' and changed the color wheel. Itten's color wheel depends 

on red, yellow and blue as the primary set of three and includes twelve hues. 

The Three Dimensions of Color 
 

The 'Post-Impressionists', subsequent to acing Impressionist theory, tossed its strict 

application out of the window, with the exception of Cezanne. He supported warm-cool 

differentiations and complexities of color-saturation (level of virtue) to such an extent like 

inverse hues. In this manner, he re-attested basic characteristics of painting, utilizing high 

color, that were lost in favoring the complexity of hues over the other two measurements of 

color. It is an essential indication on how he utilized saturation to construct frame. To 

comprehend what Cezanne was doing, it is critical to remember the three measurements of 

color and four types of differentiation that they make accessible. The three measurements are: 

1. Value (light-dim). 
 

2. Hue (the wavelengths: green, red, yellow, and so forth.). 

3. Saturation (virtue of color) 

These measurements can be set in a three-dimensional model. Note that the color 
 
 



 

 

 
 

circle is calculated in respect to the vertical value(brightness) scale with the goal that the 

unadulterated hues are set opposite to each other to their coordinating values. 

Each of these measurements gives a type of complexity: 

1. Value: light versus dim 

2. Hue: color versus its inverse 
 

3. Saturation: killed color versus unadulterated color 
 

Each of these differentiations, independently or together, can be utilized to assemble 

space and shape and to escalate lighting impacts. The last complexity accessible is the warm-

cool differentiation. A warm-cool differentiation is really a component of hue as opposed to a 

different measurement. 

Earle Loran, who distributed the conclusive work, "Cezanne's Compositions" attested 

that the canvases could be dissected on the premise of highly contrasting (value) outlines. His 

examination of the canvases on these grounds is splendid. In any case, it is deficient in light of 

the fact that he disregarded the way that Cezanne was forming with an advanced blend of 

value, hue and saturation. 

The Color Wheel 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title : RGB Color wheel Attribution : DanPMK 

Link : https://commons.wikimedia.org/wiki/File:RBG_color_wheel.svg 

The color wheel or color circle is the essential instrument for consolidating colors. 

The main circular color graph was planned by Sir Isaac Newton in 1666. The color wheel is 

outlined with the goal that for all intents and purposes, any colors you pick from it, will look 

great together. Throughout the years, numerous varieties of the essential outline have been 

made, yet the most widely recognized rendition is a wheel of 12 colors in view of the RYB 

(or creative) color model. Customarily, there are various color blends that are considered 



 

 

 
 

particularly satisfying. These are called color harmonies of color harmonies and they 

comprise of at least two colors with a settled connection in the color wheel. 

Traditional Color Theory 
 

Complementary colors 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title : Complementary Colors Attribution : Bababao 

Link : https://commons.wikimedia.org/wiki/File:Complementary.jpg 

For the mixing of colored lightweight, Isaac Newton's color wheel is normally used to 

depict integral colors, the square measure colors that cross out each other's tint to supply 

relatively colorless (white, grey or black) lightweight blend. Newton offered as a guess, that 

colors exactly inverse each other on the shade circle dispose of each other's tone; this thought 

was incontestable a ton of absolutely inside the nineteenth century. 

A key presumption in Newton's shade circle was that the "blazing" or most immersed 

tones are settled on the external perimeter of the circle, though colorless white is at the center. 

At that point the immersion of the blend of 2 ghastly shades was anticipated by the line 

between them; the blend of 3 colors was predicted by the "center of gravity" or center of mass 

of 3 triangle focuses, et cetera. 

As per old color hypothesis bolstered subtractive essential colors and consequently, 

the RYB color model that originates from paint blends, yellow blended with violet, orange 

blended with blue, or red with green creates a comparable dim and are the painter's 

corresponding colors. These kinds of complexities are the possibility of Chevreul's law of 

color difference: colors that appear along are changed as though blended with the chromatic 

color of the inverse color. In this manner, a touch of yellow fabricated set on a blue 

foundation can appear tinted orange. Be that as it may, once integral colors square measure 33

https://commons.wikimedia.org/w/index.php?title=User%3ABababao&action=edit&redlink=1


 

 

 
 

picked bolstered definition by lightweight blend, they're not comparable on the grounds that 

the craftsmen's essential colors. This disparity winds up noticeably imperative once color 

hypothesis is connected crosswise over media. Computerized color administration utilizes a 

tone circle delineated round the added substance essential colors (the RGB color model), in 

light of the fact that the colors in an exceedingly PC screen, square measure added substance 

blends of daylight, not subtractive blends of paints. 

 

Warm vs. cool colors 
 
 
 
 
 
 

Title : Warm Cool Color Attribution : Oliver Harrison 

Link : https://commons.wikimedia.org/wiki/File:ART_WARM_COOL_COLOR.png 

The qualification amongst "warm" and "cool" colors has been imperative since 18th 

century. The refinement, as inferred by historical backgrounds inside the Oxford English 

Dictionary, shows up that a scene light-weight is the "warm" colors identified with sunlight 

or sunset and furthermore the "cool" colors identified with a grey or cloudy day. Hot colors 

square measures normally aforementioned to be tints from red through yellow, tans and 

browns included; cool colors square measures ordinarily previously mentioned to be the 

tones from blue green through blue violet, most grays encased. 

Color theory creates a tangible action and mental impacts to the present refinement. 

Hot colors are said to progress or appear to be extra dynamic in an exceedingly painting, 

while cool colors have a tendency to retreat; utilized in inside style or form. Hot colors are 

said to excite or animate the watcher, though cool colors quiet and unwind. The vast majority 

of those impacts, which are genuine, will be ascribed to the upper immersion and lighter 

worth of warmth colors in comparable to chill shades. Subsequently, darker could be a dull, 

unsaturated hot color that a couple of people consider as outwardly dynamic or mentally 

stimulating. 

Achromatic colors 
 

Any shading that needs solid chromatic substance is said to be unsaturated, colorless, 

close unbiased. Close neutrals incorporate browns, tans, pastels and darker hues. Close 

neutrals can be of any hue or lightness. Unadulterated colorless or unbiased hues incorporate 

black, white and all grays. 

Close neutrals are acquired by blending unadulterated hues with white, black or gray, 

or by blending two reciprocal colors. In shading hypothesis, impartial hues are effectively 

 



 

 

 
 

changed by adjoining more immersed colors and they seem to go up against the tone 

reciprocal to the soaked shading; e.g.: beside a splendid red sofa, a gray divider will show up 

particularly greenish. 

Tints and shades 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title : Tint-tone-Shade Attribution : Jacobolus 

Link : https://commons.wikimedia.org/wiki/File:Tint-tone-shade.svg 

A tint is the blend of a color with white, which builds lightness, and a shade is the 

blend of a color with black, which reduces lightness. A tone is created either by the blend of a 

color with gray, or by both tinting and shading. Blending a color with any impartial color 

(counting black, gray and white) reduces the chroma, or colorfulness, while the hue stays 

unaltered. 

The expression "shade" can be summed up to besides incorporate any assortments of a 

specific color, regardless of whether in fact they are shades, tints, tones, or marginally unique 

hues; while the expression "tint" can be summed up to allude to any lighter or darker variety 

of a color. 

When blending colored light (added substance color models), the colorless blend of 

frightfully adjusted red, green and blue (RGB) is not gray or black, it‘s constantly white. 

When we blend colorants, for example, the shades in paint blends, a color is delivered which 

is constantly darker and brings down in chroma, or immersion, than the parent colors. This 

pushes the blended color toward an impartial color—a gray or close black. Lights are made 

brighter or dimmer by changing their brilliance, or vitality level; in painting, lightness is 

balanced through blend with white, black or a color's supplement. 

Split primary colors 
 

In painting and other visual expressions, two-dimensional color wheels or three-

dimensional color solids are utilized as apparatuses to show tenderfoots the fundamental 

connections between colors. The association of colors in a specific color model relies upon 

the reason for that model: a few models indicate connections in view of human color 

observation, though others depend on the color blending properties of a specific medium, for 

 



 

 

 
 

example, a PC show or set of paints. 
 

This framework is as yet prevalent among contemporary painters, as it is 

fundamentally a rearranged rendering of Newton's geometrical decide that colors nearer 

together on the tone circle will create more dynamic blends. Notwithstanding, the scope of 

contemporary paints accessible, numerous craftsmen just add more paints to their palette as 

craved for an assortment of viable reasons. 

Color Harmony 
 

Harmony is nature's method for saying that at least two things together bode well. 

Color harmony speaks to a fantastic adjust or solidarity of colors. Mixes of colors that exist in 

harmony are satisfying to the eye. The human mind recognizes the visual intrigue and the 

feeling of request made by the harmony and structures a dynamic equilibrium. Experts have 

particular thoughts in light of the standards of color hypothesis and color brain research of 

color mixes that are tastefully engaging and lovely. The accompanying calculated model 

shows this 21st century way to deal with color harmony: 

Color harmony = f (Col1, 2, 3, ..., n). (ID+CE+CX+P+T) 
 

Wherein color harmony is a function (f) of the cooperation between color/s (Col 1, 2, 

3,…, n) and the components that impact constructive stylish reaction to color: singular 

contrasts (ID, for example, age, sexual orientation, identity and full of feeling state; cultural 

encounters (CE), the context (CX) which incorporates setting and surrounding lighting; 

interceding perceptual impacts (P) and the impacts of time (T) as far as overarching social 

patterns. 

Color Harmonies: Basic techniques for creating color schemes 
 

Furthermore, given that people can see more than 2.8 million distinct tones, it has 

been proposed that the quantity of conceivable color mixes is for all intents and purposes 

limitless in this way suggesting prescient color harmony formulae are in a general sense 

unsound. Despite this, many color scholars have concocted formulae, standards or rules for 

color mix with the point being to anticipate or determine constructive tasteful reaction or 

"color harmony". Color wheel models have frequently been utilized as a reason for color 

blend standards or rules and for characterizing connections between colors. A few scholars 

and specialists trust juxtapositions of reciprocal color will deliver solid difference, a feeling of 

visual pressure and in addition "color harmony"; while others trust juxtapositions of 

comparable to colors will inspire positive stylish reaction. The following demonstrate the 

essential color harmonies in view of the color wheel. 

 
 
 

 
 
 



 

 

 
 

 
 

Analogous color Scheme 
 
 
 
 
 
 
 
 
 
 
 

Title : Analogous Colors 

Attribution : Trond Grøntoft 

Link : https://commons.wikimedia.org/wiki/File:AnalogousColors.png 

Practically equivalent to color plan tend to create a solitary tinted or monochromatic 

color involvement and a few scholars likewise allude to these as "basic harmonies". 

Undifferentiated from color plans are frequently found in nature and are agreeable 

and satisfying to the eye. Ensure you have enough differentiation while picking a comparable 

to color plan. Pick one color to command, a moment to help. The third color is utilized 

(alongside black, white or gray) as a highlight. 

Complementary Color Schemes 
 

Integral color plans normally delineate an adjusted corresponding pair, with rather 

than the "genuine" second color being picked, a scope of comparable to tints around it are 

picked, i.e. the split supplements of red or green. 

The high differentiation of corresponding colors makes an energetic look, particularly 

when utilized at full immersion. This color plan must be overseen well so it is not jostling. 

Reciprocal color plans are dubious to use in expansive dosages, yet function admirably when 

you need something to emerge. Correlative colors are truly terrible for content. 

Triadic Color Scheme 
 

Triadic color plan receives any three colors roughly equidistant around a color wheel 

demonstrate. Triadic color plans have a tendency to be very lively, regardless of the 

possibility that you utilize pale or unsaturated adaptations of your shades. To utilize a triadic 

agreement effectively, the colors ought to be deliberately adjusted - given one color a chance 

to command and utilize the two others for highlight. 

Split-Complementary Color Scheme 
 

Split-Complementary color plan is a variety of the complementary color plan. 

Notwithstanding the base color, it utilizes the two colors contiguous its supplement. This 

color plan has an indistinguishable solid visual complexity from the complementary color 

plan, yet has less pressure. The split-complimentary color plan is frequently a decent decision 



 

 

 
 

for apprentices, since it is hard to botch up. 
 

Rectangle (tetradic) Color Scheme 
 

The rectangle or tetradic color plan utilizes four colors organized into two integral 

sets. This rich color plan offers a lot of potential outcomes for variety. Tetradic color plans 

works best on the off chance that you let one color be dominant. You ought to likewise focus 

on the harmony amongst warm and cool colors in your outline. 

Square Color Scheme 
 

The square color plan is like the rectangle, however, with every one of the four colors 

dispersed equally around the color circle. Square color plans works best on the off chance 

that you let one color be dominant. You ought to likewise focus on the harmony amongst 

warm and cool colors in your outline. 

Color Physics (Newton, 1676) 
 

1.  A triangular prism scatters white sunlight into a range of colors (rainbow): Red, 

Orange, Yellow, Green, Blue, Dark blue and Violet. Each shade (color) can be 

precisely characterized by indicating its wavelength of recurrence. The light waves are 

discolored. Color emerges in the human eye and cerebrum. Each ghostly tone is the 

supplement of the blend of the various otherworldly tones. 

2.  Light produces the color: Colors are the offspring of light, and light is their mom. A 

question does not have any color in itself. A red question looks red on the grounds 

that the particle constituting its surface retains every other color of light, and reflects 

just red. 

3.  Color temperature: 
 

Standard Incandescent = Temperature 2700 Kelvin Halogen = 3000K 

Tungsten = 3200K Fluorescent = 4200K Daylight = 5000K 

Color Process 
 

1. Subtractive Color (reflected pigment) 
 
 
 
 
 
 
 
 
 
 
 
 

Subtractive Color 
 



 

 

 
 

Title : Subtractive Color 

Link :https://commons.wikimedia.org/wiki/File:SubtractiveColorMixingII.png#file 

Color coming about is because of retention of light. Their blends are administered by 

the run of subtraction. All color, when blended in specific extents, the subtractive outcome is 

black. (Pigmentary, objects, printed matter and CMYK color) there are three primary shades 

red, yellow and blue that can consolidate to acquire all other color tints. 

(Primary color of Pigment) Cyanine (Blue) + (Primary) Magenta = 

(Secondary) Violet 

(Primary color of Pigment) Magenta (Red) + (Primary) Yellow = 

(Secondary) Orange 

(Primary color of Pigment) Yellow + (Primary) Cyanine = 

(Secondary) Green 

Blend of 3 primaries of reflected shade: Black (Brown) 

Reciprocal + Complementary = Gray 

2. Additive Color (projected light or reflected light): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Addictive Color 

Title : Additive Color 

Source : mage:Synthese+.svg 

Link : https://commons.wikimedia.org/wiki/File:AdditiveColorMixiing.svg 

All colored light, when blended in specific extents, the added substance result in 

white. Color coming about is because of projection of light. (TV screen, PC screen and RGB 
 

color) 
 

(Primary color of light) 
 

(Primary color of light) 

 
 

Red + (Primary)Green = (Secondary) Yellow 
 

Green + (Primary) Blue = (Secondary) Cyanine 
 

(Primary color of light) Blue + (Primary) Red = (Secondary) Magenta 
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Mixture of 3 primaries of projected light: White 
 

Color Wheel of the Pigment Color (misleadingly increased range, 
 

included purple) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title : Color Pigment 

Attribution : Stib at English Wikipedia 

Source : Methecooldude using CommonsHelper 

Link : https://commons.wikimedia.org/wiki/File:Color_Pigment.png 

Color Contrast 

Much the same as for difference of structures the figure-ground relationship is 

essential for differentiate in color. The color distinction between a subject (or figure) and its 

encompassing field (ground) makes differentiate - the more difference between a figure and 

the ground, the more unmistakable it progresses toward becoming. 

Difference of color comes in two essential assortments, esteem differentiates (light 

versus dull color) and tone differentiates (contrast in color tint). Yet, there is more to color 

complexities. In his two surely understood books, "The Art of Color" and "The Elements of 

Color," Itten expounds on the viability of color associations regarding seven particular color 

differences as we'll see next. 

What is Itten's Color Contrasts? 
 

Contrast of tint: Difference between tones, for example, yellow, blue and red. 

1.   Light-dim complexity: Black and white, night and day, dim gray and 

light gray.The differentiate is shaped by the juxtaposition of light and 

dim esteems. Additionally compelling as a monochromatic creation. 

2. Cool-warm differentiation: Red, orange yellow (warm) stood out from 

blue, green and dark colored (cool). 

3. Complementary differentiation: Opposing colors on the color wheel which 

make maxi-mum complexity; yellow, violet, blue, orange, red, green. 
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4. Simultaneous difference: Contrast when the limits between colors 

perceptually vibrate here and there making fascinating deceptions. This is 

an impact that happens when two adjoining colors upgrade or reduce 

their optic immersion: 

• White looks more white when encompassed by darker esteem. 
 

• Gray seems more extreme when encompassed by lighter esteem. 

• Colors can seem lighter or darker relying upon their 

encompassing quality and shade. 
 

5. Difference of immersion: Contrast between immaculate, extraordinary 

colors and more nonpartisan, pale colors. 

6. Difference of augmentation: Involves allotting numeric properties to color 

and then utilizing them in measuring relative sums by each other. 

Color Expressions 
 

The accompanying colors summon certain implications in this culture. These 

subliminal observations, natural idea and positive information ought to dependably work 

together. They bear some broad truth, yet may shift in various social orders. They are 

identified with the mental domain, mental and enthusiastic experience of the watcher. 

Red 
 

Red stands for the color of flame and blood, and is related with war, vitality, quality, 

peril, control, assurance, enthusiasm, longing, and love. It is a sincerely serious color, and 

improves human digestion, expands breath rate, and raises circulatory strain. It has high 

perceivability, which is the reason stop signs, stoplights and fire hardware are typically 

painted red. In heraldry, red is utilized to show mettle. It is a color found in numerous 

national banners. 

 

Orange 
 

Orange joins the vitality of red and the satisfaction of yellow. It is related with 

euphoria, daylight, and the tropics. Orange speaks to energy, interest, satisfaction, 

innovativeness, assurance, fascination, achievement, consolation, and incitement. 

 

Yellow 
 

Yellow stands for the color of sunshine and is associated with happiness, joy, intellect 

and energy. Yellow produces a warming effect, arouses cheerfulness, stimulates mental 

activity, and generates muscle energy. Yellow is often associated with food. Bright, pure 

yellow is an attention getter, which is the reason why taxicabs are painted this color. When 

overused, yellow may have a disturbing effect; it is known that babies cry more in yellow 



 

 

 
 

rooms. Yellow is seen before other colors when placed against black; this combination is 

often used to issue a warning. In heraldry, yellow indicates honor and loyalty. Later the 

meaning of yellow was connected with cowardice. 

Green 
 

Green is the color of natural world. It is a symbol of development, concordance, 

freshness and fruitfulness, and has compelling enthusiastic correspondence with security. 

Dull green is additionally normally connected with cash. Green has awesome recuperating 

power. It is the most serene color for the human eye; it can enhance vision. Green 

recommends steadiness and continuance. Some of the time green signifies absence of 

experience; for instance, a "greenhorn" is a tenderfoot. In heraldry, green shows development 

and expectation. Green, instead of red, implies wellbeing; it is the color of free entry in street 

movement. 

Blue 
 

Blue is the color of the sky and ocean. It is regularly connected with profundity and 

soundness. It symbolizes put stock in, dedication, shrewdness, certainty, insight, confidence, 

truth, and paradise. Blue is viewed as advantageous to the brain and body. It moderates 

human digestion and produces a quieting impact. Blue is unequivocally connected with 

serenity and tranquillity. In heraldry, blue is utilized to symbolize devotion and earnestness. 

You can utilize blue to advance items and administrations identified with cleanliness (water 

purging channels, cleaning fluids, vodka), air and sky (carriers, air terminals, aeration and 

cooling systems), water and (ocean voyages, mineral water). Instead of sincerely warm colors 

like red, orange, and yellow; blue is connected to cognizance and acumen. Utilize blue to 

recommend accuracy while advancing cutting edge items. 

Violet 
 

Violet consolidates the soundness of blue and the vitality of red. Violet is related with 

sovereignty. Violet is a baffling, reflective, enthusiastic, devotion color and the color of 

poise. Its tints symbolize the brighter parts of life, while shades speak to the dim, negative 

powers and dread. 

White 
 

White stands with light, guiltlessness, goodness, immaculateness and virginity, and is 

the color of flawlessness. White means security, virtue and cleanliness. Rather than dark, 

white as a rule has a positive meaning. White can speak to a fruitful start. In heraldry, white 

delineates confidence and virtue. 

Black 
 



 

 

 
 

Black is related with control, style, convention, passing, abhorrence, and riddle. Black 

is a secretive color related with fear and the obscure (black gaps). It normally has a negative 

essence (blacklist, black cleverness, 'black demise'). Black means quality and specialist; it is 

thought to be an extremely formal, rich, and esteemed color (black tie, black Mercedes). In 

heraldry, black is the image of distress. 

Black gives the sentiment viewpoint and profundity, however, a black foundation 

reduces decipherability. When planning for an exhibition of workmanship or photography, 

you can utilize a black or dim foundation to make alternate colors emerge. Black stands out 

well from splendid colors. Consolidated with red or orange – other intense colors – black 

gives an exceptionally forceful color plan. 

Meaning of Color in Different Geographical Locations 
 

Colour is prompt correspondence. It genuinely is the main language, other than music, 

that doesn't require any words. Is it any ponder that color is utilized as a part of images and 

signs everywhere throughout the world! You might not need to know how to peruse to see the 

red stop sign or perceive a yellow posted warning in the United States. We can talk about light 

in a wide range of viewpoints. It has its material science and arithmetic appearances. We can 

talk about color as far as light and vitality. By a long shot the most significant dialog of color 

we can have is in the impression of color. Color, similar to style, feel or even nourishment 

inclination is to a great extent impacted by the way of life we live in. In the United States for 

instance, red means risk; in China it implies bliss and celebrations; in Japan, it stands for 

outrage; in the Middle East, it implies insidious. Know your essential crowd. Know how 

colors are seen in every nation and culture. 

Unit Summary 
 

The focus of this unit lies in as you build up your own designs, remember that shading 

is subjective and shading decisions will most likely be made in a joint effort with your 

customers. Differentiation in esteem, and also shading, assumes a critical part in design. 

Confide in your intuition and in addition theoretic information while applying shading, and 

recall that shading is only one of the variables in your design. It ought not to be utilized to 

just "enhance" highly contrasting structures. It should add something meaningful to your 

message, for example, setting the state of mind, introducing social meaning, or connecting 

through unconstrained relationship with your watchers. 

Assessment 
 

• What is a color wheel and what the purpose? 
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• What does primary color mean? 
 

• Define secondary colors? How are they produced? 
 

• What do tertiary colors mean and how are theyproduced? 
 

• Distinguish between complementary and analogous colors From where each one is 

obtained on the color wheel? 

• What does color contrasts mean and why is the importance of it? 

• How to define color dominance in design. 

• Distinguish between hue contrast and value contrast. Which is more critical in 

design of websites among them? 

• You can deliver shading contrasts yet not really esteem contrasts. Clarify how this 

functions and give cases. 

• Define color context and what is the importance 
 

• Describe simultaneous contrast and how to use it indesign 

• Distinguish between warm and cool colors 

• What does saturation mean 
 

• How does type and readability is related to color? What is the main aspect of 

choosing type color? 

• What is Gamma? What is gamma correction? 
 

• Describe hue, brightness and saturation? Distinguish between them 
 

• Define GIFs and JPGs. Distinguish between these two? How to use each one and 

why 

Resources 
 

• https://s-media-cache-ak0.pinimg.com 

• http://mexicounexplained.com 

• https://google.com 
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Unit 4 Incorporating Sound into 2D 
 

Animation 

Introduction 

is for individuals who wish to make a career in sound 
 

This unit is about the exploration of sound in 2D animation. Sound is very important 

like any visuals in an animation. Whether you're looking to make a score, surrounding noise, 

discourse, or a total soundtrack, you'll require sound for your piece. This unit incorporates 

sound for animation. It will explain the theory and working behind sound for picture, and will 

give a diagram of the frameworks and generate way to enable you to make your soundtrack. 

Figure out how to utilize the devices and procedures of the exchange. Improve your piece and 

figure out how to configure sound for animation. 

Outcomes 
 

Upon completion of this unit you will be able to: 
 

• Explain why audio is so important in animation 

• Explain the process for digitizing sound 

• Understand the important audio components 

• List sources for audio clips 

• Describe the functions of audio components 
 

• Explain the considerations when using audio inanimation 

Terminology 

Magnetization : "Mental pan" of the sound medium. 

Pitch: The apparent "highness ―or "lowness" of the 

sound 

Mouth chart: A graph in light of the eight activity phonemes (A & I, E, U, O, F & V, L, M 

and Q which is utilized to speak) utilized for lip-match up. 

Sound scrubbing: A procedure that gives you a chance to hear sound progressively while 

you advance the play head or in reverse. This is extremely helpful for fine-tuning a lip-

synchronize. 

Synchronous: The mental combination between a sound and a visual when these happen at 

the very same time. 

Composer: Individual in charge of composing and masterminding the melodic substance of 

the film. 

Recording session: The occasion amid which a film's soundtrack is recorded. 
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Incorporating Sound into 2D Animation 
 

Sound can be an imperative part of any animation medium and a significant 

component of specific applications. For instance, consider how troublesome it is to examine a 

foreign language dialect without hearing how the words are articulated; Sounds can be joined 

with animations to make temperaments, improve understandings, fortify ideas, and enable the 

client to work through the applications. 

Essential audio components 
 

Each film and animation consists of three types of different audio components. These 

are music, dialogue and sound effects. In silent films the dialogue is missed out, still sound 

effects and music make it interesting. Dialogue is more essential content than playback audio. 

Music 
 

First of all you have the music. This incorporates all the background music that 

officially isn't a part of the film. It can add a real emotional layer to a film. There has been a 

great deal of impact of music and sound. We as a whole know the minutes that make us hop, 

or the minutes that make us cry. Unknowingly, music has a huge impact in that we 

experience in a motion picture. You can really change the setting and disposition of a scene 

by utilizing different music. 

The music in movies is called film score. Creating for film is its very own train. Much 

the same as writing a catchy pop song, there are certain rules you can use to make a great 

sound track. There are a couple of styles you have to know. One of them is traditional 

ensemble orchestra. It doesn't make a difference what the genre of the film is -- almost every 

sort utilizes an ensemble orchestra. This means as a composer you have to have the capacity 

to write music for different instruments. 

Some huge film composers are AR Rehman, Vishal-Sekhar and Salim-Suleman. For 

instance, Vishal-Sekhar really knows how to make music dramatic anf emotionally charged. 

It's important the music really enhances the story that is being told. 

In Ra-One, you erase the music from the last scene and just leave in some stable 

impacts. The scene totally changes from being heroic to being very awkward and boring. 

This really indicates how music can totally change a film. 

Sound effects 
 

The sound impact is one that truly makes the feel of the story being told. It's the rain 

out of sight, the strides on wood, an entryway that closes, and so forth. Without the sound 

impacts a film or animation wouldn't feel practical. Particularly for animation, this is the part 

 



 

 

 
 

that needs a ton of work, since you don't have any sound in any case. With films, they 

frequently can utilize a considerable measure of sounds that are recorded while filming. Some 

should be supplanted by reproduced sounds, in light of the quality. They must be reproduced, 

which is frequently done in a studio and is called Foley. There are whole studios where Foley 

specialists will reproduce sounds and match them to the pictures in the film. 

'Foley is the generation of ordinary sound impacts added to film, video and other 

media in after creation to improve sound quality' . It's a decent approach to include the 

inconspicuous sounds that a creation mouthpiece regularly misses. Be that as it may, for 

animation, you need to make each and every thing in the film that makes a sound. 

As indicated by Tom Meyers, you can't generally record sounds in the "genuine" 

world, since you frequently can't control these sounds. He says that each solid has two 

segments, the exacting part and the enthusiastic segment. From one perspective it must be 

reasonable, however, on the other it additionally needs to get a specific feeling over. 'The 

sound outline doesn't need to thump you over. It is there to upgrade your experience. To keep 

you inside the story, and the occasion.' 

Adjacent to the enthusiastic layer, a few sounds you can't simply basically reproduce 

for basic reasons as wellbeing. You can't simply crash an auto each time you require a sound 

of an auto collision. This is for example why they regularly utilize a watermelon at whatever 

point they need the sound of a human head being crushed in. You likewise don't need to 

reproduce each solid yourself; there are great deals of sound impact libraries you can use. You 

frequently need to pay for this, yet there are likewise as of now a considerable measure of free 

stable libraries. 

History 
 

The primary animations utilized a considerable measure of instruments to make the 

sounds. The recording hardware was enormous -- just go outside to record sound. We most 

likely all recall those old Mickey Mouse animations where you would for example hear some 

kind of cymbal crash when somebody was hit on the head (which is presently called 'Mickey 

Mousing'). When you consider it, it isn't reasonable in any way, yet it adds a specific layer to 

a film that makes it more sensible than when you wouldn't utilize any stable impacts. 

Afterward, when animations turned out to be more famous, the sound originators 

became more inventive also. There are cases of sound fashioners, who might trigger whole 

establishments to make a particular sound. For example, they would have a 'rain- machine' 

that reproduced the sound of rain without utilizing any water. These days, the systems are 

obviously much more progressed; however, still in some cases they utilize the most bizarre 

establishments or articles to make sounds. 
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In short there are "just" three sound parts you need to consider while doing sound 

outline: discourse, music and sound impacts. Obviously, there is far more to that than simply 

recording it and putting it under a scene. You must be cautious that a scene doesn't end up 

plainly one major tumult with all these diverse sounds. You need to locate the correct adjust. 

A major piece of sound outline is quite recently attempting a variety of things. These include 

exploring different avenues regarding recording distinctive sounds, assembling the men 

tuning in to them again and again until the point you locate the ideal blend. 

Functions of each component 

Non-diegetic and Diegetic 

Sound can be divided into two types like diegetic and non-diegetic sound. Diegetic 

originates from the Greek word diegesis, which signifies 'described story'. This needs to do with 

whether the wellspring of the sound is "noticeable" in the realm of the film or not. Exchange amongst 

performing artists and sound impacts like strides, are diegetic sounds since they exist in the story 

itself. The source doesn't really need to be unmistakable; it could likewise be a rescue vehicle siren 

out of sight. 

Cases of non-diegetic sounds are music (score), a voiceover and other sound impacts 

that are for instance included for a more emotional impact. So, all sound we can listen, yet the 

characters in the film can't. We include an additional layer that aides the gathering of people 

through the film. Utilizing both diegetic and non-diegetic sounds will "appear" on the outside 

and within an occasion at the same time. 

Functions of Audio Component 
 

Toward the end, every one of the parts will meet up and make one major sensible 

condition that will ideally take you away to another universe for 90 minutes. Each bit of 

sound has its own particular capacity in doing this. In this unit it turns out to be all the more 

clear why you would utilize these diverse sounds and how you can utilize them to achieve a 

specific objective you have. 

Dialogue 
 

Dialogue has a few capacities that are very vital to make a decent story. However, it's 

more about substance than it is about sound. As indicated by Ellen Jackson, discourse has the 

accompanying six capacities: 

• Revealing the characters 

• Giving important data 

• Moving plot along 
 

• Showing the possibility of one character about another 
 
 



 

 

 
 

• Reveal strife and construct pressure 

• Show how somebody feels. 

Dialogue is more about substance, yet these things are essential and can (mostly) not 

be proficient by the other sound parts. Composing discourse is really hard and is about what 

you do and you would prefer not to uncover to the group of onlookers. 

Music 
 

One of the greatest elements of music is adding an additional enthusiastic layer to the 

film. As per Robin Hoffman, music has 17 unique capacities. Here are a couple of them that 

show in what ways you can utilize music. 

Most importantly, it truly pushes the crowd in a specific bearing. With music you can 

infer that a scene is courageous or that somebody is feeling dismal. Now and again 

individuals can locate this irritating on the grounds that it takes their capacity to judge 

something for themselves away. 

Music can likewise be utilized as a purported leitmotif. This is tied in with giving a 

character a specific personality that can be utilized through the whole film. When you hear 

this subject later on in the film, you will realize that they are discussing that character. 

It's likewise conceivable to inform all the more concerning social/social/geographic 

condition and the time/time frame the scene is set in. This should basically be possible by 

utilizing unmistakable music from a day and age or from a specific nation or culture. 

Something else is that music can likewise associate scenes. Without the music a scene 

may appear to be disorganized on account of a great deal of hops. The music pastes 

everything together and makes it more justifiable all in all. 

You can truly control or underline something in a scene by utilizing the correct music. 

You can for example, utilize repudiating music or substitute the impression of time by 

changing the rhythm. Things can turn out to be more terrifying or amusing and you can 

absolutely change the presence of a character. There are great deals of things you can do with 

music. 

Sound effects 
 

Sound impacts are particularly truly essential for animation. This is the part where you 

are truly going to make that condition. Sound impacts have three primary capacities. These 

are: 

• Creating illusion 
 

With sounds you can demonstrate individual things that aren't straightforwardly appeared in 

the scene. When you hear planes out of sight you will get an entire other thought 

of nature than when you hear youngsters snickering. 

49



 

 

 
 

• Creating mood 
 

You can likewise thoroughly change the state of mind of the scene through 

foundation sounds, this can likewise change the temperament and climate. Flying creature 

sounds will set an unexpected air in comparison to stormy climate. 

• Simulating reality 
 

This is tied in with finding the correct sounds that fit the activities occurring on the 

screen. When you see an entryway pummelling you would prefer not to hear an entryway 

being closed tenderly. The group of onlookers needs to trust that what they see is genuine, 

sound has a major impact in fulfilling that. 

Effects of sound on humans 
 

Sound is something that we're quite often encompassed by and we unwittingly 

respond to. Normally solid influences us physiologically, by making us deliver certain 

hormones, raising our circulatory strain, our heart rate and brainwaves. For example, startling 

noisy sounds will make us hop since it will make us go into battle or-flight mode. On the 

opposite side, trilling winged animals will make us feel loose. The best sort of music, 

contingent upon the individual obviously, is regularly recently basic feathered creature 

sounds. 

Emotions 
 

For film, the passionate impact of music is the most vital. A most pleasant aspect 

regarding music is that is basically a general dialect. Each culture on the planet has music, 

and in spite of the fact that this may vary especially from what we know, there are a couple of 

things that are truly all inclusive. The two essential feelings: joy and pity. Cheerful music is 

higher pitched, has more vacillations in cadence and pitch and a quicker beat. The inverse of 

this is viewed as dismal music. 

Infrasound 
 

This is a sound beneath 20Hz, which is underneath the level of what people can listen. 

Be that as it may, what is fascinating is in spite of the fact that we can't generally hear it, we 

do respond to it. These sounds can make sentiments of dread, distress and even dejection. 

These sounds are made by a ton of characteristic things. A few creatures can deliver 

infrasound, additionally quakes, vibrating channels in your storage room, atomic blasts, and 

so forth. 

Presently, how is this associated with film? There are hypotheses circumventing that 

some blood and guts movie have utilized these sounds to upgrade the experience. Paranormal 

activity is one of the films that have transparently conceded on their site to have utilized 

infrasound in specific scenes. In the event that it truly works, it's a truly decent approach to 50



 

 

 
 

give an additional measurement to a film. 
 

Considerations in using sound 
 

The accompanying ought to be considered when utilizing sound in any media 
 

application: 

1. 

2. 

 
 

Appropriateness 
 

Intended audience 
 

Appropriateness 
 

Utilizing sound can upgrade most mixed media applications. Without a doubt, sounds 

are fundamental for specific applications, for example, instructive titles that educate remote 

dialects or music. 

Notwithstanding, the simplicity with which sounds can be gotten and joined into an 

application may make a designer abuse sound as a segment and to incorporate "charming" 

sound impacts that end up diverting or irritating a client. 

Intended audience 
 

For a few people, understanding an idea is less demanding when sound is utilized. 

Envisioning how the target group will react to different sounds can control the decision of 

which sounds to utilize. For instance, grown-ups may react superior to anything kids to the 

utilization of traditional music as a foundation sound. 

Lip Sync and Mouth Chart 

Lip-sync – 1 

In full animation, it is critical for a character to emulate. When S/he is talking, thus his 

emulating must be once in a while synchronized to the soundtrack. Exchange is perpetually 

recorded before creation and the planning of it is passed to the artist as a phonetic breakdown. 

It is likewise critical that the illustrator ought to have a duplicate of the track on tape, with the 

goal that he can hear it out more than once until the example of accentuation, the ascent and 

the majority of the voice, and so forth, is clear in his psyche. It is once in a while valuable to 

demonstrate this. The phonetic breakdown by methods for a line which moves left and 

perfectly fine voice falls and rises and winds up noticeably thicker and more slender as per 

the level of accentuation. 

Lip-sync – 2 
 

The initial step is to make the character's activities fit his/her words. On the off chance 

that s/he is forceful, s/he will tend to push himself forward and strengthen certain focuses 

with signals. In the event that s/he is timid, he may shrivel away and talk conciliatory and in 

the event that s/he is cunning he may put on a show to grin, while giving speedy looks 

 



 

 

 
 

to see the response to his/her words et cetera. 
 

The second step comprises moving the character's lips and maybe the lower some 

portion of the face, to fit the edge by outline phonetic breakdown of the discourse on the 

presentation diagram. Here it is vital to listen over and over to the way the exchange is talked. 

In a typically talked sentence, there are generally a couple of complemented vowel sounds 

and whatever is left of the words are of lesser significance. Play the soundtrack again and 

again until the example of accentuation, the ascent and fall of the voice and so on, is clear. At 

that point design the lip match up to comply with this example in visual terms. As of now 

specified, mass-delivered TV arrangement the exchange conveys the focal enthusiasm of the 

film and there is basically no animation separated from the mouth. This is not adequate in 

different sorts of generation and it is along these lines imperative to guarantee as a matter of 

first importance that the mouth, eyes and different elements of the face should express the 

significance of the exchange. The hands ought to likewise be utilized for accentuation. 

Thirdly, the body itself ought to be utilized to underline the substance. The three components 

have obviously to be firmly organized. 

Lip-sync – 3 
 

Once the fundamental planning of the mouth development is worked out, the 

following stage is to consider how the outward appearance, head development and body 

motions can underline and add to the significance and enthusiasm to the exchange. 

In the main discourse of Old Major in Animal Farm, it was particularly essential to 

pass on the message of this character to the gathering of people, since the entire film was 

spurred by it. The outward appearance needed to express the figure's genuine worry, as well 

as a sickly character, physical agony too. The whole body of the pig was enlivened while its 

face, eyes, mouth, nose and the facial wrinkles passed on the feelings of the character. 

It is not fundamental to energize all vowels and consonants as far as single edges. 

Particularly in TV diversion arrangement, where speed of creation is basic around eight 

places of mouth and tongue are sufficient. 

Lip match-up is the most critical idea in animation, since the aggregate animation 

depends on energizing discoursed. Dissimilar to live activity, discourse can't be recorded 

after creation. In animation a discourse must be recorded first and energized. That implies 

artists should design the activity and acing of the character as indicated by the exchanges. 

Utilizing programming like Magpie, a discourse can be part into outlines so a track peruser 

can get the length of the exchange. Same exchanges will be composed on the introduction 

sheet alongside the edges. This implies the exchange can be measured with the casings. 

Once the length of the exchange winds up noticeably clear, particular mouths will be 
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included for every last casing. Each expression of the exchange will be part into the 

coordinating mouth shapes. A mouth diagram, of mouth shapes for each character will be set 

up in the pre-generation organize itself. There are 11 essential mouth shape utilized as a part 

of animation. 

In pre-creation arrange, the Story Board craftsman will design the acting part as per 

the discourse and scene tweak. Executive or key illustrator energizing that specific scene will 

design situating the fundamental key drawings on to the introduction sheet with key positions 

said with reference to casings and sound. Presently, activity is determined to the introduction 

sheet. At that point an artist assumes the part of producing all drawings required to fill the 

entire presentation sheet. On the keys he will specify which mouth ought to show up on what 

drawing. The collaborator artist will take after a similar guideline and produce the mouth 

shapes for in-betweens. 

Synchronizing animation to speech 
 

Not at all like real to life movies, where the discourse is at the same time recorded 

with the action, in animation it must be recorded beforehand so the development can be fitted 

to it unequivocally. It is a fundamental preproduction operation that can't be left until after the 

fulfillment of animation. 

Once the soundtrack is accessible either on tape or optical movies, the sort and 

character of the voice can be investigated through the utilization an of synchronizer (16mm 

or 35mm) and outline by outline timing guide for the animation can be made. This should be 

possible either on the introduction diagram, where there is an uncommon section for it, or on 

a different outline. In either case, it must be done as far as casing investigation. No two-

discourse exhibitions are the same. Indeed, even single words like 'you', "yes"," its', "had" 

can differ considerably when examined as far as partitioned outlines. Such data is the premise 

of fitting animation to sound. 

Initially, listen painstakingly to the soundtrack and specifically to the inclination 

behind the path in which the words are talked. At that point, tune in to the stating and beat of 

the discourse and discover the places of the principle accentuations and catchphrases. Design 

the developments of the character's body, head, arms and so on, to fit the words and the path 

in which they are being stated, to strengthen the emotional impact. Attempt to accentuate the 

principle purposes of the discourse with the entire body, if time and spending grant it. In 

animation, the significance of exchange ought to be to some degree overemphasized, 

particularly in an engaging film. 

Audio Production 
 

After the story has been laid out with a storyboard and pitched to a group of artists, 53



 

 

 
 

chiefs, and makers, it's a great opportunity to begin recording the exchange. Now, on the off 

chance that they haven't as of now, the scholars and executive will adjust their storyboard 

into a composed script, finish with a diagram of what each character is doing amid every 

scene. This procedure is intended to additionally expand on the thoughts displayed in step 1, 

as storyboards are by and large just unpleasant, divided diagrams of what the last item will 

resemble. 

After the script has been concluded, it is given to the voice ability to the film, who 

works intimately with the executive to nail down each character's individual identity. Despite 

the fact that it may not be clear to the group of onlookers, voice performing artists assume an 

immense part in fleshing out their characters' on- screen identity. Periodically, scripts are 

utilized for the most part as free rules for the performing artists, who impromptu the character 

to life, giving them a considerably more appealing identity than originally proposed and 

notwithstanding influencing the imaginative style or finished product of the film. 

Robin Williams' execution as Genie in the Disney classic Aladdin is an ideal case of 

how a voice performer can impact the identity of a character and the heading of the film 

overall. The chiefs of Aladdin enabled Williams to improvise the vast majority of his lines, 

just adhering to the script when it was completely fundamental. They even let him include his 

own particular jokes and stiflers to the script. Illustrators utilized the identity that Williams 

made to think of the last search for Genie, including how he moves and how he connects with 

alternate characters. The outcome was a standout amongst the most vital and adorable 

characters ever. 

Sources of Sound Files 

Pre-packaged 

Some solid documents may accompany your PC's working framework or with 

programs that are introduced on your PC. Some sound files that come with Microsoft Office. 

Notice that these are for special effects (applause, chimes, etc.) and that they are small in size 

and length (3 seconds). 

Purchased or Borrowed 
 

Sound files can be purchased from companies specializing in sound clips. The 

Internet is an excellent source for sound clips that can be purchased, or in some cases, they 

may be provided free and downloaded. These sources may be good for background and 

special-effect sounds as well as historical events, but for narration you will need to create 

your own files. 

Make your own sound 
 

Making your own particular sound claps can be as simple as utilizing a recording 54



 

 

 
 

program that accompanies a PC's working framework, (for example, sound recorder) and 

talking into a receiver joined to the PC. The quality of the resulting sound files may be 

acceptable for certain applications such as a simple media, web pages, etc. However, if the 

goal is to produce a high quality commercial product, you have to consider utilizing a 

recording studio with gear, for example, DAT (Digital Audio Tape) gadgets that record 

sounds carefully. 

Incorporating sound into 2D animation application 
 

Presentation development programs such as Macromedia Flash, Pencil, Tupi, Synfig 

Studio, Plastic animation Paper, PowToon and Victorian Giotto and many other programs 

allow you to easily incorporate sound. 

For complex projects where sound will be a significant component, storyboards and 

scripts should be used to guide the application developer. There are various formats for a 

script. 

The figure below shows the audio script format that would be used for incorporating 

sound into the accompanying storyboard. The storyboard in the image also shows how an 

animation sequence would take place. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Example of a storyboard associated with an audio script) 

Title : Storyboarding Example Attribution : Tomas Mitkus 

Link : https://commons.wikimedia.org/wiki/File:Storyboarding_template_02.jpg 

Making a video or animation truly woken up isn't something you will essentially fulfil 

by following two or three stages. Sound is something that you not record but also put it under 

a scene. You need to consider its numerous parts: exchange, music and sound impacts. To put 

it plainly, with exchange you can truly recount the story, with the music you include an 

emotional layer and with the sound impacts you can truly make a whole world. 
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Unit summary 
 

In this unit, you have learned how sound is used in animation. You are familiar with 

the categories of sound, as well as the ways sound can be used (set a mood, provide narration, 

add special effects, etc.). You know about the sources for sound clips and how sound can be 

created. You also know about the considerations for using sound in animation. 

Assignment 

• State the important audio component. 
 

• Describe the music importance in animation. 

• Explain synchronizing animation to speech. 

• Explain the history behind animation, sound. 

• List the various steps of sound recording. 

• Explain the effect of sound on humans. 

• Explain developing audio production. •

 Explain infra sound. 

• List the component of sound effects. 

• Explain diegetic sound. 

Resources 
 

• https://animationbrain.com 

• http://wikipedia.com 

• https://google.com 
 

• http://minyos.its.rmit.edu.au 
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Unit-1 Basic of Sketching 

Introduction 

Drawings are methods for articulation of our perceptions, contemplations and 

emotions. Over the wide field of workmanship and outline, specialists and planners will 

utilize drawing as a particular tool for visual correspondence. In the meantime, it may also be 

utilized for a wide range of attracting strategies to express, create and showcase thoughts and 

work with the watcher for innumerable reasons. It is difficult to make a drawing unless the 

craftsman has a reasonable comprehension of what type of thought or scenario is to be 

presented and what visual dialect will be utilized in giving shape and expressing the flow of 

the drawing. This is frequently overlooked or misjudged by most educators of drawing. 

In this unit, you will learn about basics of sketching, still life drawing and composition 

of basic elements. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• Describe various types of pencil 

• Examine various techniques of holding apencil 

• Explain the meaning of sketching 

• Practice still life drawing 
 

• Assess the components of compositio 

Terminology 

Pencil: A bar of graphite encased in a delicate wood for drawing and writing. 
 

Balance: Balance is the feeling that the depiction "feels right" and not heavier on one side. 

Pattern: A customary reiteration of lines, shapes, hues, or qualities in a composition. 

The Pencil 
 

A pencil is a bar of graphite encased in a delicate wood, for example, cedar which is 

around six or seven inches in length and uncovered toward one side. Unrefined types of 

graphite pencils were first utilized as ahead of schedule as the 17th century. Prior to this, 

poles of lead or silver (known as silver point) were utilized as executables for making 

drawings. The cutting edge type of lead or graphite pencil with its wooden encasement 

initially came into utilization about the start of the 19th century. 

            The pencil essentially works by pushing or pulling the lead end over the surface 

filaments of the paper, which gets grated getting separated into little drops. Weight on the 

pencil pushes the pieces of lead into the filaments of the paper to leave a stamp. 



 

 

 
 

Graphite, a type of carbon, otherwise called mineral dark, is the real constituent of the 

cutting edge pencil. The delicate quality or hardness of a pencil fluctuates relying upon the 

measure of earth blended with the carbon. Practically, no earth contains the mildest 

assortments of pencil. Craftsmen and creators will have to utilize the scope of pencils, for 

shifting their decisions as indicated by the impact based on their attempts to accomplish. 

As the graphite is worn away through utilization, it has to be uncovered. This is 

finished by the activity of honing the pencil utilizing a sharpener. Honing and uncovering the 

graphite ought to be viewed as an imperative demonstration, since how it is done changes the 

kind of stamp you make with it. There are numerous methods for honing. A specific point 

creates a specific outcome. 

The craftsman should test to find what is conceivable and how to make each kind of 

pencil meet his specific needs at any given point of time. 

The pencil can be utilized for an assortment of purposes and, as with any material 

which is utilized, you should be completely aware of its possibilities and its impediments --

diverse pencils and sorts are intended for specific employments. In the resulting section, some 

of these practices will be uncovered with specific pertinence to the suitable pencil or graphite 

material. 

The imprints that appear over the accompanying couple of pages give some thought of 

the extensive variety of checks making conceivable. When you are taking a look at them, see 

each of the pencils thoroughly as to what marks you can make. Aside from being extremely 

animating and finding methods for opening your brain to new potential outcomes with your 

drawing, you will discover how it expands your "vibe" for the pencil itself. As specialists, 

what we feel through the materials we utilize affects what we deliver. And understanding the 

nature of those materials is indispensable for a decent result. 

Types of Pencil 
 

There are many types of pencils like hard pencil, soft pencil, peel- back pencil, clutch 

pencil, standard thick dark pencil, triangular craftsman's pencil, graphite pencil or stick and 

aqua drawing pencil. But as a basic, we will discuss only about hard pencil and soft pencil. 

Hard pencil 

Hard pencil marks have almost no variety in the scope of stamp making. They just for 

the most part shift through a direct movement. Tone is normally produced using a 

development of crosshatch impacts. Hard pencils are meant by the letter H. Similarly as with 

delicate pencils, they arrive in a range, involving HB, H, 2H, 3H, 4H, 5H, 6H, 7H, 8H and 9H 

(the hardest). 

 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Hard pencil marks 
 

Attribution- Peter Stanyer 
 

Source- The complete book of drawing techniques 
 

These pencils are essentially for use by originators, planners and individuals who 

create exact specialized diagrammatic drawings for which a fine, precise line is fundamental 

(for example, viewpoint or other projection drawings). Despite the fact that the imprints made 

with hard pencil demonstrate almost no variety, it can be utilized as a part of an expressive 

medium. Likewise, with delicate pencil, tone can be constructed utilizing across-incubating 

framework, despite significantly better and more formaloutcome. 

Hard pencils are generally proper for drawings requiring exactness. As we have paid 

attention to already, such drawings are typically done by engineers, mechanical fashioners, 

visual originators and modellers. The last drawings which are created must be proportional 

and exact with the goal of an individual, for example skilled workers can choose in the 

directions to develop and improve the instigated drawing or make the exact proposed 

drawing. These drawings arrive in diverse point of views or parallel projection frameworks, 

extending from level of orthographic arrangement or rise drawings to 3D point of view 

delineations. 

Soft pencil 
 
 



 

 

 
 

The soft pencil has more flexibility for making tone and surfaces than the hard pencil. 

Soft pencils are meant by the letter B. The HB pencil is a blend of hard and soft and is the 

essential pencil between the two extremes. The scope of soft pencils accessible comprises of 

HB, B, 2B, 3B, 4B, 5B, 6B, 7B, 8B and 9B (thesoftest). 

These pencils are intended for the fine craftsman to express specific thoughts. For 

instance the working of tone, the making of surface, cross-bring forth or even simply basic 

line. Range of pencils having softest end can be utilized to create pieces of tone. A graphite 

stick is by far the most suitable for this kind of work and for creating bigger ranges of tone. 

Mainly the soft pencil is reasonable for refined work requiring extraordinary 

exactness - basically for the safeguard of the hard pencil depends on the fine grip of the 

pencil. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Soft pencil marks 

Attribution- Peter Stanyer 

Source- The complete book of drawing techniques 

Pencil holding techniques 

Holding Pencils 
 

There are numerous approaches to hold the pencil yet the watchword to recall while 

drawing is "unwind." Avoid holding the pencil as though you were composing, in light of the 

fact that, for the written work, the pencil has to be grasped fairly firm and tight. The hold 

required for portraying is relatively loose and simpler. Hold the pencil roughly, a few crawls 

from the tip of the lead. The holding position ought to include the thumb and the initial two 



 

 

 
 

fingers just, with the pencil lying easily within the tip of the third finger. Utilize the second 

finger and the thumb to settle the pencil and to keep it from slipping out. 

The connection between the second finger and the thumb as a rule directs the sort of 

lines and portraying style. At the point when the tips of the two are moderately near one 

another, for mooring of the pencil the whole hand by and large creases internal; and in this 

manner the portability and reach of the pencil for development is restricted by how far the 

fingers can extend. This position is called Position A and is very similar to the written work 

grasp. It is exceptionally helpful in portraying short strokes and points of interest and it also 

gives the craftsman more control of the instrument managing to be less inclined towards 

committing errors 
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Position A 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Position B 
 

Title- Pencil holding techniques Attribution- Thomas c. wang 

Source- Pencil Sketching (2
nd 

Edition) 

Link- 
 

Position B is the point at which the tips of the second finger and thumb are far separated. The 

second and third fingers are normally straight as opposed to being twisted internally thereby 

expanding the portability and reach of the pencil. By clearing here and there with the 

broadened second and third fingers, the strokes can be achieved up to six to seven inches. 

This is a perfect position for shading in light of the fact that, the hold is free and the fingers 

are substantially less demanding to move. This position additionally enables the craftsman to 

hold the pencil sideways and boosts the adequacy of the whole pencil tip. General terms are 

one aftereffect of this hold. Basically broadening the fingers of the whole hand having the 

palm down helps coasting the pencil over the page. The edge of the pencil must be changed 

in accordance with the individual craftsman's hand and level of adaptability. One ought to 

have the capacity to change from Position A to Position B in a nonstop development 

decisively or stoppage. 
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Position C 
 

Title- Pencil holding techniques Attribution- Thomas c. wang 

Source- Pencil Sketching (2
nd 

Edition) 

The third (Position C) includes holding the pencil as though holding a putty blade or 

little hand apparatus. The pencil is held between the thumb and the second finger. This 

dispenses with any type of finger or hand development and along with hand development 

these lines are essentially suited for long and general terms. The whole lower arm is utilized, 

giving the craftsman most extreme reach. Contingent upon the extent of paper accessible and 

the scope of the craftsman's arm, pencil strokes can reach more than three feet. This position 

can likewise be utilized to make etch strokes. Simply hold the pencil and strike it here and 

there utilizing short and sudden strokes. 

Pressure 
 

Applying pressure (drive) to the pencil is the thing that gives beauty and enthusiasm to 

a line. Without pressure, the strokes and lines are plain and exhausting. A straight forward 

line attracting pen and ink can be very excellent but if there is a consistency in the lines, they 

can draw out the lucidity and softness of theportray. A hard lead can give a line that is 

moderately reliable when contrasted than a softer lead. Considering this, the magnificence of 

pencil portraying lies in the craftsman's capacity to apply pressure to the pencil keeping in 

mind the end goal to change the nature of the lines. The striking, lifting and turning, the 

incidental bumping and bending, and the sudden change of the edge of the lead all add to a 

huge number of impacts which are one of a kind to pencil portraying. What's more?It is this 

uniqueness that makes pencil exceptional. 

A pencil ought to and should be dealt like as an expansion of the craftsman's hand arm 

and fingers. The creators of drawing not only include the movement of a hand holding a 

pencil but also manage the whole tactile transfer from eyes to cerebrum to that of hand. We 

watch and inspect with our eyes; streamline with our cerebrum and eyes; dissuade our mind 

about what ought to be kept; record with our hand; assess with our eyes again to check 

whether the picture takes a look at all like the one we saw before; roll out moment 

improvements and reexamine everything again in an unending cycle. This is the outlining 

procedure more or less. Similarly, as drawing is without doubt a mental procedure that is 



 

 

 
 

extremely individual and cozy, so is the demonstration of applying pressure to the pencil is 

based on individual and personal experience. There is no logical standard for how much 

constrain one ought to apply on a specific lead. It is fundamentally an experimentation 

procedure which you gain from your trials and errors. You do it more than once to 

accomplish a predictable example and you attempt to keep it that way, however nobody can 

show you how to do it. 

Sketching 
 

A definitive objective of sketching is to graphically decipher the picture effectively. In 

spite of the fact that the way of elucidation and introduction is an individual issue (and each 

craftsman has his or her methods for communicating it), the ultimate result of a draw is 

regularly represented by some pleasing benchmarks. The portrayal must have some level of 

authenticity and the subject of elucidation must be fairly conspicuous. For instance, on the 

oversimplified level, a portrayed tree should resemble a tree and not a man. On the more 

propelled level, an old tree ought not to resemble a youthful sapling. The storage compartment 

and the bark ought to some way or another uncover its age. If a house with a stone exterior is 

ought to be drawn, then the unobtrusive contrasts in the joints and mortar can be uncovered 

and highlighted. 

Observation 
 

With a specific end goal to effectively translate the picture that we are endeavouring 

to portray, we should invest energy watching it painstakingly. Cautious perception is a critical 

initial phase really taking shape of a decent outline. Perception must be sharp. Rehashed 

perception and recording are required to comprehend the subject. Once in a while estimations 

are taken just to ensure that the best possible relationship is accurately depicted. Scene 

sketching (and especially the sketching of trees) gives one of the best vehicles to exhibit the 

significance of perception and recording. Estimations and recordings have an astonishing 

advantage for originators in light of the fact that these right and appropriately proportioned 

pictures can turn into the visual information bank from which they can later infer motivation 

and thoughts for future work. 

Steps to sketch: 

• See 

• Identify 

• Isolate 

• Simplify 
 

• Translate into sketching 
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Still life drawing 
 

Still life is the best subject in workmanship for learning and educating the aptitudes of 

drawing and painting. It shows you what is the look for items and see those like a craftsman -

- with a discerning attention to their framework, shape, extents, tone, shading, surface, frame 

and organization. 

Well ordered, still life lesson will show you the attracting strategies used to create the 

still life, which was finished with a 2B pencil on cartridge paper. 

• Steps 1 to 4: It exhibits how to draw the shapes and extents of the still 

life objects utilizing line. 

• Steps 5 to 8: It represents how to render the three dimensional type of the 

still life utilizing tone. 

For this still life lesson you will require: 

• 2B pencil 

• Eraser 
 

• A3 sheet 
 

Step 1: Beginning the still life drawing 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Beginning the Still Life Drawing 
 

Link-http://www.artyfactory.com/still-life/still_life_pencil.html 
 

In any still life, you should begin to draw the items, as though they are 

straightforward wire outline frames with noticeable lines of development. This procedure 

causes you to be completely mindful of the state of every individual frame and its position in 

connection to alternate structures. It is critical to outline the items softly as this commits it 

simpler to change any errors and delete any lines of development. 

 
 
 

NOTE: This transparent drawing strategy utilizes vertical and even lines of 

development to help you to attract persuading circles and to adjust the symmetry 

of round and hollow structures. 
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Step 2: Making a fascinating synthesis 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Making a fascinating synthesis 
 

Link-http://www.artyfactory.com/still-life/still_life_pencil.html 
 

While forming a still life, attempt to present the qualities that make a fascinating plan. 

You should know about the conceptual structure of your course of action: its rhythms and 

complexities of line, shape, tone, shading, example, surface and frame. 

 

NOTE: A straightforward wire outline way to deal with sketching the still 

life encourages you to sort out the organization of the gathering. It makes it 

less demanding to see the shape, position and extents of each protest in 

connection to its neighbours. 

 
 
 

Step 3: Eradicating the lines of development 
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Title- Eradicating the line of development 
 

Link-http://www.artyfactory.com/still-life/still_life_pencil.html 
 
 

When you are content with the shape, extent and structure of the still life, you can 

delete the lines of straightforward development. This will abandon you with a precise 

noticeable layout of each shape and the certainty that everything of the articles is situated 

accurately. You are currently prepared to take a shot at the points of interest of each protest. 

Step 4:Including the points of interest in line 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Including the points of interest in line 
 

Link-http://www.artyfactory.com/still-life/still_life_pencil.html 

Presently softly portray in the states of any shadows or reflections onto each question. 

 

NOTE: The more care you assume control over the precision of these 

imprints, the less demanding you will locate the following phase of the 

drawing - the Application of Tone. 
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Step 5: Shading Method: 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Shading method step-1 
 

Link-http://www.artyfactory.com/still-life/still_life_pencil.html 
 
 
 
 

The tone of our still life is developed in four phases sketched out in steps 5-8. In this 
 

progression, some essential tones are softly connected to each protest help develop its three 

dimensional shape. 

Step 6: Shading Method: 
 
 
 
 
 
 
 
 
 
 
 

Title- Shading method step-2 

Link-http://www.artyfactory.com/still-life/still_life_pencil.html 
 

The second stage in working up the tone concentrates on the spaces between and 
 

around the articles. 
 

NOTE: The drawing of the light and shade between the items must be 

regarded with as much significance as the drawing of the articles themselves. 

The shadows cast underneath and around the articles add as much to the 

meaning of their shapes as does the shading on their surfaces. Notice how the 

counter-change of tones between the items and the spaces assumes control 

from the utilization of line to characterize the types of the still life. 
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Step 7: Shading Method: 3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Shading method step-3 
 

Link-http://www.artyfactory.com/still- 
 

life/still_life_pencil.html 
 

In the third phase of working up the tone, you concentrate back on the items. This 

time you extend their tone, expanding the complexity between the territories of dim and light. 

This will improve the type of the articles and increment the effect of the picture. 

 
 

NOTE: The most concerning issue at this stage is keeping up an 

adjustment of tones over the entire still life with the goal that no protest 

shows up excessively dim or too light. You are hunting down solidarity of 

tone and shape. 

Step 8: Shading Method: 4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Shading method step-3 
 

Link-http://www.artyfactory.com/still-life/still_life_pencil.html 
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At last, you concentrate again on the spaces between the articles, developing their 

tones and expanding their complexity. 

NOTE: You should be cautious in adjusting the tonal estimations of the 

articles and the spaces between them to guarantee that you make a bound 

together picture. 

The finished still life should chip away at two levels: as a practical portrayal 

of the gathering of items and as a dynamic creation of visual components, 

orchestrating and differentiating the utilization of line, shape and tone. 

 
 

Composition 
 

The demonstration of perception is the most critical part in sketching. A decent draw 

starts with watchful perception and innovative seeing. Inventive seeing needs to go with 

figuring out how to disengage things. Earnest Watson said in his book The Art of Pencil 

Sketching that ―in pencil drawing, one always avoids any leaning toward photographic 

simulation.‖ How genuine that is. Sketching is tied in with catching the quintessence of the 

genuine article. An outline speaks to another dialect particularly like shorthand that records 

the genuine article with shortened images of lines and surfaces. Imaginative seeing is tied in 

with finding the conspicuous element, exhibiting it, and disposing of the rest. It is tied in with 

catching the skeletal structure and the soul that rises above it. Clearly, the genuine article can 

be scattered wreckage; however, a decent draw comprehends what to dispose of. 

Arrangement is a piece of the whole inventive seeing procedure. It includes visual 

determination, visual positioning and visual core interest. Maybe we know what to dispose 

of;however what do we do with the things that we keep? How would we rank them in the 

request that we need to accentuate them in an outline? For instance, should the attention be 

on the entryway or the windows? How would we disengage the purpose of intrigue and 

utilize differentiation to highlight the significance? How would we adjust tone and esteem 

and how would we outline the draw keeping in mind the end goal to outwardly lead the 

watchers into the photo? By tending to these inquiries effectively, a great structure has the 

uncommon capacity to join the craftsman and watcher both outwardly and inwardly. 

Piece is the term used to depict the course of action of the visual components in an 

artistic creation or other fine art. It is the manner by which the Elements of Art and Design -

line, shape, shading, esteem, surface, frame, and space -- are sorted out or formed by the 

Principles of Art and Design - adjust, differentiate, accentuation, development, design, mood, 

solidarity/assortment - and different Elements of Composition, to give the canvas structure 

and pass on the aim of the craftsman. 

Arrangement is not the same as the topic of a work of art. Each depiction, whether 



 

 

 
 

theoretical or illustrative, paying little mind to topic, has an organization. Great organization 

is basic to the achievement of an artistic creation. Done effectively, great organization attracts 

the watcher and afterward moves the watcher's eye over the entire painting with the goal that 

everything is taken in and at last, settling on the primary subject of the depiction 

 Element of Composition: 

The Elements of Composition in craftsmanship are utilized to orchestrate or arrange 

the visual parts in a way that is satisfying to the craftsman and one‘s expectations, the 

watcher. They enable to provide structure for the format of the artistic creation and the way 

the subject is introduced. They can likewise energize or lead the watcher's eye to meander 

around the entire painting, taking in everything and eventually returning to lie on the point of 

convergence. 

Components of composition are by and large thought to be: 
 

• Unity: Does every one of the parts of the composition feel as though they have a place 

together, or accomplishes something feel stuck on, fumblingly strange? 

• Balance: Balance is the feeling that the depiction "feels right" and not heavier on one 

side. Having a symmetrical course of action includes a feeling of quiet, though an 

awry game plan makes a more powerful feeling. An artistic creation that is not 

adjusted makes a feeling of unease. 

• Movement: There are numerous approaches to give a feeling of development in a 

work of art, for example, the plan of items, the position of figures, the stream of a 

waterway. You can utilize driving lines (a photography term appropriate to painting) 

to coordinate the watcher's eye into and around the canvas. Driving lines can be real 

lines, for example, the lines of a fence or railroad, or they can be suggested lines, for 

example, a column of trees or bend of stones or circles. 

• Rhythm: Similarly music does, a bit of craftsmanship can have a musicality or 

fundamental beat that leads your eye to see the fine art at a specific pace. Search for 

the substantial basic shapes (squares, triangles, and so forth) and rehashed shading. 

• Focus (or Emphasis): The viewer's eye at last needs to lay on the "most vital" thing 

or point of convergence in the artwork, generally the eye feels lost, meandering 

around in space. 

• Contrast: Paintings with high differentiation -- solid contrasts amongst light and dim, 

for instance -- have an unexpected vibe in comparison to artistic creations with 

insignificant complexity in light and dim. Notwithstanding light and dim, complexity can 

be contrasts fit as a fiddle, shading, estimate, surface, kind of line, and so forth. 

• Pattern: A customary reiteration of lines, shapes, hues or qualities in a composition. 



 

 

 
 

• Proportion: How things fit together and identify with each other regarding size and 

scale; regardless of whether enormous or little, adjacent or inaccessible 

Summary 
 

In this unit, we described the basics of sketching and elements of composition. You 

got general information of sketching. You will know how to utilize pencil, you must have 

realized what materials are best used for and you will know how to approach your sketching. 

More importantly, in any case, you will have an unmistakable understanding that sketching is 

about how to impart your perceptions, your imaginations, and your thoughts in the 

light of nature and our general surroundings. 

Assignments 

1. List the different types of pencils 

2. Describe hard pencil 

3. Describe soft pencil 

4. Write the ways of holding pencil for sketching 

5. What is sketching and what are the steps 

6. Describe still life drawing with step by step techniques 

7. Explain what composition is 

8. List the elements of composition 
 

9. Describe the elements of composition 

Resources 

• https://en.wikipedia.org/ •

 https://www.google.co.in/ 

• https://www.rmit.edu.au/ 
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Unit 2 
 

Work in Different Media 

Introduction 

Any work structure can be a good thing; but in regards to art, innovation is the key to 

finding out how far you can take a painting and how sincerely you‘re prepared to express 

your visualization. A few artists want to take in any particular sole medium, and essentially 

they wants to use individual preferences for that picked medium. And of course, there are 

those of us who are curious to see how different mediums will work together; you can build 

up a totally unique style of art while using variety methods of different drawing media. 

In this unit, you will learn about different kinds of artworks listed. The unit will give a 

diagram with a few illustrations that may help make you think about how our function in 

encaustic can be integrated into the more extensive universe of art. You will learn that each of 

the three fields that is focussed on painting, drawing and mixed media/collage has a distinct 

method for describing what the work is made of - a material vocabulary all its own.. 

Outcomes 

Upon completion of this unit you will be able to: 

• Describe different type of drawingmedia •

 Explain the major theories influencingart •

 Assess how to use materials 

• Formal elements and safe working practices 
 

• Differentiate between various water colour techniques. 

Terminology 

Canvas: The fabric that is extended on a wooden casing in which oil paintings and acrylic 

paintings are finished. 

Crafts: Art frames used for creating attractive art pieces that are both excellent and helpful. 

Crafts include weaving, texture outline, pottery, and gems making. 

Crayons: Pigments held together with wax and formed into sticks. 
 

Fresco: A procedure of painting on a layer of wet mortar. The mortar ingests the shades and 

the painting turns out to be a piece of the divider. 

Mosaic: Small pieces of tile which is creatively placed together to make a design on a wall or 

floor. 

Palette: A wood, metal, or plastic surface used by an artist to blend paint. 
 



 

 

 
 

Solvent: A fluid material that is utilized to thin the binder in paint. 
 

A Brief History of Designing 
 

Exploring Different Art 
 

Art has implied different things to different individuals at distinctive circumstances 

through our mankind's history. In the content Art Fundamentals, the authors* discuss the term 

"art" we utilize it today is likely to be gotten from the renaissance words arti and arte. ―Arti 

was the designation for the craft guilds of the 14th, 15th and 16th centuries to which the 

artists were closely tied by the traditions of their calling. The word for craftsmanship is art, 

implied knowledge of the materials utilized by the artist as well as the surface on which they 

would execute their work. Art or craftsmanship also implied the skilful handling of those 

materials in the sense of producing images more or less like those of nature, but certainly not 

in the sense of imitating the exact appearance of nature.‖ 

This unit investigates conventional and non-customary medium related with Two 

Dimensional artworks including: 

1. Drawing 

2. Painting 

3. Collage 

Two-dimensional media are gathered into general classifications. We should take a 

look at each gathering to comprehend their specific qualities and how craftsmen utilize them. 

Drawing 

Drawing is the expertise to utilize lines and shapes to make a pleasing piece which 

shows profundity, differentiation, light and shadow and gives the impression of measurement, 

using different degrees of detail. Drawing is the least complex and most proficient approach 

to impart visual thoughts, and for a considerable length of time. Charcoal, chalk, graphite and 

paper are sufficient apparatuses to dispatch the most profound pictures in workmanship. 

Leonardo da Vinci's The Virgin and Child with Saint Anne and Saint John the Baptist wraps 

every one of the four figures together, what is basically a more distant family picture. Da 

Vinci attracts the figures an astoundingly sensible style, one that accentuates individual 

characters and encompasses the figures in a grand, unfinished landscape. He invigorates the 

scene with the Christ kid pulling himself forward, trying to discharge himself from Mary's 

grip to get more like a young John the Baptist on the right, him self's identity turning toward 

the Christ tyke with a look of inquisitive interest in his younger cousin. 

The customary part of drawing was to make outlines for bigger arrangements to be 
 



 

 

 
 

shown as paintings, mold or even design. In view of its relative immediacy, this capacity for 

drawing continues today. A preliminary draw by contemporary modeller Frank Gehrycatches 

the mindboggling natural types of the buildings he outlines. 

Types of Drawing Media 

1. Dry Media 

Dry Media includes charcoal, graphite, chalks and pastels. Each of these mediums 

gives the craftsman an extensive variety of stamp making abilities and impacts, from thin 

lines to expansive ranges of shading and tone. The craftsman can control a drawing to 

accomplish wanted impacts in numerous ways, including exerting different weights on the 

medium against the drawing's surface, or by eradication, blotting or rubbing. 

This procedure of drawing can instantly exchange the feeling of character to a picture. 

From vivacious to inconspicuous, these qualities are clear in the most straightforward works: 

the immediate and unalloyed soul of the craftsman's thought. You can see this in the self-

pictures of two German craftsmen; Kathe Kollwitz and Ernst Ludwig Kirchner. Injured 

during the main world war, his Self-Portrait under the Influence of Morphine from around 

1916 presents us with a nightmarish vision of him wrapped in the mist of sedative 

medications. His empty eyes and the realistic brokenness of his imprints verify the energy of 

his drawing. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Portraits 

Attribution- Sandrine Pelissier 

Source- pinterest.com 

Link-https://www.moma.org/s/ge/collection_ge/artist/artist_id-3115_role- 

1_sov_page-71.html 

2. Graphite 
 

Ernst Ludwig Kirchner, Self Portrait under the Influence of Morphine Graphite is the 
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most widely recognized drawing medium. Graphite usually comes in the type of pencils, 

powder or packed sticks and is the thing that a large portion of us basically allude to as 

"pencil". Each one makes a scope of qualities depending on the hardness or softness inherent 

in the material. Hard graphite tones territory from light to dark dim, while softer graphite 

enables a range from light dim to almost dark. In this manner a great deal of graphite 

drawings are basically called pencil drawings, despite the fact that calling them graphite 

drawings would be more exact. 

Graphite drawing procedures are for all intents and purposes interminable. At any rate 

that you apply graphite to a surface will deliver some kind of results. French stone carver 

Gaston Lachaise's Standing Nude with Drapery is a pencil drawing that fixes the vitality and 

feeling of development of the figure to the paper in only a couple of strokes. And Steven 

Talasnik's contemporary huge scale drawings in graphite, with their swirling, natural 

structures and design structures are demonstration of the energy of pencil (and eraser) on 

paper. 

3. Charcoal 
 

Charcoal is scorched natural material. Typically the material is wood. There are a 

couple of sorts of charcoal utilized by craftsmen to make a drawing. These sorts of charcoal 

include "vine" and "packed". Vine charcoal is more often used that does not comprise of 

consumed willow wood. Vine charcoal is effectively spread on a surface and is anything but 

difficult to eradicate. As an outcome it is for the most part makes a lighter stamp when you 

draw than packed charcoal and it is effectively smirches. Compacted charcoal is held together 

by a gum binder and is darker than vine charcoal. Thus, it is harder to eradicate, harder to 

smirch, yet makes a darker stamp. Compacted charcoal may come as a round stick, a square 

stick, or in a pencil. (Vine charcoal is quite often a round stick.) But it's harder to control once 

they are connected topaper. 

4. Pastels 
 

Significantly more prominent color refinement is conceivable with pastel colored 

pencils, produced using powdered shades blended with a base measure of non-oily cover. At 

the point when the colors are connected to paper, they perpetually look new and bright, in 

spite of the fact that they should be safeguarded from scattering by been kept under glass. 

Pastel colors can be connected in straight method straightforwardly with the pastels, or to a 

region of the paper specifically with the fingers. Pastels originated in the north of Italy amid 

the 16th century, and were utilized by Jacopo Bassano (1515-92) and Federico Barocci 

(1526- 1612). Pastel drawings were known to the Accademia degli Incamminati no later than 

 



 

 

 
 

the 17th century, in spite of the fact that as a work of art it didn't achieve its apogee until the 

eighteenth century, eminently in France (with Jean Marc Nattier, Maurice Quentin de La 

Tour, Jean-Baptiste Perronneau and Jean Chardin) and in Venice (with Rosalba Carriera) 

 
 
 
 
 
 
 
 
 
 

Title-Pastels 
 

Source- pixabay.com 
 

Link-https://www.pexels.com/photo/art-artistic-bright-close-up- 268435/ 
 

Wet media 
 

Ink: Wet drawing media generally eludes to ink, however, truly includes any substance that 

can be put into arrangement and connected to a drawing's surface. Since wet media is 

controlled much like paint – through thinning and the utilization of a brush – it obscures the 

line amongst drawing and painting. Ink can be connected with a stick for linear impacts and 

by brush to cover huge zones with tone. It can likewise be weakened with water to make 

estimations of dim. 

Felt tip pens are viewed as a type of wet media. The ink is immersed into felt strips inside 

the pen at that point discharged onto the paper or other help through the tip. The ink rapidly 

dries, leaving a lasting imprint. The hued marker drawings of DonnabelleCasis have a 

flowing, natural character to them. The conceptual nature of the topic infers body parts and 

viscera. 

Different fluids can be added to drawing media to improve impacts – or make new 

ones. Craftsman Jim Dine has sprinkled soda onto charcoal drawings to make the surface rise 

with bubbling. The outcome is a visual surface dissimilar to anything he could make with 

charcoal alone, in spite of the fact that his work is known for its solid control. Dine's drawings 

often utilize both dry and fluid media. His topic includes creatures, plants, figures and 

apparatuses, ordinarily packed together in thick, darkly sentimental pictures. 

Conventional Chinese painting utilizes water-based inks and colors. Truth be told, it is 

one of the most seasoned continuous imaginative conventions on the planet. Painted on 

backings of paper or silk, the topic includes landscapes, creatures, figures and calligraphy, a 

fine art that utilizations letters and script in liquid, expressive motions. 

Painting 

https://www.pexels.com/photo/art-artistic-bright-close-up-268435/
https://www.pexels.com/photo/art-artistic-bright-close-up-268435/


 

 

 
 

Painting is the act of applying paint, shade, shading or other medium to a strong 

surface (bolster base). The medium is normally connected to the base with a brush, however 

different actualizes, for example, blades, wipes, and enhances with Photoshop, can be 

utilized. 

Painting is a method of inventive articulation, and the structures are various. Drawing, 

signal (as in gestural painting), piece, portrayal (as in story craftsmanship), or reflection (as in 

dynamic workmanship), among other stylish modes, may serve to show the expressive and 

theoretical intention of the professional. Paintings can be naturalistic and illustrative (as in a 

still life or landscape painting), photographic, conceptual, story, symbolist (as in Symbolist 

craftsmanship), emotive (as in Expressionism), or political in nature (as in Artivism). 

Painting mediums are to massively flexible, in light of the fact that they can be 

connected to a wide range of surfaces (called bolsters) including paper, wood, canvas, mortar, 

earth, veneer and cement. Since paint is normally connected in a fluid or semi-fluid state it 

can douse into permeable help material, which can, after some time, debilitate and damage it. 

To keep the help material, it is typically first secured on a solid land with a blend of binder 

and chalk, when dries makes a non-permeable layer between the help material and the 

painted surface. There are six noteworthy painting mediums, each with particular individual 

qualities: 

1. Encaustic 

2. Tempera 3. 

Fresco 

4. Oil 
 

5. Acrylic 
 

6. Watercolour 
 

All of them use three basic ingredients: 

1. Pigment 

2. Binder 

3. Solvent 

Pigments are granular solids incorporated into the paint to contribute shading. The 

binder, generally alluded to as the vehicle, is the genuine film-forming segment of paint. The 

binder holds the shade in arrangement until it's prepared to be scattered onto the surface. The 

dissolvable controls the stream and utilization of the paint. It's mixed into the paint, usually 

with a brush, to weaken it to the best possible consistency, or thickness, before it's connected 

to the surface. Once the dissolvable has vanished from the surface the remaining paint is 

 



 

 

 
 

settled there. Solvents go from water to oil-based items like linseed oil and mineral spirits. 

How about we look a gander at each of the six main painting mediums: 

 
 

1. Encaustic 
 

Encaustic is a wax based paint (made out of beeswax, resin and color), which is kept 

liquid on a warmed palette. It is connected to a retentive surface and then warmed so as to 

meld the paint. "Encaustic" originates from the Greek word enkaiein, meaning to consume in, 

referring to the way toward fusing the paint. Though they originate from a similar root word, 

"encaustic" ought not to be mistaken for "acidic," which alludes to a destructive synthetic 

response. There is no such risk with encaustic. 

2. Tempera 
 

Tempera, otherwise called egg tempera, is a changeless, quick drying painting 

medium consisting of hued pigments mixed with a water-solvent binder medium (typically a 

glutinous material, for example, egg yolk or some other size). Tempera additionally alludes 

to the paintings done in this medium. Tempera paintings are durable and customarily 

connected in progressive thin layers, called coats, painstakingly developed using systems of 

cross brought forth lines. 

3. Fresco 
 

Fresco painting is utilized only on mortar dividers and ceilings. The medium of fresco 

has been utilized for thousands of years, yet is most connected with its utilization in Christian 

pictures during the Renaissance time frame in Europe. 

There are two types of fresco: Buon or "wet", and secco, meaning "dry". 
 

Buon fresco method comprises of painting in color mixed with water on a thin layer of 

wet, crisp lime mortar or mortar. The color is connected to and consumed by the wet mortar; 

following various hours, the mortar dries and responds with the air: it is this substance 

response that fixes the shade particles in the mortar. As a result of the compound cosmetics of 

the mortar, a binder is not required. Buon fresco is steadier on the grounds, that the shade 

turns out to be a piece of the divider itself. 

Buon Fresco alludes to the hues and subtle elements are safeguarded in the dried 

mortar divider. 

Secco fresco alludes to painting a picture on the surface of a dry mortar divider. This 

medium requires a binder since the shade is not mixed into the wet mortar. Egg tempera is 

the most widely recognized binder utilized for this reason. It was basic to utilize secco fresco 

over buon fresco paintings with a specific end goal to repair damage or roll out 



 

 

 
 

improvements to the original. Then the colours and details are preserved in the dried plaster 

wall. 

4. Oil 
 

Oil paint is the most flexible of all the painting mediums. It utilizes color mixed with a 

binder of linseed oil. Linseed oil can likewise be utilized as the mixing fluid, alongside 

mineral spirits or turpentine. Oil painting was thought to have created in Europe during the 

15th century, however, late research on wall paintings found in Afghanistan hollows show oil 

based paints were utilized there as right on time as the 7thcentury. 

A portion of the characteristics of oil paint includes an extensive variety of color 

decisions, its capacity to be thinned down and connected in practically straightforward 

coatings and in addition utilized straight from the tube (without the utilization of a vehicle), 

developed in thick layers called impasto (you can see this in many works by Vincent van 

Gogh). One disadvantage to the utilization of impasto is that after some time the body of the 

paint can part, leaving systems of breaks along the thickest parts of the painting. Since oil 

paint dries slower than different mediums, it can be mixed on the help surface with careful 

detail. This expanded working time additionally takes into account alterations and changes to 

be made without having to rub off segments of dried paint. 

5. AcrylicPaint 
 

Acrylic paint was created in the 1950s and turned into another option to oils. Shade is 

suspended in an acrylic polymer emulsion binder and utilizations water as the mixing fluid. 

The acrylic polymer has attributes like elastic or plastic. Acrylic paints offer the body, 

shading reverberation and toughness of oils without the expense, wreckage and danger issues 

of using overwhelming solvents to blend them. One noteworthy contrast is the generally 

quick drying time of acrylics. They are water dissolvable, yet once dry wind up noticeably 

impenetrable to water or different solvents. Additionally, acrylic paints cling to a wide range 

of surfaces and are to a great degree solid. Acrylic impastos will not split or yellow after 

some time. 

6. Watercolour 
 

Watercolour is the touchiest of the painting mediums. It responds to the lightest touch 

of the craftsman and can turn into an overworked mess in a minute. There are two kinds of 

watercolour media: straightforward and obscure. Straightforward watercolour works in a 

switch relationship to the next painting mediums. It is generally connected to a paper bolster, 

and depends on the whiteness of the paper to reflect light back through the connected shading 

(see underneath), while hazy paints (including murky watercolours) reflect light off the skin 

 



 

 

 
 

of the paint itself. Watercolour comprises of shade and a binder of gum Arabic, a water-

solvent compound produced using the sap of the acacia tree. It breaks up effectively in water. 

The conventional and most basic help-material to which the paint is connected for 

watercolour paintings is paper. Different backings include papyrus, bark papers, plastics, 

vellum, or calfskin, texture, wood, and canvas. Watercolour paper is often made completely 

or somewhat with cotton, which gives a decent surface and minimizes contortion when wet. 

Watercolours are generally translucent, and seem luminous, in light of the fact that the 

pigments are set down in an unadulterated shape with couple of fillers obscuring the shade 

hues. Watercolours can likewise be made hazy by adding Chinese white. 

In East Asia, watercolour painting with inks is alluded to as brush painting or 

parchment painting. In Chinese, Korean, and Japanese painting it has been the dominant 

medium, often in monochrome dark or tans. India, Ethiopia and different nations have long 

watercolour painting conventions also. Finger-painting with watercolour paints originated in 

mainland China. 

Water Colour Techniques 
 

Watercolour painting has the notoriety of being very demanding; it is more exact to 

state that watercolour methods are remarkable to water colour. Not at all like oil or acrylic 

painting, where the paints basically stay where they are put and dry pretty much in the frame 

they are connected, water is a dynamic and complex accomplice in the water colour painting 

process, changing both the sponginess and state of the paper when it is wet and the outlines 

and appearance of the paint as it dries. The trouble in water colour painting is totally in 

learning how to envision and use the conduct of water, instead of attempting to control or 

dominate it. 

Washes and Glazes 
 

In water colours, a wash is the use of weakened paint in a manner that masks or 

destroys individual brush strokes to deliver a bound together region of shading. For example, 

this may be a light blue wash for the sky. 

A coating is the use of one paint shading over a past paint layer, with the new paint 

layer at a weakening adequate to enable the main shading to show through. Coatings are 

utilized to blend at least two hues, to alter a shading (darken it or change its tone or chroma), 

or to deliver to a great degree homogenous, smooth shading surface or a controlled yet 

sensitive shading move (light to dark, or one tint to another). The last strategy requires the 

principal layer to be an exceptionally weakened consistency of paint; this paint layer 

disintegrates the surface sizing of the paper and slackens the cellulose tufts in the mash. 

Painters who utilize this method may apply 100 coatings or more to make a single painting. 



 

 

 
 

This technique is as of now exceptionally mainstream for painting high difference, intricate 

subjects, and specifically brilliant blooms in precious stone vases splendidly illuminated by 

coordinate daylight. The glazing technique likewise works extraordinarily well in water 

colour picture, allowing the craftsman to delineate the complex tissue tones successfully. 

Wet in wet 

Wet in wet includes any utilization of paint or water to a region of the painting that is 

as of now wet with either paint or water. As a rule, wet in wet is a standout amongst the most 

distinctive elements of watercolour painting and the method that delivers a striking painterly 

impact. The fundamental thought is to wet the whole sheet of paper, laid level, until the point 

when the surface no longer wicks up water yet gives it a chance to sit at first glance, at that 

point to dive in with an expansive brush immersed with paint. This is typically done to define 

the extensive zones of the painting with unpredictably defined shading, which is then honed 

and refined with more controlled painting as the paper dries. 

Dry brush 
 

Dry brush is the watercolour painting system for accuracy and control, especially 

exemplified in numerous herbal paintings and in the dry brush watercolours of Andrew 

Wyeth. Crude (undiluted) paint is gotten with a pre-moistened, little brush and then 

connected to the paper with little hatching or crisscrossing brushstrokes. The brush tip must 

be wetted however not cheated with paint, and the paint must be sufficiently liquid to 

exchange to the paper with slight weight and without dissolving the paint layer underneath. 

The objective is to develop or blend the paint hues with short exact touches that mix to stay 

away from the presence of pointillism. The aggregate impact is objective, textural, and 

profoundly controlled, with the most grounded conceivable esteem differentiates in the 

medium. Often it is difficult to distinguish a decent drybrush watercolour from a shading 

photo or oil painting, and numerous drybrush watercolours are varnished or lacquered after 

they are finished to upgrade this likeness. 

Diluting and Mixing 
 

Tube paints are regularly utilized with a level palette that gives compartmentalized 

paint wells (for holding separate paint hues) and an extensive mixing zone for mixing or 

diluting paints; skillet paints are exhibited in enamelled metal paint boxes that give shallow 

mixing zones in the folding spread or in a crease out faceted plate. With tube paints, the 

abundance paint remaining in the palette paint wells ought to be use or wash out just in case if 

the paint moves toward other well dirtying another paint; generally the paints ought to be 

permitted to dry out quickly and totally, as this keeps shape from forming. Regardless of the 

regular misguided judgment, there is no visual contrast between the gooey paint bundled in 83



 

 

 
 

tubes and the dried paints in skillet. Tube paints left to dry in paint wells are utilized as a part 

of the very same path as skillet paints—the painter essentially dribbles or showers water over 

the paint a couple of minutes before starting work. The main remarkable contrast is that some 

tube paints, for example, viridian or cerulean blue, create a coarse, uneven paint blend when 

left to dry and then rewetted. 

Minimal Palettes 
 

Palette is likewise the term for a particular choice of paints. A natural decision is the 

"primary" palette consisting of a fuchsia (generally yet inaccurately distinguished as "red"), 

yellow and cyan (customarily "blue") paint, each representing subtractive primary shading. 

This palette can blend every conceivable tint, however the purple, orange, and green blends 

are distinctively rather dull or dark, and most shading blends require utilization of each of the 

three paints. The primary palette is in this manner helpful to exhibit that smallness 

additionally influences accommodation (the trouble involved in mixing any normal shading) 

and shading immersion (by and large, the paint blend range or aggregate number of 

exceptional hues it is conceivable to blend with a palette). Leonardo, in his note pads, 

referred to red, yellow, green and blue (alongside white and dark) as the "painter's primaries". 

However, he might not have had a particular palette in mind; but rather replacing the cyan 

paint with a dark blue paint, (for example, ultramarine blue), and adding a green paint, 

incredibly enhances the immersion of both purple and green blends in a smaller four-paint 

determination, and enables a dark impartial or dark to be mixed specifically, using just red 

and green. 

In the 19th century six paint "split primary" palette was introduced and is still upheld 

today as an answer for the mixing restrictions of the three paint "primary" palette. It depends 

on the three conventional subtractive primary hues (red, yellow, and blue), each in a "warm" 

and "cool" adaptation. 

Collage 
 

A collage is any work of art that is created by gluing or otherwise attaching objects to 

a base. The base can be canvas, wood, stone, paper or anything the artist wants to use. In 

collage the medium attached to the base is usually paper or fabric. 

History of Collage 
 

Collage turned out to be all the more completely created during the coming of 

innovation, when Cubist pioneers Pablo Picasso and Georges Braque explored different 

avenues regarding combining parts of different materials to make a radical new synthesis. 

These craftsmen mixed high culture (present day workmanship) with components of 

 



 

 

 
 

everyday life (bits of materials, daily papers, magazines, colour paper, and so forth.). Dada 

craftsmen introduced the use of existing photos in their compositions, which often remarked 

on the province of German culture in the disorder of World War I. The craft of arrangement 

continued to fill in as inspiration in the 1950s and 1960s, when array and Pop craftsmen 

utilized discovered questions and pictures from mass created commercials in their works. 

While numerous craftsmen today continue with original strategies for arrangement, many 

introduce more updated computerized mediums to rejuvenate the customary craftsmanship. 

Mixed Media Techniques for Collage 

Rice paper and gel medium present an excellent opportunity to preserve many 

different objects while creating a beautiful piece of art. Leaves, flowers, feathers, pieces of 

paper and bits of fabric can all be used in this simple technique. When the gel medium dries, 

the rice paper becomes transparent and encases the items you used to create the collage. 

Consider thinking outside the box on the selection of a base for your collage. Stone or 

ceramic tiles that are commonly used in kitchens or bathrooms can make interesting bases. 

The ―wrong‖ side of a travertine tile makes a lovely natural base for alcohol inks, acrylic 

paints, glass powders and other interesting bits. Try using stamps that you already have or 

make your own. Small found objects can be glued on to add interest or tell a story. 

Collage is an excellent technique for people that love to scrapbook as well. You can 

add pieces of paper such as concert or movie tickets. Pieces of fabric from special dresses, 

such as a wedding dress or prom dress could be added to a collage that is part of a scrapbook 

project. This is a good way to transform memories to art and make them last for generations to 

come. 

Unit Summary 
 

In this unit you have learned the different types of drawing media and its use in 2D 

animation. Besides that you have learnt the exploration of different medium and materials for 

producing a 2D art. You learn extra strategies and aptitudes to utilize them to express your 

own innovative thoughts. 

Assessment 
 

1. Describe formal elements of art. 

2. Classify different types of art. 

3. Explain the term media in art. 

4. Define pigment in art. 

5. List the characteristics of abstract art. 
 
 



 

 

 
 

6. Explain the meaning of texture in art. 

7. Define creative arts. 

8. State what is acrylic? 
 

9. How is a Pegasus drawn? 
 

10. Write the way to erase crayon from paper. 

11. Define washes. 

12. Describe perspective in painting. 

13. State what is ink? 

14. Describe "Fresco". 

15. What is collage? 

Resources 
 

• https://www.google.co.in/ 

• https://www.rmit.edu.au/ 

• https://www.wikipedia.org/ 
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Unit 3 Exploration of 2D elements 

Introduction 

All of us visit several websites in a day. Some websites grab our sights all the more 

effectively, while others don't. Why? Once in a while we need to comment our feeling about 

preferences or abhorrence of web sites, and it is anything but difficult to state just "I like this 

thing, or I don't care for that thin " But in the event that we are asked to answer the inquiry 

for what good reason, it is extremely troublesome for us to discover the fundamentaldriver. 

Which factors do impact on somebody to have a specific disposition towards a web 

page? There is a probability of many reasons associated with it, yet I think the "plan" of the 

webpage is extremely basic one of them. 

This unit portrays the components and standards of plan and eloquent the sub-

variables of outline. Color, values, structures and shapes, space lines and surfaces are known 

as the components of outline. These components are known as the basics for all gems. 

Without these components, craftsmanship couldn't be made. These components exist in our 

general surroundings in nature and in the situations we make for ourselves. 

In this unit, you will learn the relationship between elements and principles. 

Outcomes 

Upon completion of this unit you will be able to: 

• Describe various design elements 

• Division of elements 
 

• Elaborate, design elements 

• Define a line 

• Differentiate between 'outline randomness' and different forms of randomness 

• Discuss various grid systems 

Terminology 
 

Line: A line is a shape with width and length. 

Scale: Scale is a huge piece of outline. Color: 

It explains the particular state of mind. 

Texture: Texture alludes to the surface quality. 
 

The plan components and standards portrayed here can be an investigating outline for 

webpage plan. It illuminates us where to start, what to test and how to examine. For instance, 

the creator who knows the outline components and standards can break down the page in 

terms of lines, colors, developments, adjustments, amicability, etc., while others simply 



 

 

 
 

imagine whether it is suitable for them or not. This data can likewise give a communicating 

instrument to the web planner. An author can express his/her idea utilizing dialect. A 

webpage originator likewise communicates their idea or a specific aim with components of 

outline and does it viably alongside the plan standards. When a planner needs to state 

something through the webpage, he should utilize the components (line, color, and so forth) 

as a specialized device. So it is essential to know such sort of implications of the outline 

components and standards. 

Note: Although colorstands out amongst the most vital outline components, I barred 

the detail depiction of it, since color-related subject has just grabbed creator’s interests and 

numerous architects, I think, definitely they know about it in particular. 

Design Elements 
 

The components will be segments or parts which can be disconnected and 

characterized in any visual outline or masterpiece. They are the structure of the work and can 

convey a wide assortment of messages. The points of interest might be differently selected by 

scientists, however, I included ―line‖, ―scale, ―color‖, ―repetition‖, ―negative space‖, 

"symmetry", " transparency ", "texture", "balance ","hierarchy ", "contrast", "framing", 

"grid", "randomness","direction", "rules"and "movement‖ 'in this unit 

 
 
 
 
 
 
 
 
 

Title-Line drawing Attribution- Source- prawny 
 

Link-https://pixabay.com/en/vintage-sketch- 
 

doodle-line-drawing- 1778234/ 
 

A line is a shape with width and length, yet no profundity. Artists utilize lines to make 

edges and the outlines of articles. A line is made by the movement of the craftsman's pen. 

The direction of a line can pass on disposition. Flat lines are quiet and tranquil, 

vertical lines proposes mostly the potential for movement, while corner to corner lines 

emphatically recommend movement, which gives a greater degree of sentiment essentialness 

to a photo. 

Lines can be characterized as any linear imprints. In this way, when you consider it, 

lines make up pretty much everything. Indeed, even these words and letters you're pursuing 

comprises thousands of bended, calculated and straight lines. 



 

 

 
 

Lines can channel certain thoughts as well. Straight ones can bring out request and 

tidiness, wavy lines can make movement and crisscrossed lines can infer pressure or fervour. 

A strategy to improve photography to a considerable measure is by the utilization of 

'driving lines' which does exactly what they guarantee i.e. they lead the eye. Finding and 

underscoring solid driving lines in your piece can enable you to coordinate the eye through 

the whole piece or to certain central focuses. 

Let‘s take a look at a case of driving lines in web outline. This webpage has a cool 

askew grid with extremely solid driving lines that brings down the page from area to segment 

in a quick crisscross shape. A solid utilization of line is an incredible approach to stylise your 

representations. 

Lines are adaptable, basic and viable realistic components that you surely ought not to 

underestimate! Let‘s explore different avenues regarding them and find out what cool things 

they can add to your plan. 

2. Scale 
 

Scale is a huge piece of outline, once in a while actually. In an extremely fundamental 

definition, scale is the presence of mind measuring the individual components. 

Scale can enable us to comprehend plans and pictures. Consider if you somehow 

happened to attract a mouse alongside an elephant, you'd likely draw the mouse substantially 

littler than the elephant, which would help watchers easily comprehend your drawing. 

Along these lines, scale encourages us to comprehend different things. In any case, 

scale doesn't generally need to be found on authenticity. You can estimate your components 

drastically expansive or little to make staggering impacts and to flag which parts of your 

outline are more vital and which are less. 

While this scale is not in fact in light of authenticity as individuals' countenances for 

the most part are of similar size. All things considered (Ryan Gosling is not a mammoth as far 

as anyone is concerned) are the sensational scaling all over. The confront causes watchers to 

get a fast handle on each character's level of significance in the film. 

This scaling of components to flag significance is frequently called "Progressive 

System", which we'll discuss later. For the interim, let‘s take a look at a case that utilizes 

scale to connote significance. 

3. Color 
 

Color is vital factor. It explains particular states of mind, channels feelings and as well 

as each shade has certain particular undertones related to it. To put it simply, color can 

represent the deciding moment your outline. 

 



 

 

 
 

Color consists of three properties. The first is tone, which is the name of the colors. 

The essential tones are yellow, red and blue. Auxiliary colors are made by blending two 

primaries. Middle colors are the blends of an essential and adjoining auxiliary color. 

The second property of color is esteem, which alludes to the softness or murkiness of 

shade. The third property of color is power, which alludes to the virtue of the shade (likewise 

called "chroma"). 

Color isn't a rule essentially restricted to marking components.However, color 

ventures into everything, even photos. Channels and picture adjustors have given us the 

boundless capacity to change our photo‘s coloring and tones. 

It is safe to say that if you are planning a smooth and advanced publication, then why 

not a sharp, noir-propelled monochromatic channel run over your picture, similar to Canvas 

"Road" channel. On the other hand, if you're going for an offbeat look, then consider dropping 

the contrast of your picture a little to quiet your picture‘scolors a bit, making it milder and 

more quiet. 

4. Contrast 
 

Contrast is regularly the magical key fixing to make your plans 'pop', which is a 

(sometimes disappointing) demand from many outline clients. 

In an exceptionally basic definition, contrast is the level of difference between two 

elements of your outline. 

Some common forms of contrast are dull versus light, thick versus thin, vast versus 

small, etc. 

Contrast greatly affects meaningfulness and neatness also, it's a major motivation 

behind why you see books and many different publications imprinting in black content on a 

white background. Imagine that they printed utilizing light dim on a white background. The 

contrast would be low and the sort of hard to peruse. In this way, in case you're utilizing sort, 

make beyond any doubt you bump up that contrast. 

Contrast isn't only a stylistic element or a decipherability enhancer; it can likewise act 

to attract the eye to certain elements of your plan. This technique is utilized as a considerable 

measure in website plan. 

5. Texture 
 

Texture alludes to the surface quality, both simulated and actual pattern of 

craftsmanship. Techniques used as a part of painting serves to indicate texture, i.e. the dry 

brush technique produces a harsh simulated quality and substantial application of pigment 

with brush or other implementation that produces an unpleasant actual quality. 

 



 

 

 
 

Clean, sharp and smooth graphic plans can be superb, however sometimes; roughing it 

up a little with some texture can be far superior. Texture can include tactility, profundity, and 

can add some entirely fascinating effects to your outline. 

Be that as it may, as with many things, make sure to use this technique in moderation, 

as a lot of texture can quickly overwhelm your plan. Remember: there's a barely recognizable 

difference between shabby-chic and out and out old shabby. 

The more textures connected, the harder sort and different elements are created 

without a stroke effect around each letter. 

Of course, in case you're going for the muddier look stylistically, at that point layering 

textures might look good for you. However, if you're searching for an approach to 

incorporate texture in a less imposing manner, follow the example below 

 
 
 
 
 
 
 
 
 
 
 
 
 

Title-texture Attribution- Source-monicore 

Link-https://pixabay.com/en/vintage-sketch-doodle-line-drawing-1778234/ 

How about we observe an example that utilizes texture in a way that enhances the 

piece. Notice that the utilization of the unpleasant texture isn't distracting, rather giving it a 

more handcrafted, authentically-vintage feel. 

6. Repetition 
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Title-repetition Source-kaatjem 
 

Link-https://pixabay.com/en/row-of-trees-repetition-sunrise-2168579/ 
 

Imagine about any big brand name such as Pepsi, Adidas, Audi, Motorola and Apple, 

this is certain that you would all be able to think about their logo, their manner of speaking 

and their general color plans utilized. Why are these things so significant without a moment's 

notice? That is correct, you got it – repetition. 

Repetition is a critical component with regards to marking outline, both as far as 

keeping your marking predictable and as far as entwining your things. 

7. Negative Space 
 

To put it gruffly, negative space is the 'space inbetween', the range between or around 

different elements that form its own particular shape. 

Take example of broadly respected ruler and counterfeiter of negative space 

craftsman M.C. Escher, whose work I'm certain you have seen and would have been 

sometimes astounded. Escher did a number of decorations that focussed on one shape driving 

into the following, by means of negative and positive space. 

 
 
 
 
 
 
 
 
 
 
 
 

Title-Negative space 
 

Attribution-Maurits Cornelis Escher 

Source- 

Link- https://www.flickr.com/photos/pedrosimoes7/38798263524 

Perceive how the space in the middle of the black kangaroos is utilized to display the 

state of white kangaroos. This is negative space at work – considering everything around and 

in the middle of your physical outline and manipulating that space to form something new. 

Negative space when utilized strategically can help create really staggering and clever 

plans. Observe these simple animal icons to render clear depictions of each animal. 
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8. Symmetry 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Symmetry Source-bogitw 

Link-https://pixabay.com/en/architecture-stairs-steel-abstract-1313678/ 

 
 

As species, human creatures are scientifically ended up being attracted to symmetry. 
 

We find symmetrical faces, examples and outlines, by and large more attractive, effective and 

lovely. 

Symmetry is utilized as a considerable measure in logos so as to create a harmonious 

and balanced plan. Some examples of extensive brands with symmetrical logos are Target, 

McDonald's, channel, Starbucks, etc. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
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Of course, symmetry is not generally a possibility for each plan and nor should it be. 
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There's an almost negligible difference between an outline looking balanced and symmetrical 

in appearance as though one side was copied, flipped or stuck to one side. So as opposed to 

attempting to achieve perfect symmetry, rather attempt are made to introduce inconspicuous 

elements of symmetry into your outline. 

Symmetry isn't generally as evident, either sometimes it is inconspicuous or 

sometimes you may not even notice it. A prime example of imperceptible symmetry can be 

found in article plan and more specific message boxes. Open up any magazine you came 

across , the chances are more in a extended article where you'll notice that the body copy that 

has been part up into columns of content and they are frequently symmetrically measured to 

keep things readable, flawless and additionally outwardly engaging. 

By utilizing a touch of symmetry in your format, you can create a feeling of balance 

and request. In this way, next time you're planning a publication outline or a plan with a 

considerable measure of sort, focus on how much (or how little) symmetry you're utilizing. 

On the off chance that your outline doesn't look very right, have a run at toying with your 

symmetry, regardless of whether this be increasing it or decreasing it. 

9. Transparency 
 

Likewise occasionally known as 'opacity', transparency alludes to how 'transparent' an 

element is. The lower your opacity, the lighter and less noticeable your element is, and the 

higher it is, the more strongly noticeable the element is. 

Transparency is additionally an incredible technique for producing a feeling of 

movement in static images. For example, check out this blurb, layers different images with 

various levels of transparency to create an immersing effect and feeling of movement. 

Transparency isn't quite recently limited to advanced graphics either. Check out how 

this welcome card for the New York Museum of Glass has apropos which has been imprinted 

onto straightforward glass, giving the plan a special and drawing in effect. Consider on what 

mediums your outlines will be imprinted on, what will be the opacity and what completion 

they will have while designing or showcasing your creativity. 

10. Balance 
 

Balance is a really important thing in most of life and it's equivalently important in the 

realm of outline. 

One approach to master balance is to think about each of your elements as having a 

"weight" behind it. From content boxes to images, to that of blocks of color, consider each of 

their sizes, shapes and what "weight" they have in connection to different elements on the 

page. 

 



 

 

 
 

A decent technique is to imagine if your outline were to be printed out as a 3D model. 

Would it stand, or would it tip to the other side? 

One kind of balance is 'asymmetrical balance', which is less about mirroring left and 

right/top and bottom and more about conveying, measuring and adjusting elements so their 

"weights" are in occasion. 

11. Hierarchy 
 

Hierarchy in configuration is a great deal like that in culture, as both are based on 

fundamentally the same thought. At the highest point of a hierarchical scale, we have the 

most important things, the lords. These elements are to be "dressed" the most indulgently and 

command the most consideration. 

 

In the following level of hierarchy, we have the noblemen i.e. the elements that are 

important.However they don't command much consideration as the lords. These are things 

like subheadings, pull cites and extra information. Make beyond any doubt to keep these eye-

catching and noticeable, however not at anyplace close as noticeable as your headings. 

What's more?On the last rung of the hierarchical scale are the labourers, the humble 

elements of your plan that are given minimal amount of visual spirit, as a rule things like 

body copy, less important information, joins, etc. 

Observe this blurb. You can without much of a stretch bring up the title, the 

subheading/date, and down the bottom, the smallest sort of extra information that isn't as 

crucial to the communication. 

Of course, hierarchy isn't recently limited to sort. Images likewise have hierarchy. The 

bigger, more colorful or more central elements of your image will have a higher hierarchy 

than those smaller, blunter and less point by point elements. 

12. Framing 
 

Much the same as you do with your photos and pieces of workmanship, framing your 

plans correctly is an important aspect. We as a rule consider framing in terms of photography 

– what you include and what you don't. Be that as it may, framing is similarly as important in 

plan. 

Physical frames such as box outlines or graphic elements can enhance or attract regard 

for specific elements of your plan. 

For example, we should check out this menu plan that chooses to frame one of the 

specials and the business mission statement to attract consideration regarding these two 

elements that the eye may have generally disregarded. Such a simple method for highlighting 



 

 

 
 

certain elements of your outline can have a major impact. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Framing 

Attribution-Paleocookbook 

Link-https://commons.wikimedia.org/wiki/File:Paleo_diet_book.jpg 
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Frames don't need to be graphic either. In case you're working with photographic 

elements, consider utilizing them to frame your plans. Check out how this notice uses random 

objects to create a frame for the superimposed sort. Along these lines, you attract 

consideration regarding the piece by the frame and direct the eye to the truly important bits. 

13. Grid 
 

Think about an outline grid like the establishment to a house – it's a crucial initial 

phase in taking into consideration for you to construct a functional and wonderful final 

product. It signs to the developer/planner where certain elements ought to be placed, what 

ought to line up with what and it also gives a general outline for construction. 

Grids are important, normally imperceptible elements to pretty much any outline. 

They are comprised of a certain number of lines and columns that you can adjust your 

elements against. Grids can keep your content all together, perfectand neat and great looking. 

Here are some examples of various grid systems. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Grid 

Attribution- William Caslon 

Link-https://commons.wikimedia.org/wiki/File:A_Specimen_by_William_Caslon.jpg 

This example demonstrates a four-column grid at work. Note how some elements are 

contained to one column, while others stretch more than two, sometimes three columns. But 

the outline all in all seems perfect, clean and very much adjusted. 

For more adaptability, consider including some more columns, similar to this example 

beneath. 

In any case, this example has a clear and identifiable grid system to which each 

element has been adjusted, making for a striking, perfect and attractive outline. 

Grids are adaptable, versatile and endlessly helpful.So consider utilizing one for your 
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next outline and see what it can accomplish for you. 
 

14. Randomness 
 

As of not long ago we've been preaching about alignment and request. Be that as it 

may, shouldn't something be said about the more organic, unpleasant and random outlines? 

Randomness has an extensive impact on outline.However, it is a specific sort of randomness 

that we should call 'plan randomness'. 

The difference between 'outline randomness' and different forms of randomness is the 

reason and execution. With outline, your main objective ought to be communication – what 

does this piece need to state to consumers? Is it saying it plainly? How might I make the 

communication more grounded? 

This piece layers the hand-sort and positions. It is in an exceptionally random manner 

that some individuals would state obstruction to the intelligibility. But the idea behind this is 

to speak to a scrambled and distorted psyche. 

In this lies the difference amongst "randomness" and 'plan randomness'. If this outline 

were connected to a blurb for a children's movie about cheerful talking animals, it would 

seem random and wouldn't communicate the best thing by any stretch of the imagination. 

However, in this case, the random outline communicates the movie's themes perfectly. 

Likewise, observe this plan by Laura Berglund that uses a level of randomness to 

create an organic-looking, collage-like effect. While this piece seems as though it was slapped 

down onto a page and in a flash looked beautifully harsh and rumpled. Have somewhat a 

glance at it and note what number of outline conventions it actually uses. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Collage 
 

Attribution- Source- 

Link-https://pxhere.com/en/photo/992512 

Take a look at how each element has actually been strategically situated. Driving lines 

have been implemented to manage the eye around the piece and there has been a 
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selective balance between color level, texture and photography. 
 

This plan seems random; however, if you dissect its elements, you'll notice that certain 

parts of the outline have been adjusted. The design enables the eye to stream across the page 

and there are even some indications of a grid at work. 

The fact of the matter being – things don't need to be flawless and efficient to be 

classed as plan. Speaking to "randomness" and playing with a couple of vanguard outlines 

can be effective and super fun. 

15. Direction 
 
 
 
 
 
 
 
 
 
 
 

Title-Direction Source- Pixabay 

Link- https://pixabay.com/en/direction-road-sign-note-arrow-95475/ 

An important aspect of many plans is the means by which the eye moves over the 

page and the direction it takes – this is likewise sometimes alluded to as 'stream'. How does 

your eye move across the page? Do your peruses know exactly where to look next? Is the 

direction that their eye takes is logical? 

Studies have dissected the exact idea of our eye movement propensities and the 

examples our eyes trace over, when seeing specific things. 

By and large, the general thought is that the eye normally goes from the upper-left 

corner to the bottom-right corner, in a "clearing" motion. This hypothesis is best clarified top 

to bottom. Instead of planning 100% by these examples, however, attempt to adjust your 

outline‘s' stream and direction on a case-by-case premise. Simply remember that the eye 

inclines toward the upper left of a page and winds its way down from there. 

16. Rules 
 

This without question begins a lot of verbal showdown and to parcel any room of 

makers – half announcing that there are no tenets in layout, the other testing that there are 

numerous. Additionally, in fact, they're both right. 

Similarly as with any ability, there are things you need to learn and this comes with 

general rules. Things like: make your sort neat beyond any doubt, figure out how to kern, 

don't utilize pixelated images, etc. These are the establishments of plan, the things that assist 

you to make a basic outline. 
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In any case, once you've learnt these rules, it's certainly time to break them. 
 

Thus, while the clarity is a little compromised, the communication certainly is 
 

definitely not. 
 

Following the rules and breaking them, each have their own places in the realm of 

outline. Bring everything with a grain of salt and learn as much as you can so that you can 

break and twist the rules in the correct way and make a memorable sprinkle. 

17. Movement 
 

Have you at any point heard or seen somebody describe an artistic creation or piece of 

craftsmanship as having "a considerable measure of movement to it"? You might have first 

been bewildered by that clarification – all things considered, how does a static painting move? 

In any case, movement is a major piece of the visual expressions, including graphic plan. 

Prior we discussed the direction and stream of your plan, these factors have a major 

influence in the movement of your outline. On the off chance that your last piece has a decent 

spill out of through and through, left to right, corner A to corner B, etc., your piece will 

"move" smoothly. 

Yet, shouldn't something be said about the cases where you need to give an element an 

exact feeling of movement? Maybe you paint the town that you need to appear in motion, or a 

car that you need to depict zooming down a roadway. 

Movement can likewise be captured through motion lines. These are common in 

comics representations, when a character is fleeing or moving quickly. Along these lines, 

channel your internal comic book artist and make the most of motion lines. 

Unit Summary 
 

Elements of configuration described here are point, line, shape, form, space, color, and 

texture. Furthermore, I accumulated information about different outline principles, similar to 

the balance, extent, perspective, emphasis, movement, design, repetition, rhythm, assortment, 

harmony, and solidarity. These elements and principles can be the basic information and 

analytical frame work for an architect. I attached the examples of the elements and principles 

in supplement. I hope the perusers would find it useful. 

Configuration is a complicated business loaded with principles, tricks, and techniques, 

some of which you can gain from others and some you need to learn by yourself. 

Take each "govern" you read about with a grain of salt and apply it where it feels 

proper and relinquish the rules at whatever point you feel they aren't. Configuration is a 

constantly developing and changing field and each circumstance is distinctive -- one of a 



 

 

 
 

kind and exciting. 
 

Assessment 
 

1. Elements are divided into categories 2. 

Describe the various design elements 

3. Elaborate how line helps us in design elements 
 

4. The difference between 'outline randomness' and different forms of randomness 

5. What can keep your content all together, perfect, neat and looking great 

6. Discuss the various grid systems 

Resources 

• http://mexicounexplained.com 

• https://google.com 

• http://minyos.its.rmit.edu.au 

• http://wikipedia.com 

• https://encrypted-tbn3.gstatic.com 

• http://3.bp.blogspot.com 

• https://cdn0.iconfinder.com 
 

• https://thumbs.dreamstime.com 

• https://cdn.shopify.com 

• https://cms-assets.tutsplus.com 

• http://www.woot-design.co.uk 

• http://www.magazinedesigning.com 

• https://www.smashingmagazine.com 

• https://i.ytimg.com 

• http://montrealblackfilm.com 

• http://thecontextofthings.com 

• http://www.rockdesign.com •

 https://market.envato.com 

• http://subdimensionstudios.com 
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Unit 4 Pixel & Resolution 

Introduction 

In this unit, you will be introduced to pixel and resolution with vector-based and 

bitmapped graphics. In order to understand each graphic format, you will also have to know 

the benefits and the drawbacks of both types of images on a multimedia screen, calculation of 

Pixels and its color and intensity depth. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• Know the resolution 

• Describe facts about vector and bitmap 
 

• Elaborate the depth of pixel color and intensity 

• Choose the right format 

• Convert bitmap to vector 

Terminology 

Pixels : Picture elements in digital images. 
 

Image Resolution: Number of pixels in a digital image. 
 

Digital Image: Which resolution always yields better quality, generally Higher Resolution is 

chose. 

Bitmap: A representation for the graphic /image data in the same manner as they are stored 

in video memory 

Bits/Pixel: It contributes to the quality of the image 

Introduction 

Digital images are basically divided into two distinct categories. They are either 

bitmap files or vector graphics. You need a good understanding of the advantages and 

disadvantages of both types of data. In this unit you learn the differences. 

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Title-Photorealistic vector art 
 

Source-OpenClipart 
 

Link-https://pixabay.com/en/apple-red-fruit-nature-food-146453/ 

Pixels and Resolution 

The image that is displayed on the screen is composed of thousands (or millions) of 

small dots which are called pixels. The word ―Pixel‖ is a contraction of the phrase "Picture 

Element". A pixel represents the smallest piece of the screen that can be controlled 

individually. Each one can be set to a different color and intensity (brightness). The number 

of pixels that can be displayed on the screen is referred to as the resolution of the image.This 

is normally displayed as a pair of numbers, such as 640x480. The first is the number of pixels 

that can be displayed horizontally on the screen and the second represents how many can be 

displayed vertically. The higher the resolution, the more pixels that would be displayed and, 

therefore, more content can be shown on the monitor at once. However, pixels are smaller at 

high resolution and detail can be hard to make out on smaller screens. Resolutions generally 

fall into predefined standard sets, only a few different resolutions are used by most PCs. 

The aspect ratio of the image is the ratio of the number of X pixels to the number of Y 

pixels. The standard aspect ratio for PCs is 4:3, but some resolutions use a ratio of 5:4. 

Monitors are calibrated to this standard so that you can draw a circle and have it appear to be 

a circle and not an ellipse. Displaying an image that uses an aspect ratio of 5:4 will cause the 

image to appear somewhat distorted. The only mainstream resolution that currently uses 5:4 is 

the high-resolution 1280x1024. There is some confusion regarding the use of the term 

"resolution", since it can technically mean different things. First, the resolution of the image 

you see is a function of what the video card outputs and what the monitor is capable of 

displaying. To see a high resolution image such as 1280x1024 requires both a video card 

capable of producing an image this large and a monitor capable of displaying it. Secondly, 

since each pixel is displayed on the monitor as a set of three individual dots (red, green and 

blue), some people use the term "resolution" to refer to the resolution of the monitor.The term 

"Pixel Addressability" is referred to the number of discrete elements that the video card 

produces. In practical terms, most people use resolution to refer to the video image as it is 

done in this unit. The table below lists the most common resolutions used on PCs and the 

number of pixels each uses: 

Resolution Number of Pixels Aspect Ratio 
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320x200 
 

640x480 

800x600 

1024x768 

1280x1024 

1600x1200 

Resolution 

64,000 8:5 
 

307,200 4:3 

480,000 4:3 

786,432 4:3 

1,310,720 5:4 

1,920,000 4:3 

 

The resolution can be defined in many ways such as pixel resolution, spatial 
 

resolution, temporal resolution, spectral resolution. We are going to discuss pixel resolution. 

You have probably seen that in your own computer settings, there are different monitor 

resolutions such as 800 x 600, 640 x 480 

e.t.c. in the options for selecting pixel resolution. The term resolution refers to the 

total number of count of pixels in an digital image. For example,if an image has M rows and 

N columns, then its resolution can be defined as M X N. 

If we define resolution as the total number of pixels, then pixel resolution can be 

defined with set of two numbers. The first number is the width of the picture or the pixels 

across columns and the second number is height of the picture or the pixels across its width. 

We can say that the higher is the pixel resolution, higher will be the quality of the image. 

We can define pixel resolution of an image as 4500 X 5500. 

Megapixels 

We can calculate mega pixels of a camera using pixel resolution. Column pixels 

(width ) X row pixels ( height ) / 1 Million. 

The size of an image can be defined by its pixel resolution. Size = pixel resolution X 

bpp ( bits per pixel ). 

Calculating the mega pixels of the camera 
 

Lets say we have an image of dimension: 2500 X 3192. Its pixel resolution = 2500 * 

3192 = 7982350 bytes. 

Dividing it by 1 million = 7.9 = 8 mega pixel (approximately). 

Aspect ratio 

Another important concept with the pixel resolution is aspect ratio. Aspect ratio is the 

ratio between width of an image and the height of an image. It is commonly explained as two 

numbers separated by a colon (8:9). This ratio differs in different images, and in different 

screens. The common aspect ratios are:1.33:1, 1.37:1, 1.43:1, 1.50:1, 1.56:1, 1.66:1, 1.75:1, 

1.78:1, 1.85:1, 2.00:1, e.t.c . 

 



 

 

 
 

Advantage 
 

Aspect ratio maintains a balance between the appearance of an image on the screen, 

means it maintains a ratio between horizontal and vertical pixels. It does not let the image to 

get distorted when aspect ratio is increased. 

Pixel Color, Intensity, Depth of Color and the Color Palette 
 

Each pixel of the screen image is displayed on a monitor using a combination of three 

different color signals: red, green and blue. This is similar (but by no means identical) to how 

images are displayed on a television set. Each pixel's appearance is controlled by the intensity 

of these three beams of light. When all are set to the highest level, the resultant color is white; 

when all are set to zero the pixel color is black, etc. 

The amount of information that is stored about a pixel, determines its color depth, 

which controls how precisely the pixel's color can be specified. This is also sometimes called 

the Bit Depth, because the precision of color depth is specified in bits. The more bits that are 

used per pixel, the finer the color detail of the image. However, increased color depths also 

require significantly more memory for storage of the image, and also more data for the video 

card to process, which reduces the possible maximum refresh rate. 

This table shows the color depths used in PCs: 
 
 
 
 
 
 
 
 
 
 
 

True Color 
 

True color is named as such because three bytes of information are used, one for each 

color such as red, blue and green signals that make up each pixel. A byte has 256 different 

values, which means each color can have 256 different intensities, allowing over 

16 million different color possibilities. This allows for a very realistic representation 

of the color in images, with no compromises necessary and no restrictions on the number of 

colors an image can contain. In fact, 16 million colors is more than the human eye can 

discern. True color is a necessity for those doing high-quality photo editing, graphical design, 

etc. 

High color uses two bytes of information to store the intensity values for the three 

colors. This is done by breaking the 16 bits into 5 bits for blue, 5 bits for red and 6 bits for 

green. This means 32 different intensities for blue, 32 for red and 64 for green. The reduced 



 

 

 
 

color precision results in a slight loss of visible image quality, but it is actually very slight --

as many people cannot see the difference between the true color and high color images, 

unless they are looking for them decisively. For this reason, high color are often used instead 

of true color- as it requires 33% (or 50% in some cases) less video memory and it is also 

faster for the same reason. 

In 256-color mode the PC has only 8 bits to use; this would mean something like 2 

bits for blue and 3 for each of green and red. Choosing between only 4 or 8 different values 

for each color would result in rather hideously blocky color, so a different approach is taken 

instead i.e. the use of a palette. A palette is created containing 256 different colors. Each one 

is defined using the standard 3-byte color definition that is used in true color: 256 possible 

intensities for each of red, blue and green. Then each pixel is allowed to choose one from the 

256 colors in the palette, which can be considered as sort of "Color Numbers". So the full 

range of color can be used in each image, but each image can only use 256 of the available 16 

million different colors. When each pixel is displayed, the video card looks up the real red, 

green and blue values in the palette based on the "color number" the pixel has assigned. 

The palette is an excellent compromise: it allows only 8 bits to be used to specify each 

color in an image, but allows the creator of the image to decide what the 256 colors in the 

image should be. Since virtually no images contain an even distribution of colors, this allows 

for more precision in an image by using more colors than would be possible by assigning each 

pixel a 2-bit value for blue and 3-bit values each for green and red. For example, an image of 

the sky with clouds (like the Windows 95 standard background) would have many different 

shades of blue, white and gray and virtually no reds, greens, yellows would be choosed. 

256-color is the standard for much of computing, mainly because the higher-precision 

color modes require more resources (especially video memory) and aren't supported by many 

PCs. Despite the ability to ―hand pick" the 256 colors, this mode produces noticeably worse 

image quality than high color; most people can tell the difference between high color and 256-

color mode. 

Raster(Bitmap) 
 
 
 
 
 
 
 
 
 
 

Screenshot 1



 

 

 
 

A raster image is defined by pixels. In raster images, the more pixels an image 

contains, the higher will be its resolution. For example, in a raster image a square is drawn as 

a grid of pixels (dots) and each of those pixels will have a specific color value.The amount of 

detail that can be seen in a picture depends on the resolution of the image i.e. how many 

times per inch these squares or pixels occur. 300 times per inch is what is needed for good 

quality production of a commercial printing press and 72 pixels per inch is required for 

monitor display. A line is made up of a row of pixels with each pixel having a color value 

and you work with this line by working with the group of pixels that makes up the line, not as 

a single object as you would find in a vector file. Programs such as Photoshop, PaintShop, 

and PhotoPaint all work with pixels (raster images). Raster images are the best choices for 

creating subtle gradations of shades and color, such as in a photograph. 

A raster image is resolution-dependent because it contains a fixed number of pixels 

that are used to create the image. Since there is a fixed and limited number of pixels, a raster 

image will lose quality if enlarged beyond that number of pixels as the computer will have to 

'make up' the missing information. This is usually the cause of the image becoming ‗‘fuzzy‖ 

or "steppy". 

The other disadvantage with bitmaps is when an image is enlarged, the individual 

coloured squares become visible and the illusion of a smooth image is lost to the viewer. This 

'pixelation' makes the image look coarse. 

Raster (Bitmap) 
 

• Pixel-based 
 

• Raster programs best for editing photos and creating continuous tone images 

with soft color blends 

• Do not scale up optimally: Image must be created/scanned at the desired 

usage size or larger 

• Large dimensions and detailed images equal large file size 
 

• It is more difficult to print raster images using a limited amount of spot 

colors 

• Some processes cannot use raster formats 
 

• Depending on the complexity of the image, conversion to vector may be time 

consuming 

• Raster images are the most common image format, including: jpg, gif, png, 

tiff, bmp, psd, eps and pdfs originating from raster programs 

• Common raster programs: photo editing / paint programs such as Photoshop 

& Paint Shop, GIMP (free) 
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Vector (Lines/Calculated Points) 
 
 
 
 
 
 
 

Screenshot 

A vector image is defined by objects which are made of lines and curves that are 

defined mathematically in the computer. Vectors can have various attributes such as line 

thickness, length and color. For example, in a vector image, a square is drawn as four lines 

connected at the corners. Those lines can be set to different thickness and colors. The square 

can be empty or filled. A line is one object with attributes, and you work with this line as a 

single object, not as a group of pixels as you would in a raster image. All programs such as 

PowerPoint, Illustrator and Freehand work with vectors. Vector graphics are resolution-

independent because the vector objects are drawn mathematically in the computer. They can 

be made larger or smaller without any loss of quality to the image. Vectors can be printed at 

any size, on any output device, at any resolution, without losing detail and without altering 

the resolution of the image. Vector images are the best choice of typefaces, charts and graphs, 

drawings and other graphics that must have sharp lines when scaled to various sizes. 

Vector graphics, however, cannot reproduce 'continuous tone' photographic images 

like bitmaps. 

Vector 
 

• Mathematical calculations that form shapes 
 

• Vector programs best for creating logos, drawings and illustrations, technical 

drawings. For images that will be applied to physical products 

• Can be scaled to any size without losing quality 
 

• Resolution-independent: Can be printed at any size/resolution 

• A large dimension vector graphic maintains a small file size 

• Number of colors can be easily increased or reduced to adjust printing 

budget 

• Vector art can be used for many processes and easily rasterized to be used 

for all processes 

• Can be easily converted to raster 
 

• It is not the best format for continuous tone images with blends of color or to 

edit photographs 

• Common vector programs: drawing programs such as Illustrator, 



 

 

 
 

CorelDraw, Inkscape (free) 
 

Types of bitmap images 
 

Bitmap images can contain any number of colors, but there are four main categories: 

1. Line-art: These are images that only contain two colors, usually black and white. 

Sometimes these images are referred to as bitmaps because a computer has to use only 

1 bit (on=black, off=white) to define each pixel. 

 
 
 
 
 
 
 
 
 
 
 

Title-Line art 
 

Source- pixabay.com 
 

Link-https://pixabay.com/en/bicycle-meadow-

flowers-grass-bike- 788733/ 

2. Grayscale images:These contain various shades of gray as well as pure black and 

white.Typically 256 shades of gray (8-bit) are used even though the human visual 

system needs only 100 tints to perceive an image as life-like. 

 
 
 
 
 
 
 
 
 
 
 
 

Title- Grey scale images 

Source- pixabay.com 

Link-https://pixabay.com/en/bicycle-meadow-

flowers-grass-bike- 788733/ 

3. Multitones: Such images contain shades of two or more colors. The most popular 

multitone images are duotones, which usually consist of black and a second spot color 

(often a Pantone color). The example below contains black and Pantone Warm Red. 
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Title- Multitone images 
 

Source- pixabay.com 
 

Link-https://pixabay.com/en/bicycle-meadow-

flowers-grass-bike- 788733/ 

4. Full-color images: The color information can be described using a number of color 

spaces: RGB, CMYK or Lab for instance. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Full Color images 

Source- pixabay.com 

Link-https://pixabay.com/en/bicycle-meadow-

flowers-grass-bike- 788733/ 

Characteristics of bitmap data 
 

Bitmap data can take up a lot of room. A CMYK A4-size picture that is optimized for 

medium quality printing (150 lpi) takes up 40 MB. Compression can reduce the size of the 

file. 

The image with the enlargement showed one of the main disadvantages of bitmap 

images. Once they are enlarged too much, they look unnatural and blocky. Reducing their 

sizes also has an impact on image quality as images lose a bit of sharpness. 

Bitmaps are fairly simple to output, as long as your RIP or printer has sufficient 

memory. 

File formats for Bitmap data 
 

Bitmap data can be saved in a wide variety of file formats. Among these are: 
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https://pixabay.com/en/bicycle-meadow-flowers-grass-bike-788733/
https://pixabay.com/en/bicycle-meadow-flowers-grass-bike-788733/
https://pixabay.com/en/bicycle-meadow-flowers-grass-bike-788733/
https://pixabay.com/en/bicycle-meadow-flowers-grass-bike-788733/
https://pixabay.com/en/bicycle-meadow-flowers-grass-bike-788733/
https://pixabay.com/en/bicycle-meadow-flowers-grass-bike-788733/


 

 

 
 

BMP: An outdated and limited file format that is not suitable for use in prepress. 
 

EPS: A flexible file format that can contain both bitmap and vector data. It is gradually being 

replaced by PDF. 

GIF: It is mainly used for internet graphics 
 

JPEG: Rather the JFIF file format, which is mainly used for internet graphics 
 

PDF: A versatile file format that can contain just about any type of data, including complete 

pages, it is not yet widely used to exchange just images. 

PICT: A file format that can contains both bitmap and vector data, but that is mainly used on 

Macintosh computers and is not very suitable for prepress. 

PSD: The native file format of Adobe Photoshop (which can also contain vector data such as 

clipping paths). 

TIFF: A popular and versatile bitmap file format 

Applications for Bitmap format data 

• Microsoft Paint 
 

•     Adobe Photoshop 

•     Corel Photo-Paint 

• Corel Paint Shop Pro 

• GIMP 

All scanned images and digital camera images are bitmaps. 
 

Converting between bitmap formats is generally as simple as opening the image to be 

converted and using your software's ―Save As‖ command to save it in any other bitmap 

format supported by your software. 

Bitmap images, in general, do not inherently support transparency. A couple of 

specific formats - namely GIF and PNG- support transparency. In addition, most image 

editing programs support transparency, but only when the image is saved in the software 

program's native format. A common misconception is the transparent areas in an image will 

remain transparent when an image is saved to another format or copied and pasted into 

another program. That just doesn't work, however, as there are techniques for hiding or 

blocking out areas in a bitmap that you intend to use in other software. 

Key Points About Bitmap Images: 

• Pixels in a grid 

• Resolution dependent 
 

• Resizing to a larger size reduces quality 

• Easily converted 

• Restricted to rectangle 

111



 

 

 
 

• Minimal support for transparency 

Vector graphics 

Vector graphics are images that are completely described using mathematical 

definitions. The image below shows the principle. To the left, you see the image itself and to 

the right, you see the actual lines that make up the drawing. 

 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Example of a vector based image, drawn using bézier curves. 
 

Each individual line is made up of either a vast collection of points with lines 

interconnecting all of them or just a few control points that are connected using so called 

Bézier Curves. It is this latter method that generates the best results and is used by most 

drawing programs. 

Characteristics of vector drawings 
 

Vector drawings are usually pretty small files because they only contain data about the 

Bézier curves that form the drawing. The EPS file format that is often used to store vector 

drawings includes a bitmap preview image along the Bézier data. The file size of this preview 

image is usually larger than the actual Bézier data themselves. 

Vector drawings can usually be scaled without any loss in quality. This makes them 

ideal for company logos, maps or other objects that have to be resized frequently. Please note 

that not all vector drawings can be scaled as much as you like: 

• Drawings containing trapping information can only be scaled up to 20 

percent larger or smaller. 

• Thin lines may disappear if a vector drawing is reduced too much. 
 

• Small errors in a drawing may become visible as soon as it is enlarged too 

much. 

It is fairly easy to create a vector-based drawing that is very difficult to output. 

Especially the use of tiles (small objects that are repeated dozens or hundreds of times) and 

Corel Draw lens effects can lead to very complex files. 

Applications for vector data 
 



 

 

 
 

There are hundreds of applications on the market that can be used to create or modify 

vector data. 

• Adobe Illustrator 

• CorelDRAW 

• Xara Xtreme 
 

• Serif DrawPlus 

• Inkscape 

File formats for Vector data 
 

Bitmap data can be saved in a wide variety of file formats. Oddly enough the most 

relevant formats for the printing industry are also capable of storing bitmap information: 

EPS: The most popular file format to exchange vector drawings even though PDF is quickly 

gaining ground. 

PDF: A versatile file format that can contain just about any type of data including complete 

pages. 

PSD: The native file format of Adobe Photoshop. 

AI: The native file format of Adobe Illustrator 

AI: The native file format of Adobe Illustrator. 

Note : By the way, PDF and EPS are technically compound file formats, 

meaning that they can handle both vector and bitmap artwork. However, for 

simplicity, they‘re more commonly known and categorized as vector file 

formats. 

 

How to convert bitmap data to vector data andback Visual 
 

Comparisons of Vector vs. Bitmap 
 

300 dpi is generally considered the minimum resolution for printing bitmap work, like 

photos or complex artwork. There can be a marked difference between the way bitmaps and 

vectors are printed. 

Below are some close-up images from a chapter on file types in ‗The Print 

Handbook‘. The book was printed using a Heidelberg Speedmaster XL75 litho printer. Each 

image‘s actual width is roughly 15 mm (just over half an inch). 

JPEG OR JPG(300 dpi/Quality: High): 
 

Developed by the Joint photographic expert‘s group, jpg became an imaging standard 

in 1992, which is roughly about three years before the web gained broad acceptance. 

Jpg images support up to 24-bits of color in the RGB color space. Though typically 

used for photos and scanned images, jpg is what is called a lossy imaging format. By that, it 

 



 

 

 
 

means every time an image undergoes jpg compression, color data is lost. The amount of 

compression is determined at the time of creation through the use of a quality slider or value. 

The default value is traditionally 80% or high quality, which kicks out a rather nice result. 

The issues appear when you take that same image and recompress it. Suddenly colors 

disappear and white dots or halos appear around object. This means the color information has 

been wiped out in those areas and can‘t be recovered. It is replaced by what is called a 

"Specular Color". Due to the relatively small file size, jpg has become a de facto imaging 

standard on the web or for any graphics displayed on a screen. 

GIF 
 

The grand daddy of web imaging formats, the Graphics Interchange Format , has been 

around since 1987 and was created by compuserve partly to provide 256 colors in the 

hexadecimal color space to otherwise black and white images. 

The other objective behind its development was the image created which had to be 

small enough to be transferred over the slow dial-up modems that were common at the time. 

One case where the use of a GIF over a jpg image makes sense is a single- color logo or 

illustration being shown on a screen. Even thought the low quality GIF fell out of grace with 

the rise of faster bandwidth, its animated GIF counterpart is undergoing a bit of a nostalgic 

renaissance. 

To learn more about the GIF, this article is a great overview of its history. A huge 

variety of some of the hilarious GIF and animated GIF files are available in the web for ready 

reference. 

PNG 
 

More commonly called ―Ping‖ images, the Portable Network Graphic format actually 

rose to prominence thanks to competing GIF copyright claims between Compuserve and 

Unisys. The reason was due to the fact it was a non-patented alternative to GIF. Like its jpg 

counterpart, png images use the 24-bit RGB color space. What has spurred its popularity on 

the web and in mobile, is the fact PNG images can also support an 8-bit Alpha channel 

(RGBA) which means this is the only imaging format- other than GIF- which permits 

transparency. 

TIF 
 

The Tagged Image File Format (TIF or TIFF) is the preferred imaging format for the 

print industry. The reason is this is the only format that fully supports the CMYK color space 

and can supports very high resolutions of 300 dpi/ppi or more. At those resolutions the file 

size of a tiff image, compared to its jpg or png cousins, is relatively massive. Interestingly, 

this format is under the control of Adobe which explains why Photoshop is the software of



 

 

 
 

choice when it comes to working with TIFF images. 
 
 

Unit summary 
 

In this unit, you‘ve learned how image files can be divided into two distinct 

categories: vector-based and bitmap images. These two are different in the way that how to 

be processed by computers by calculating the pixels and Pixel Color and Intensity Depth in 

order to decide, which format will help you with your multimedia or web project. You need 

to have a good understanding of both kinds of images and know their advantages and 

disadvantages. 

Assignment 
 

1. What is a pixel made of? 
 

2. What does "dpi" stand for, and what is its relationship to a digital file? 

3. Describe mega-pixel 

4. How the image is "pixelated"? 
 

5. Differentiate between raster and vector graphics 

6. What is a Bezier curve? 

7. Describe the difference between screen resolution, print resolution and image 

resolution. 

8. Elaborate the difference between a halftone (or bitmap) image and a greyscale 

image 

9. Write down the advantages and disadvantages of the JPEG and Tiff file formats 

10. Explain the relevance of the term 72dpi 

11. What is "ppi", and how is it different from "dpi"? 
 

12. If an image is three inches by four inches at a resolution of 200ppi, how many pixels 

does it contain? 

Resources 
 

• https://google.com 
 

• http://wikipedia.com 
 

• https://www.prepressure.com 
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Unit-1 Digital Layout Creation 

Introduction 

GIMP is software that is freely available and is meant for editing images and 

correcting colors. It is available for GNU/Linux, Windows, OS X, and other operating 

systems. Whether you are a graphic designer, an image editor, an illustrator, or a scientist, 

GIMP provides sophisticated tools and filters to aid in graphic designing, illustrations, 

scientific application and image editing tasks. Productivity of GIMP can be supplemented 

with various customization options using 3rd party plug-ins. The instructions for GIMP have 

been soured from its documentation that has been accessed under GNU Free Documentation 

License. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• The basics of GIMP open source free image editor 

• The use of various tools and functions associated withGIMP 

• Various shortcut keys for ease of image editing 

Terminology 
 

RGB: Red, Green, Blue – Primary Colour 
 

Rectangle tool: Rectangle selection tool is used to choose rectangular regions of an image or 

a picture. 

Ellipse Tool: Ellipse Selection tool is used to create circular or elliptical regions from an 

image. 

Fuzzy selection Tool: Fuzzy Select (also known as Magic Wand) tool is used to selection 

regions of the image based on similarity in color. 

Path Tool: Paths tool allows for the creation of complex regions called Benzier Curves. 

GIMP Installation 

The GIMP software may be installed from their official website-

https://www.gimp.org/downloads/ 

Select the Current Stable Version- 
 

The current stable release of GIMP is 2.8.22 (2017-05-11). Download the official 

GIMP installer for Windows (approx. 100MB) by clicking on the above link. The installer 

contains both 32-bit and 64-bit versions of GIMP. The appropriate version shall be 

automatically installed. 

 

https://www.gimp.org/downloads/


 

 

 
 

GIMP – Main Window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The above screenshot shows the Main window of GIMP. The various sub-windows 

available in the main windows are listed below: 

Main Toolbox, Tool options, Image window, Layers dialog, and 

Brush/Pattern/Gradient 

Image Window- 
 

Image Window of GIMP helps with the editing of multiple images at the same time. 

Each image is shown in its own separate window. 

The following tools/functions are available-

a. Title Bar 

b. Image menu 

c. Menu button 

d. Ruler Quick Mask Toggles 

e. Pointer co-ordinates, 

f. Unit menus g. 

Zoom button h. 

Status area 

i. Cancel Button 
 

j. Navigation control 
 

k. Inactive peddling area 

l. Image display 

m. Image window resize toggle 

GIMP Basics 



 

 

 
 

GIMP Image 
 

GIMP image format contains many layers also includes several objects such as a 

selection mask, sets of channels and paths, undo history etc. making it complicated. 

There can be three possible modes to define an image: 

a. RGB 

b. Grey scale 

c. Indexed 

In GIMP, each Colour channel includes the alpha channel (which represents the 

opacity) with a range from 0 to 255. 

Creation of New Files 

New files can be created by navigating to File → New 
 

In the popup window, the initial width and height of the files can be defined. 

Opening Files 

Navigate to File → Open from Toolbox menu. Browse and open the required file from 

this window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

An image can also be opened by choosing the file URL or web address. Click File, 

open Location from Toolbox menu or Image menu and enter the image URL. 

Some images can be simply copied and pasted by clicking on File → Acquire → Paste 

as New from toolbox Menu. 

Saving Files 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

GIMP allows saving the image with all layers in a format which is known as XCF 

format. It is allowed only in Native XCF format. In other formats, it does not store all the 

data with all its layers and properties in a GIMP image. XCF format is GIMP default format 

which can save data with all its properties. Saving a file is available in several types of 

formats. The easiest way to save a file is to go to File and save it. 

Main Toolbox 
 

The main tool box is shown in the figure on the right. The various tools available in 

the main tool box are as listed below - 

• Rectangle selection tool 

• Ellipse tool 

• Free select tool/lasso 

• Fuzzy selection tool 

• Select by colour 

• Scissors 
 

• Foreground 

• Path tool 

• Colour picker tool 

• Zoom tool 

• Measure tool 

• Move tool 

• Alignment tool 

• Crop tool 

• Rotate tool 
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•     Scale tool 

•     Shear tool 

• Prospective tool 

• Flip tool 

• Cage transform/deform tool 

• Text tool 

To demonstrate the use of the tools, we have taken the example of India Gate 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-India gate 
 

Source- inspiretourism.com 
 

Link- http://www.inspiretourism.com/?s=delhi 

Rectangle Tool 

Rectangle Selection tool is used to choose rectangular regions of an image or a 

picture. It is a basic yet useful selection tool. It is also used to produce a rectangle or square 

selection on an image to be filled or modified using other types of Tools. 

 
 
 
 
 
 
 
 
 
 

http://www.inspiretourism.com/?s=delhi


 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Keyboard Shortcuts for Rectangle Regions 
 

Ctrl Key: Click and hold down the left mouse button. Then press down the Ctrl key until the 
 

rectangle is created. The starting point will be used as the centre of the rectangle. 
 

Shift Key: Click and hold down the left mouse button. Then press down the Shift key until a 

square is created. 

Ctrl + Shift Keys: Click and hold down the left mouse button. Pressing both keys together 

combines the two effects give above, giving a square with its centre at the starting point. 

Activating Tool: Rectangle Selection Tool can be accessed in different ways: 

-Click on the Rectangle tool icon in toolbox 

-Use the keyboard shortcut R or 

-Go to the ‗Tools‘ menu, hover over ‗Selection Tools‘ and click on ‗Rectangle 

Select‘ Ellipse Tool 

Ellipse Selection tool is used to choose circular or elliptical regions from an image, 

with high-quality ant aliasing if needed. It can produce a circular or elliptical region on an 

image and then fill it using the Bucket Fill Tool. 

Activating tool 
 

Ellipse Selection Tool can be activated in three different ways: 

-First click on the Ellipse tool icon in toolbox. 

-Use the keyboard shortcut E. 
 

-Go to the ‗Tools‘ menu, hover over ‗Selection Tools‘, and click on ‗Ellipse Select‘. 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Keyboard Modifiers 

Ctrl Key: Click and hold down the left mouse button. Now press the Ctrl key until the ellipse 

has been created. The starting point is used as the centre of the selected ellipse. 

Shift Key: Click and hold down the left mouse button. Now press the Shift key until the 

ellipse has been created. Holding Shift creates a circle instead of a ellipse. 

Ctrl+Shift Keys: Click and hold down the left mouse button. Pressing both keys together 

will combine the two effects, giving a circular selection centreed at the starting point 

Free Selection Tool or Lasso 
 

Free Selection tool or Lasso helps create a selection by clicking around an object (any 

part of the image). The Lasso is best used for outlining a selection. However, it is not precise. 

The practice image is in the folder Toolbox/Free Select Tool. Most users find the Lasso tool 

convenient to begin with, but then swiftly move on to Quick Mask mode to get an accurate 

selection. (You will learn more about Quick Mask later). 

Activating tool 
 

This tool can be activated in several ways as listed below -

- Click on the Lasso tool icon in toolbox; 

- Use the keyboard shortcut F; 
 

Go to the ‗Tools‘ menu, hover over ‗Selection Tools‘, and click on ‗Free Select‘ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Screenshot 

Tool handling 

 

When you click around an area with the Lasso tool, each anchor point will change 
 

colour briefly. When you hover over the first point again, it will change its colour. Click on it 

and the selection will be created automatically. 

Alternatively, when you hold down the left mouse button, the lasso becomes a free-

hand tool and enables you to draw a selection. To delete the selection, navigate to the ‗Select‘ 

menu and click ‗None‘. 

Fuzzy Selection Tool 
 

Fuzzy Select (also known as Magic Wand) tool takes colour similarities into account 

to select areas of the image. The Magic Wand works well when the objects have sharp edges. 

It works best for selection of a solid-coloured (or nearly solid-coloured) background area. As 

the selected area expands outwards from the centre, it spreads to pixels that are connected to 

each other by jumping over small gaps, depending on the Threshold option number selected. 

To increase or decrease the threshold, drag the pointer downward (or to the right) or 

upward (or to the left) after the first click. The further you drag the mouse, the larger the 

selected region will become. You can reduce the selection region by dragging upwards or to 

the left. The Fuzzy Tool starts selecting as you click at a spot on the image and go outwards, 

thereby selecting colours which are same or similar to the initial colour. 

 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Select By Colour Tool 

This tool is used when you need to select areas of an image based on colour similarity. It 

works mostly like the Fuzzy Select tool (‗Magic Wand‘). 

 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The main thing that differentiates the two tools is that the Magic Wand selects 

adjacent regions with similar colours where all colours are connected to the starting point, but 

having no large colour barriers. Recall that the objects of separate colours prevent the Magic 

Wand from spreading everywhere in the Fuzzy Tool lessons. 

On the other hand, the Select by Colour tool selects all pixels that are sufficiently 

similar in colour to the pixel clicked on, regardless of where they are located. 

In case of Fuzzy Tool, the selection starts once clicked with the reference being the 

first clicked colour. With the Select by Colour tool you can change the threshold by dragging 

across the image in the same way as with the Fuzzy Tool. 

Activating Tool 
 

The ‗Select by Colour‘ tool can be accessed in several ways as listed below 

- From the image menu, Bar Tools then Selection Tools then By Colour 

Select 
 

- Using the keyboard shortcut Shift +O 

Scissors Select Tool 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The Intelligent Scissors tool has an interesting function. It has some features in 

common with the both Lasso and the Path Tool while having some features of its own. If you 

are trying to select a region defined by strong colour-changes at the edges, this can be very 

useful. To use the Scissors, you need to create a set of "control nodes", also referred to as 

anchors or control points, at the edges of the region you are trying to select. The tool 

produces a continuous curve passing through these control nodes, following any high-

contrast edges it can find. With some luck, the path that the tool finds will correspond to the 

contour you are trying to select. 

However, the edge-following logic for this tool results in the selection being pretty 

crude in many cases. A good way to clean them up is to switch to Quick Mask mode and use 

paint tools to paint the problematic areas. 

Overall, Path tool is more useful than the Intelligent Scissors tool as the paths it 

produces are retained until you delete them and can be altered at any time. 

Activating tool 
 

From the image menu, go to Bar Tools, then Selection Tools, then Scissors or you 

may use the keyboard shortcut I. 

Foreground Select Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

This tool allows extraction of the foreground from the active layer or from a selection. 

Activating Tool 
 

Clicking on the tool icon in the Toolbox through Tools> Selection Tools> Foreground 

Select in the image menu. 

 
 
 

Key modifiers 
 

Ctrl- By pressing the Ctrl key, you can switch between foreground and background 

selection painting. 

Path Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 



 

 

 
 

Path tool allows for the creation of complex regions called Bézier Curves. It is similar 

to Lasso but has the adaptability of vectorial curves. You can edit your curve; you can paint 

with your curve or even save, import and export the curve. Paths can also be used to create 

geometrical figures. These paths have their own dialog box. 

Activating Tool 
 

In the image menu through Tools then Paths or by using the keyboard shortcut B 

Key modifiers Shift 

This key has several functions depending on the context. See Options for more details. 

Ctrl; Alt 
 

Three modes are available to work with the Paths tool: Design, Edit and Move. 
 

Ctrl key toggles between Design and Edit. Alt (or Ctrl+Alt) 

key toggles between Design and Move. 

Colour Picker Tool 
 

Colour Picker Tool, as the name suggests, is used to pick or select a colour from the 

screen. By clicking on an image, you can change the foreground colour or background colour 

to the colour that you have selected. To test this tool we will load a sample image. Go to 

Toolbox/Colour Picker folder and load carnations .jpg. 

Colour Picker Options 
 

Tool options are displayed in a window attached under toolbox the moment a tool is 

activated. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Zoom Tool 
 

Open a new image that you want to zoom. A magnifying glass with a ‗+‘ sign will 
 



 

 

 
 

appear on the image. The default action is to ‗Enlarge‘ the image. This means with each left 

click of the mouse the image gets bigger. 

To enlarge a specific area, simply click on that spot in the image. It can also be done 

by drawing around the area with the zoom tool. The image can be shrunk by holding down 

the Ctrl key and clicking the left mouse button. When you press Ctrl after selecting the Zoom 

tool a minus sign will appear inside the magnifying glass. You can also see the size of the 

image in pixels and the percentage of enlargement at the lower left part of the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Measure Tool 
 

The Measure Tool is used to measure pixel distances in th eimage. By clicking and 

holding the left mouse button, you can determine the angle and number of pixels between the 

point where you click and the place where the mouse pointer is subsequently located. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
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The Move Tool is used to move the image, layers, regions or guides along with text. 

You should make it a habit to use this tool as it prevents the accidental use of a tool 

which may then corrupt the image. 

Activate Move Tool 

The Move Tool can be activated in the following ways: 

- Click on the 'Move' Tool icon in the 'Toolbox'. 

- Press keyboard shortcut M. 
 

- Go to the 'Tools' menu, hover over 'Transform Tools' and select 'Move'. 

Key modifiers for the Move Tool 

Alt Key: This key should be used to move regions or layers without altering the 

image. Only the frame is moved and not the contents. 

Using Arrow Keys: 
 

Arrow keys can be used to move the active layer by one pixel, instead of using the 

mouse. Pressing Shift and the arrow key, moves it by 25 pixels. 

Alignment Tool 
 

The Align tool is used for aligning the image layers with various image objects. When 

this tool is selected, the mouse pointer turns into a small hand. By clicking on an element of a 

layer in the image, you can choose the layer which is required to be moved (with Shift + 

click, you can choose several layers to be aligned). This focalized layer has small squares in 

the corners. Several buttons in the dialog allow you to select the mode in which the layer will 

be moved. You can also select the image, an object (other layer, selection, and path) the 

selected layer to which other layers is required to be aligned on. This object is called Target. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Activating the Tool 

You can activate the Align tool in several ways as listed below 



 

 

 
 

- From the image-menu, through Tools , Transform Tools, to Align By 

using the keyboard shortcut Q. 

Crop Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The Crop Tool is used to crop or clip an image or layer. This tool is often used to get a 

more focused working area, by removing the borders or unwanted areas. It can also be used if 

you need a specific image size that is different from the dimensions of your original image. 

To use the Crop Tool, click inside the image and drag a rectangular region before releasing 

the left mouse button. When you click, a dialog pops up showing you the dimensions of the 

cropped region and allows you to perform various actions. If you want to change the region, 

you can do so either by clicking and dragging the corners or by altering the values in the 

dialog box. When you are dome, you can crop your image by clicking inside the crop region 

or by pressing the Crop or Resize buttons in the dialog box. 

Activating Tool 
 

The Crop Tool can be called from the image-menu: Tools Transform Tools Crop and 

Resize 

Rotate Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

The Rotate Tool: To Level the Horizon. 

Navigate to toolbox/Rotate Tool folder. Select an image. Select the Rotate tool 

depicted by two blue rectangles. 

Set Clipping to 'Crop to Result'. Set Guides to 'Number of Lines'. Then gently drag the 

image up, from the right corner, to rotate it until the image horizon is between two guidelines. 

When the horizon is aligned, click 'Rotate' to create a horizontal horizon. The Rotate tool will 

crop the image automatically. 

Scale tool 
 

The Scale Tool is used to scale layers, regions or paths. When you click on the image 

using the tool, the Scaling Information dialog box is opened, allowing you to change 

dimensions of the image separately. At the same time a Preview with a grid or an outline is 

superimposed on the object and handles appear on corners of the image which you can click 

on and drag to change the width and height. A small circle appears at the centre of the 

Preview allowing us to move this preview. 

Activating tool 
 

The Scale Tool can be called in the following order, from the image-menu: Tools -

Transform Tools-Scale or by using the Shift T key combination. 

 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Shear Tool 
 

Shear tool is used to tilt an image. For example, the upper part of the image may be 

tilted to the left and the bottom tilted to the right. The image is not rotated (as with the 

Rotation tool) but deformed. See the example image below. Shear tool may also be used to 

distort a layer, a selection, or a path. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Shear dialog box 
 

Shear magnitude X- Tilt the image to the left or to the right (horizontal movement). 

Positive numbers create a clockwise tilt. Negative numbers create a counter-clockwise tilt. 

The unit of measurement is half-pixels. 

Shear magnitude Y-Tilt the image up or down (vertical movement). Of course, we can 

set X and Y dialog to create the complete Shear effect without activating tool twice. 

Activating tool 

Click on the Shear icon in toolbox. Keyboard shortcut: Shift+S or go to Tools menu, 
 

hover over 'Transform Tools' and select 'Shear'. 



 

 

 
 

Perspective Tool 
 

Perspective Tool is used to change the position or angle of a part or whole image: 

Leaning buildings, monuments, pillars, etc. can all be corrected. 

Select an image. Click on the image and a rectangular frame or a grid pops up around 

the image with a handle on each of the four corners. By moving these handles, using click-

and-drag motion we can change the perspective. At the same time, a ‗Perspective‘ box pops 

up seeking agreement to the transformation. At the centre of the grid, a circle also allows 

movement of the image by click-and-drag 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Flip tool 

This tool flips layers or regions either horizontally or vertically. When a selection is 

flipped, a new layer with a Floating Selection is created. This tool can also be used to create 

reflections. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 



 

 

 
 

Activating tool: Click the Flip tool icon in toolbox. Use the Shift F keys. Go to tools menu, 

hover over Transform Tools and select 'Flip'. 

Key modifiers 
 

Ctrl Key: Ctrl allows toggling the modes between horizontal and vertical flipping. 

Flip Type: 

This setting controls flipping in either horizontal or vertical direction. This tool can 

also be switched by using the Ctrl key modifier. 

Flip Tool Actions: 
 

The ‗Horizontal flip‘ is very simple: Click on the ‗Flip‘ tool, select ‗Horizontal‘ from 

the ‗Flip type‘ and click on the image. The image will flip horizontally. 

Cage Transform/Deform Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Cage tool is a special transformational tool that allows us to select the transforming 

area by setting anchor points by free hand drawing, similar to the free selection-Lasso tool. 

Activating Tool - From the image menu, go to Tools, then Transform Tools, then Cage 

transform 

Text Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Screenshot 
 

A text item created using the Text tool can be transformed into a path using the Create 

path from text button in the Tool Options for the Text tool. It can be used for converting text 

into a path, then transforming the path and finally either stroking the path or converting it to a 

selection and filling it. This action often leads to much higher-quality results than rendering a 

text as a layer and transforming the pixel data. 

Bucket Fill Tool 
 

This tool fills a selection with the current foreground colour. If you Shift+click and 

use the Bucket tool, it will use the background colour instead. Depending on how the tool 

options are set, the Bucket Fill tool will either fill the entire selection or only parts whose 

colours are similar to the point you click on. The tool options also affect the way transparency 

is handled. 

The amount of fill depends on the Fill Threshold specifications provided. The Fill 

Threshold determines how far the fill will spread (similar to the way in which the magic 

wand works). The fill starts at the point where you click and spreads outward until the colour 

or alpha value does not apply any more. 

Activating tool 
 

The Bucket Fill can be called as follows: 
 

From the image-menu: Tools → Paint Tools → Bucket Fill 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Blend Tool/Gradient Tool 
 

Blend/Gradient tool fills the selected area with a gradient blend of the foreground and 

background colours by default, but there are many options. To use the blend, drag the cursor 

in the direction you want the gradient to go and release the mouse button when you feel you 

have the right position and size of your blend. 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Activating Tool 
 

The Blend Tool can be called in the following order: From the image-menu: Tools → 
 

Paint Tools → Blend 
 

Pencil Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The Pencil tool is used to draw free hand lines with a hard edge. The pencil and 

paintbrush are similar tools 

Activating Tool 
 

The Pencil Tool can be called in the following order: From the image-menu: Tools 

→ Paint Tools → Pencil or clicking N keyboard shortcut 

Paintbrush Tool 
 

The paintbrush tool is used to paint fuzzy (soft) or hard (sharp edged) brush strokes. 

All strokes are rendered using the current brush. The size of a brush is adjustable. The 

 



 

 

 
 

Paintbrush is the tool used while employing the Quick Mask. It can also be used to paint on 

images, regions or layers. 

Activating tool 
 

The Paintbrush Tool can be called upon in the following ways: 

- Click the Paintbrush icon in toolbox; 

- Use the P keyboard shortcut; 
 

- Navigate to 'Tools' menu, hover over 'Paint Tools' and select 'Paintbrush'. 

Key modifiers 

Ctrl Key: Changes the paintbrush to a Colour Picker. 
 

Shift Key: Pressing the Shift key places the paintbrush into straight line mode. Holding Shift 

key, left click the mouse will create a straight line. Consecutive clicks will continue drawing 

straight lines that originate from the end of the previous line. 

Paintbrush tool options: Tool options are displayed in a window attached under toolbox as 

soon as a tool is activated: Mode; Opacity; Brush; Dynamics; Dynamics Options; Apply 

Jitter; Smooth Stroke; Incremental 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Erase Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 

Eraser tool is used to delete anything in the image. 
 

In case of over-deletion, you can press Ctrl+Z to recover lost areas of the image. 

Instead of painting with the eraser, it is advised to work click by click. You can recover the 

deleted areas by using Ctrl+Z. This will reverse one click at a time. 

Airbrush tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

This tool is used to paint soft areas of colour. While it mostly works just like the 

paintbrush, it offers with a lighter touch. With multiple clicks, the Airbrush darkens the flow 

of paint. 

Activating tool 
 

Airbrush tool may be activated in several ways: 

- Click on the Airbrush icon in toolbox 

- Use the A keyboard shortcut 
 



 

 

 
 

- Go to the 'Tools menu', hover over 'Paint Tools', select 'Airbrush' 
 

Ctrl Key: It changes the airbrush to a Colour Picker. Choose the colour for the airbrush from 

the image and paint over the area of the image required to be enhanced. 

Shift Key: It changes the airbrush to straight line mode. Hold down the Shift key and left 

click the mouse. Release the left button of the mouse and move the mouse across the image 

and click again. A straight line of multiple images could be seen. 

Tool options: These are displayed in a window attached under Toolbox as soon as a tool is 

activated. See image above. 

Rate: The Rate slider adjusts the speed of colour application. A higher setting produces 

darker brush strokes in a shorter amount of time. 

Flow: This slider controls the amount of colour that the airbrush paints. A higher setting here 

will result in darker strokes. 

Ink Tool 
 

The Ink tool simulates an ink pen with a controllable nib to paint solid brush strokes 

with an ant aliased edge. The size, shape and angle of the nib can be set to determine how the 

strokes need to be rendered. 

Activating the Tool 
 

In the Image menu navigate to Tools then Paint Tools then Ink or by using the K 

keyboard shortcut. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Clone Tool 
 
 
 
 
 
 
 



 

 

 
 

The Clone tool uses a 'brush' to copy from an image. It is used to repair problem areas 

in digital images, by ‗painting over‘ them with stuff copied from other areas. Hold down Ctrl 

key while selecting the source, if cloning from an image. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 

Heal Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Heal tool is used for removal of wrinkles, lines and fixing of discoloured spots in 

portrait image graphs. Areas of the image are not simply copied, but the area around the 

wrinkle, line or spot is assessed and reproduced before the healing process begins. 

First load an image. Then, set up Heal tool as shown above. All other settings can 

remain untouched (default). To use the Heal tool, you need to first set a brush size slightly 

larger than the flaw on the skin. You can zoom in to the image for easy viewing. 

Hold down the Ctrl key and click on a perfect area of the skin which is close to the 

flaw. Release the Ctrl key and drag the Heal tool to the flaw. Left click on the mouse. If the 



 

 

 
 

defect is slight and not very different from its surrounding skin, it will get corrected quickly. 

Painting with the heal tool is possible if the brushing is confined to a small area. 

Blur/Sharpen Tool 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The Blur/Sharpen tool uses the current brush to locally blur or sharpen your image. 

Blurring with it can be useful if some image elements stand out too much and you would like 

to soften it. If you want to blur a whole layer or a large part, it is probably better using one of 

the Blur Filters. The direction of a brushstroke has no effect. If you want directional blurring, 

use the Smudgetool. 

The ―Sharpen‖ mode works by increasing the contrast where the brush is applied. A 

little bit of this may be useful, but over- application will produce noise. Some of the 

Enhancement Filters, particularly the unsharp Mask, do a much cleaner job of sharpening 

areas of a layer. 

Activating the Tool 
 

From the image-menu: Tools → Paint tools → Blur/Sharpen OR by using the 

keyboard shortcut Shift+U. 

Key modifiers Ctrl 
 

Holding down the Ctrl key toggles between Blur and Sharpen modes; it reverses the 

setting shown in the Tool Options. 

Smudge Tool 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The Smudge tool uses the current brush to smudge colours on the active layer or a 

selection. It picks colour while moving the brush and uses it to mix it to the colours it meets 

next. 

Activating tool 
 

The Smudge tool can be activated in several ways as listed below: 

- Click on the Smudge tool icon in toolbox. 

- Hit the S key on keyboard. 
 

- Navigate to the Tools menu, hover over 'Paint Tools', select 'Smudge'. 

Key modifiers 

Shift Key - The Shift key places the smudge tool into straight line mode. Holding 

Shift while holding the left click on the mouse will smudge in a straight line. Consecutive 

clicks will continue smudging in straight lines that originate from the end of the last line. 

Ctrl Key - Using Ctrl with Shift, constrains the angle between two successive lines to 

vary by steps of 15°. 

Dodge/Burn Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The Dodge or Burn tool uses the current brush to darken or lighten the colours in your 

image. The mode will determine the types of pixels that will be affected. 

Activating Tool 
 

From the Image menu: Tools → Paint Tools → Dodge / Burn. The Tool can also be 

called by clicking the tool icon or by using the Shift+D keyboard shortcut. 

Key modifiers 
 

Ctrl - Toggles between dodge or burn types. The type will remain switched until Ctrl is 

released. 

Shift - Shift places the Dodge or Burn tool into straight line mode. Holding Shift, while 

clicking the mouse Left Button, will Dodge or Burn in a straight line. Consecutive clicks will 

continue Dodge or Burn in straight lines that originate from the end of the last line 

Summary 

In this unit, you have learned about animation. It would introduce and expand the 

knowledge, understanding and skills for a diverse range of different types of animation by 

exploring relevant techniques and processes. Also, it explains the history of animation. You 

should be able to apply the 12 principles of animation and production processes to create an 

animation film. 

Assignments 
 

• Explain what is animation 
 

• Examine the basic types of animation 
 

• List various steps for creating a 2D animation 
 

• Explain basic techniques used in 2D animations 
 
 



 

 

 
 

•     Describe animation process 

•     List principles of animation 

• Explain stop motion animation 

• What is layout design 

• List the types of colour use in inking and colouring 
 
 

Resources 
 

• http://resumbrae.com 
 

• https://upload.wikimedia.org 

• https://cdn.pixabay.com 

• https://google.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://resumbrae.com/
https://cdn.pixabay.com/
https://google.com/


 

 

 
 

Unit 2 Professional Image Editing 

Introduction 

Images produced by scanners and digital cameras are mostly quite good, though not 

always perfect. They may suffice as records of a scene or event, but they rarely have the 

dramatic impact of a great print. If your aim is to make prints that go beyond simple records 

to capture the essence of people and places-- to create prints that stand as works of art-- you 

will need to edit the image. 

Image editing is at the heart of creative photographic printing-- it is where you 

transform a well-crafted snapshot into a work of art. One reason you need to edit is that a 

print can rarely capture the tonal range of an actual scene, particularly a naturally illuminated 

landscape. If you try to transfer a scene literally to a print, the contrast may be too low, 

resulting in a flat appearance. A print has a maximum tonal range of not more than 100:1. 

Scenes have widely varying tonal ranges, often much greater. More often it's too high, 

blocking out highlights and shadows. 

Our eyes function differently while viewing prints and viewing scenes. As they move 

about a scene, they constantly adapt to differences in illumination using all sorts of cues not 

present in a print. The scene we experience is the result of numerous adaptations, both small 

and large. When we look at a print, our eyes adapt very little. They grasp the print as a whole. 

In order to capture the feeling of a scene, those adaptations have to be put into the print. You 

can achieve this by editing selected portions of the print. 

Some of the specific goals of image editing are - 
 

• Adjustment of geometry: crop, rotate, correct perspective distortion, etc. 

• Removal of dust specks and scratches. 

• Correction for lens aberrations, if needed: distortion (barrel and pincushion), 

chromatic aberration (colour fringing) and light falloff (in wide angle lenses). 

• Adjustment of brightness, contrast, colour tint and colour saturation of the image 

as a whole. 

• Adjustment of portions of the image to bring them into balance with the image as 

a whole. This typically involves the use of masks and may be facilitated by 

sophisticated techniques such as contrast masking. 

• Sharpening of the image and if necessary, reduced grain. 

Outcomes 

Upon completion of this unit you will be able to: 
 



 

 

 
 

• Understand various tools of professional image editing using GIMP. 

• Learn to use various tools like colour tools and filters using GIMP. •

 Leading to advanced image editing skills. 

Terminology 
 

Hue-Saturation: This is used to adjust hue, saturation and lightness levels on a range of 

color weights for the selected area of active layer. 

Threshold: It can be used to enhance a block and white image (a scanned text for example) 

or to create section masks. 

Curves: The Curves tool is by far the most sophisticated tool and is used to adjust the 

tonality of images. 

Gradient map: This filter uses the current gradient, as shown in the 

Brush/Pattern/Gradient area of teh Toolbox, to recolour the active layer of teh image to 

which the filter is applied. 

Colour Tool 

Colour Balance 

Helps modify the colour balance of the active selection or layer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Activation - 
 

• The Colour Balance Tool can be called in the following order, from the image 

menu: Tools>Colour Tools>Colour Balance. 

Hue-Saturation 
 

This is used to adjust hue, saturation and lightness levels on a range of colour weights 

for the selected area or active layer. 

Activation 



 

 

 
 

You can call the Hue-Saturation Tool in the following order, from the image-menu: 

Tools>Colour Tools>Hue - Saturation. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot. 
 

Colourize 
 

This helps render the active layer or selection into a greyscale image seen through a 

coloured glass. See HSV Colour Model for Hue, Saturation and Luminosity. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Activation 

 

The Colourize Tool can be called in the following order, from the image-menu: 
 

Tools>Colour Tools>Colourize. 
 

Brightness-Contrast 
 

This tool helps to adjust the brightness and contrast levels for the active layer or 

selection. This tool is easy to use, but relatively unsophisticated. The Levels and Curve tools 

not only allow you to make the same types of adjustments, but also give you the ability to 

treat bright colours differently from darker colours. Although Brightness-Contrast tool is



 

 

 
 

great for doing a quick adjustment in a few seconds, but if the image is important and you 

want it to look as good as possible, some other tools have to be used. 

In GIMP 2.4, a new way of operating this tool has been added by clicking the mouse 

inside the image, and dragging it while keeping the left mouse button down. Moving the 

mouse vertically changes the brightness and moving it horizontally changes the contrast. 

Once are satisfied with the result, you can either press the "OK" button on the dialog, 

or hit the Return key on your keyboard. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Activation 

The Brightness-Contrast Tool can be called from an image menu: Tools>Colour Tools 

Brightness - Contrast. If you find yourself using this tool often, you can add it to 

theToolbox using the Tools dialog. 

Threshold 
 

It helps to transform the current layer or the selection into a black and white image, 

where white pixels represent the pixels of the image whose Value is, in the threshold range 

and black pixels represent pixels with Value, out of the threshold range. It can be used to 

enhance a black and white image (a scanned text for example) or to create selection masks. 

As this tool creates a black and white image, the anti-aliasing of the original image 

 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

disappears. If this poses a problem, consider using the Levelstool. 
 

Screenshot 
 

Activation 
 

The Threshold Tool can be called in the following order, from the image-menu: 

Tools>Colour Tools>Threshold or by clicking on the icon in Toolbox, if this tool has been 

installed in it. You can do that through the Tool dialog. 

Levels 
 

This tool not only provides features similar to the Histogram tool but can also change 

the intensity range of the active layer or selection. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Activation 
 

You can call the Level Tool in the following order, from the image- menu: Tools> 

Colour Tools> Levels 

 
 
 



 

 

 
 

Curves 
 

The Curves tool is by far the most sophisticated tool and is used to adjust the tonality 

of images. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Activation 
 

The Curves Tool can be called in the following order, from the image-menu: Tools> 

Colour Tools > Curves. 

Posterize 
 

This is designed to intelligently weigh the pixel colours of the selection or active layer 

and reduce the number of colours while maintaining a semblance of the original image 

characteristics. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 



 

 

 
 

Activation 
 

The Posterize Dialog can be called in the following order, from the image-menu: 

Tools > Colour Tools> Posterize or by double-clicking on the icon in ToolBox, if Colour 

Tools has been added to it. 

Colour 
 

Introduction to Colour Filters 
 

This tool contains several filters to modify colours in an image, a layer or a selection. 

You can find filters to compose, decompose, uncolour and many other effects. 

Alien Map 2 
 

Found in Filters> Colours Map> Alien map 2, this filter renders much modified 

colours by applying trigonometric functions. Alien Map can work on RGB and HSV. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Two Colours Exchange 

This filter is found in Filters> Colours Map> Colour Exchange. This filter replaces a 

colour with another one. 

Colourmap Rotation 
 

This filter is found in Filters> Colours Map> Colour Map Rotation. Colourmap 

Rotation lets you exchange one colour range with another range.



 

 

 
 

Screenshot 

Main Options 

There are two colour circles, one for the "From" colour range and the other for the 

"To" colour range. 

Grey Options 
 

In this tab, you can specify how to treat grey. By default, grey is not considered as a 

colour and is not taken into account by the rotation. You can convert slightly saturated 

colours into grey and vice-versa. 

Map Colour Range 
 

Found in Filters> Colours Map> Colour Range Mapping, the Map Colour Range filter 

maps a defined colour range against another defined colour range. 

Sample Colourize 
 

This filter is found in Filters> Colours Map> Sample Colourize. This filter allows you 

to colourize old black and white images by mapping a colour source image or a gradient 

against it. Any grey- tone image must be changed to RGB before using this filter 

(Image/Image>Mode>RGB). 

Options - The filter window is divided into two parts: Destination on the left and 

Sampling on the right. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Gradient map 

This filter uses the current gradient, as shown in the Brush/Pattern/Gradient area of the 

Toolbox, to recolour the active layer of the image to which the filter is applied. To use it, first 

choose a gradient from the Gradients Dialog, and then select the part of the image you 



 

 

 
 

want to alter and activate the filter by choosing Filters, Colours Map, and Gradient Map from 

the image menu. The filter runs automatically, without showing any dialog or requiring any 

further input. It uses image colour intensities (0 - 255), mapping the darkest pixels to the left 

end colour from the gradient and the lightest pixels to the right end colour from the gradient. 

Intermediate values are set to the corresponding intermediate colour. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Border Average Overview 

Found in Filters> Colours> Border Average, this tool calculates the average colour in 

a border around active layer or selection. Calculated colour becomes the foreground colour in 

Toolbox. This filter is interesting when you have to find a Web page colour background that 

differs as less as possible from your image border. The action of this filter is not registered in 

Undo History and cannot be deleted with Ctrl+Z. 

Channel Mixer 
 

Found in Filters> Colours> Channel Mixer, this filter combines the values of the RGB 

channels. It works with images with or without an alpha channel. It also has a monochrome 

mode and a preview. 
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Screenshot 

Colourcube Analysis 

 

Found in Filters > Colours > Colourcube Analysis, this tool gives data about the 
 

image: dimensions, file size, colour number and compression ratio. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Colourify 
 

Found in Filters > Colours > Colourify, this filter renders a greyscaled image like it is 

seen through coloured glass. 

Colour to Alpha 
 

Found in Filters > Colours > Colour to Alpha, this filter makes all pixels transparent 

with a selected colour. An Alpha channel is created. It will attempt to preserve anti-aliasing 

information by using a partially intelligent routine that replaces weak colour information with 

weak alpha information. Thus, areas that contain an element of the selected colour will 

maintain a blended appearance with their surrounding pixels. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Compose 
 

This filter is found in Filters > Colours > Compose. This filter is active in 

Filters/Colours after using Decompose. This filter is used to reconstruct an image from its 

RGB, HSV... components. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Decompose 
 

Found in Filters 

Screenshot 
 
 

> Colours > Decompose, this filter separates an image into its 
 

different components (RGB, HSV). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Screenshot 

Filter Pack 

 

This tool provides a collection of unified filters to treat the image. Of course, same 
 

functions can be performed by particular filters, but what one can have here is an interesting 

and intuitive overview. 

Starting filter 
 

This filter is found in the image menu via Filters > Colours > Filter Pack. 

Hot Overview 

This filter is found in the image menu via Filters>Colours Hot. It identifies and 

modifies pixels which might cause problems when displayed onto PAL or NTSC TV screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Filter - Introduction 

Filters are special kind of tools that are designed to take an input layer or image by 

applying a mathematical algorithm to it and return the input layer or image in a modified 

format. The GIMP uses filters to achieve a variety of effects and those effects are discussed 

here. 

• Blur 

• Noise 

• Edge-Detect 

• Enhance 

• Generic 
 

• Glass Effects 

• Light Effects 

• Distorts 

• Artistic 
 



 

 

 
 

• Map 
 

• Render 
 

• Combine 
 
 

1. Blur filters 
 

Blur filters: Introduction 
 

This includes a set of filters that blurs images or parts of them in various ways. If there 

is a selection, only the selected parts of an image will be blurred. There may, however, be 

some leakage of colours from the unblurred area into the blurred area. To help you pick the 

one you want, we will illustrate what each does when applied to the image shown at right. 

These are of course only examples; most of the filters have parameter settings, which allow 

you to vary the magnitude or type of blurring. 

Gaussian blur is one of the most used filters. This filter makes an image blurry in the 

most basic way. It has an efficient implementation that allows it to create a very blurry blur in 

a relatively short time. If you only want to blur the image a little bit-- to soften it, you might 

use the simple "Blur" filter. In Gimp 2.2 this runs automatically, without creating a dialog. 

The effect is subtle enough that you might not even notice it, but you can get a stronger effect 

by repeating it. In Gimp 2.0 the filter shows a dialog that allows you to set a "repeat count". If 

you need a strong blurring effect, this filter is too slow to be a good choice; the Gaussian blur 

can be used instead. 

Blur 
 

This simple Blur filter produces an effect which is similar to that of an out of focus 

camera shot. To produce this blur effect, the filter takes the average of the present pixel value 

and the value of adjacent pixels and sets the present pixel to that average value. The 

advantage of this filter is its calculation speed. It suits big images. The drawback of this filter 

is that its action is hardly perceptible on big images, but very strong on small images. 

Activation - This filter can be called from the image menu: Filters> Blur> Blur 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Gaussian Blur 

This filter can be found in the image menu under Filters> Blur> Gaussian Blur. The 

IIR Gaussian Blur plug-in acts on each pixel of the active layer or selection, setting its value 

to the average of all pixel values, present in a radius defined in the dialog. A higher value will 

produce a higher amount of blur. The blur can be set to act in one direction more than the 

other by clicking the Chain Button so that it is broken and altering the radius. GIMP supports 

two implementations of Gaussian Blur: IIR G.B. and RLE G.B. They both produce the same 

results, but each one can be faster in some cases. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Motion blur 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

This filter can be found in the image menu under Filters>Blur> Motion Blur. The 

Motion Blur filter creates a movement blur. The filter is capable of Linear, Radial and Zoom 

movements. Each of these movements can be further adjusted, with Length, or Angle settings 

available. 

Pixelise 
 

This filter can be found in the image menu under Filters> Blur>Pixelise. The Pixelise 

filter renders the image using large colour blocks. It is very similar to the effect seen on 

television when masking a criminal during trial. 

 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Tileable blur 
 

This filter can be found in the image menu under Filters> Blur>Tileable Blur. This 

tool is used to soften tile seams in images used in tiled backgrounds. It does this by blending 

and blurring the boundary between images that will be next to each other after tiling. If you 

want to treat only image borders, you can't apply filter to the whole image. The solution to get 

the desired effect is as follows: Duplicate layer (Layer Duplicate Layer) and select it to work 

on it. Apply "Tileable Blur" filter with a 20 pixels radius to this layer. Select all (Ctrl+A) and 

reduce selection (Selection Shrink) to create a border with the wanted width. Delete selection 

with Ctrl+K. Merge layers with Layer Merge down 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

2. Noise filter 

Noise filters - introduction 
 

Noise filters add noise to the image. To remove small defects from an image, see 

Despeckle filter. 

Hurl Overview 
 

Found in Filters>Noise> Hurl. The Hurl filter changes each affected pixel to a random 

colour, so that it produces real random noise. All colour channels, including an alpha channel 

(if it is present) are randomized. All possible values are assigned with the same probability. 

The original values are not taken into account. All or only some pixels in an active layer or 

selection are affected, thepercentage of affected pixels being determined by the 

Randomization (%) option. 

 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Scatter RGB 
 

Found in the image window menu under Filters> Noise> Scatter RGB, this filter adds 

a normally distributed noise to a layer or a selection. It uses the RGB colour model to produce 

the noise (noise is added to red, green and blue values of each pixel). A normal distribution 

means, that only slight noise is added to most pixels in the affected area, while fewer pixels 

are affected by more extreme values. If you apply this filter to an image filled with a solid 

grey colour and then look at its histogram, you will see a classic bell-shaped Gaussian curve. 

The result is very natural looking noise. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Pick 

Overview 
 

Found in Filters> Noise> Pick, this filter replaces each affected pixel by a pixel value 

which is randomly chosen from its eight neighbors and itself (from a 3×3 square the pixel is 

centre of). All or only some pixels in an active layer or selection are affected. The percentage 



 

 

 
 

of affected pixels is determined by the Randomization (%) option. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

3. Edge detect filters 

Edge-detect: Introduction 
 

Edge detect filters search for borders between different colours so that they can detect 

contours of objects. They are used for making regions and for many artistic purposes. 

Based on gradient calculation methods, most of them give thick border lines. Look at 

fig.1 which represents colour intensity variations. On the left is a slow colour gradient which 

is not a border. On the right is a quick variation which is an edge. Now, let us calculate the 

gradient and the variation speed of this edge i.e the first derivative (fig.2). We have to decide 

that a border is detected when gradient is more than a threshold value (the exact border is at 

top of the curve, but this top varies according to borders). In most cases, threshold is under 

top and border is thick. The Laplacian edge detection uses the second derivative (fig.3). The 

top of the curve is now at zero and clearly identified. That is why Laplace filter renders a thin 

border, only a pixel wide. But this derivative gives several zeros corresponding to small 

ripples, resulting in false edges. Some blurring before applying edge filters is often necessary 

as it flattens small ripples in signal and so prevents false edges. 

Difference of Gaussians 
 

This filter is located at Filters> Edge detect> Difference of Gaussians. This filter is 

new in GIMP 2.2. It does edge detection using "Difference of Gaussians" algorithm, which 

works by performing two different Gaussian blurs on the image with a different blurring 

radius for each and subtracting them to yield the result. This algorithm is very widely used in 

artificial vision and is pretty fast because there are very efficient methods for doing Gaussian 

blurs. The most important parameters are the blurring radii for the two Gaussian blurs. It is 

probably easiest to set them using the preview, but it may help to know that increasing the 

 



 

 

 
 

smaller radius tends to give thicker-appearing edges and decreasing the larger radius tends to 

increase the "threshold" for recognizing something as an edge. In most cases you will get 

nicer results if Radius 2 is smaller than Radius 1, but nothing prevents their reversal. In 

situations where you have a light figure on the dark background, reversing them may actually 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

improve the result. 
 

Screenshot 

4. Enhance filters 

Enhance filters: Introduction 
 

Enhance filters are used to compensate for image imperfections, which include dust 

particles, noise, interlaced frames (mostly coming usually from a TV frame-grabber) and 

insufficient sharpness. 

Deinterlace 

Overview 

This filter is found in Image>Filters/Enhance/Deinterlace. Images captured by 

videocards, especially when fast movement is recorded, may look blurred and stripped with 

splitted objects. This is due to the way cameras work. They don't record 25 images per 

second but 50, with half vertical resolution. There are two interlaced images in one frame. 

The first line of the first image, it is followed by the first line of the second image then 

second image followed by second line of first image, etc. Thus, if there has been an important 

move between the two images, objects will appear splitted, shifted and stripped. The 

Deinterlace filter keeps only one of both images and replaces missing lines by a gradient 

between previous and following lines. The resulting image or selection will be somewhat 

blurred, but can be improved by Enhance filters. 

 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Despeckle 
 

Found in Image>Filters/Enhance/Despeckle, this filter is used to remove small 
 

defects due to dust, or scratches on a scanned image and also Moiré effect on image scanned 

from a magazine. One must select isolated defects before applying filter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Sharpen 
 

This filter is found in Image>Filters/Enhance/Sharpen. Most of digitized images need 

correction of sharpness. This is due to the digitizing process that must chop a colour 

continuum up in points with slightly different colours. The elements thinner than sampling 

frequency will be averaged into a uniform colour, so sharp borders are rendered a little 

blurred. The same phenomenon happens when printing colour dots on paper, the Sharpen 

filter accentuates not only edges but also any noise or blemish. It may also create noise in 

graduated colour areas like the sky or a water surface. It competes with the Unsharp Mask 

filter, which is more sophisticated and renders more natural results. 
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5. Generic filters 

Generic filters introduction 
 

Generic filters are filters that you can build your own filters with. Convolution Matrix 

filter could help you understand this better. 

Convolution matrix Overview 
 

This filter can be found via the image menu under Filters> Generic> Convolution 

Matrix. Most filters use convolution matrix. With the Convolution Matrix filter, one can 

build a custom filter. 

It is possible to get a rough idea about Convolution Matrix without using 

mathematical tools. Convolution is the treatment of a matrix by another one which is called 

"Kernel". The Convolution Matrix filter uses a first matrix which is the Image to be treated. 

The image is a bi-dimensional collection of pixels in rectangular coordinates. The used kernel 

depends on the effect you want. GIMP uses 5x5 or 3x3 matrices. We will consider only 3x3 

matrices as they are the widely used and are enough for all required effects. If all border 

values of a kernel are set to zero, then system will consider it as a 3x3 matrix. The filter 

studies every pixel of the image successively. For each of them, which we will call the 

"initial pixel", it multiplies the value of this pixel and values of the 8 surrounding pixels by 

the kernel corresponding value. Then it adds the results and the initial pixel is set to this final 

result value. 
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Dilate 

Overview 
 

Found in Filters> Generic> Dilate, this filter widens and enhances dark areas of the 

active layer or selection. For every image pixel, it brings the pixel Value (luminosity) into line 

with the lowest Value (the darkest) of the 8 neighboring pixels (3x3 matrix). So, a dark pixel 

is added around dark areas. An isolated pixel on a brighter background will be changed to a 

big pixel, composed of 9 pixels and that will create some noise in the image. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

6. Glass Effects filters 

Glass Effects filters: Introduction 
 

Glass Effects filters result in an image as if it were seen through a lens or glass tiles. 

Apply lens 

Overview 
 

This filter can be accessed via the image menu under Filters> Glass effects> Apply 

Lens. After applying this filter, a part of the image is rendered as through a spherical lens. 

 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

7. Light Effects filters 
 

Light Effects filters: Introduction 
 

Light Effects filters render several illumination effects of the image. 

FlareFX 

Overview 
 

Found in Filters> Light Effects>FlareFX, this filter gives the impression that the sun 

hit the objective when taking a shot. You can locate the reflection with a reticule you can 

move, but you would not have the possibilities that Gflare filter offers. 
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Gflare 

Overview 
 

Found in Filters> Light Effect>Gflare, this filter reminds you of the effect you get 

when you take a photograph of a blinding light source, with a halo and radiations around the 

source. The Gflare image has three components: Glow which is the big central fireball, Rays 

and Second Flares 
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Lighting Effects 
 

Found in Filters> Light Effects, this filter simulates the effect you get when you light 

up a wall with a spot. It does not produce any drop shadows and of course, does not reveal 

any new details in the dark zones. 
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8. Distort filters 

Distort filters: Introduction 
 

The distort filters transform images in many different ways. 

Blinds 

 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Found in Image>Filters/Distorts/Blinds, this filter generates a blind effect with 
 



 

 

 
 

horizontal or vertical battens. You can lift or close these battens, but you cannot lift the whole 

blind up. 

CurveBend 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Found in Filters> Distorts> Curve Bend, this filter allows you to create a curve that 

will be used to distort the active layer or selection. The distortion is applied gradually from an 

image or selection border to the other. 

Emboss 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Found in Image>Filters/Distorts/Emboss, this filter can be used only with RGB 

images. If your image is greyscale, it will be greyed out in the menu. It stamps and carves the 

active layer or selection, giving it relief with bumps and hollows. Bright areas are raised and 

dark ones are carved. You can vary the lighting. 

 
 
 
 
 
 
 



 

 

 
 

Ripple 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Found in Image>Filters/Distorts/Ripple, this filter displaces the pixels of the active 

layer or selection to waves or ripples thus simulating a reflection on disturbed water. 

9. Artistic Filters 

Artistic filters: Introduction 

Artistic filters create artistic effects like cubism, oil painting, and canvas. 

Apply Canvas 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Found in Image> Filters/Artistic/Apply Canvas, this filter applies a canvas-like effect 

to the current layer or selection. It textures the image as if it is an artist's canvas. 
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Cubism 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 

Found in Filters> Artistic> Cubism, this plugin modifies the image so that it appears 
 

to be constructed of small squares of semi- transparent tissue paper. If setting possibilities of 

this filter are not enough for you, see GIMP ressionist filter, which offers more options. 

Oilify 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Found in Filters> Artistic> Oilify, this filter gives the image a semblance of an oil 

painting. The Mask Size controls the outcome. A high value gives the image less detail, as if 

you had used a larger brush. The GIM Pressionist filter can produce similar effects, but it also 

allows a much wider variety of options. 

10. Map filters 
 

Map filters: Introduction 
 

Map filters use an object named map to modify an image in which you map the image 

to the object. Thus, you can create 3D effects by mapping your image to another previously 

embossed image ("Bump Map" Filter) or to a sphere ("Map Object" filter). You can also map 



 

 

 
 

a part of the image elsewhere into the same image ("Illusion" and "Make Seamless" filters) or 

bend a text along a curve ("Displace" filter). 

Bump Map 

Overview 

Found in the image window menu under Filters> Map> Bump Map, this filter creates 

a 3D effect by embossing an image (the card) and then mapping it to another image. Bump 

height depends on pixel luminosity and you can set light direction. See Emboss for more 

information about embossing. You can bump map for any type of image, unlike the Emboss 

filter. 
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Displace 

Overview 
 

This filter can be accessed from the image menu Filters> Map> Displace. It uses a 
 

'displace-map' to displace corresponding pixels of the image. This filter displaces the content 

of the specified drawable (active layer or selection) by the amounts specified in X and Y 

Displacement multiplied by the intensity of the corresponding pixel in the 'displace map' 

drawables. Both X and Y displace maps must be grey-scale images and have the same size as 

the drawable. This filter allows interesting distortion effects. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 

Screenshot 

Illusion 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

This filter can be accessed from the image window menu under Filters> Map> 

Illusion. With this filter, your image (active layer or selection) looks like a kaleidoscope. This 

filter duplicates your image in many copies, more or less dimmed and split and puts them 

around the centre of image. 

Warp 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Found in the image window menu under Filters> Map Warp, this filter has no 

Preview. This filter displaces pixels of active layer or selection according to grey levels of a 

Displacement map. Pixels are displaced in accordance with the gradient slope in the 
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displacement map. Pixels corresponding to solid areas are not displaced. Higher the slope, the 

higher is the displacement. 

11. Rendering filters 

Render filters introduction 

Although most Gimp filters act on a layer by transforming its contents, the filters in 

the "Render" group are a bit different. They create patterns from scratch, in most cases 

obliterating anything that was previously in the layer. Some create random or noisy patterns, 

others have regular fractal patterns and one (Gfig) is a general-purpose (but rather limited) 

vector graphics tool. 

Plasma 
 

This filter can be found in the image menu following Filters> Render> Clouds 

Plasma. You can generate colourful clouds through Plasma, which can be used for textures. 

The turbulence in the plasma cloud can be controlled with the Turbulence slide. All of the 

colours produced by Plasma are completely saturated. Sometimes the strong colours may be 

distracting and a more interesting surface will appear when you desaturate the image using 

Layer/Colours/Desaturate. An enhanced version of the Plasma plug-in called Plasma2, with 

many more options and parameters, is available from the Gimp Plugin Registry. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Soild noise 

 

This filter can be accessed through the image menu through Filters> Render> 
 

Clouds> Solid noise. Solid Noise is a great texture maker. Note that this noise is always grey, 

even if you apply it to a very colourful image (it doesn't matter what the original image looks 

like -- this filter completely overwrites any existing background in the layer it is applied to). 

This is also a good tool for creating displacement maps for the plug-in. With the "turbulence" 

setting active, the results look quite a bit like real clouds. 
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12. Combine filters 
 

Combine filters: Introduction 
 

The combine filters associate two or more images into a single image. 

Depth merge 

It combines the two pictures selected as "sources" by blending them. Darkest values 

are predominant in the resulting image. This could be done using blending modes but in this 

case there aren't any options. To work with this filter, at least two images are needed that have 

to be of the same size. This filter can be accessed through Filters/Combine/Depth Merge. 
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Film 
 

The film filter allows a user to merge several pictures into a photographic film 

drawing. This filter does not invert colours, hence it does not imitate negative film of the sort 

used to produce prints. Instead you should think of the result as an imitation of slide film or 

cinema. This filter can be accessed via Image/Filters/Combine/Film Options. A double click 



 

 

 
 

on the tool buttons opens the Tool Options dialog. 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Unit Summary 
 

In this unit you have learnt about advanced image editing using GIMP open source 

software. We have learnt about Colour Tool and various filters using examples from a 

screenshot. In Colour Tool we have learnt about Colour Balance Tool, Hue Saturation Tool, 

Colourize Tool, Brightness Contrast Tool, Threshold Tool, Levels Tool, Curves Tool and 

Posterize Tool. In Filters, we have learnt about various filters and their sub functions like 

Blur, Noise, Edge-Detect, Enhance, Generic, Glass Effects, Light Effects, Distorts, 

Artistic, Map, Render and Combine filters. 

Assessment 
 

1. What are filters? 
 

2. What are the various types of filters and theiruses? 3. 

What is the current stable version of GIMP? 

Resources 
 

1. All images describing the Toolbox functions are screenshots taken while 

working with India Gate image. 

2. Some of the key modifiers are referenced from 

https://docs.gimp.org/odftest/en.pdf which is an open source material 

with no copyrights by GIMP. 
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Unit 3 Advertising and Illustration 

Introduction 

Pixlr is a cloud-based set of image tools and utilities that include a number of photo 

editors, a screen grabber browser extension and a photo sharing service. The apps provide 

tools for simple to advanced photo editing. Pixlr can be used on PCs and on smartphones or 

tablets using a mobile app. Time put Pixlr on its list of the top 50 websites of 2013. It has 

web-based 'paint' features similar to online image manipulation software such as Sumo Paint. 

Pixlr Editor- It is an open source online photo editor of PIXLR used for advanced 

photo editing. It is free and no download is required. 

Pixlr Express- It is another open source online photo editor of Pixlr and as the name 

suggests it is used for minor photo editing. It is free and easy to use. 

Pixlr-o-Matic- It is a photography/darkroom tool that makes it easy to add style to 

photos using effects, overlays andborders. 

Outcomes 
 

Upon completion of this unit you will be able to: 

a) Dynamic ways to transpose images. 

b) To use Lasso, Clone Stamp, and the Magic Wand tool to edit your pictures. 

c) The fundamental techniques to animate and revive any picture 

d) Advanced techniques to animate and edit images 

Terminology 

Pixlr Editor: Image Editing Software. 
 

Cropping: Cropping lets you ―cut‖ unwanted parts from sides, top or bottom of a 

picture. Moire effect: Moire is a pattern that is created in some photos by grids or series 

of lines. Pixlr Express: Pixlr Express is a faster way to crop, resize, rotate, adjust and add 

photo effects to your photos. 

Pixlr Editor 
 

Pixlr Editor is a type of browser photo editor that addresses your editing needs. It 

allows you to have full control over your images, including layers and effects. It is the most 

popular advanced online photo editor and contains features that are available in desktop 

graphic design applications. Tools have features such as red-eye reduction, a spot healing 

tool, drawing tools, clone tools, sharpen, blur and many more. Similarly, filters include mimic 

HDR, glamour glow, tilt-shift, Gaussian blur, vignetting, noise and many others. 

Adjustments include advanced concepts like Levels, Curves, Cross Process, Desaturate, Auto 



 

 

 
 

Levels, Hue/Saturation and Brightness/Contrast. 
 
 
 
 
 
 
 
 
 

Screenshot 

Advantages of Pixlr Editor 

• Account is not necessary. You can create an account for free storage space if 

you wish to do so. 

• No special download or installation. You can fire it up in your browser when 

needed 

• The Pixlr Editor provides tools such as Layers, Lasso Tool, Brush controls, 

Cloning and Filters. 

• An optional private Pixlr Library where you can store all your photos and 

images. 

Website- https://pixlr.com/editor/ 

Getting Started 

1. At the initial screen, choose Open Pixlr editor. 

2. You have to choose from the following: 

a. Create a new image - To make a brand new image, or to cut-and-

paste an image from somewhere else. 

b. Open image from computer - Open a picture stored in your computer 

or on a flash drive. 

c. Open image from URL - Open a picture by putting in its unique 

Internet address. 

d. Open image from library - Open from an account at Pixlr, Facebook, 

etc. 

3. At the point when the picture is open in Pixlr, you can modify the span of the picture window 

by dragging it in or out (see the red hover in the picture underneath). You can zoom in and 

out by holding down the [Ctrl] key and squeezing either the [+] or [-] keys. 
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Screenshot 

The Pixlr screen. Main menu is at top (green oval). 

Basics 
 

Pixlr is much similar to a basic variant of Photoshop. Apparatuses are on the left, the 

work territory is in the center and boards are put on the correct side of the screen. The 

program offers full help for layers. Huge numbers of the apparatuses -, for example, the Clone 

Stamp Tool - work particularly like their partners in business programming programs and are 

simpler to use than with some other Web 2.0 picture editors. 

The Move Tool is the best instrument to choose for a lot of your work in Pixlr. 

Consider it the "default" apparatus. 

Fix the last activity by squeezing the [Ctrl] and [Z] keys all the while. Then again, 

select Edit from the best menu of the Pixlr window and pick Undo. 

At whatever point you pick a device, its choices are shown simply under the menu at 

the highest point of the Pixlr window. Infrequently these settings significantly influence the 

utilization of the instrument. 

Bear in mind that this arrangement of apparatuses is easy to utilize and can add some 

exceptionally fun impacts to pictures. 

Try not to fear the "propelled" mode. It isn't difficult to utilize, and is by a long shot 

the most effective piece of Pixlr. 

Cropping an Image 
 

Via cropping, you can "reduce" undesirable parts from the sides, pinnacle or bottom of 

an image. you can additionally absolutely change the character of a picture by disposing of 

distracting or unnecessary elements of it. 

1. Select the Crop Tool from the Tools at the left. 
 
 



 

 

 
 

2. Click on the image and "drag" out a "box". This is the area that will remain 

after cropping. 

3. Adjust the cropping area: 
 

a. Click the blue boxes at the corners of the cropping area and drag them to resize the part 

of the image tocrop. 

b. Place your cursor on the cropping area. It should change to a "plus sign" with four 

arrows, then click and drag the cropping area to where you want it. 

4. Press the [Enter] key to crop. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Resizing an Image 

This tool is used to change the dimensions of a image. After cropping the above 

photograph, it measures 1388 x 777 pixels (width is continually indexed first). that is too 

extensive for use in maximum of the functions and approximately four-five times too wide 

for an internet web page. 

1. Select the Move Tool. 
 

2. From the menu at the top of the Pixlr window, select Image, then choose 

Image size 

3. The Image size window should appear. Make sure the Constrain proportions 

box (circled in red) is checked, to keep the image from being distorted in the 

resize. 

Type in the width or height you want and the other dimension will automatically be adjusted. 

Click [OK]. 
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Rotating an Image 

You can rotate an image in Pixlr in two ways – select Image from the menu for simple 

rotation (90 or 180 degrees), and choose the appropriate amount of rotation. 

To get the finer control of rotation, you can use Free Transform: 

1. Just select the Move Tool and click the image. 

2. In the Menu, select Edit and Free transform, the "frame" of which should 

appear around the image. 

3. Move the cursor around the outside edge of the image to rotate, until it 

changes into an arrow bent into a circle. Click and drag to rotate the image. 

4. Then click any tool in the Tools to finish editing in free transform. You have 

to choose [Yes] to apply the changes made. 
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Note: Free transform can also be used to resize an image, by dragging the 

"handles" at its sides or corners 

How to save an Image 
 

Saving an image in Pixlr is easier and simpler as it allows you to save an image to 

your Facebook account. 

1. Choose File and select Save 
 

2. Type the filename for the image in the Name box 3. 

Select the Format (several formats to choose from): 

JPEG–It is the best final format for most photos (which are not required to be 

edited again in Pixlr). 

You can adjust the Quality control to change the appearance and file size 

of the image. 

PNG - PNG format is used when the image has a transparent background. Else, 

JPEG is a better choice. 

BMP–It is also known as a Bitmap file format. Since it is an uncompressed 

format, file size tendsto be verylarge. 

TIFF–It stands for Tagged Image File Format, another file format with very large 

file sizes. Again, JPEG will be a better choice. 

PXD–This is called Layered Pixlr image. You can use this format if you plan to 

open the file again in Pixlr. This maintains layers, while other formats "flatten" 

them. 

4. Look in the lower-right corner to make sure the file size is acceptable, and then click 

Working with Layers 

Pixlr, like Photoshop and many other expert-stage applications, allows you to work on 

photographs with layers. 

By unlocking and renaming the historical past layer, adjustments to an picture can't be 

made till the principle layer of the picture is unlocked. Pixlr calals this the heritage layer. 

1. First, open an image in Pixlr 
 

2. Ensure the Layers panel is visible to the right of the image. If not select View, 

choose Layers to make it visible 

3. In the Layers panel, just double-click the padlock icon (circled in red in the 

image to the right) in the Background layer, which will change the padlock 

to a check box and unlock the layer to enable you to edit 

 
 
 



 

 

 
 

4. The name of the layer has been changed from Background to Layer 0. Double-

click the name and type in somethingdescriptive 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Adding Text in a new layer 

Typing text in a new layer will allow you to move the text around, edit it, and delete it 

without causing disturbance to the rest of the image. 

1. First, select the Type tool to find if your cursorchanges 
 

2. Then click on the image where you want your text to appear 

3. Type the text, which will probably be black in colour 

Moving text 
 

1. Choose the Move tool 
 

2. Check the Layers panel to ensure text layer is selected. If not, click the text 

layer 

3. Now, you can move the text anywhere on the image 

Modifying text 

1. First, select the Type tool 
 

2. And choose the layer for the text in the Layers panel 3. 

Now click the text and editing window should appear 

4. Edit the Text. You can change the Font and change the Size or the Style. 
 

5. Click the colour picker (circled in red, below) to change the Colour. You have 

to choose a tab at the top of window for the colour format and select a 

colour. Remember to click [OK] in both windows. 

 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Layer order 

 

Keep in mind the layers as being on clean plastic. Layers are visible at one time, 

however the Layers panel controls how they overlap. The layer on the top inside the Layers 

panel seems "closest" to the viewer. you have to click a layer and drag it up or down to 

exchange the order of layer. 

Hiding layers 
 

An image comprises several layers. By selecting the layers to hide and to keep them 

visible, many images can be saved from one "master" image. 

1. In the Layers panel, select the checkbox to remove the check mark and hide 

the layer. 

2. To make the layer visible again, click the checkbox. 

Using layers to make a composite image 

Setting multiple photograph collectively with layers is easy. you presently have a JPG 

image for the historical past, however the popcorn picture is a GIF with a "obvious" heritage, 

because of this when it's miles inserted into some other photograph, the popcorn flashes. 

1. You have to download the images below and save them to your computer. 

2. Then open the photo. 

3. Select the Move Tool. 
 

4. Choose Layer and select Open image as layer. 
 

5. Browse to and open the popcorn image. Notice that a new layer has been 
 



 

 

 
 

created. 
 

6. Double-click the name of the new layer and rename it. 
 

7. Make sure the layer for the image is selected, then click and drag it to where, 

you want it to appear. 

8. To resize/rotate the image 
 

a. Select the image layer in the Layers panel. 
 

b. Hold down the [Ctrl] key and press [T]. This will turn on the Free 

Transform mode for the layer. 

c. Move the cursor near the Free Transform box and it should turn into an 

arrow bent into a circle (see image, below). Click and drag to 

rotate the contents of the Free Transform box. 

d. To resize, hold down the [Shift] key to prevent distortion and click any of 

the corners of the Free Transform box. Click and drag inwards or 

outwards to resize. 

e. Select any tool in the Tools to finish editing in free transform. Choose 

[Yes] to apply the changes you've made. 
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Advanced Techniques 

Pixlr offers you options to adjust the image‘s look: 

Moire Effect 

Moiré pattern is created in pix by using grids or collection of traces. It now and again 

props up in television images, whilst the camera faces trouble with sure patterns on clothing, 

and is visible while a digital camera is used to take a photograph of a television display 

screen. Let us now see the description of the Moiréeffect: 

 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Moire effect is a visual perception that occurs when viewing a set of lines or dots that 

is superimposed on another set of lines or dots, where the sets differ in relative size, angle or 

spacing. The Moiré effect can be seen when looking through ordinary window screens at 

another screen or background. 

Using Gaussian Blur to remove the Moire effect 
 

To remove Moiré effect, Gaussian Blur is used. Any kind of blur is applied after 

image editing is complete, but it‘s an exception when you are using the Gaussian blur to 

remove Moiré patterns. 

The effect is visible in this drawing at some resolutions: Choose Filter from the menu 

and select Gaussian blur. 

Carefully adjust the amount of blur, to try to lessen the Moiré effect without blurring 

the image in general. 

Quick adjustment auto levels 
 

Auto levels are supposed to adjust colour, brightness, contrast, etc. in one quick-and-

easy step. 

1. Select Adjustment from the menu and choose Auto levels. Observe the 

changes (if any) in your picture. 

2. Use Edit > Undo to reverse the adjustment, if desired. You may wish to try 

some of the adjustments described below. 

Adjusting hue, saturation 
 

1. First choose adjustment from the menu and select Hue and Saturation. 
 



 

 

 
 

2. Next, you have to use the sliders for Hue, Saturation and Lightness to adjust 

your image. 

Hue is used to change the colours in an image. 
 

Saturation alters the intensity of colours. In the extremes, change the image colours to pure, 

saturated colours. Else, you can just wash the colour completely out of a picture. 

Lightness changes the colours along a lightness–darkness scale. 
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Adjusting the levels manually 

This is a perfect feature to use with "murky" images not having a true black or a true 

white anywhere. The process is a bit intimidating, but it's simple and easy. 

The following image is well-composed and framed.It is somewhat "washed out." 

Colours may be brighter and the photo contains only a small amount of "true black" colour. 

You can use the levels to improve the photograph.
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1. Select Adjustment and choose Levels... 

2. The Levels window shows a histogram, with three "sliders" at the bottom of it. The 

curve shows how colour lightness values are distributed in the image. 

3. To achieve a true black in the image, move the leftmost slider (circled in red in image 

below) inwards, onto the bulk of the histogram. 

4. To adjust the image to have a true white, move the rightmost slider (circled in green in 

image below) inwards to meet the right edge of the bulk of the histogram This will 

also lighten colours in the photo. 

5. The middle slider can be used to adjust mid-tone values. 
 

6. If you wish, you can also click the Channel selector and adjust the red, green and blue 

colour channels individually. In our example, we'll just try the small adjustments 

shown below. 
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Using the colour curves to modify an image 
 

The challenging Colour Curves give the fastest and most powerful tools to edit an 

image. Each "curve" appears as a straight and diagonal line. There are many ways to modify 

the curves: 

• Use the Channel selector at the top of the window to adjust, Red, Green or 

Blue channels or leave it set to RGB to adjust all three at once. 

• Move either endpoint of the line. 
 

• Click anywhere on the line and drag, to "bend" it into a curve. 
 

• Click and drag other points to create a complex shape. Let's look at two easy 

changes you can make: 

Correcting tonality 
 

This will help make dark colours more distinct and brighter, and improve colour 

balance of a picture. 

1. First choose Adjustment and select Curves. 
 

2. Click the Histogram box to make its shape visible. 
 

3. Move the left endpoint horizontally toward the histogram. 
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Using the Curves to "Solarize" Images 
 

When a film is exposed to light during or after the developing process, it is called 

―Solarization‖. This extra exposure could cause extreme brightness or even colour inversion 



 

 

 
 

in the photo. To do in Pixlr, you have to select Adjustment and choose Solarize. Use of 

Curves gives you more control over the finished effect.Choose Adjustment and then select 

Curves. 

1. Click the Histogram box to make its shape visible. 
 

2. Move the RGB curve to match the shape of the histogramroughly. There are 

many possibilities. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Removing a background to create a Transparent Image 
 

To remove a background from a Pixlrimage is different from the process in other 

image editors, but it isn't tough to do. Some YouTube tutorials talk about copying of the main 

layer and the creation of another file, but these steps are necessary if you unlock the 

background layer. 

1. Open the image 
 

2. Choose the Move tool 
 

3. In the Layers panel, double-click the padlock icon that is circled in yellow in the image 

to the right in the Background layer. This will change the padlock to a check box and 

unlock the layer to enable for edit 

4. Select the Wand Tool 
 

5. Click the background of the image to select it to see dotted lines "running" around the 

background. Now, unlock the background layer 

6. Press the Delete key to remove background, which will be replaced with a 

checkerboard pattern, indicating that it is transparent. 

7. Select File and choose Save. Change the format to PNG and see the background in 
 
 



 

 

 
 

the preview image changed to transparent (checkerboard). Click [OK]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Free, High-Quality Images 

You should not use bad clip art in the Web pages, PowerPoints or lesson plans. 

Neither should you use copyrighted images. 

Wikipedia (en.wikipedia.org) - Free or Fair to use images. Click an image on the 

browser if think it is usable. Some images are either in the public domain or are available for 

fair use for the educators. 

MorgueFile (www.morguefile.com)- Free images. The morgueFile database of free 

pictures is extensive and you can search the images subject. You should avoid the 

Dreamstime images, which are not free. 

Pixlr Express 
 

As the name suggests, Pixlr Express is a faster way to crop, resize, rotate, adjust and 

add photo effects to your photos. It‘s a great tool to use if you want a quick fix to a photo in a 

hurry! 

1. In Google, type in Pixlr 
 

2. Once you are at the Pixlr site, select Pixlr Express 

3. Select Open image from computer or from URL 

4. When your photo appears, select Basic to crop, resize, rotate or flip 
 

Note: You may need to do each task in the order that they appear. For some reason, if you 

rotate and Flip first and then Crop or Resize, your image will rotate back to the original 

position. 



 

 

 
 

Cropping Photos 
 

Select Crop. Frame your photo by dragging the blue boxes in each corner. Click on 

Apply when you have finished. 

Resizing Photos 
 

Pixel width and the height will automatically change. 
 

Typically a pixel (or DPI) is 300 per inch. For instance, if you want a 3 X 4 photo, you 

can change the pixel width to 900 X 1200. 

If you aren‘t going to print your photo, but are going to post it online or insert it into a 

power point slide show, the proportions aren‘t critical. If, however, you plan to print the 

photo, you may need to go back to crop and play around with the dimensions again to get a 

closer width to length proportion. 

Rotate and Flip 
 

Click to rotate left or right or flip horizontally or vertically. Click on Apply when you 

have finished. 

Photo Adjustments 
 

Once you are satisfied with the basic size of your photo you can try out some, out of 

many adjustments. 

Click on Adjustments and you will find a list of options. 
 

The most used options are usually Red eye removal, Auto levels and Brightness & 

Contrast. 

Practice with your photo to see what kinds of adjustments you can make! You can 

undo anything you don‘t like. Click on the green back arrow above the word Basic to undo a 

move. 

Adjust the size of your photo by dragging the radio button just to the right of the green 

arrows to zoom in on the area you want to change or adjust. 

Click on Done when you have finished. 
 

Save your photo before going to Photo effects. You can open it up again as needed. 

The above photo is an example of what happens when you select invert. 

 

Note: Pixlr Express will save your photo in whatever format it was in 

originally. However, if you change the name of the photo, you‘ll need to add 

.jpg or .gif after the name to save the photo as a .jpg or .gif. 

Photo effects 
 

Open your saved photo. You can now play with some of the many photo effects. Once 

you are done with your final image, save it. 

Unit Summary 



 

 

 
 

In this unit, we have learnt the use of online tool Pixlr to edit images professionally. 

We discussed in detail about the Pixlr Express, which is used for minor editing, and Pixlr 

Editor, which is used as a professional image editing tool. 

We have learnt the use of Pixlr to edit images using its various online tools. We have 

learnt how to open, crop, resize and rotate images and subsequently save them. We have seen 

how to work in layers, add layers to an existing project, hide layers and turn an image into a 

composite one by using layers. 

We have gotten comfortable with cutting edge methods, for example, auto levels, 

utilizing Gaussian obscure to remove Moire impact, altering tint and immersion, physically 

changing the levels, utilizing the shading bends to adjust a picture, revising tonality, utilizing 

bends to solarize pictures, expelling foundation to make straight forward pictures and so 

forth. 

Assignment 
 

1. What are the three different types of Pixlr tools? 

2. True/False 

a. Tools in Pixlr are on the left side of thescreen b. 

In Pixlr, work area is on the right of thescreen c. 

In Pixlr, panels are in the middle of the screen 

3. What is the major difference between Pixlr Editor and Pixlr Express? 

4. What is the Moire effect? Give examples? 

5. What is used to remove the Moire effect? 

Resources 

1. All images saved from screenshots which are done manually using the above editors. 

2. Some material is referenced from http://pixlrtutorial.blogspot.in/p/tutorials- 

navigation.html The material is not copyrighted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://pixlrtutorial.blogspot.in/p/tutorials-navigation.html
http://pixlrtutorial.blogspot.in/p/tutorials-navigation.html


 

 

 
 

Unit 4 Vector Composition & 2DAnimation 
Introduction 

Animation is the rapid display of a sequence of images in order to create an illusion 
 

of movement. Traditionally, 2D animation is created by drawing each displayed image 
 

individually. These images are called "Frames", thus the method is called "Frame-by- Frame 

Animation". To create a good illusion of movement, you need to draw many frames. As such, 

the method requires a lot of time and resources. Synfig Studio is open-source 2D vector 

animation software designed to produce film having quality animation with fewer people and 

resources. It is built to eliminate the need to draw each frame individually. The instructions in 

this unit have been sourced from Synfig Studio‘s user documentation that is available under 

Creative Commons Attribution license. 

Outcomes 
 

Upon completion of this unit you will be able to: 
 

• Learn the use of Synfig vector 2D animation open source software 
 

• Study the use of various functions of Synfig like toolbox, canvas, panels 

• Understand the process of adding colours, linking, and animation basics 

• Learn to animate shapes and add layers 

Terminology 
 

Canvas: It displays the artwork and animation 
 

Panel: It contains tools and information about certain elements of your project 
 

Navigator: It shows a thumbnail image of what the currently selected canvas looks like. 

You can also zoom in and move the focus around with this panel 

Getting Started 
 

The screenshot below displays Synfig Studio's complete window layout 
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Screenshot 

Illustration 1: Standard Synfig Studio's window layout 

The main interface components of Synfig Studio are: 
 

Toolbox — is the main Synfig Studio window. It contains system menu and buttons, 

tools and more to create and edit your artwork. Closing it exits the application. 

• Canvas — displays your artwork and animation. 
 

• Panels — contain tools and information about certain elements of your 

project. Some panels will allow you to modify those elements. 

Note 
 

To reset Synfig to its default window arrangement, you have to select "Panels/Reset 

Windows to Original Layout‖ from the ―File‖ menu of the Toolbox. 

The centre window is the Canvas Window. A new Canvas Window appears each time 

Synfig Studio starts. The window represents the Root Canvas. In the upper left corner of the 

Canvas Window, you'll see a button with a caret. If you click on this caret button, the canvas 

window menu will pop up. If you right-click on the canvas area and there is no Layer under 

the mouse position, this menu will also appear. The other two windows (one on the bottom, 

and one to the right) are customizable dock dialogs. Each dock dialog contains a set of panels, 

arranged horizontally or vertically. Some panels share the same space inside the dock dialog 

and you can switch between them by clicking on their tabs. You can rearrange the contents of 

dock dialogs as you wish by dragging the panel tab to your need. You can even create a new 

dock dialog by dragging a tab out of its dock dialog. If you accidentally close a panel, (by 

dragging it out of the dock dialog or closing the new dock dialog that gets created) you need 

not worry. Simply go to the Toolbox, select "File/Panels" in menu and click on the name of 

the panel you need. 

The most important panels are: 
 

• Layers Panel — shows the hierarchy of the layer of your working canvas. It also 

allows you to manipulate these layers. 

• Parameters Panel — shows the parameters of the layer currently selected. When 

multiple layers are selected, only the parameters that the selected layers have in 

common are displayed 

• Tool Options Panel — shows any options specific to the currently selected tool. 
 

• Navigator — shows a thumbnail image of what the currently selected canvas looks 

like. You can also zoom in and move the focus around with this panel. 

• History Panel — shows you the history stack for the current composition. You can 

also edit the actions in history. 
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Screenshot 
 

There are also many other panels in Synfig Studio. In order to know what a panel 

does, simply hold the mouse over its icon and a tooltip will pop up describing its function. 

First steps 

Let's create something to work with. 
 

First, go over to the toolbox and click on the Circle Tool (if you don't know which one 

it is, just mouse over them until you find the one with the tooltip that says "Circle Tool"). 

When you click on the Circle Tool, you should notice that the Tool Options Panel has 

changed. But we'll get to that later. 

With the Circle Tool selected, you can now create circles in the Canvas Window. This 

works as you might expect — click on the canvas, drag to change length of the radius and 

release the mouse button when you are done. Go ahead and create two circles. If you 

accidentally release the mouse button before dragging, you end up creating a circle with 0 

radius and it is effectively invisible! However, you can easily fix this. In the Parameters 



 

 

 
 

Panel, you can change the parameters of the selected object. If you just made a 0 radius 

circle, it should be the current selected object. You can change its radius to some value other 

than 0, say 10 and manipulate it to your liking with the handles later. 

Note 
 

Some users might experience the following problem: when you click and drag on the 

canvas using the Circle Tool, either nothing seems to happen or you end up making insanely 

huge circles. To fix this, go to "File/Input Devices" and disable all the devices you can find 

there. 

Now go back to the toolbox and click on the Transform Tool (the button with the 

arrow on it). After you do this, click on one of your circles. You will see a "bounding box") a 

green dot at the centre and a cyan dot on the radius. Those dots are called "Handles". If you 

want to modify the circle, grab a handle and drag it around. 

You can select a Layer by clicking on it. If you want to select more than one layer, 

hold down Ctrl key while you are clicking — this works in both the Canvas Window and the 

Layers Panel. You can do this in several ways. First, you can hold down Ctrl and individually 

click the handles that you want to select, but this can be tedious. However, there is a much 

faster method — just create a selection box by clicking the mouse and drag it over the handles 

that you want. 

Go ahead, select two circles and select all of their handles. With several handles 

selected, moving one handle will move all of them. 

Note 
 

Synfig Studio has an auto-recovery feature. If it crashes, even if the current file has 

not been saved, you will not lose more than 5 minutes of work. At restart, it will 

automatically prompt you to recover the unsaved changes. Unfortunately history isn't 

recovered yet. 

The rotate and scale tools work much like the Transform Tool, except in the case 

where you have multiple handles selected. Select a few circles then select all of their handles 

and try using the rotate and scale tools. 

Note that tools manipulating with handles have options associated with them. If a 

particular tool isn't doing what you want, take a look at the Tool Options Panel to see the 

available options. 

Linking 
 

Suppose we always want these two circles to be of same size. Select two circles and 

then select both of their radius handles (the cyan dots). 

To select multiple handles, you have to either drag a rectangle around them or select 
 



 

 

 
 

the first one and then hold the Ctrl key while selecting the rest. Once you have selected the 

two radius handles, right click on either of them and a menu will pop up. Select "Link". Now 

the parameters are linked together. You can prove it to yourself by selecting just one of the 

circles and changing its radius. 

Linking is a fundamental concept in Synfig. You can create links not only for handles, 

but also between parameters as well, by selecting multiple layers then right clicking on the 

parameter in the Parameters panel and selecting "Link". 

Colour selection 
 

Let's say you want one of the circles to be a different colour. If you look in the 

toolbox below the tools, you'll see the outline/fill colour selector, the outline width selector 

and some other stuff like the default blend method and gradient. The outline/fill colour 

widget works exactly as you might expect — you can click on the fill colour and a modest 

colour chooser will appear. Now you can change the colour pretty easily. 

But sometimes you may just want to click on a colour and go. This is where the 

palette editor tab comes in. 

Click on the Palette Editor Panel tab and have a look — it's the one with the palette-

ish looking icon. Clicking on colours with the left mouse button will immediately change the 

default outline colour and clicking with the middle mouse button will change fill colour. 

That's all great, but we still haven't changed the colour of the circle. There are three 

ways to do this. The first is to click on the "Fill Tool" from the toolbox and then click on the 

circle in the Canvas Window. This works with more than just circles. Also, you can select the 

circle layer you want to modify. Go to the Parameters panel, right-click on the Colour 

parameter and select "Apply Fill Colour" or "Apply Outline Colour" at you preference or 

simply double-click on the "Colour" parameter- a colour selector dialog will show up and you 

can just tweak away. To start, try out to set the Feather Parameter to 5. 

Animation Basics 
 

Creating an animation in Synfig Studio is really easy. It basically means to change a 

drawing — you just need to create the first stage and last stage of a change and Synfig takes 

care of the steps in between. 

Let's look at a simple example. Consider a moving light like the one at the front of the 

Knight Rider car. Drop the realism, you get a circle moving from left to right and back. In 

other words, you need to create three 'steps' or 'stages': 

1. The circle is on the left. 2. 

The circle is on the right. 

3. The circle is back on the left. 



 

 

 
 

Setting up 
 

Let's do it. Start Synfig Studio. A new file is created at the start automatically. Click 

the caret menu (between the horizontal and vertical rules, in the top left hand corner of the 

canvas), then select "Canvas/Properties" or select "Canvas/Properties" from the menu and the 

Canvas Properties Dialog will appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Now we need a circle. Change the fill colour to red, select the Circle Tool and create a 

circle. It doesn't matter if it's not perfect: You can edit it. Select the Transform Tool and click 

the circle. It will go into an editing mode which is easy to detect by the small green dot in the 

middle and the white rectangle around it. You can move the circle by grabbing it on its green 

dot (the Origin) in themiddle. 

Give a name and description for your canvas, then click "Apply" (don't click "OK" yet 

—we're not quite done with the Properties dialog). Go to the "Time" tab and make sure to edit 

"End Time". Change "5s" to "2s" — that will make our animation 2 seconds long. Now click 

"OK". Select the Rectangle Tool and create a simple black rectangle that will serve as 

ourbackground. 

These are the first steps to draw an object and to move it, but not an animation yet. 

Adding movement 

In the beginning, you entered a value of 2 seconds in the Properties dialog. Because 

the length of your animation is non- zero, your canvas window (the one where you draw) has 



 

 

 
 

a grey time slider at the bottom of the Timebar. You can click on it and a small orange 

indicator will appear indicating your position in time. Try clicking in several places on the 

time slider and you will notice that the entry field on the left of the time slider is changing its 

values to something like "12f", "1s 15f", etc. You can set your position on the time slider by 

changing values in that field. For example, if you enter "1s" and press ↵ Enter, the orange 

indicator will move in the middle of the time slider and entering "2s" will move it to the end 

of the time slider. 

Note: 
 

At 2s the orange indicator won't be visible. That's because "2s" is at the far right 

boundary of the time slider, putting the indicator out of view. 

You may notice that nothing changes on the canvas at this point. Return to "0s" and 

switch to Animate Editing Mode by clicking the green man button to the right of the grey 

time slider. The canvas will display a red outline. It reminds you that changes to your objects 

now affect your animation at the time shown in the time slider. 

In animate editing mode, every change to your object‘s parameters creates a waypoint 

that associates the changes with the current time. As you will see, Synfig can create smooth 

intermediate changes between waypoints and you can even choose the way in which the 

intermediate changes take place. You will probably find it helpful to associate some or all of 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Previously, three "steps" or "stages" were mentioned. These are represented by 
 

keyframes. (Just in case you're familiar with video encoding: No, it's not the same!) A 

keyframe is an image in time where something important happens with your objects. 

Default keyframe at 0f when creating a new project- a default "keyframe" is already 
 

201



 

 

 
 

set at 0f. If for any reason you do not have this default keyframe, go to the Keyframes Panel 

— click on the little tab with the small key icon in the bottom window to edit keyframes. 

Now press the small button with the "plus" sign and you should get a new entry in the list 

displaying "0f, 0f, (JMP)". Now, go to the "1s" mark in the time slider. The small orange 

indicator should move there. Then add another keyframe by clicking the small plus sign. 

Repeat the process with the time slider indicator set to "2s" (it's at the end of your animation). 

You should now have three keyframes in the list. 

Understanding the Timeline 
 

By now, you may have figured out what those mysterious "1s 10f"- type marks 

represent. They indicate a specific point on the timeline, expressing a location in terms of 

seconds (s) and frames (f). By default each second is divided into 24 frames, much like a 

meter on a measuring tape is divided into 100 centimeters. The frame markings begin at zero 

(0) and go up to 24, whereupon a new second frame is entered and the frame-count returns to 

zero. 

For example, when five whole seconds and three frames have passed using this, the 

timeline notation would be "5s 3f". 

The Keyframes Panel 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The Keyframes Panel is rather easy to understand. It displays "Time" which is 

basically the start time, "Length" which is self- explanatory, "Jump" which we'll cover next, 

and "Description" which is, again, self-explanatory. 

You might be wondering about the entries called "(JMP)". In fact, these are links just 

like web links: click them and the indicator in your time slider will jump to the correct time. 

You can use this to edit your image for a given moment in time. For instance, you can 

now jump to the first second and move the red circle to the right. 

To see your animation click at an arbitrary position on the time slider: You will note 

that the red circle is in a new position, one that you didn't specify! So what happened? Synfig 

figured out what you would like to do, namely move the circle and drew all the images 

between these states. Each image will later make a frame in your animation and the circle 
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will appear to bemoving. 
 

Note that you don't need to go to the last keyframe at "2s" and move your circle back 

to the left. Keyframes make Synfig remember the image states at particular times. That's why 

when we modified the circle's position at "1s", it stayed on the left at "2s" (as well as at "0s"). 

If you switch back to the Parameters Panel and look at the Time Track Panel, you will see that 

three orange diamonds (or green dots depending on the default interpolation) appeared on the 

right of the "Origin" parameter. Those are called Waypoints and they represent times at which 

object's parameters like location or colour are instructed to take on specified new values. 

Rendering your animation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Before you can see your animation, you need to render your work. There are two ways 

to do so: using the Synfig Studio (what you have been using so far) or the command-line 

program called "Synfig". 

Let's try the first way. Leave the Animate Editing Mode by clicking on the red man 

icon in the timeline editing widget and save your file, for instance under the name 

"BasicKnightRider.sifz". Then go to menu in the Canvas Window (Canvas Menu Caret 

button in the upper left corner) and select "File/Render" or click on the render icon. Change 

the filename to "BasicKnightRider.gif" in the same location where you saved 

"BasicKnightRider.sifz" and choose "gif" target format instead of "Auto", then click 

"Render". Depending on your processor speed it should take a few moments, but finally a 

message should be displayed in the image window status bar (located on the bottom of the 

window) which says "File rendered successfully". 

Note 
 

The "magick++" target (if it is available) produces much better gif files than the "gif" 
 



 

 

 
 

target because it can optimize the palette for the image. 
 

Open BasicKnightRider.gif in Firefox or another application that is able to show 

animated GIFs. However, Firefox will replay the GIF all the time which makes your short 

animation a rather long one. If there is a red circle moving from the left to the right and back. 

Now the animation is ready. 

Note 
 

You can also preview your animation. Press the "caret" menu button in the upper left 

corner of the Canvas Window and choose"File/Preview". 

If you would rather use the command line instead of the menu to render your 

animation, then open a terminal (on Windows, go to "Start/Run", type "cmd" and press ↵ 

Enter), change to the directory you saved the file in and type: synfig -t gif 

BasicKnightRider.sifz 

A few messages appear that don't matter right now. Depending on your processor 

speed it should take a few moments, but finally a line like this will appear: 

BasicKnightRider.sifz ==> BasicKnightRider.gif: DONE 
 

You can view your animated gif using Firefox or another program as mentioned 

above. 

Adding Layers 
 

In the previous tutorial, you made your first simple animation by changing the 

attributes of primitive objects, such as: position, colour and size. These simple types 

however, are self sufficient to create advanced characters and objects. To do so, Synfig uses 

layers. They are similar to layers used in other drawing applications in that they are used to 

separate different elements of an image. 

However, Synfig's layers have the following important features: 

1. Every object or element gets its own layer. 

2. You can organize layers into hierarchical groups. 
 

3. You can use upper layers to change the behavior (or look) of underlying layers. 

Those are called filter layers or effect layers. 

Combining layers 
 

Screenshot 
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Let's look at a simple example of how we can combine two layers to create a gradient 

effect on a rectangle. 

Create a new file with 0 duration. There's no need to bother with a timeline at this 

point. Next, create a simple rectangle with the Rectangle Tool. 

Pick the Gradient Tool from the Toolbox, press the left mouse button on the canvas 

while dragging it to change the gradient direction and then release the button when you are 

done. You should note that another layer was added in the Layers Panel called Gradient. 

Note 
 

If you see no gradient but just a plain colour, it means that you probably clicked on the 

canvas without dragging your mouse. To fix that, pick the Transform Tool, click into the 

canvas, to activate the gradient's handles. You need to grab the one you see and move a bit 

until a gradient appears. 

You now have a gradient, but it is not what you wanted as it spreads across the whole 

canvas. The goal was to have a gradient in the rectangle. So, let's fix this now. In the Layers 

Panel, select both the gradient and the rectangle layer. Then, right-click and select "Group 

Layer" from the menu. The view of your Layers Panel should change now, showing a small 

box called ―Group‖ with a "+" in front. By clicking on the "+" you can expand the group 

layer to see its contents, your previous two layers: the gradient and the rectangle. 

Using locality 
 

However, there is still a problem: the gradient still covers the whole canvas although 

we wanted it to be restricted to the rectangle. To do so, activate the gradient layer in the 

Layers Panel. Now go to the Parameters Panel (by default it resides in the bottom window) 

and search for the attribute called "Blend Method". Double-click the entry and select "Onto" 

from the drop-down menu. 

 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The gradient should now be restricted to the rectangle. The first effect is applied by 

interacting layers with Synfig. 

Modify layers with other layers 
 

Make sure you have the group layer selected and create two red circles. They will 
 
 



 

 

 
 

appear on top of the group layer. Select the group layer and use the "Raise Layer" button in 

the Layers Panel to place it on top of the circles. 

Now our group layer (with rectangle and gradient) is in front of those two circles. 

Expand the group layer to show its contents and select the top layer inside it (should 

be the gradient layer). This is where we require inserting a new layer. Create another circle 

filled with a black colour. The black circle layer will be created over the gradient layer inside 

the group layer. 

Now, right click on the black circle layer in the layers panel and a popup menu will 

appear. The first item in that popup is "New Layer". Inside the "New Layer" menu, you'll see 

several categories of layers you could create, but what we want is a blur, so go to the blurs 

category and select the "Blur" layer. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The blend method for newly created blur is "Straight" (if the default blend method in 

the Toolbox is set to "By Layer Default"). It blurs all around the outside edge of the contents 

of the group layer. You can change the default blend method for new layers from the New 

Layer Defaults section of the Toolbox. 

Now we have all of the contents of the group layer blurred, but everything under it is 

sharp! This is because the effect of the Blur Layer over the underlying layers is limited to the 

scope of the group layer as the blur layer is inside it. 

Animating Shapes 
 

Basic settings 
 

First, we need colours 

in the Toolbo 

gradient by clicking th 

 
 
 
 

nt for a background. Click on the outline and fill 
 

urs of our gradient. You can also directly edit the 
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Screenshot 
 

Now that the trace of the form is closed, select the transform tool (or any another tool) 

to generate the proper form. This will be the base of the stem. You can tweak the tangent 

handles (red dots) a bit to make a rounder triangle. With the Transform Tool, right-click on 

each vertex and select "Split Tangents", so that the tangent handles of each vertex can be 

moved separately. 

Select the Gradient Tool and drag your cursor vertically across the canvas to fill it 

with the gradient. Next select the Spline Tool and in the Tool Options Panel, make sure that 

only "Create Region Spline" is checked. In the tool box, set the fill colour to green. Draw a 

triangle with the Spline tool. To close the shape after drawing the 3 vertices, right click on the 

first vertex and choose "Loop Spline". 

Animate the stem 
 

In the Canvas Menu, select the caret menu icon in the upper left hand corner, where 

the rulers intersect and select "Canvas/Properties". Go to the "Time" tab, set the "End time" to 

"6s" and click OK button. Click at the beginning of the timetrack ("0f") then, in the 

Keyframes Panel (the one with a key icon) click the button with a "+" icon (add a new 

keyframe). Keyframes allow us to settle down the scene i.e. on a keyframe every element of 

the scene will have all its properties remembered. Click again on the timetrack at "4s 12f" (ie 

4.5s at 24 fps) and press the green circle at the bottom right of the canvas (or whatever icon 

you have there, depending on your icon theme) to switch to the Animate Editing Mode (the 

circle is now red). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

With the Transform Tool, select the green sprout and move the upper vertex to make a 

stem. You can play with the vertex handles to bend the shape a bit if you want. While you are 

still at "4s 12f", right-click on the stem border, close to the top and choose "Insert Item". 

 



 

 

 
 

Do the same on the other side of the stem. Right click on those new points and choose "Split 

Tangents". Then try to make a shape that looks like the one on the image, to create the flower 

bud.Right-click on them in the parameters list and select "Mark Active point as off". 

The greyed parts are those parts where the bud vertices have no effect on the stem. 

Now if you click on "2s" (for example), the shape of the bud is slightly visible, even if the 

sprout is rather small and even if the bud handles are invisible. Let's say we want the bud to 

appear only at 3s 12f and be of full size at 4s 12f. 

Click on "3s 12f" on the time track. Now take a look at the "Parameters" and "Time 

track" panels at the bottom. You'll see that each parameter in the Parameters Panel matches a 

row in the Time Track Panel. The last parameter is the vertices list. Click on the small arrow 

on the left to unfold the list. Each brown diamond (or waypoint) stands for a recorded value 

(here the vertices positions were recorded at 0f with the key frame and at 4s when we moved 

some vertices or vertices handles). The two vertices we added to make the bud are marked 

with green and red vertical line on their 0s and 4s waypoints. 

For example if you click on "2s" or even "3s" now, the bud shape is not visible. It 

starts to appear only a little after 3s 12f. 

However, the shape of the stem may not look very nice during its growth between 0 

and 4s. Make sure you're still in Animate Edit Mode, and tweak the shape at various moments 

in time, to get something you like. The animation of the stem is now finished, but it still lacks 

the petals. You can watch a preview of your animation: Go to "File/Preview", validate, wait 

for the preview to be generated, and watch. 

Note 
 

Previews are often pixelated and blurry, but the final render will be clean-cut. Higher 

quality previews are obtainable by using higher values for 'Quality' and 'Frames per second' 

in the preview dialog window. 

Adding the petals 
 

Now leave the "Animate Editing Mode" by clicking on the red circle at the right 

bottom of the canvas. 

Change the fill colour to pink and create a petal with the Spline Tool. You'll notice 

that the green handle that allows easy movement of a shape is at the centre of the canvas. 

Select all the vertices of the petal with Ctrl + A and move them close to the green handle 

(with the Transform Tool), as shown.



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Then drag the green handle very close to the top of the bud. Hit Ctrl+A again to select 

all vertices of the petal and tweak it a bit with Rotate Tool. Also, in the Layers Panel select 

the petal layer and put it under the stem layer. Click on the petal to select it, then ctrl+leftclick 

on the stem. Both objects should be selected. Now click on the vertex at the top of the stem 

and ctrl+leftclick on the green handle of the petal (both should appear in a lighter colour, as 

they are selected). Then right-click on the stem top vertex and select "Link". The petal will 

move a bit as the green handle is snapped on the stem vertex. 

Now that there's a link between the petal and the top of the stem, when the top of the 

stem moves, the petal will follow it. (And if the green handle of the petal moves, the top of 

the stem will move, but we don't want to do that here.) 

On the Layers Panel, select the newly created Petal layer and duplicate it (with the 

third button, on the bottom of the Layers Panel). On the canvas, press Ctrl+A to select all the 

vertices of the duplicated petal, and move them a little, so the petals are no longer overlaid. 

(Don't move the green handle, just the orange ones). Repeat the process several time, to get 

something looking like this image. 

Note that the duplicated petals are also linked to the stem. If you go back to the first 

keyframe, you'll see that the petals are visible. We don't want that. We want the petals to 

appear and bloom almost at the end of the growth. 

Hiding the petals 
 

Let's say we want the petals to appear a little after 4 seconds in the animation and be 

full size at 5 seconds, instead of being visible and full size all the time. 

Switch to "Animate Editing Mode" again by clicking on the green circle at the bottom 

right of the canvas. But if we will go to "4s" and modify them, then they also change at "5s". 

This is because the shape/ position of the petals is not fixated at this moment of time by any 

waypoints or keyframes. That means we need a keyframe at "5s". Click to place the cursor at 

5 seconds on the timetrack. Next, on the Keyframes Panel, click on "+" to add a new 

keyframe. 



 

 

 
 

 

Now click on "4s" and on the Layers Panel, select all the petals layers (with 

ctrl+leftclick), then press Ctrl+A to select all the petals vertices. Scale them down with the 

Scale Tool and move them, so they are hidden by the stem, as shown. 

From 4s to 5s, the petals will now appear and bloom. But notice that we have a 

keyframe at 0s which also remembers petals shape. That makes the problem — the petals are 

still visible from the first keyframe to the 4s keyframe. We could either make the petals tiny 

and hidden tweaking their size on every frame from 0s to 4s, or we could make them 

invisible on this interval. 

Let's choose the second solution. To make things easier, we are going to group the 

petal layers into a Group Layer. With the entire petal layers selected, right-click on them on 

the Layers Panel and select "Group". You can rename the layers to make things easier to 

understand. Select the Petals Group Layer and jump to the first keyframe. In the Parameters 

Panel, set the "Amount" value to "0". The petals are now invisible on that keyframe. Note that 

two waypoints were added in front of the "Amount" parameter, one at 0s and the other at 5s. 

Drag the 5s waypoint to 4s, so that the opacity of the petals will be 1 at 4s. 

There is still one problem left: from 0s to 4s, the opacity of the petals slowly 

increases, making the petals visible when they shouldn't. To solve this, we will change the 

Amount interpolation method. Right click on the Amount waypoint at 0f and select "Edit". A 

new dialog will appear, in which you can choose the In and Out interpolation. Set the Out 

Interpolation to "Constant". 

 
 
 
 
 
 
 
 
 
 

Screens 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 

Tip 
 

You can also change waypoint out interpolation by right-clicking on it and selecting 

"Out/Constant". 

This means that after that waypoint, the Amount value will remain constant until 

another waypoint is encountered. So from 0f to 4s the Amount value will be equal to 0 and at 

4s it will suddenly change to 1 and make the petals visible, as expected. 

Alternatively, we could have achieved the same effect by setting the In Interpolation 

of the waypoint at 4s to "Constant". Notice how (half of) the waypoint changes from a green 

circle (meaning smooth animation of the amount parameter) to a red step (meaning that the 

amount parameter is suddenly stepped). 

Now you're done. The stem grows for 4.5 seconds and staystill the last 1.5 seconds. 

The petals are hidden until 4 seconds and then grow quickly between 4 and 5 seconds and stay 

till the last 1 second too. Click on "File/Render" to render your animation. Select any format 

you want and ensure that "Use current frame" option is unchecked (otherwise, only one frame 

will be rendered). In the next and last part, we will be covering the basic usage of the bone 

system in Synfig. 

Unit summary 

In this unit, you‘ve learned: 

- The use of Synfig vector 2D animation in open source software 

- The various functions of Synfig like toolbox, canvas, panel 

- The process of adding colours, linking, and animation basics 

- The process of animating shapes and adding layers. 

Assessment 
 

1. What is Synfig software? 
 

2. What are the three main interfaces of Synfigstudio? 

3. List important panels and their function? 

4. Which tool helps in changing the colour of theobject? 5. 

What are the two important parameters of circle tool? 6. 

Which operation controls the layer of visibility? 

Resources 

https://wiki.synfig.org 

www.gimp.org docs.gimp.org 

https://wiki.synfig.org/
http://www.gimp.org/


 

 

 
 

 

www.nisd.net 
 

www.gimp2tutorials.info 
 

www.dotputs.de 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.nisd.net/
http://www.gimp2tutorials.info/
http://www.dotputs.de/
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Unit-1 Working with Visual Images 

Introduction 

 

The design elements and principles described here can be an analyzing frame for a 
 

design. They can inform us where to begin, what to probe and how to analyze. 
 

This information can also give an expressing tool to the designer. A novelist can 

express his or her thought using language. A page designer also expresses his thought or a 

certain intention with elements of design and does it effectively along with the design 

principles. If a designer wants to say something through the creativity of design, then he/she 

must use the elements (line, color, etc) as a communication tool. So it is very important to 

know the kinds and meanings of the design elements and principles. 

Outcomes 
 

Upon completion of this unit you will be able to: 
 

• Understand the importance of design while working with image design 

• Learn about various design elements 

• Balance all the design principles 
 

• Know the designs basics Understand the importance of visuals 

Terminology 

Movement: Movement is a visual image occurs when objects seem to be moving in a visual 

image. 

Rhythm: Rhythm is the repetition of visual movement of the elements-colours, shapes, lines, 

values, forms, spaces and textures. 

Variety: Variety consists of the differences in objects that add interest to a visual image. 

Shape: A shape is formed when a line encloses an area. 

Values: Value is the relative degree of lightness and darkness in a design element. 

Design Elements 

The elements are components or parts which can be isolated and defined in any visual 

design or work of art. They are the structure of the work and can carry a wide variety of 

messages. The details may be differentiated by researchers, but we will study ‗point or mark‘, 

‗line‘, ‗shape‘, ‗forms‘, ‗space‘, ‗color‘, and ‗texture‘ in this section. 

Point or Mark 
 

A point or mark is the smallest and most basic element. Often it is the personal 

'handwriting' of the artist that can be natural or learned. It can vary in size, value, regularity 

 



 

 

 
 

or irregularity and can be used alone or as a unit in a group which forms a line or shape in the 

image. Marks can be used to form a value or pattern (placed close together forms a darker 

value, further apart forms a lighter value) or to delineate space (largermeans closer, etc.). A 

good example of the use of marks is the ink drawings of Van Gogh. The Impressionist 

painters used what could be called Patches and the Pointillists, such as Seurat used the dot. 

Even though there is only one point or mark on a white blank page, it can catch our 

sight. If there are two points, we will make a connection and see a line. If there are three 

points, it is unavoidable to interpret them as a triangle as the mind explains the connections. 

These are called as Grouping or Gestalt. Gestalt is the fundamental tool, a designer or artist 

uses to build a coherent composition. 

Line 
 

A line is a form with width and length, but no depth. Artists use lines to create edges, 

the outlines of objects. A line is created by the movement of the artist's pen. 

The direction of a line can convey mood. Horizontal lines are calm and quiet, vertical 

lines suggest more of a potential for movement, while diagonal lines strongly suggests 

movement and give more of a vitality feeling to a picture. 

Shape 
 

Shape is an area that is contained within implied line or is seen and identified because 

of change in colour or value. Shapes have two dimensions that are length and width. It can be 

geometric or free-form. Design in painting is basically the planned arrangement of shapes in a 

work of art. In a picture, the shapes that the artist has placed are considered to be the positive 

shapes. The spaces around the shapes are the negative spaces. It is just as important to 

consider the negative space in a picture as the positiveshapes. 

Forms 
 

Form describes volume and mass or three dimensional aspect of objects that take up 

space. (Shape is two-dimensional). Forms can be viewed from any angles and we should 

observe it from different angles inorder analyse its actual structure.. When you hold a 

baseball, shoe or small sculpture, you are aware of their curves, angles, indentations, 

extensions and edges - theirforms. 

Space 
 

Actual space is three-dimensional volume that can be empty or filled with objects. It 

has width, height and depth. Space that appears three-dimensional in a two-dimensional 

painting is an illusion that creates a feeling of actual depth. Various techniques can be used to 

show such visual depth or space 

Colour 
 



 

 

 
 

Colour has three properties. The first is hue, which is the name of the colours. The 

primary hues are yellow, red and blue. Secondary colours are made by mixing two primaries. 

Intermediate colours are mixtures of a primary and adjacent secondary colour. 

The second property of colour is value, which refers to the lightness or darkness of 

hue. The third property of colour is intensity, which refers to the purity of the hue (also called 

"Chroma"). 

Texture 
 

Texture refers to the surface quality, both simulated and actual artwork. Techniques 

used in painting serve to show texture, i.e. the dry brush technique produces a rough simulated 

quality and heavy application of pigment with brush or other implement produces a rough 

actual quality. 

Design Principles 

Balance 

Balance is a psychological sense of equilibrium. As a design principle, balance places 

the parts of a visual in an aesthetically pleasing arrangement. In visual images, balance is 

formal when both sides are symmetrical in terms of arrangement. Balance is informal when 

sides are not exactly symmetrical, but the resulting image is still balanced. Informal balance is 

more dynamic than formal balance and normally keeps the learner's attention focused on the 

visual message. 

 
 
 
 
 
 
 
 
 
 
 
 

Title- Balance 

Source- pixabay.com 

Link-https://www.pexels.com/photo/balance-macro-ocean-pebbles-235990/ 

There are three main types of balance, 

• Horizontal balance, 

• Vertical balance, 

• Radial balance. 

Proportion 

Proportion refers to the relative size and scale of the various elements in a design. The 
 

https://www.pexels.com/photo/balance-macro-ocean-pebbles-235990/


 

 

 
 

issue is the relationship between objects or parts of a whole. This means that, it is necessary to 

discuss proportion in terms of the context or standard used to determine proportions. 

Perspective 

Perspective is created through the arrangement of objects in two- dimensional space to 

look like they appear in real life. Perspective is a learned meaning of the relationship between 

different objects seen in space.Is the dark rectangle in front of a circle or beside a semi-circle? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Perspective 

Source- pixabay.com 

Link-https://www.pexels.com/photo/bridge-clouds-cloudy-dark-clouds- 556416/ 

Perspective adds realism to a visual image. The size of a rectangle will be considered 

small until another reference object‘s size is compared such as the size of a desk or the size of 

a building. Perspective can be used to draw the audience into a visual. Perception can be 

achieved through the use of relative sizes of objects, overlapping objects and blurring or 

sharpening objects. 

Emphasis 
 

Emphasis is used by artists to create dominance and focus in their work. Artists can 

emphasize colour, value, shapes or other art elements to achieve dominance. Various kinds of 

contrast can be used to emphasize a centre of interest. Emphasis can also be achieved by 

isolation and / or placement. 

Movement 
 

The way the artist leads the eye in, around and through a composition. The path the 

eye follows. Motion or movement in a visual image occurs when objects seem to be moving 

in a visual image. Movement in a visual image comes from the kinds of shapes, forms, lines 

and curves that are used. Diagonal lines tend to create the illusion of movement or motion. 

 

https://www.pexels.com/photo/bridge-clouds-cloudy-dark-clouds-556416/
https://www.pexels.com/photo/bridge-clouds-cloudy-dark-clouds-556416/


 

 

 
 

Similar shapes connected with each other or overlapping each other can imply movement or 

restlessness. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Movement Attribution- Scott Webb Source- pixabay.com 

Link-https://www.pexels.com/photo/bench-light-city-road-136739/ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title- Movement 

Attribution- Tanino 

Link-https://www.pexels.com/photo/blur-color-exercise-fidget-spinner- 

448539/ Pattern 

Pattern uses the art elements in planned or random repetition to enhance surfaces, 

paintings or sculptures. Patterns often occur in nature, and artists use similar repeated motifs 

to create pattern in their work. Pattern increases visual excitement by enriching surface 

interest. 

https://www.pexels.com/photo/bench-light-city-road-136739/
https://www.pexels.com/photo/blur-color-exercise-fidget-spinner-448539/
https://www.pexels.com/photo/blur-color-exercise-fidget-spinner-448539/
https://www.pexels.com/photo/blur-color-exercise-fidget-spinner-448539/


 

 

 
 

Repetition 
 

Repetition works with pattern to make the artwork seem active. The repetition of 

elements of design creates unity within the artwork. 

Rhythm 
 

Rhythm is the repetition of visual movement of the elements- colours, shapes, lines, 

values, forms, spaces and textures. Variety is essential to keep rhythms exciting, active and to 

avoid monotony. Movement and rhythm work together to create the visual equivalent of a 

musical beat. 

Variety 
 

Variety provides contrast to harmony and unity. Variety consists of the differences in 

objects that add interest to a visual image. Variety can be achieved by using opposites or 

strong contrasts. Changing the size, point of view and angle of a single object, it can add 

variety and interest to a visual image. Breaking a repeating pattern can enliven a visual 

image. 

Harmony 
 

Harmony in visual design means all parts of the visual image relate to and 

complement each other. Harmony pulls the pieces of a visual image together. Harmony can 

be achieved through repetition and rhythm. Repetition reemphasizes visual units, connecting 

parts and creating an area of attention. Rhythm is the flow depicted in a visual. Rhythm helps 

direct eye movement. Patterns or shapes can help achieve harmony. By repeating patterns in 

an interesting arrangement, the overall visual image comes together. 

Unity 
 

Unity means the harmony of the whole composition. The parts of a composition made 

to work together as a total visual theme. Unity is the relationship among the elements of a 

visual, which helps all the elements function together. Unity helps in organizing a visual 

image, facilitating interpretation and understanding. Unity gives a sense of oneness to a visual 

image. We can also explain that, the words and the images work together to create a meaning. 

Unity can be achieved through 

• Use of similar shapes. 

• Use of a common pattern. 

• Use of space. 

Summary 
 

Elements of design described here are point, line, shape, form, space, colour and 

texture. Design principles include the balance, proportion, perspective, emphasis, movement, 



 

 

 
 

pattern, repetition, rhythm, variety, harmony and unity. These elements and principles can be 

the basic knowledge andanalytical framework for a designer. 

Examples of design 

Design Elements 

 
 
 

Line 
 
 
 
 
 
 
 
 
 
 
 

Title-Line 

Attribution- ben neale 

Link-https://www.pexels.com/photo/apartment-architecture-building- contemporary-380330/ 

Horizontal lines are calm and quiet 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Title-VerticalLine 

Source-pixabay.com 

Link-https://www.pexels.com/photo/background-board-carpentry- construction-207253/ 

Vertical lines suggest more of a potential for movement. 

Diagonal lines strongly suggest movement and give more of a feeling of vitality to a

https://www.pexels.com/photo/apartment-architecture-building-contemporary-380330/
https://www.pexels.com/photo/apartment-architecture-building-contemporary-380330/
https://www.pexels.com/photo/background-board-carpentry-construction-207253/
https://www.pexels.com/photo/background-board-carpentry-construction-207253/


 

 

 
 

picture. 
 

Title-DiagonalLine 

Source-pixabay.com 

Link-https://www.pexels.com/photo/abstract-art-design-diagonal- 416430/ 

Shape 

 
 
 
 
 
 
 
 
 
 
 

Title-Shape 
 

Source-pixabay.com 
 

Link-https://www.pexels.com/photo/close-up-high-angle-view-of-blue- objects-256485/ 
 

A shape is defined as an area that stands out from the space next to or around it due to 

a defined or implied boundary, or because of differences of value, colour, or texture. 

A shape is formed when a line encloses an area. Shapes can vary endlessly and can 

suggest physical form and direct eye movement. Simple shapes are remembered and 

understood more easily than complex shapes. 

Simple shape 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-SimpleShape 

Attribution- User:Amada44 

Source-Similar-geometric-shapes.png 
 

Link-https://commons.wikimedia.org/wiki/File:Similar-geometric- shapes.svg 
 
 
 
 
 
 
 

https://www.pexels.com/photo/abstract-art-design-diagonal-416430/
https://www.pexels.com/photo/abstract-art-design-diagonal-416430/
https://www.pexels.com/photo/close-up-high-angle-view-of-blue-objects-256485/
https://www.pexels.com/photo/close-up-high-angle-view-of-blue-objects-256485/


 

 

 
 

Complex shapes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-ComplexShape 

Attribution- Tabitha Mort 

Source- 

Link-https://www.pexels.com/photo/photo-of-blue-pink-and-green-led- light-775907/ 

Space 

Size & vertical location 
 

Detail (aerial or atmospheric perspectives) 

Values 

Value is the relative degree of lightness and darkness in a design element. 
 

Line, colour, texture and shape all need value contrast in order to be seen.Value is 

used to describe objects, shapes, and space. 

Dark areas tend to denote: gloom, mystery, drama, and menace 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Dark area 
 

Attribution- 
 

Source-pixabay.com 
 

Link-https://www.pexels.com/photo/background-board-carpentry- construction-301378/ 
 
 

https://www.pexels.com/photo/photo-of-blue-pink-and-green-led-light-775907/
https://www.pexels.com/photo/photo-of-blue-pink-and-green-led-light-775907/
https://www.pexels.com/photo/background-board-carpentry-construction-301378/
https://www.pexels.com/photo/background-board-carpentry-construction-301378/


 

 

 
 

 

Texture 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Texture 

Source-pixabay.com 

Link-https://www.pexels.com/photo/background-board-carpentry- construction-301378/ 

Why use visuals? 

PowerPoint slides and overhead transparencies (OHTs) are useful in visual aids for all 

sizes of classes, provided they are well designed and appropriately used. They are cost-

effective and quick to produce, and most of the classrooms are generally equipped with the 

means to displaythem. 

Visual aids can be used to: 
 

• Organize your lesson or presentation 
 

• Provide interest and motivation for your students 

• Increase retention of information and learning 

• Save instructional time and preparation time because they can be reused 

• Aid communication 

• Explain the relationships of parts to the whole 
 

• Clarify something difficult, complicated or very large 

• Stress important points 

If you are using Powerpoint slides or other presentation software to design your 

visuals, you can automatically print the outline view and print 2, 3, or 6 frames per page. 

This makes an excellent note- taking guide. 

Key principles - Apply the following six principles to the design of your visuals. 
 

Chunk information — having similar materials together in manageable and sensible chunks. 

If information must be split over a number of slides or screens, consider reducing the size of 

the chunks you have. 

Organize the content—use basic principles such as simple to complex, known to unknown 
 

and knowledge to application. Position any image as close to the relevant content as possible. 

https://www.pexels.com/photo/background-board-carpentry-construction-301378/
https://www.pexels.com/photo/background-board-carpentry-construction-301378/


 

 

 
 

Relevance— be sure that the information or visual that you are using is relevant to the topic. 

Be able to give a rational reason for something to be in the visual. Over-use of bulleted slides 

is a common student complaint. 

Importance— places the most important information early in your slides or visuals. Call 

attention to it in some way. Be sure it really is an important idea to include. 

Appropriateness— considers the audience receiving the information and the material being 

presented. 

Visual effectiveness— keeps your visuals simple so that they have the most impact. 

• Use key phrases rather than long sentences. 

• Use no more than 6 words per line 
 

• Not more than 6 short lines per slide. 
 

• Ensure that all type is visible from the back of the room (all lettering 

should be at least 1/4" high or 24 pts). 

• Leave plenty of white space around images. 

• Use a graphic rather than text 

• If you have more than 36 words of content, break them up into a series 

of slides beginning with an overview slide. 

The Influential Factors and Elements of Motion Graphics in Communication 
 

Motion graphics' area of activity is an area in which audience attraction is the first 

priority, while this matter is the second priority for the field of brochures, posters, and other 

printed media. It is not easily possible to estimate the amount of likeness of the audience and 

the effects of the poster on the audience when they see a poster. Continuous presence and 

effect, getting used to it, and waiting for it, the element of time, are of the important 

characteristic of motion graphics. As a result, it seems that motion graphics has a notable 

characteristic. 

Motion in Motion Graphics 
 

Naturally, every substance is in motion and struggle in the nature. Motion in picture 

may be created by dot and line and presented in different shapes. The type of movement 

might be helical, circular, zigzag or direct. The direction of motion can also be upward, 

leftward, rightward, etc. Each visual element or each shape more or less might have the 

energy for movement. According to the influence of the energy,the dominance of which side 

to be selected is judged. It will move toward the side which has more 

length. The concept of motion can be understood via other forms, for example, by the 

repetition of a visual element in motion which is possible through the repetition of many 

elements. For instance, the repetitive motion of a circle in the screen which forms a type of



 

 

 
 

rhythm as well can be named (Nave, 2005). 
 

Sound in Motion Graphics 
 

Although flawless, visual effects and graphic environments will not be effective, if 

they are not accompanied by appropriate sounds. Sounds and their masterful combination will 

not be successful unless they involve the audience and they are listened to, through the right 

technology. Actually, 70% of the influence of a motion graphic work which is usually shown 

in the format of a commercial advertisement or the same formats is made by the sound. Music 

and appropriate sound can help the transfer of influence. Music helps feelings be well 

expressed; it really enlivens a dead work. Image and sound are related to the main sensations 

of human which are vision and hearing. A graphic motion designer tries to make people move 

by presenting an attractive program and utilizing these two principal elements. How much 

they will be able to attract the audiences' vision and hearing senses will depend on their art 

and expertise. In other words, in a motion graphic work, in which image is more attractive, 

the audience will focus on the image; and, in a motion graphic work, in which sound is more 

attractive, the audience will focus on the sound (Woolman,2004). Alphabetical Characters 

in Motion Graphics 

In the realm of motion graphics, alphabetical characters are considered as images. 

These characters are more watchable than readable. For instance, a Japanese graphic expert 

who does know about Persian can comment on a sample of Persian handwriting about its 

graphical psychology expression by looking at Persian alphabetical characters. For example, 

Nastaliq calligraphy has such characteristics as gentleness and passionate impressive 

tranquillity which are the characteristics of curves in graphics. Representation and readability 

aspects are considered to be the secondary priority, while aesthetic aspects are considered as 

the primary priority. Nastaliq calligraphy is magical and its curves are strong while flexible, 

that is why it cannot be used for describing a tragic event or an accident; it cannot be used for 

news, either. On the other hand, Naskh calligraphy is exciting and venturesome. It is like a vigorous 

voice which orders and has a predicative statement (Woolman, 2004). 

Color in Motion Graphics 
 

In the context of motion graphics, colour and paying attention to colour are important. 

When focusing on the nature of human mind, the importance of the matter becomes clear. In 

the procedures related to vision, the stimulators enter into sensing memory and are saves there 

for about one second. The capacity of this storage space is about 16 objects. In this condition, 

the objects and stuff enter the sensing memory and immediately disappear (Kaufman, et al., 

2001). 

Visual Elements of Motion Graphics 
 



 

 

 
 

Graphics, pictures, and the collection of images, which are present in each motion 

graphic, can help improve the quality of the works and increase its popularity to the audience, 

or vice versa, decrease its worth. The more comfortably the audience deals with the work and 

the more quickly they find a relationship with the work, the sooner the designer will reach to 

their goal. These images and visual attractions must be designed in accordance with 

audiences' ideas, desires, and criteria so that they will be able to convey the visual messages 

in the best manner. Many designers are not aware of these important factors and their 

influence on the attraction of the audience, so they do not consider images, graphics, and 

their visual messages as they should while designing a motion graphic work. 

The important points which can be called main points in visual language grammar and be 

used in motion graphics are listed below: 

1. The primary visual elements (dot, line, shape, colour,direction, etc.) 

2. Composition 

3. The methods ofcreating visual language (simulation, code, abstraction,etc.) 

4. Visual techniques and recognition of different styles (Dadgaran, 1384). 

Dot in motion graphics 
 

Wherever it is, the dot seriously attracts eye's attention. As a result, the dot can be used 

as a strong visual element in motion graphics for showing the concept of emphasis. By the 

repetition of dots in different and numerous combinations, it is possible to identify the concept 

of rhythm. By the concentration and disunion of dots in a new combination, the concepts of 

expansion and contraction can be presented. This phenomenon, that is the combination of 

dots, simulates the vision system in human (Dadgaran, 1382). 

Line in motion graphics 
 

Line has active and mobile energy. Lines in a motion image can appear as broken, arc, 

flat, ragged, wavy, wide, thick, etc.; each of them has their own visual inspirations and 

meanings. The vision sensation in human being is sensitive to the psychological impacts and 

artistic values of lines in a frame. That is why gaining knowledge over the characteristics of 

lines is essential in order to appropriately use them. It might also be said that lines are the 

most influential and the mostly used elements in motion graphics which are used in different 

forms and with different meanings (Braha, 2011). 

Surfaces in Motion Graphics 
 

It is the third visual element which has length and width. Different geometric figures 

are surfaces; a 2D space which is created due to the movement of line on screen. Among flat 

geometric figures, triangle, circle, and foursquare are mostly used in motion graphics. Other



 

 

 
 

geometric figures are somehow derived from these three figures or a combination of them. 

Each of these figures in different positions and circumstances find a new visual expression 

(Dadgaran, 1382). 

Lighting in Motion Graphics 
 

Light is certainly a determinative element in human life. Beside applied uses, light has 

always had symbolic values as well. Light is a part of the essence of life and in many cultures, 

light or sun is considered as a divine element and is eulogized. Using different lighting tricks 

for reinforcing imagination has also become usual (Fransis, 1391). In motion design, 

innovative and influential phenomena are created, using special forms and appropriate 

lighting. 

Space in Motion Graphics 
 

Space defines the position and circumstance of each objective or any other 

phenomenon. The space defines the existence of any object in relation with other objects and 

makes internal, external, and intermediate space understandable. There are different concepts 

defined for the space such as hollow space, free space, green space, live or dead space, etc. 

The space is not definable by itself; however, by positioning a 3D mass in the space, the 

location of the mass is specified and space defines its existence (Dadgaran, 1382). 

Unit Summary 
 

In this unit you have learned the importance of design while working with image 

design. You also learned about various design elements like point, mark, line, shape, colour, 

texture. Know all the design principles like Balance, Proportion, Perspective, Emphasis, and 

Movement. Know the various designs basics with the help of extensive examples. 

Motion graphics as a method of expression and communication with the audience has 

unique themes and domains in utilizing innovation, imagination and graphic effects. In fact, 

motion graphics is a context for displaying where performance and image are considered as 

expression elements in the creation of the work. Visual communication plays an influential 

role in taking advantage of informative concepts for people. 

 

Assessments 
 

Briefly explain the design principles-

• Balance 

• Proportion 

• Perspective 

 



 

 

 
 

• Emphasis •

 Movement 

Resources 
 

• https://link.springer.com/book/10.1007%2F978- 81-322-2232-3 

• https://www.intofilm.org/clubs 

• www.svnfilm.com 
 

• www.videomaker.com 
 

• www.junctiongoogle.co.uk 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://link.springer.com/book/10.1007%2F978-81-322-2232-3
https://link.springer.com/book/10.1007%2F978-81-322-2232-3
https://www.intofilm.org/clubs
http://www.svnfilm.com/
http://www.videomaker.com/
http://www.junctiongoogle.co.uk/


 

 

 
 

Unit 2 Story Boarding 

Introduction 

When you are set out to make a movie, the more planning you can do beforehand, and 

the chances of success becomes better. Figuring out exactly what you‘ll be doing during a 

shoot saves your crew time and labour and saves the producer and director, from cost 

overruns and production headaches. A storyboard is one method of planning ahead. By 

visualizing your shots ahead of time with a storyboard, you can see how your shots fit 

together before you‘ve shot a single footage of film or frame of video. This will prevent you 

from wasting both time and footage. A good storyboard allows you to explain your crew 

about what are you planning to achieve. It saves you from trying to convey what you want 

with wordy explanations and frustrated hand gestures. When you show the boards to your 

director of photography and cameraperson, they will immediately understand what type of 

shot you need and how to frame the subjects. 

During your learning process about filmmaking, paying your dues as a production 

assistant or other crew member or even just searching around the internet, you may have seen 

elaborately detailed storyboards by professional artists. Boards like this are nice, but you 

don‘t need to be a talented artist to storyboard effectively. Even simple stick figures can give 

people a good idea of what your shot sequence will look like. 

In other words, rudimentary art skills are perfectly fine. What you need to know is 

how you are going to frame the subjects of your film. A basic knowledge of camera shots, 

paired with few simple perspective tricks, will enable you to map out your scene in easy- to-

read visual shorthand. 

Outcomes 
 

Upon completion of this unit you will be able to: 
 

• Explain the importance of storyboarding and storytelling in relation to your stop-

motion animation project 

• Use various media and technology to convey messages and meaning 
 

• Work interactively, co-operatively and collaboratively to plan and create a 

storyboard 

• Engage in critical reflective thinking as part of the decision- making and problem-

solving process 

• Invent and incorporate unique visual symbols andmovement to create 

personal meaning in art 

 



 

 

 
 

• Appreciate the diversity of individuals, as reflected in their artwork 
 
 
 

Terminology 
 

Long shot: A long will include the entire body of the subject or subjects. 
 

Mid short : A mid shot or medium shot will usually depict your subject anywhere from 

above the knees and up to just above the waist and up. 

ECS: Extreme close shot. Extreme Close-Ups (ECU) add drama. 
 

Master shot: This refers to a shot that runs for the length of a scene and shows all of the 

characters in view. 

Different types of shots 
 

Let‘s begin with a quick rundown of basic shots and what they look like. 

Long Shot 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Long shot 
 

Link-https://mooc.employid.eu/storyboarding-tutorial/ 

Generally speaking, a long shot will include the entire body of the subject or subjects. 

Medium Shot 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Mid shot 
 

230

https://mooc.employid.eu/storyboarding-tutorial/


 

 

 
 

Link-https://mooc.employid.eu/storyboarding-tutorial/ 
 

A medium shot will usually depict your subject anywhere from above the knees and 

up to just above the waist and up. Remember not to cut off your subjects‘ right at the knees, 

or any other juncture of the body. It looks awkward and poorly composed. Try to frame them 

just above or below the joint in question. 

Close up 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Close-up shot 
 

Link-https://mooc.employid.eu/storyboarding-tutorial/ 
 

Close-ups are where we most often see the emotional content of a scene. They allow 

us to see the character‘s faces up close and thus their state of mind. Close ups are usually 

framed from the chest up. Occasionally, however, they can be framed from forehead to chin 

or will even involve just the subject‘s eyes. We call this an Extreme Close-Up: 

Extreme Close up 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Extreme closeup 
 

Link-https://mooc.employid.eu/storyboarding-tutorial/ 
 

Extreme Close-Ups (ECU) add drama. For the most part, they‘re used sparingly, but a 

single ECU can add a real punch to a scene. 

Master Shot 
 

This refers to a shot that runs for the length of a scene and shows all of the characters 
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in view. It‘s the most conservative way of staging a scene. Think of a master shot which is 

like watching a play from somewhere out in the audience. You see the entire set and where 

the characters are in relation to each other on the stage. In older films and multiple-camera 

productions like sitcoms, scenes often begin with a master shot in order to orient the audience 

and all of the rest of the shots in the scene, relate back to this shot. Most single-camera 

productions don‘t rely so heavily on the master shot. However, keeping the master shot in 

mind can help you plan out the rest of your shot list. For example, in a scene depicting a 

conversation between two people, you may decide to cut to close ups of each person talking, 

plus an insert shot of an item that they‘re talking about and then cut back to the master shot 

after each one. This is a very basic way of editing ascene. 

There are also some special shots you might want to use in your storyboard. Here are a 

couple of examples. 

POV 
 

POV or the point-of-view shot allows the audience to see what‘s going on through a 

character‘s eyes. The easiest way to indicate this is to show a character looking at something, 

and then move to, what they‘re looking at from an angle, that makes it look as if the camera 

is in that character‘s place. 

POV shots tend to be used sparingly, although there have been some films with entire 

sequence shot from a character‘s point of view. In fact, the 1947 film ‗Noir Lady in the 

Lake‘ was shot entirely from the POV of the main character. 

Depicting Camera Movement 
 

Now that we‘ve talked about some basic shots, let‘s go over some important camera 

movements and the ways to depict them on the page. 

PAN 
 

Panning involves a sideways or up/down rotation of the camera on the tripod. It‘s one 

way to put the camera on another subject without cutting to a different shot. It can also be 

used to follow a character or characters when they‘re moving within the frame. 

A panning shot can be depicted by first placing a couple of frames in order to show 

where the camera will start and where it will end up and then adding arrows to describe the 

camera‘s movement. In the illustration below, we see a panning shot for a simple dialogue 

scene. 

TRACK 
 

A tracking shot is another way to follow a subject or subjects. This type of shot 

involvesmoving the entire camera from one place to another, instead of merely rotating the 

camera body on a fixed point. Tracking can involve moving the camera with tracks, on a



 

 

 
 

dolly or it can be done hand-held. 
 

ZOOM 
 

Zooming is a movement of the camera lens as opposed to a movement of the camera 

itself. Zooming In means adjusting the lens to the frame, closer on the subject. While 

Zooming Out, it means the opposite i.e. adjusting the lens to take in more of the scene. 

What if you don‘t need the camera itself to move, but want to show characters moving 

into, out of, or through the frame during a shot? An easy way to do this is by drawing arrows. 

Arrows can also depict smaller movements within the frame, such as a head turning. 180 

Degree Rule 

Now that we‘ve covered the basics, here are a couple of other things to keep in mind 

when setting up your shots. Firstly, you may have heard people talk about ―not crossing the 

line‖ when they‘re setting up a scene. They‘re using a slang term for the 180 degree rule, 

which is a very important thumb rule for filmmaking. 

 
 
 
 
 
 
 
 

Drawn by Author 
 

Keeping your camera on the same side of this line—aka the 180 degree line-- will 

assure visual continuity and prevent your viewers from becoming disoriented 

Here is a similar diagram with a few possible camera placements. Notice that shots A, 

B and C are on the same side of the line. 

Let‘s put shots A, B, and C into a storyboard. It will end up looking like this: 
 
 
 
 
 
 

A 
 
 
 
 
 
 
 
 
 
 
 
 

B  C 
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Drawn by Author 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Drawn by Author 
 

This shot sequence adheres to the 180 degree rule. Bill and Carol are having a 

conversation. First we have a master shot of the two of them, showing the audience where 

they are in the scene and where they are in relationship to each other (shot A). Next is a close 

up of Bill (shot B), and then one of Carol (shot C). When the individual shots are edited 

together, Bill and Carol appear to be facing each other, just as they are in the master shot. 

Now let‘s try putting together shots A, B, and D from the diagram. The storyboard 

will look like this: 

 
 

A 
 
 
 
 
 
 
 

B D 
 
 
 
 
 
 

Drawn by Author 

Creating Story Boarding 

Creating well-drawn, motivated figures that kinetically move in an interesting way 

through the 3D space of the film is one of the primary jobs of the storyboard artist. A finished 

storyboard covering all the basic shots tells the story and is an invaluable aid to the entire 

preproduction team. Vivid images from a strong director and a storyboard illustrating 



 

 

 
 

their robust style complements, the intensity of the action and the raw emotions of the 

characters. The shots from important films in this chapter demonstrate how dynamic are the 

placement of figures within the continuity of the storyboard frames; however it has to be 

rendered simply yet effectively. Indications of sets constructed or actual buildings and 

locations used must be illustrated in the storyboard artist‘s renderings, remembering that sets 

are background for the action. The use of special effects, computer graphics (CG) and the 

compositing of different images enhance the continuing action of the storyline and the VFX 

must be indicated and illustrated in the storyboard. Superman Returns (2006), directed by 

Bryan Singer, is a super send off of the previous versions and is considered to be the best so 

far. It has a strong back-story and an interesting new story line, with strong performances 

from all the leads, plus spectacular new VFX. Nominated for an Oscar for Best Achievement 

in Visual Effects, this film would make one agree with the ads for the film. Talk about action! 

Talk about adventure! Talk about superb visuals! 

Superman Returns is a terrific contemporary showcase for the very latest 

digital/CGI/green screen technology. For showcasing, make sketches of some key scenes 

very quickly. 

Unit Summary 
 

In this unit you have learned the importance of storyboarding and storytelling in stop 

motion animation projects and how to work interactively, co-operatively to plan and create 

story board. Use various media and technology to convey messages and meaning. Also we 

have learned different types of shots and camera movements. We also discussed the art of 

storyboarding with real examples of movies. 

Assessment 
 

1. What are the different types of shots? 

2. What is the uniqueness of POV shot? 

3. What is 180 degree rule? 

4. What are some important camera movements? 

5. Why is storyboarding important? 

Resources 
 

• https://link.springer.com/book/10.1007%2F978- 81-322-2232-3 

• https://www.intofilm.org/clubs 

• www.svnfilm.com 
 

• www.videomaker.com 
 

https://link.springer.com/book/10.1007%2F978-81-322-2232-3
https://link.springer.com/book/10.1007%2F978-81-322-2232-3
https://www.intofilm.org/clubs
http://www.svnfilm.com/
http://www.videomaker.com/


 

 

 
 

Unit 3 Titles & Credit Making 

Introduction 

Indian cinema, produced across India, has cinematic culture of different states. It 

shows a very diverse pattern of visual culture. This could be because of its multilingual and 

multicultural nature. Bollywood is one of the dominating Indian film industries based in 

Mumbai. 

In the history of film production in India, different mediums have been implemented 

for film advertisement. During early period of the cinema, the mode of publicity has been 

dominated by print media in the form of newspaper advertisements, handbills, lobby cards, 

publicity booklets, posters and hoardings. 

Throughout the timeline, film posters have been one of the important medium for film 

publicity. Like other advertising material, film poster too responds to its environment. From 

time to time it gets influenced by different art movements and socio- cultural changes. 

Bollywood film posters also perceived as a public urban icon which offers a visual 

experience of changing social and emotional standards to its audience. 

Film posters being the most significant form of publicity is a symbolic visual 

representation of film in two dimensions where it condenses all the value and theme of a film 

in a single static plane. It features images and text to create first-hand visual experience to its 

audience. Keeping the mass audience in mind, the use of textual content is very strategic. 

Because of the regional language problem and low literacy levels in majority of the 

audiences, posters show minimum textual content to cater all. The textual content generally 

includes film title, tagline, credit block, and names of leading characters. Title design plays 

an important role in suggesting the theme of the film. Due to advancement in the technology 

and other influential factors, title design has seen gradual changes in terms of form, style, 

texture, colour, composition, perspective and typeface. 

The Film posters in India also reflect the diversity of its audiences in terms of culture, 

religion, class and language. Though the films titles are mostly remains in Hindi across the 

timeline, one can observe the changes in film title from trilingual script i.e. Latin, Devanagari 

and Urdu to mainly Latin due to multiplex paradigm. Also the changes in literacy rate can be 

observed through the changes from decorative lettering to more sophisticated and modern 

typography. 

Let‘s discuss the role and development of title design in Bollywood film posters by 

using semiotic framework. Through this analysis the relation of title with respect to layout of 

the poster, letterform, film genre, treatments and poster production techniques will be 236



 

 

 
 

discussed. 
 

Outcomes 
 

Upon completion of this unit you will be able to: 
 

• Have understanding about title design of film posters in Indian film industry i.e 

Bollywood 

• Analyse the adaptation and evolution of the title making 
 

• Understand the use of fonts, image resolution, colour in titles making 

• Understand credit making 

Terminology 

2K: 2048 pixels 

Gestalt Theory: Gestalt theory is an attempt to state the laws of visual reconstruction. 

Semantic Analysis: Semantics is a study of meaning. It deals with the generation of meaning 

from any sign. This section enquires the relationship of title to the theme or story of the film. 

Pragmatic Analysis: This section enquires about the title design in relation with the context. 

Basic Design Issues 

Choice of font 
 

The film title is meant to establish the context and set the tone of the movie, where 

typefaces could be a powerful assistant towards this goal due to their second-level 

communication abilities and special expressive qualities. Type contains impassioned rhetoric; 

the magic is hidden under the appearance of each typeface. Thus choosing a suitable font is 

the primary task, a designer needs to accomplish when assessing a project. However, 

typography has about a five hundred year history in the West, which has left a forest of 

typefaces. Computer techniques have created even more of them. How to get to know each 

typeface‘s individual identity? A typeface classification could be a shortcut. There have been 

various classification systems to use. Each of them could be an essential tool to help a 

designer in selecting appropriate typefaces that enhance the expressive message in 

typography. It is always recommended for designers to spend some time taking a look at 

certain kinds of classification before actually working on the design. 

Image resolution 
 

When film frames are stored digitally, the resolution of the image is measured in 

thousands of pixels across the frame or K. A horizontal resolution of 1K means 1024 pixels; 

2K is 2048 and so forth.1K resolution is the lowest, yielding a result that is similar to video. 

2K resolution is the most common because of reduced file size and less taxing throughout 
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requirements (data flow). 3K and 4K are also common and they are the most aesthetically 

desirable because the threshold of human vision is about 2500 x 2500 pixels when viewing 

an average movie theatre screen (if the picture were square). Pixel height varies depending on 

the aspect ratio. In Table 1, we can see the rule of correspondence between image resolution 

and mass storage size request. 

Understanding the image resolution is especially important when we are digitalizing 

images for eventual film output. We can calculate what the appropriate scanning resolution 

should be, by dividing the film resolution that will be used by the horizontal dimensions of 

our image in inches. For example, if the output resolution will be 2K and our image measures 

10 inches horizontally, we would scan it at 200 dpi. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Table-1 Drawn by Author 
 

Colour 
 

The printing world operates on inks and full colour (CMYK) mode. Traditional 

typographers deal with Cyan, Magenta and Yellow inks, which are known as ―Subtractive 

Colours.‖ If subtractive colours are printed overlapped in the same proportion on white paper, 

they absorb the light shining on the page and we perceive pure black. The world of on-screen 

publication is built upon lights rather than inks. Designers uses ―additive colors‖ namely 

Red, Green and Blue light. If all the three coloured lights are put together on the screen, we 

get white light, not ―black.‖ Black can only be reached if there is no light involved. RGB 

principles are those behind computer and TV monitors as well as the movie screen. 

Designing Over Space 
 

A designer needs to consider many fundamental elements in designing the title 

sequences. The following section will briefly introduce some of the most basic concepts and 

then explain how these principles will affect the title sequence design. 

Visual perceptions 
 

Designers always wish for desired responses from audiences through the visual 
 



 

 

 
 

expressions. Before talking about how to position visual elements within a frame (the concept 

of frame will be explained later in the section on ―frame and aspect ratio‖), let us take a look 

at how human beings perceive visual objects and environments. Since seeing is not just an 

optical process but also a process of our thinking, the early researches on the laws of visual 

perceptions were pioneered by physiologists whose concerns were human mind and brain. 

Gestalt Theory 
 

Gestalt theory is an attempt to state the laws of visual reconstruction. Although 

computer-based design follows several new disciplines, it has not yet fully exploited the 

Gestalt theory results. This section briefly reviews the basics of Gestalt theory and explains 

how it can be used to render desired perceptions. As a theory of mind and brain, Gestalt 

theory proposes that the operational principle of the brain is holistic, parallel and analog with 

self-organizing tendencies or that the whole is different from the sum of its parts. Some of the 

key principles of Gestalt systems include 

1) The law of figure and ground 2) The law of similarity or proximity 3) The law of 

closure 

The law of figure and ground captures the idea that the visual field is normally 

divided into two parts, figure and ground. Some elements are contrasted with other elements 

to give the impression of a whole. 

The law of similarity dictates that the mind, groups similar elements into collective 

entities of totalities. Such similarity might depend on relationships of form, colour, size or 

brightness. In the figure, the filled circles give the impression of three horizontal lines. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Gestalt principle composition 

Attribution- Impronta 

https://commons.wikimedia.org/wiki/File:Gestalt_Principles_Composition.jpg 

The law of closure applies when people see complete figures even when part of the 

information is not provided. In the following figure, a complete three-dimensional sphere is 

seen, where in fact no such thing is drawn 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Gestalt principle composition 

Attribution- Impronta 

Link- https://commons.wikimedia.org/wiki/File:Gestalt_Principles_Compositi on.jpg 

Methodology 

Human beings always try to interpret thing as per their understanding and background 

knowledge. We can‘t take reality for granted and define it objectively. Semiotics teaches us 

that reality is a system of signs. Studying semiotics can help us to be more aware of reality as 

a construction and of the roles played by everyone in constructing it. Semiotics is a study of 

signs and according to Saussure anmodel; the sign is the whole that results from the 

association of signifier and the signified. This relationship is called as 'Signification' and the 

value confirmed by a sign depends on its relationship with other sign within the system. The 

meaning making and persuasion of Bollywood films posters depends on relationship 

generated by different components of the film posters. Title designs in these posters are 

analysed separately by syntactic, semantic and pragmatic approach. 

Syntactic is a study of relationship among signs in formal structure. It is useful to 

understand structural relationship among the parts of sign. This section utilizes the syntactic 

principle to see the relationship of title design with respect to poster layout, letterform 

structure and kind of treatment. 

Semantics is a study of meaning created by signs in a system, where they interact with 

others signs. This approach helps in analysing title design to see how effective is the film title 

in overall meaning in relation to the film story and genre wise type classification. 

Pragmatics is study of relationship between signs and sign-using agents. Here context 

contributes to the meaning and interpretation of particular design. This approach helps to see 

the effect of poster production technique, display positions and display technology on title 

design in films posters. 

 



 

 

 
 

Syntactic analysis 
 

Poster layout, letterform structure and decorative elements play a key role in the 

overall title design and its expressiveness. In this section title design is examined based on its 

structural parameters like layout and typography. 

Poster layout 
 

Title has occupied different positions in poster layout. Figure-3.3 shows three possible 

position of title in film posters. Out of 129 posters taken for an analysis, 61% shows title at 

bottom whereas 28% at top and 11% in the middle. Positioning of title was also influenced by 

the visual hierarchy principles. In maximum cases central characters has been considered as a 

primary element of the poster. This put title at secondary position in term of importance. So 

in most of the cases central space is occupied by the leading character‘s visuals whereas title 

comes next to it. When it comes in centre of the poster, in 73% cases it is horizontal whereas 

17% shows diagonal orientation. 

 
 
 
 
 
 
 
 
 
 

Figure 3.3 Title position with respect to poster layout 

Designed by Author 

Letterform 

In a title design, individual letters act as a building block where its structure and style 

contribute a lot in suggesting the film‘s theme. The denotation of individual letters is a 

straight forward task. Anyone who knows the written language can read and understand the 

literal meaning of the title but the constructive meaning can only be generated through the 

understanding of message hidden somewhere in the style and structure of the individual 

fonts. When we analyse the individual letters across the title, it gives an interesting statistics. 

Approximately, 63% posters show title in uppercase, whereas 23% in title case, 3% in 

lowercase and 11% with mix lettering. 

Use of decorative elements 
 

Posters are made to attract the viewer at first sight. They are also competing with the 

other visuals across the city wall to draw attention. This competitive streetscape culture leads 

designer to give some ornamentation to title so that it can stand out as a poster. Titles in 96% 

posters show the use of decorative elements to make it more prominent and appealing. Out of 



 

 

 
 

124 titles, 89 (72%) titles show decoration in terms of outline and shadow whereas 35 (28%) 

titles show decoration by manipulating text and image. Films like Anand (1970), Aradhana 

(1969), Upkar (1967), Ghulami (1985), DilwaleDulhania Le Jayenge (1995) are some 

example in second category. Contrast colours are prominent in title design throughout the 

timeline. 

Semantic analysis 
 

Semantics is a study of meaning. It deals with the generation of meaning from any 

sign. This section enquires the relationship of title to the theme or story of the film. 

Title design based on meaning of title 
 

Title design in posters in the early period of Bollywood cinema shows very minimal 

variations in letterforms irrespective of the meaning of the title. Letters have been designed 

randomly like in Bandhan (1940), Ram Rajya (1943) or Anmol Ghadi (1946) showing 

individual artistic skill and style. Some of the exceptions from this era wereBarassat (1949), 

Aan (1952), Jewel Thief (1967) and Aradhana (1969). Barasaat in which artist has used rain 

strokes to give the feeling of rain whereas in Aan poster letterform is in bold, 3D perspective 

placed in the background in such a way that it reflects the meaning of ‗Aan‘ or pride. But this 

kind of exploration was rare till 1960s, where only 13% title designs show relationship with 

the meaning of the title. 

Beginning of 1970s saw a dramatic increase in the use of expressive typography in the 

title design. As shown in Figure 3.4, poster of films like Mera Nam Joker (1970), Bobby 

(1973), Andhi (1975), Sholay (1975), and ShatranjKeKhiladi (1977) are some example of this 

trend. In title Gadar, the letter has been designed in such a way that it reflects the literal 

meaning of the title whereas in MeraNaam Joker the form of letters has been designed to give 

a sense of comical and jovial mood. It is interesting to see the letterform in the title 

ShatranjKeKhiladi where each letter is designed to look like 'Mohra' (64 square pieces in 

chess), exactly relating with the chess game. In similar way the fluffy form and colour of 

letters in Bobby, flowing strokes of letters in Aandhi and flame colour with cracks in Sholay 

reflect the meaning of the title in first sight 

 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Figure 3.5Film titles where letterforms directly relate with the meaning of the title. 

This trend continued during 1980s and 1990s with some prominent example like 

Disco Dancer (1982), Coolie (1983), Razia Sultan (1983), Ghulami (1985), Tezaab(1988), 

Agneepath (1990), 1942 a Love Story (1994), Rangeela (1995) and Satya (1998). Like in 

Razia Sultan, the title and letterform are made in such a way that it looks like a fort in the 

background. This goes well with the heroic nature of Razia Sultan and reflects her power in 

theposter. 

By the end of 1990s and beginning of 2000s design studios were taken hold of poster 

making in the Bollywood film industry. Advancement in technology and availability of 

different medium gave more opportunities in designing film‘s titles. Designers cleverly 

exploited text-image relationship to make title more attractive and meaningful. When it 

comes to the whole title composition and its meaning, in most of the cases it succeed in 

conveying the gist of the film. Looking at the poster of first full length Indian film Raja 

Harishchandra (1913), by DadasahebPhalke, the title itself is giving a sense that the film is all 

about the legend Raja Harishchandra, a story from Indian epic. 

Title design based on film story 
 

It is difficult to relate the letterform with the meaning of the story. Very few movies 

title has been designed according to the meaning of the story. To reflect the story, exploration 

was done mainly with letterform structure and colour. Khiladi (1992) is one example where 

letter ‗A‘ is replaced by human figure holding gun in hand to reflect the action in the film 

irrespective of the literal meaning of the title which is player. 

Most of the Indian films are melodramatic with full of emotions, drama, action and 

more. This makes difficult for an artist to design a film poster which can represent all 

parameters of the film. So in most of the cases the letterforms depict only a part of the total 

theme of the film. As shown in Figure-3.5, letterforms in the title of Disco Dancer (1982) 

reflect the theme of the film which is musical and romantic. The use of led bulb to create the 

type, which gives a sense that this is a film revolving around a disco dancer but this is one 

part of the film. The other part is action, revenge and family drama. 

 
 
 
 
 
 
 
 

Created by Author 

Figure-3.5 Letterform going with central theme of the film 

Title design with external semantic elements 



 

 

 
 

Film posters are meant to invite the viewer to watch the film. Thus it is important that 

posters should show the highlights of the film into prominence. Till 1960s Bollywood film 

poster were less explored in terms of use of external type elements. In most of the cases title 

designs were plain and variations were limited to orientation, texture and forms of the letters 

and in some cases with perspective style. From mid 1970s, designers started using some 

external typo elements or ―image as a type" for title design. A symbolic language was 

developed to communicate with illiterate people. 

This style comes randomly in many posters throughout the timeline. Images were 

interestingly used as a type in many movies like TeesariManzil, MeraNaam Joker, Khiladi, 

Zanjeer, Coolie, Ghulami, DilwaleDulhania Le Jayenge, Border, LOC, Iqbal, Raja 

Hindustani, Rab Ne Bana Di Jodi and many more. This introduction of images as a type plays 

an important role in making posters more persuasive and powerful in terms of conveying 

message of the film. 

Letterforms with respect to genre of the film 
 

Having the melodramatic nature, it is hard to categorise most of the Bollywood films 

into a specific genre. The basic genres in which most of the films fall under are social, 

romantic, comedy, action and thriller. The industry started with film based on epic story like 

Raja Harishchandra (1913), Alam Ara (1931) and later dominated by romantic and action 

films. The "Golden period" of Hindi cinema (1940s to 1960s) gives some of the most 

critically acclaimed films of all time featuring the social themes mainly dealing with working 

class urban life in India. Films like Awaara (1951), NayaDaur (1957), Shree 420 (1955), 

Pyaasa (1957) and Mother India (1957) are few of them. The print technology was limited 

and result of it. The main emphasis was given to keep titles plain and simple. Some 

exceptions like Mugha-e-Azam, where artist has used 3D perspective and shadow to create an 

illusion of fort suggesting a historical genre. 

In the 1970s, India was going through social and economic changes and this 

influenced the Bollywood film making significantly. Industry came up with more of action 

and violent films in terms of commercial cinema. Films like Sholay (1975), Deewar (1975) 

and MuquaddarKaSikandar (1978) are prominent examples of this genre. In most of the cases 

letterforms have followed similar patterns, like use of outline, 3D perspective and shadow to 

create emphasis irrespective of genre of the film. Action films established the trend of using 

3D style decorated with shadow and outline gel well with the film genre. This type of 

lettering dominated upto 1980s and became a trend throughout the decades independent of 

film genre. 

 
 



 

 

 
 

Pragmatic analysis 
 

This section enquires about the title design in relation with the context. It enquires 

how designing of the title in film poster has been influenced by the techniques of poster 

productions, display positions or platform and technology. 

Poster making techniques 
 

In the beginning of Bollywood film industry, only hand painting was in use for 

making posters and lithography was the only technology for mass production. These 

limitations in a way restricted the possibilities in terms of font exploration, whereas in other 

way gave freedom to use style and imagination of the artists. Because different hands were 

involved, no specific pattern has been followed till 1970s. Cut-paste technique was 

introduced in early 1970s, which has been overcomed by computer in 1990s. 

Display position 
 

A display position is one of the deciding factors in terms of title design. What would 

be the distance of viewer from the poster, whether it will be used for day light display or 

night, kinds of viewer (rural or urban), whether it is alone or competing with surrounding 

environment full of other forms of advertisement, all these parameters are deciding factors in 

title design. These constrain makes designer to think about the size of fonts, visibility and 

contrast in the poster. Extensive use of bold, sans-serif and 63% uppercase letterform reflects 

the designers‘ concern. Letterforms in most of the cases are shadowed and decorated with 

outline in contrast colour so that it can stand out of the poster. 

Till late 1960s, when there was no regulatory rule about the poster display platform, 

there were plenty of spaces in the society to use for the poster display. So posters are used 

everywhere, above eye level, bellow eye level, far from the viewer as hoardings or just side of 

the viewer on the sidewall of the street. This might be the reason behind random positioning 

of title in the film poster. Since late 1970s, when guidelines on outdoor advertisement were 

made by the Indian government, poster designs became more standardized and in majority of 

the cases titles started appearing in the bottom of the film posters. 

Findings reveal that variation in the structural elements in title design has lot of 

syntactic, semantic and pragmatic influences. Syntactic influences in structural variations 

include stroke thickness, weight, texture, colour and letter-spacing. In most of the cases 

(96%), titles are decorated with outline and shadow to create more emphasis. Semantic 

influence has been adapted by the use of decoration and external semantic elements. A 

symbolic meaning has been created by manipulating letters and use of colour. It evolved 

gradually and usage of external typo elements became evident in the later period as out of 35 



 

 

 
 

titles showing image-text manipulation, 31 (89%) are from 1960s onwards. External typo 

elements like use of Coolie badges in the place of letter ‗O‘ in film Coolie (1983,) enhances 

this ability by making it simpler for common viewer to read and understand the hidden 

meaning behind the title. Expressive typography maximizes persuading ability of film poster. 

There are also pragmatics aspects involved in the title design variation like positioning of title 

in the film poster and context of usage. Advancement of technology has its effect on the title 

characteristics across the timeline. The sample size used for this study is not statistically 

significant to generalize any arguments. But it definitely provides enough qualitative insights 

to predict few trends and various causes responsible for those trends. For future study it will 

be interesting to regenerate these patterns by considering more number of posters from each 

decade. Future study can also explore the relationship of film title with other elements in the 

film poster. 

Frame and aspect ratio 
 

A frame is a single still image, the smallest component of a sequence. In a movie, all 

actions take place within the borders of the screen or frame – much as if it is a room. Thus 

designers of kinetic type in a movie, need to make decisions about the compositional 

proximity of the text and objects to the edges of the screen/frame. The issue regarding the 

dimension of the screen/frame is termed ―aspect ratio.‖ The aspect ratio of an image is its 

width divided by its height. 

There are a number of aspect ratio standards used in movies and videos. Three of 

them, namely Academy Standard, Academy Flat and Cinemascope are the most influential or 

common ones in movies. 

Academy Standard 
 

The Academy Standard refers to the aspect ratio of 1.37:1, which was used almost 

universally in 35 mm full-screen sound film images or 16 mm standard professional formats 

between 1932 and 1953. This ratio means that the picture is 1.37 times as wide as it is tall. 

(Note that1.37:1 standard is referred to as 1.33: 1 by Krasner, 2004, p. 316.) 

Recognized officially by the Academy of Motion Picture Arts and Sciences (AMPAS) 

in 1932, the 1.37: 1 aspect ratio eventually became known as ―Academy Standard‖ or 

―Academy Ratio‖ for movies. Classic films such as Gone With the Wind (1939), The 

Wizard of Oz (1939) and Singing in the Rain (1952) appeared in this ratio according to the 

IMDb database. This standard is still occasionally used. 

Academy Flat 
 

The so-called ―Academy Flat‖ aspect ratio was developed in the circumstances that 

film had to compete against the threat from television. One of the film industry‘s weapons 



 

 

 
 

was ―wide-screen pictures.‖ The development of wide-screen formats aimed to create a 

more visually breath-taking experience that would give viewers an incentive to attend the 

theatre rather than stay at home. An aspect ratio of 1.85:1 served this purpose. It was usually 

used for 35 mm US and UK widescreen theatrical films and was known as ―Academy Flat.‖ 

In the US, 35 mm was usually projected at this wide-screen ratio by cutting off the top and 

bottom of the frame. Films shot in this ratio can also save on the cost of film stock. 

Cinemascope 
 

A less widely used wide-screen format is Cinemascope (also known as ―letter-box‖ or 

―anamorphic‖) with an aspect ratio of 2.35:1. The anamorphic standard has subtly changed 

since the 1970s. The anamorphic productions today are actually 2.39:1, which is commonly 

labelled 2.40:1, e.g., in the American Society of Cinematographers' American 

Cinematographer Manual, but often referred to as 2.35 anyway, due to old convention. 

Design structure 

Pictorial composition 
 

Pictorial composition refers to how design elements are arranged in space within one 

single frame. It is important to recognize the distinction between pictorial composition and 

sequential composition. The latter is characterized by the continuity and recurrence of 

elements between frames. Since the sequential composition is basically a time-related issue, it 

will be discussed in the later chapter of ―designing over the time.‖ 

Grid system 
 

Designers of all types (print, web, animation, etc.) are constantly facing issues 

involving the structure of their designs or the pictorial order in a moving composition. All 

those designers can get assistance from the ―grid system,‖ which is a structure made up of a 

series of intersecting vertical and horizontal lines used to divide the page into grid units or 

modules. The lines of the grid themselves are not necessarily visible (although in some 

designs they are). 

Grids allow for the distribution of typographic elements in a clear, intelligible order. 

They work such that certain design elements occupy one unit or module, while others can 

deviate and intrude into other units or modules. Design elements can also align according to 

the grid. Once a general grid has been set up, the designer can always deviate from it. 

It is said that grids can help refine the approach to spatial organization, establish 

consistency within the design, achieve balance, help organize complex information within a 

rectangular space and allow the information to be communicated clearly and effectively. 

Should a designer decide to use a grid, it is best to sketch it out on paper first and then 
 

implement it in the application. Most animation programs provide guidelines that can be 247



 

 

 
 

adjusted and locked to position elements into vertical or horizontal alignment. 
 

Designing Over Time 
 

Frames, shots, scenes and sequences 
 

Any film is composed of frames, shots, scenes, and sequences. A frame is a single still 

image, the smallest component of a sequence. A shot is a combination of frames that contains 

a continuous action. Juxtaposition of groups of related shots composes a scene. Finally, 

scenes can be assembled in a specific order to create a sequence that expresses a narrative or 

atheme. 

Computer animation 
 

Animation with the aid of computer technique is called ―computer animation.‖ The 

most basic computer animation tools assist the process of traditional animation by 

automatically generating some of the frames of animation. Traditionally, animators needed 

tohand-draw illustrations and photocopied frame-by-frame onto ―cels‖ (transparent acetate 

sheets). The final art was photographed one-by-one onto motion picture film by a camera. 

Computer animation works in a totally different way. For 3D animations, objects are 

modelled and rendered with 3D and lighting software. Models are rigged with a virtual 

skeleton, which contains many ―joints.‖ The animator can make the model ―move‖ by 

dragging and controlling the skeleton and joints. For 2D figure animations, separate objects 

(illustrations, graphics) and separate transparent layers are used, with or without a virtual 

skeleton. To make the objects move, animators create the important frames of a sequence 

called ―key frames,‖ then let the software calculate and generate the in-between frames 

(animations). Such technique is known as ―tweening‖ or ―morphing.‖ 

Credit Making 
 

Rolling credits is a technique used to give acknowledgement to those who have 

worked on your project. The main benefit to creating rolling credits (as opposed to having 

multiple names on a still frame) is that the movement helps keep the viewers interested. You 

can roll your credits on any background. Depending on your video you might choose to use a 

solid background, or use different pictures. 

Rolling Credit Basics 
 

To create your rolling credits, you'll need two clips and two layers in Timeline mode. 

One clip (bottom layer) will be the background where your credits will roll. The other clip 

(top layer) will be your text clip and will be where you‘ll write your credits 

Unit Summary 
 
 



 

 

 
 

Titles are important in creating first impression of a film. Titles along with opening 

credits play an important role in introducing the film and setting the mood. Making good title 

and credit line is also a serious art form. Titles can be made with syntactic, semantic and 

pragmatic approach. Fonts, use of semantic elements, display position etc pay an important 

role in making effective titles and credit lines. 

Assessment 
 

1. What are the three components of design over time? 

2. What are the components of design structure? 

3. What is the difference between academy standard and academyflat? 

4. What is Gestalt theory? 

5. What are the components of design over space? 

Resources 

• https://link.springer.com/book/10.1007%2F978- 81-322-2232-3 

• https://www.intofilm.org/clubs 

• www.svnfilm.com 
 

• www.videomaker.com 
 

• www.junctiongoogle.co.uk 
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https://www.intofilm.org/clubs
http://www.svnfilm.com/
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http://www.junctiongoogle.co.uk/


 

 

 
 

Unit 4 Stop Motion Animation 

Introduction 

Stop Motion Animation is a technique used in animation to look at static object as a 

moving animation on a screen. This is done by moving the object in increments while filming 

a frame per increment. When all the frames are played in sequence it shows movement. Clay 

figures, puppets and miniatures are often used in stop motion animation as they can be 

handled and repositioned easily. 

The basic process of animation involves taking photograph of your objects or 

characters, moving them slightly and taking another photograph. When you play back the 

images consecutively, the objects or characters appear to move on their own. 

Animation creates the impression of movement through an optical illusion referred to 

as the ―Persistence of Vision.‖ The eye retains an image for a split second after it has 

actually been shown. Animation works by presenting slightly different images in quick 

succession, with the persistence of vision filling in the gap between each image and allowing 

for the illusion of motion. 

In the 19th century, this phenomenon was made use of in many children‘s toys that 

some students may still be familiar with. 

Outcomes 
 

Upon completion of this unit you will be able to: 
 

• Learn about the basics of Stop motion animation 
 

• Understand the importance of story and subsequent character, sets and props 

• Know the use of various equipments 

• Learn how to use PowToon open source free software to create stop motion 

animation Terminology 

Flick book : A collection of slightly altered images bound at one end to allow the user to 

flick through the images by hand. 

Zoetrope: It is a cylindrical drum with slits cut into the sides 
 

Powtoon: This is Web-based animation software that allows users to create animated 

presentations by manipulating pre-created objects, imported images, provided music and user 

created voice-overs. 

Storyboard : An outline of visual idea. 

History 

Thaumatrope 



 

 

 
 

Made popular by John A. Paris in 1824, thaumatropes work by presenting two 

separate images on the front and back of a piece of card with string attached to each side. 

When the card is spun quickly using the string the two images are shown in quick succession, 

giving the illusion of one image. 

Mutoscopes 
 

Mutoscopes were manufactured between 1895 and 1909. To achieve the illusion of 

movement, a series of slightly altered images were mounted onto a circular core (a bit like a 

Filofax) and then turned quickly using a handle or crank. Mutoscopes were coin operated; the 

viewer would put in their money and then turn a crank to see the animation 

Flick books 
 

Flick books were invented in the latter half of the 19th century and it is thought that 

the first flick book was created by John Barnes Linnett in 1868. Flick books use the 

persistence of vision in a similar way to mutoscopes to fool the eye into perceiving motion. 

Flick books are essentially a collection of slightly altered images bound at one end to allow 

the user to flick through the images by hand, viewing the images in quick succession and 

creating the illusion of movement. 

Zoetropes 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Zoetropes 

Attribution-Andrew Dunn 

Link-https://commons.wikimedia.org/wiki/File:Zoetrope.jpg 

Zoetropes were also invented in the 19th century and use the persistence of vision to 

fool the eye into perceiving motion. A Zoetrope is a cylindrical drum with slits cut into the 

sides. On the inside of the drum are a series of slightly different images so when the drum is 

rotated the viewer looks through the slits to see the animated movement. The invention of the 

Zoetrope is credited to William George Horner in 1884, although a variety of Zoetropes that 

uses a similar principle are thought to have been created in China at around 100 BC. 

Story 
 
 



 

 

 
 

Before you start any animation, you will need to come up with a story that you want to 

bring to life. This could be as simple as a character or two, coming into the frame and doing 

something visual like jumping in the air or simply two characters having a conversation. 

Keep it simple 
 

The more characters you have, the more time it takes to create your animation and the 

more complicated the story becomes, so use not more than four characters to begin with. 

Remember, you also have to make sets and backgrounds for each scene in the film, so it is 

good to limit your story to four different scenes maximum if you only have a short amount of 

time. Get clear guidelines and set limits on what the film needs to include. By limiting them 

to four characters and four scenes, you are also asking them to think about how they can 

convey the story concisely and in a visual way. 

Keep it familiar 
 

Animations can take a long time to make (just like anything worth doing), so it is 

important that Animator do not spend all day deciding on the storyline. You could base the 

animation on something simple that you have been studying recently, or take your inspiration 

from a film you have recently seen. By having a starting point such as lyrics from a song, a 

topic, a prop to include or a suggested title you can focus the story, while still thinking 

creatively about the film and visual storytelling. 

Pitch it 
 

Share your ideas for the film. Select the best idea, based on consensus. 

Split it into scenes 

Once you have your basic narrative in place, it is required to break it up into different 

scenes. This helps to start visualising their film and gives you an opportunity to start listing 

the set, props and background models to be made for each scene. If you are working in team, 

you can split them among members, with each one being responsible for a different element 

of model making. For example, one member could design the main characters, while another 

team could make the buildings needed and the third team could craft the props, trees or 

outside spaces. 

Character, Set and Props 
 

The star of your animation could be anything from models made out of clay/dough, 

paper cut-outs, to toys, food and cutlery or real people. All you need to do is adjust their 

position between frames to create the illusion that they are moving. Have thorough 

understanding about how you are going to film the models, so that you can visualise the best 

way to make them. If you are going to be filming with the camera resting on the table, then 



 

 

 
 

the characters are required to be able to stand up unaided or be stuck against a wall. If you 

film using a tripod with the camera pointed downwards, then the characters will need to be 

flat onto the surface. Also, it is a good idea to decide the scale for your animation early on. 

You can make your models as large or small as you like, but characters, props and 

backgrounds need to be to, of the same scale. It is a good idea to know the areas you will be 

animating first, and then you can decide the scale required for the models. 

Modelling clay 
 

A quick tip for creating modelling clay characters is to keep them strong and simple – 

you do not want pieces falling off, as you are adjusting their limbs. You may try to shape the 

characters flat onto the table - this is fine for light weight paper cut-outs but will make clay 

characters too flimsy. Start them off with blocks or round balls rather than thin strips and 

encourage them to build models with a flat round base. Thin legs can be a weak area that 

might see your characters topples over. 

Example film: Binn Bunny Goes Green 

Paper cut-outs 

You could also create characters out of paper or card. Paper figures might be easily 

broken, so try to use thin card or reinforce coloured paper with card. Draw the characters 

with long arms and legs, then these can be cut out and reattached at the joints with adhesive 

putty or split pins ready to animate. Remember when using adhesive putty less is more. You 

don‘t want to be able to see the putty past joints as you move your character, so be quite strict 

with the amount you give out. Unlike Claymation, anything you make using paper cut-outs 

will be in 2D. If you have time, you could make profile and front-on versions of the main 

characters and models to add depth to your animation. A good cheat is to put detail on both 

sides of your model, so that one model can be used for the front and back of a character. To 

give the illusion that a character is turning to the side, simply swap your front-facing 

character for the side profile. 

Silhouettes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Silhouettes Source-Pixabay.com 
 

Link-https://www.pexels.com/photo/light-sky-sunset-people-40723/ 
 

Using a lightbox can create a very dramatic and filmic aesthetic for your animation. 
 

Lightboxes can be bought cheaply. For a bold and eerie animation, use black card to create 

silhouetted characters, backgrounds and sets. Any details, character features and definition 

should be cut out so that the light can shine through the card. Cut out windows, cut around 

doors (leaving the hinge attached) and your characters can move through houses by moving 

them behind the card. Coloured acetate and thin tissue paper can also be used to add a little 

colour to your animation. Example film: Ominous Shadows 

Mixed media 
 

You can be creative and experiment with different mediums, colours and textures. 

Newspaper, corrugated cardboard, reflective paper, sandpaper and tissue paper can be used to 

create different textures and patterns. Crumpled, coloured tissue paper can be used for water 

and fire effects in particular. They could also experiment with different textures by adding 

sand to paint before painting the backgrounds. 

Example film: High Above the Sky 

Equipment 

Cameras 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Camera 
 

https://www.pexels.com/photo/light-sky-sunset-people-40723/


 

 

 
 

Attribution-Martin Foskett 
 

Link-https://www.pexels.com/photo/television-camera-broadcast-camera- 67654/ 
 

You can capture frames with a video camera, stills camera, tablet or mobile phone and 

then transfer the images onto a computer to edit. You could also try stop-motion software, 

capturing the frames directly into a timeline. The most important thing to remember is to keep 

the camera still and in the same position. A good idea is to sticky tack your camera down to 

the table so that it does not move, or alternatively you could mark its position with tape. When 

using sticky tack, be careful to ensure that the frame is straight, as this may affect the film 

when you put it alltogether. 

Tripod 
 
 
 
 
 
 
 
 
 
 
 
 
Title-Tripod Attribution-Photo mix 
 

Link-https://www.pexels.com/photo/black-dslr-camera-mounted-on- black-tripod-212372/ 
 

If you are using a tripod, mark where the legs are placed with duct or masking tape, so 

that if the tripod is knocked you can line it up to the original position. This is where using 

animation software such as iStopmotion can be really helpful as it keeps your last image up 

on the screen whilst also showing you the live feed image from your camera, allowing you to 

match up the images. This process is called ‗Onion Skinning‘. Tripods are particularly useful 

when using a light box to animate. Ensure your tripod can be tilted 180 degrees as this will 

allow you to shoot from above onto a flat surface. 

The bare bones 
 

A tripod and camera are not always necessary – for example, you could use the inbuilt 

camera on your laptop with free software like iMovie or Windows Movie Maker or you could 

simply take images with your phone or camera and feed them into the software with a USB 

lead. The most important thing is that you are able to get a clear, straight photograph of each 

movement of your set, work with what you already have. To begin with, the process of 

animating is more important that the equipment used. 

Animating 
 

Now that you have your set, props, characters and equipment in place it is time to 
 

https://www.pexels.com/u/knelstrom/
https://www.pexels.com/photo/television-camera-broadcast-camera-67654/
https://www.pexels.com/photo/television-camera-broadcast-camera-67654/
https://www.pexels.com/u/knelstrom/
https://www.pexels.com/photo/black-dslr-camera-mounted-on-black-tripod-212372/
https://www.pexels.com/photo/black-dslr-camera-mounted-on-black-tripod-212372/


 

 

 
 

start animating. At this stage it may be a good idea to split the class up into small groups of 

four or five with each group taking a turn to animate. This will make things easier to manage, 

will ensure everyone has the opportunity to animate and will prevent you from becoming 

restless with the process. It could also be an idea to split the sessions into Pre-production and 

Production days if you have the time to do so. If you have the space, equipment and staff 

available you can also set up multiple animating stations and animate scenes simultaneously. 

On your marks 

Put all models and scenery in place for the first scene to begin. It is a good idea to take 

four or five establishing frames at the beginning of every new scene; this will slow down the 

action and allow the viewer to take in the new surroundings. 

Get set 
 

To give an impression of movement, carefully adjust your props and characters 

positions by a tiny amount. Once everyone in the group is happy then take a photograph. 

Take care that the group do not change anything that is meant to stay still. It is worth taking 

two photographs every time you move your character or object as this will help to ensure the 

movements are smooth. 

Go 
 

A thumb rule is 12 adjustments, each one captured twice on camera which will add up, 

to about one second of film. Remember to make only small adjustments each time, the bigger 

the movements between the frames, the faster the action and jerkier the animation. 

In the frame 
 

A good tip to keep their fingers out of shot when capturing each frame is to mark a 

line of the floor with gaffer tape and ask everyone to stand behind this line while one member 

captures the frame. Ask the team to give a signal to the person taking the photo each time, this 

can be ―Action‖ or simply ―Ready‖. 

The person capturing the frame can then respond, letting the team know they are ready 

to put the new frame in place. 

Software and Editing 
 

There is an easy to use animation software package in which you can make your films. 

iStopmotion can be downloaded onto macs and iPads and allows you to import images 

directly on to a timeline and export the footage as a QuickTime file to edit in iMovie. These 

both come with easy to follow instructions. You might need to play back your animation and 

check that the movements you have made are smooth and not jerky. 

Slow down and repeat it 
 

Once you have exported your footage to your editing software, it is now possible to 
 



 

 

 
 

slow down the action, simply by adjusting the speed settings. It is likely that some parts of 

the animation will have to be slowed down but you may also think about looping and reusing 

some of the footage. For example, a short scene where two characters are talking to each 

other can be looped to fit a longer conversation or reused with different voiceovers. 

Similarly, you can also reverse some of your footage to create a bigger impact, if you have 

footage of your character looking away from the camera, this can be copied then reversed so 

that the character looks away from and then back to the camera. 

The process verses the product 
 

Most computers, tablets and phones will have some kind of editing software that you 

can use, however if you don‘t have the time to make edits to your final film don‘t worry. The 

beauty of animation is that a lot of the editing is achieved ‗in-camera‘. It means that the way 

you set up the shots and the amount of movement between frames can often determine how 

smooth the finished film is. Animation is about teamwork, creativity and visual storytelling in 

which students will gain a lot in the process of making an animation, even if the finished 

product is not polished or edited to industry standard. 

Adding sound 
 

Adding voiceovers, sound effects and music will have a dramatic effect on your 

animation. Voiceovers can help to move the action along and reiterate the storyline for the 

audience. Adding atmospheric music and sound effects can help to punctuate the action, infer 

an emotion or feeling to the audience and add humour. If you are using iMovie to edit your 

films, this program comes with a bank of royalty-free music and sound effects that you can 

add to your film. If not, then there are many royalty-free music websites that you can use to 

download music and sound effects. 

Some Software Links 
 

Stick man: drawn animation http://www.stykz.net/ 
 

Stop motion animation http://www.culturestreet.org.uk/activities/stopframeani mator/ 

Stop frame animator www.culturestreet.org.uk/activitiesstopframeanimator 

Hand drawn cartoon animation http://www.pencil-animation.org 

Sound effects www.freesound.org 

Royalty free music http://www.freesfx.co.uk 
 
 

PowToon Basics 
 

PowToon is Web-based animation software that allows users to create animated 

presentations by manipulating pre-created objects, imported images, provided music and user 

created voice- overs. Powtoon uses an Apache Flex engine to generate an XML file that can 

http://www.stykz.net/
http://www.culturestreet.org.uk/activities/stopframeanimator/
http://www.culturestreet.org.uk/activities/stopframeanimator/
http://www.culturestreet.org.uk/activitiesstopframeanimator
http://www.pencil-animation.org/
http://www.freesound.org/
http://www.freesfx.co.uk/


 

 

 
 

be played for Powtoon online viewer, exported to YouTube or downloaded as an MP4 file. 

PowToon is also available on the Google Chrome Store. 

Through this tutorial you will learn to: 
 

• Access PowToon and create a presentation 

• Navigate the PowToon Interface 

• Access and use the panels 
 

• Apply the basic animation workflow 

• Publish your project 

Accessing PowToon 

Step 1:Login 

Login at http://www.powtoon.com 

Step 2: Start a PowToon 

You can create a PowToon from a readymade presentation and start from Scratch with 

or without a template. Start from scratch categories includes pre-arranged slides for 

Promotional Videos, Slideshows, Educational Clips, Info-graphic Videos and Social Clips. 

Select Edit for readymade presentations or go after selecting a Blank Project or template. 

Note: Some readymade presentations and templates are only available to Premium 

users. 

 

The Interface & Panels 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.powtoon.com/


 

 

 
 

The Library Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

The PowToon Library is made up of different categories of text, objects (shapes, 

markers), props and characters that can be added to your presentation. You can even add your 

own images to the library by selecting an Image Holder (image frame) option 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Using Items in the Library 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 

To use the Library, select a Style from the top of the panel. To add objects, props and 
 

characters simply drag/drop to the slide. 
 

Note: Some Items in the Library may be part of the premium PowToon package (marked as 

―More‖). 

The Timeline 
 

The PowToon timeline is used to add animation timing to objects in your presentation. 

1. Playhead: The playhead indicates at what second you are currently in your    

slide. You can slide the playhead throughout the timeline to preview 

theanimation for eachslide. 



 

 

 
 

2. Total Slide Time: Each slide by default is assigned 10 seconds. This can be 

decreased or increased to up to 20 seconds maximum. 

3. Object Duration Bar: Each object has an animation timing duration bar. To 

access this bar select the object on the stage and adjust the timing as desired. 

4. Object Thumbnails: All objects in the slide will appear below the timeline. 

Click on an object to adjust the effect and duration of the object. 

5. Object Effects (Animation): Objects can be set to Enter or Exit the stage 

using a variety of options including fades, directionality and even a hand 

function (where a human hand slides the object onto the presentation). Each 

object can be animated using these effects. Note: You can also Flip an 

object‘s orientation from this area. 

6. Playback Controls: Helps you to preview your presentation animation as you 

go. 

Note: There are four playback options • from left to right • 
 

(a) Play all slides from start (b) play current slide from start (c) play from play head 

then continue (d) Play current slide. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

The Slide Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

The Slide Panel contains your slides for your presentation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Slide Options: You can add/remove and duplicate slides (all objects and timing). Note: You 

can also clone slides, which duplicates the previous slide with the last frame (1 second) on it. 

This can help you make a smooth transition from slide toslide. 

Presentation/Movie Mode: Toggle between the movie and presentation modes depending on 

how you want to show or explain your information. Note: Presentation mode allows you to 

create Hold Points for live presentation narration. 

Transitions: Transitions between slides can be added by accessing the Transition Options 

from the Library Panel. To add a transition, select the slide and click on the desired transition 

effect. The transition will appear below the selected slide and the name of the transition effect 

will appear between the two slides. Note: Transitions are a standard length and cannot be 

edited. To remove a transition, select the slide and from Transition options from the Library 

Panel, select None. 

 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Layouts: Layouts for slides include animation placeholders and basic timings. Access the 

slide layout options by clicking on the slide and selecting the layout option‘s tab. A menu of 

layout will appear. Select a layout. 

Edit the individual items on the slide and timings to adjust the effects. 
 

Note: You can only apply a layout option to a slide once. To apply a new layout, simply add 

a new slide and select a new layout option. 

 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 
 
 
 
 
 
 



 

 

 
 

The Menu Panel 
 

The Menu Panel contains features common to many presentation tools. 
 

1. Save: although PowToon will autosave every 5 minutes, it is important to 

save regularly. 

2. New: to create a new PowToon. 
 

3. Cut, Copy, Paste: cut, copy and paste slides and objects in your 

presentation. 

4. Sound: add a sound file (import, record or use a track from the PowToon). 

5. Image: Import image from computer or from the web. 

6. Text: add text to a slide and format text options. 
 

7. Preview (Share/Link, Embed): Select preview to review your PowToon and 

share via a URL link, social media site or embed into a web site. 

8. Exporting (YouTube): directly share your PowToon to YouTube or export as 

a video file (paid option). Note: free accounts include PowToon branding. 

 
 
 
 
 

Screenshot 

Basic WorkFlow 

Step 1: Storyboard 
 

It is highly recommended that you plan your presentation using a storyboard that 

outlines your visual ideas and narration. It is the most effective approach for animation. 

Step 2: Add the Voiceover/Music 
 

It is much easier to add the voiceover first then add the animations. Why? It provides 

you with the timings, making it easier to add slides and animations. 

STEP 3: Adding Sound 
 

From the Menu Panel select Sound OR select the Audio Icon from the Timeline. 

1. Import or Record Voiceover 

2. Import or Add Music Track Note: Some music requires a paid account. 

3. Adjust sound with controls 

4. Preview / Play 

5. Apply 

 
 
 
 



 

 

 
 

STEP-4 Add Slides 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
 

Using the Slide Panel add slides to your presentation based on your storyboard. 

STEP-5 Add Objects 

Drag and drop objects from the PowToon Library Panel onto your slides (including 

characters, text, objects and props). 

Tip: You can layer objects on top of each other and use the animation timings to 

introduce objects strategically to create a sense of dynamic movement and cartoon 

interaction. 

Managing Objects Managing objects in PowToon is similar to MS PowerPoint. 

• Left-click on the item to select, either hold and move on the stage with 

the mouse or use the arrow keys. 

• Use the object handles to resize the object. 
 

• Right-click for more object management options such as arrangement 

(back, front), orientation (flip), etc. 

 
 
 
 



 

 

 
 

Step 6:Animate 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Objects 

From the Timeline use the Duration Bar to animate each object on the slide. 

1. Select the object to animate. 

2. Choose an effect style for the object entry/exit. 

3. Use the sliders to adjust the duration ofthe object animation in the slide. 

4. Add/Remove overall slide timing as needed (slides can be up to 20 

seconds in length). 

Step 7: Preview 

Use the Playback Controls or select Preview from the Menu Panel to review your 

video. 

NOTE: Don‘t forget to save throughout the process of creating your presentation. The 

save feature is located in the MenuPanel. 

Step 8: Publish 
 

To publish your PowToon select from the following: Share via Link or Embed 

1. Select Preview from the Menu Panel 

2. Choose from one of the sharing options in the Preview dialog. 

Export to YouTube/Other 

1. Select Export from the Menu Panel 

In the dialog select an output option and add a YouTube Account. NOTE: In the 
 

FREE PowToon account you can only export up to 30 videos at medium resolution with 269



 

 

 
 

branding. Video exports are also part of premium packages. 
 

Unit summary 
 

In this unit you have learned the basics of stop motion animation and how to make it. 

We have discussed bout character, set and props for various different projects. Also we 

studied about various equipment used for stop motion animation and learned basics of open 

source software PowToon. 

Assessment 
 

1. What is stop motion animation? 

2. What is PowToon? 

3. True of False 
 

a. "My styles" in Powtoon is in left side of thescreen b. 

PowToon is a open sourced software 

Resources 
 

• https://link.springer.com/book/10.1007%2F978- 81-322-2232-3 

• https://www.intofilm.org/clubs 

• www.svnfilm.com 
 

• www.videomaker.com 
 

• www.junctiongoogle.co.uk 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://link.springer.com/book/10.1007%2F978-81-322-2232-3
https://link.springer.com/book/10.1007%2F978-81-322-2232-3
https://www.intofilm.org/clubs
http://www.svnfilm.com/
http://www.videomaker.com/
http://www.junctiongoogle.co.uk/


 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DMA-03 

2D Animation 
Block – V: Production / Post-Production (Practical) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Unit-1 Painting & Animating Practical 

Introduction 

 

Before beginning 2D animation, you require pictures or artistic creations. Your drawn 

edges should be converted into an advanced digital format. Keeping the end goal in mind, you 

need to check the drawn frames. So before you check them, you will need to set them up for 

the scanner. Consider the line quality that is on the paper. If it's too light, the scanner won't 

lift it up, and you will need to settle those lines in the PC or totally redraw them later. 

In this practical unit, you will learn the basics of animation techniques, 

implementation of traditional 2D techniques in digital animation, understanding the 

techniques of scanning the drawings. You will be introduced to ink paint of drawings, the 

techniques of tracking and tracing the paths, various paint techniques involved in animation 

production and painting them in 2D painting tools. Thus, you can apply the principles to 

create the animated character. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• Understand the stages of 2D animation 

• List the techniques of scanning inked drawings 

• Use GIMP to scan and edit images 

• Work with ink and paint in GIMP program 

Terminology 

Background: It is thearea where the action takes place. There are usually very few 

backgrounds in a film compared to Cels. 

Cel&Cel setup: A picture is drawn on a unique place of plastic. This plastic is called as Cel. 

At least one Cel overlays on a base which is known as Cel setup. 

Depth of Field: Depth of field deals with the range of depths over which objects in a frame 

are in focus. It forces the eye to focus on the next focal place. Depth of field is very important 

in computer animation. 

Maquette: It is a statue based on the model sheet. 
 

Model Sheet: It is the drawing of a single character in a variety of attitudes and expressions, 

created as a reference guide for animators. 

Motion Blur: Motion blur helps in bringing the frames together & eliminating the jittery 

images that can come from animation. 

 



 

 

 
 

Rough Animation Drawings: They are the original first sketches of a character in action. In 

computer animation, it‘s done with wire frames. 

Rough Sketch: It is the animator‘s drawings used in the process of creating the finished 

image to be transferred to Cel. 

Xerography: It was tested in sleeping beauty and then used for the first time as a feature in 

101 Dalmatians. 

Computer Assisted Animation: Animation performed by hand, with the computer, creating 

the in between steps. 

Background Layout: Accurate drawing that depicts everything in a scene that has to 

appear in the background, prior to the animation or background art being created. 

Ink and Paint 
 

A long time back, our only alternative for painting animation drawings was to trace 

the image with ink on top of Cels. At that point, the colours were painted onto the Cel. The 

Cels were then stacked on racks to consume scarce space. As clear as the Cels seem to be, 

they must be stacked to six or seven levels because of a somewhat loss of light and shading 

with each layer. 

Then the ongoing procedure called "Digital Ink and Paint" came. It is the similar 

process as traditional ink and paint until, after the animation drawings are finished. Instead of 

being transferred to Cels, the drawings are scanned on to computer or drawn directly on the 

digital program (for example, a Pen tablet), where they are coloured using a software 

program. With all the ink-and-paint programs now advanced features, we can paint a whole 

area in a click or use an advanced paintbrush to colour a character. We can change the line 

colour, improve the drawings, scale and adjust the animation layer, build a customized palette 

and also can export the output in various formats. In addition, all programs have the dope 

sheet for tracking record of our animation. 

With computers, exchange of artwork between different departments, states and even 

nations has become easier. 

As the cost of both inking and painting, new Cels for animation programs and the 

reuse of older Cels for new programs goes up, the cost for doing the same thing digitally goes 

down. The digital ink and paint process became the standard for animations. The 

computerized ink and paint animation drawings are created and organized in computer 

through bitmap or vector graphics. This is advanced digital procedure of traditional methods 

like morphing, onion skinning and rotoscoping. 

There are some differences between the latest ink and paint programs. The main difference is 

in the interfaces of each software, their user-friendliness, project management, 



 

 

 
 

camera and compositing functions and capabilities to keep the images as bitmap pictures or 

to vector formats. Vector Images have lowerfile sizes and can be scaled to any size without 

quality loss. 

The various procedures inside ink and paint programming are broken into different 

module. In digital painting, camera or compositing modules may not be required, so some 

selected modules should be procured to keep the cost down. These modules we use on 

different computers. 

To begin the ink and paint process, various parameters should be set for every scene. 

Each ink and paint program enables you to modify different parameters, some with limited 

options and others with a large number of options. 

Digital ink-and-paint programs arethe computerized adoption of complete2D 

animation using: 

• Scan 
 

• Tracing 
 

• Ink and Paint 
 

Choose the Right Software 
 

Picking the right software is a lot like picking the right car, but it depends upon your 

feel and preferences, you may prefer one bellow the rest. The following is a quick list of the 

best professional 2D animation software. You can use it to animate and produce your video. 

Take a look at these to determine the best fit for your skill level and budget. 

• Free software: Pencil, Ink & Paint, Tupi, Synfig Studio, Plastic 

animation Paper, Gimp, Krita etc. 

• Professional grade software: Adobe Flash, Toon Boom 
 

Let‘s select the Open Source free software GIMP as it is user friendly for 

beginners.Now we start the techniques of Paint and Animate (Scanning, Tracing, Ink and 

Paint). 

Technique for Scanning Inked Drawings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Image Scanner Attribution-User:Dhscommtech Source- 
 

Link-https://commons.wikimedia.org/wiki/File:Image_Scanner.JPG 

After all the hand drawings are finished, then it is scanned through the computer 

scanner. The large scanner with auto feeder is too expensive for a small production. These 

categories of scanners together with the right software can read the drawing sheet holes. So 

even if the drawing sheet was not properly aligned, the software automatically positions all 

the drawing sheets at the right location. 

Before we scan a drawing sheet, we need the followingtools: 

• Good scanner 

• Scanning software 

Scanning Via GIMP 

Considering your scanner has been set up and it's associated with your PC/network, 

the actual steps you use to scan a picture (or anything else) will rely upon your scanner. 

Ordinarily, it will be one of the following: 

Begin "The GIMP" to start the scan 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select "File" menu, select "Acquire" and 

afterward "TWAIN". In the event that you don't see these choices, you may need to choose 

"File > Scanner > Import". Here "TWAIN" is the scanner. 

Screen shot 

• Select the scanner, you are using from the rundown. If you don't see your scanner 

here, it might be that the scanner driver is not installed. 

 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• GIMP has accessed the scanner software via TWAIN standard. The scanner 
 



 

 

 
 

software makes it quite simple from here on. You can click "preview" to check 

that your photograph is positioned effectively or not. You can also change the 

scan quality. Note that in case you're just going to utilize the picture on the HD 

Video, 300 dpi is fine. Having said this, by increasing the resolution, the more 

detail you capture (and the bigger the image becomes). Higher resolution will often result 

in a much larger file size, so check the file size once you've scanned it. 

Screen shot 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• After clicking the "Scan Now" button, the scanner starts making noises and after a 

few seconds, the image pops up on my screen. Note that this image has been 

transferred to my graphics software (The GIMP). 

Screen shot 

So, now that the photo has been scanned, you can save it just as you would any other 

file (i.e. via the "File > Save As..." menu). Once you've saved it you don't need to do anything 

more. Having said this, you can make changes to the image as you wish. For example, you 

might want to resize it, use a filter such as "sharpen", "despeckle" etc. 

Presently the photograph has been scanned, you can save it similarly as you would 

some other file (i.e. By means of the "File > Save As..." menu). Once you've saved it you 

don't have to do much else. Having said this, you can roll out improvements to the picture as 

you wish. For instance, you might need to resize it, utilize a channel, for example, "sharpen" 

and so forth. When it's done, stop your scanning application. 

If you are utilizing your photographs on the web, you'll have to ensure you save it in 

the right format. 

 
 
 
 
 
 
 
 



 

 

 
 

Edit Scanned Image 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

If the scanning application hasn't opened up picture automatically, you have to open 

the scanned image manually. If you zoom in, you'll see it looks extremely crude and 

pixelated. It'll disappear in the subsequent steps. However, before we do that, we should 

remove the white paper background and any mistakes. Rotate image if necessary, select the 

Eraser Tool (press SHIFT + E on your keyboard) and remove any lines or those things you 

don't need. You don't have to go into the small details at this time, so just give it a quick 

correction; once over and you may save the image. 

Now, since we scanned in Line Art/Bitmap, we need to switch the mode to Grayscale, 

to do that just select Mode->Grayscale in the Image menu. A dialog box will come up, but 

just leave the setting at 1 and click OK. 

Next, open your Layerspalette; press Ctrl+L on your keyboard if it's not already 

visible. You'll see the layer's name has a little padlock next to it, so click twice on the layer's 

name and click OK, without disturbing the other settings. 

Choose ByColourin the Select menu. Set the Fuzziness to 0, click once in the white 

"paper" part of the image and press OK. 

You'll see that all the white parts of your image have been selected. Now hit 

Backspace or Delete on your keyboard, it'll be removed and replaced by a checker grid, 

indicating that it's now transparent. 

 
 
 
 
 
 
 



 

 

 
 

It is recommended to create a new white layer behind your drawing so you can see it 

better. 

Scale Image 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

In the Image menu, choose Scale image, set the Resolution to half of what it is 

currently and press OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

Here's the rundown for the GIMP user. 

• Scan your artwork in Line Art at twice your planned determination 

• Remove any evident mix-ups 

• In Grayscale Mode, open your layer 
 

• Use Select-> By Colour to choose the white foundation, at that point to evacuate 

it 

• Go to Image Size and set the resolution to half of what it was before 

• Complete 

Note: If you often scan a lot of drawings in high resolutions it is recommended that you save 

them in the bitmap mode for later use and do the following steps when you need to. In the 

long run,it becomesa huge difference in file size. Even though you might be able to get the 

same results by scanning in grayscale, adjusting the levels and removing any irregularities, 

this method will save you a lot of time. 

Preparing the Image 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

Screen shot 

• File > Open > Select image to manipulate 
 

• If necessary, Image > Transform > Rotateby necessary degrees 

• Using Rectangle Select Tool, select area of image* to be traced 

• Copy area to clipboard (Ctrl + C) 

• File>New>Choose US Letter 
 

• Paste an image (Ctrl + V) to New Untitled Image 

• Layer>Scale layer 

Path Tracing 
 

Launch GIMP and open an image that contains an object you'd like to trace. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

Press "Ctrl-B" to view the Toolbox window if it's not visible, and click the window's 

"Paths" tool to select it. The Paths tool looks like a blue pen with a yellow tip that sits to the 

right of a white bar. That bar contains three boxes stacked vertically. A white curve extends 

from the top of that bar to the brush's tip. GIMP displays the tool's name when you move 



 

 

 
 

your mouse cursor over the correct icon. 
 

Click a point along the edge of the object you wish to trace. For instance, in the event 

that you need to trace a building, click a point along the building's edge. When you do that, 

GIMP puts a little dot by then. Move your cursor a short distance along the edge and click a 

new point. GIMP puts a dot at that location and draws a short line segment between that dot and the 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

past one. 
 

Screen shot 

Keep moving your cursor short distances along the object‘s edge and clicking points to 

draw short line segment. Eventually, you will draw a path around whole object. When you 

reachthe starting point (the location where you made the first dot), double click the dot to 

finish the path. This path will comprise all the small line segments you made by putting dots 

along the path. 

Using Path 
 

Click "Windows," select "Dockable Dialogs" and click "Paths" to open the Paths 

dialog window. This window has an icon that represents the path you traced. By default, its 

name is "Unnamed." If you had multiple paths, you would see them in this window. 

 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

Review the buttons at the bottom of the window. Click the "Path to Selection" button 

if you'd like to convert the path into a selection. 

Find the window's "Paint along the Path" button. This button enables you to generate a 

line around your object automatically using the path you traced. 

Click the ―Paint along the Path‖ button, and type a value in the "Line Width" text 

box. That value determines the line's width in pixels. To draw a line around the object, click 

"Stroke". The line's color matches the project's current foreground color.The line's shading 

matches the venture's present foreground shading. 

 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

After you make a selection from a path or draw a line around an object, you can delete 

the path by choosing it in the Paths dialogue window and clicking "Delete." You would then 

be able to upgrade the selection any way you like better. 

When youtrace a path around an object, you can click and drag any dot along that path 

to modify the line segment at that location. You'll most likely need to do this since it's hard to 

trace around an object perfectly. For example, in the event that you see that one line segment 

has a space between it and the object's edge, you can click and drag the two circles at either 

end of the segment and move them to bring the segment closer to the object's edge. Your goal 

when tracing is to make your outline fit flush against an object‘s edge. 

If you want to trace a small object, do that more precisely by clicking the drop-down 

box at the bottom of the image window and selecting a zoom percentage. Select "400%," for 

instance, and GIMP makes the image four times larger. 

Tracing the Image 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

• Create New Layer 

Layer fill type Transparency (default). Naming the Layer "trace" is 

helpful. Be sure the new layer "trace" is highlighted 

• Select Pencil Tool 
 

• Choose brush size based on thickness of lines you prefer 

• Begin "tracing" the important lines of the image 

TIPS: Be sure to save your work occasionally. 

Use Zoom Tool for more accuracy 

Numbering 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 
 



 

 

 
 

 

• Once an entire image is traced to preference, Remove visibility from pasted layer. 

• This is done by deselecting the "eye." 

NOTE: Only the tracing should remain. This should resemble a line drawing. 

• Select the Text Tool. 

• Set font & size. Try Smaller, may be necessary depending on the detail of the 

trace. 

• Click on an area of the trace to be numbered. Enter # for each area. 
 

TIP: 1-5 colour regions works best. If using a colour photo, try Posterizing it before 

tracing as follows. 

• Colours>Posterize. Try 3-10 levels. 

Paint 

Scan the pencil Drawing 
 

First step is the scanner acquisition with Xsane of drawing (HB pencil on A4 paper). 

Scan it with Gray level at 300dpi. To get an excellent outcome, first clean the Background 

white. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Real pencil Drawing drawn by Author 

Paint Using GIMP 
 

This projectuses GIMP to make Paint by Number of a particular picture, be it low 

resolution GIF of some object or high resolution photograph. 

Paint and Ink 
 

Start to change to convert the pencil artwork in a light blue range of colours; use the 

tool colorize ( Color> Colorize ). 

 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

The colorize tool in action 

With the Pen tool of Gimp-painter, start to ink the drawing, on a different layer. The 

screenshot above demonstrates the setting with Pen tool. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Starting the inking process 

Toward the end, include a white layer under the line-art to complete the inking. When 

it's complete, save the work, and save in another file a duplicate of the last Line-art layer;it 

will be required later. 

Multi-Fill 



 

 

 
 

This is an important section of this instructional exercise. Include another layer under 

the line art, and start with a thinner pen in darker to draw the limit of each different color zone 

I want. I flatten the layer when it's finish. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Setting up the zone for the Cell-shading 

Launch the script 'Multi-Fill' with the same setting as in the screenshot above and let 

the scriptdetect each closed zone, and fill with arbitrary shading. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

The flatting-tools script in action 

When it's done, delete the layer above with Line-art + red limits; and load (Load as 

new layer) old copy of final Line-art (the one without red lines). 

 
 

288



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

The result of the flattingtools 

As you see on the animation above; the benefit of this script is in the clean result of the 

colorization: each zone frontier is right in the middle of the thickness of your black lines. 

Summary 

This unit focuses on three central areas of 2D animation production – 

‗Scanning‘, ‗Tracing‘ and ‗Ink &Paint‘. You have learned the selection of proper software 

for scanning and painting. Besides, we also discussed the techniques of scanning inked 

drawings, editing of scanned images, tracing of image paths, painting your imagination using 

through GIMP. 

Assessments 
 

1. How you can resize the image in GIMP? 
 

2. How do you select an exact colour to match? 

3. Explain How to organize layers? 

4. What is a lasso tool? 
 

5. Explain the difference between Layer and group 

6. Create a path in GIMP 

7. Create a duplicate layer 
 



 

 

 
 

8. Describe how to rename a layer 

9. Explain pen tool‘s job 

10. For a perfect straight line in any direction, which tool we used? 

11. Explain digital ink and paint 

Resources 
 

• Traditional animation book 

• GIMP: 6.2. Paths 

• http://www.quackit.com 

• GIMP: 6.2. Paths 

• Maximum PC: 10 Sweet GIMP Photo Editing Tricks 

• GIMP: Main Windows - TheToolbox 

• http://gimp-registry.fargonauten.de 

• http://www.questionablecontent.net 

• http://creativecommons.org 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.quackit.com/web_graphics/gimp/tutorial/about_gimp.cfm
http://gimp-registry.fargonauten.de/node/14051
http://www.questionablecontent.net/
http://creativecommons.org/


 

 

 
 

Unit 2 Understanding Background 
 

Composition 

Introduction 

In this unit you will know the practicalities of 2D animation background composition; 

explore the rationale behind various functions of layout and background composition 

principles with clear visual examples. This unit is designed chapter-by-chapter, to 

sequentially build fundamental on components of background composition with easy to 

follow step-by-step examples and diagrams. Beginners in the field will hopefully find the 

information contained here, a good starting point. 

Outcomes 
 

Upon completion of this unit you will be able to: 
 

• Understand the basics of background composition in animation 

• Plan the background 

• Create a margin in GIMP 
 

• Know how to create backgrounds in Pencil 2D 
 

• Create and design a background with multiple layers 

Terminology 

Animation Layout : Exact drawing which designs the volume and situation of activity in a 

scene. There are normally two different kinds of layout in 2D animation such as BG Layout 

and the Animation Layout. 

Atmospheric Sketches: Experimental color sketches describing the moods and setting for a 

secnce 

Background Layout : Accurate drawing describing everything in a scene that is to appear in 

the background, prior to the animation or background art being created. 

Rough Outline : It is the artist's drawings used as a part of the way towards making the 

complete picture which is to be exchanged to cel. 

Clean up: The act of standardizing the appearance of a drawing or image. 
 

Exposure sheet: A printed diagram format which shows each frame, exact layers, actions and 

dialogue columns for different timing and breakdown. Also it is known as a Dope Sheet. 

Flipbook: A simple process of movement made by drawing small figures at the edge of a 

book and watching them move as the pages are flipped. 

Foreground: Finished artwork depicting all that does not move in an animation scene. 



 

 

 
 

Usually seen in front of the animated action in the form of an overlay level. Opposite of 

Backgrounds. 

Hand Tracking : The process where the animation is traced, by brush or pen, onto the Cel by 

an Inker. 

Image Map: A term used in game animation to indicate the background image. 
 

Master Background: The animated equivalent of a live-action master shot. Establishes the 

setting, lighting and scale of a sequence but may not be an actual production background. 

Drawing Concept 

Understanding Background Composition 
 

Now, we are going to learn the basic background composition rules, software and 

techniques used for animation. 

Hardware 
 

One of the primary things needed to create a background is a Pen tablet. With Pen 

tablet we can draw straight into the computer using a pen. Use of Pen Tablet makes animation 

easier as we don't need to draw it in the traditional way. In the traditional way, we have to 

draw into a paper and then scan it into the computer or take pictures. But that's quite a long 

process and we can't preview what we've drawn, whereas in the software and computer we 

can draw something and straight away look through the footage and check if it works or not. 

So a Pen Tablet is very beneficial in creating a background. 

Software 
 

The next thing required is software such as: Flash, Blender, Illustrator, Adobe 

Photoshop, Gimp, Toon Boom etc. Let‘s use ―pencil‖ and ―Gimp‖, which are open source 

and have all the features of normal animation software. In ‗pencil‘ you will able to make 

films for free. If you find yourself liking 2D animation you can go ahead and buy some better 

software. But to start with, some free software is perfectly fine. 

Creating the Margin 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

 

First start the GIMP or any supported software, open a new project and select the



 

 

 
 

image ratio of the canvas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Then select the frame size as per requirement, and then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Start the creation of first margin, which is known as the outer margin. Now we got the 

new transparent layer and rename this layer as margin. 

 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Then select the square selection and create the outer margin, and convert the square 

selection to path. After the path is selected, deselect the path and select the paint tool and 

choose the margin size. After resizing, go to create the margin through path tool, then repeat 

the above process for the inner margin. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 
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Save the file and export the margin as the bitmap format. Now it is completed in 

Gimp, but it is not supported in pencil 2D. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

So now open MSPaint program and open the margin sheet or import in paint. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot After 

importing, save the file in bitmap format again. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

In this process pencil 2D supports this bitmap margin. 

How to plan a background? 

Now we know about the background, it tips where to position the characters in the 

background and how to move the camera and edit different points and how to manage other 

details. 

 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

 
 

On the above figure, we have a simple sequence, a character that is coming towards 

camera from a background. Here it's an opening shot. Let's start setting the scene. First, we 

create a new vector layer and then draw on the drawing area. Select the fat brush tool and 

plan the backgrounds eye leading area. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

Let‘s use the brush tool to mark. It's a lead-in shot, zoom in the frame. After we get 

the character‘s position area, now the mouse is kept on the character and that is where we're 

going to have our hero.This was planned in pre-production process. Now slide up to the 

background where character is not animated and it is going out of the dark. 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen shot 

Now, we may think about our lighting condition and put the framer on the 

background. It is then planned according to what's going to happen in the scene. The 

character is coming forward in the scene, therefore here we need to think about all that 

background space characters that are going to be in dark as the character reveals on close 

observation. Now we have to plan the shots exactly like that, which must be adding the 

mood. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Note: Inorder to give a sense of revealing to the character into the scene where character 

blends with the environment, dynamic camera techniques like first camera angle is set 

according to character's point of view. Now the camera zooms out and the character walks 

into the scene. 

 
 
 
 
 
 
 
 
 
 



 

 

 
 

Screenshot 

 
 
 
 

When we have a look at the background we can see that it's a long drawing. 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Now focus of the camera moves on the background as we predetermined. The green 

line is the beginning point and red line is the end point. You can see that we have created a 

background which is looking as if it is at a distance far away from the scene. But you don't 

really notice the bridge or anything else in the background because if we look at the 

background, although the whole background can be seen.But the focus is on the door, so 

when we see him walk in, we can see the scene in character‘s point of view. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

So here is a small directional style of shot where the shots have been divided. It is 
 



 

 

 
 

displaying dif ferent angles of shot like profile, close-up, mid close etc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Here in the scene, as we can see the character and the statue is taken in close shot. 

Then the character turns his head to change the direction of view point of the shot. By such 

techniques, directors give the audience a feel of suspense inorder to understand the scenario 

before introducing the statue, through his actions, look and the geography of the background. 

When we turn off the geography and review the background



 

 

 
 

Screenshot 

We could sense its absence in the background. The statue is facing towards the 

audience and the character is placed towards the left in the scene. Having the character in the 

shot, a little bit of editing is usedto keep the background left of the character and the 

character to our left. If our face is towards the character from the background point of view 

his left would be to our right. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

In the above figure by creating a small movement of the statue, it portrays as if it is 

threatening or frightening kind of disturbed feeling to the background atmosphere. 

How to create and design a background with multiple layers 
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Screenshot 

Now open the pencil program to start the background design. This is the pencil‘s 

margin template. First of all, copy (Ctrl+C) the margin and paste (Ctrl+V). Now, add some 

key frames on animation layers. Goto layers and add another layer and rename it as 

 
 
 
 

Background Layer because now we are creating the background. 
 

Screenshot 

Now we have got the drawing area, we are nowready to draw and can paint the 

background. Let‘s start a simple background having grass. In the beginning, the work area is 

zoomed for ease to work. Then go to the tools, select the sketch tool and draw a simple 

ground grass field layer. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Then select the BG colour layer and select the coloring tool. Go to the alpha layer and 

check all the settings of brush and colour tools. Select the required colour for background and 

start colouring. If our colour exceeds a little bit from the margins inner outline, it‘s ok but 

don‘t cross the outer margin. Note: When we paint, we don‘t erase the margin outline. If we 

are erasing it, we will lose the frame alignment. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

When we colour the background, we can use all the tools as per coloring requirement 

like coloring tool, zoom, sketch, fill and pick colour. Then erase the margins over colours and 

clean it through the erase tool. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Now, we can do some detailing on the background through the smuggled, erase and 

colouring tool. In colouring period, select the proper brush size from the tools layer for 

detailing the background. 

 
 
 
 
 
 
 
 
 
 
 

Screenshot 

 
 
 
 
 
 
 
 



 

 

 
 

Now we add some light colours on the ground for detailing the grass background 

layer. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

 
 

Then add some sky blue colours of the sky. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Select the white colour from colour layer and add some cloud on the sky layer 

through the colouring tool. Use the alpha tool, smoothly erase some sky colour, and draw the 

layer which would look like the cloud on the sky. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Now it is the final background output and you can save and export it. 
 
 
 



 

 

 
 

Unit Summary 
 

In this unit, you have learned about 2D animation background composition tricks. We 

discussed about understanding and skills about different type of background composition by 

exploring relevant techniques and processes as well as creating a practical background 

composition. We also learned about the Pencil 2D and Gimp animation software and the 

production process to create an animation background. 

Assessment 
 

1. Explain the process of creating margin 

2. Describe creation of background 

3. Elaborate the process to design a background with multiple layers 

4. Explain what is layout design 

5. List the types of colour use in inking and colouring 
 
 
 

Resources 
 

Books for Reference 
 

• The Animator's Survival Kit: Richard Williams 
 

• Timing for Animation: Harold Whitaker and John Halas 
 

• The Animator‘s Guide to 2d Computer Animation: Hedley Griffin 

• Character Animation-2d Skills for Better 3d: Steve Roberts 

• How to Make Animated Films: Tony White 
 

• Flash Cartoon Animation: Learn From the Pros 
 

• The Art of Flash Animation: Creative Cartooning: Mark Stephen Smith 

Web resources: 

• http://pencil-animation.org 

• http://www.awn.com 

 
 
 
 
 
 
 
 
 
 
 
 

http://pencil-animation.org/
http://www.awn.com/


 

 

 
 

Unit 3 2D Animation Techniques 

Introduction 

2D animation figures are made and/or edited on the computer using 2D bitmap 

graphics or created and edited using 2D vector graphics. This includes automated 

computerized versions of traditional animation techniques such as interpolated morphing, 

onion skinning and interpolated rotoscoping. 

2D animation has several applications, including computer animation, Flash animation 

and PowerPoint animation. 

In this practical unit, you are going to learn how to create 2D animations. It will teach 

you how to get started, what equipment you're going to need and software required. 

This unit will make you understand the pencil 2D animation tools and how to apply 

them to create a basic 2D animation. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• Apply the 2D Animation Techniques 

• List various Techniques of 2D Animation 
 

• Name the software‘s used for 2D Animation 

• Apply pencil animation tool 

Terminology 
 

Bitmap image: Computer graphic consisting of ―pixels‖ on a grid. Each ―pixel‖ contains 

color information for the image. 

Vector image: An alternate option for bitmap image is vector image. It depends on 

mathematical equations defining the lines, shapes and points that structure the image. 

Key: A placeholder on the Pencil timeline contains information about what the layer should show or 

produce at the frame where it is located. A key characterizes vital purposes of movement in 

animation. 

Onion skin views: A view alternative inorder to show the past as well as subsequent key 

frame as semi- transparent. 

Model Sheet: It is the drawing of a single character, in different poses created as reference 

for animators. 

Character Models: First a model sheet of any character is made by the animator. The model 

sheet contains the character in a variety of facial expression & poses, which will serve as the 

model for each time they are drawn. 

 



 

 

 
 

X-Sheet: It is also called an Introduction Sheet or a Dope Sheet. It is a worksheet that gives 

particular guidelines on how the animation should be captured. It is used to planning the 

timing and activity and incorporates details on field, camera and action. 

Rough Sketch: It is the animator‘s drawings used in the process of creating the finished 

image to be transferred to Cel. 

Layout: The black & white rendering done by a layout person that determines the basic 

composition of the scene. 

Traditional animation: The black & white rendering done by a layout person that 

determines the basic composition of the scene. 

Computer Animation : The animation is created digitally using computer techniques. 

Hardware 

One of the primary things is to create a 2D animation is a Pen tablet. With Pen tablet 

we can draw straight into the computer using a pen. Use of Pen Tablet makes animation easier 

as we don't need to draw it in the traditional way of animation. In the traditional way, drawing 

was initially drawn in paper and then it was scanned into the computer or pictures are taken. 

But that took quite a long time and was a lengthy process. Also it didn‘t have provision to 

check the preview of what has been drawn. Whereas in the software used in computer, we can 

draw something and straight away look through it to check if that the footage works or not. So 

a pen tablet is very beneficial in creating a background.  

Software 

The next thing required is software such as: Flash, Blender, Illustrator, Adobe 

Photoshop, Gimp, Toon Boom etc. Let‘s use ―pencil‖ and ―Gimp‖, which are open source 

and all the features of normal animation software. In ‗pencil‘ you will be able to make films 

for free. If you like 2D animation you can start with free software and latter work on higher 

professional software. 

Pencil 2D animation 
 

Pencil is free and open-source 2D animation software available for various operating 

systems. One can use it free by just downloading it from internet. 

Let us discuss some basics of pencil through some figures: 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

You can see above figure on red circle area, it shows the tools of pencil. 

1. Sketch 

2. Colouring 

3. Draw 

4. Polyline 

5. Erase 

6. Clear 

7. Fill 

8. Pick Colour 
 

9. Marque Selection 

10. Move Object 

11. Zoom 
 

12. Modify Curve 

Colour 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

In the above figure, you can see there are basic colours, main colours and different 

variations like Blue, Gray dark and skin colours. These will go a long way as far as animation 

colours are concerned. Let‘s say you have an image or something you want to get that colour. 

Pick whichever colour you want and put it in colour pallet, so that you can use it on your 

pencil and save it anywhere. 

When you save colors, it chooses any one of your color and keeps the label on it. Here 

you can add customized colors by using the drop in the ‗pick colour tool‘ which is called a 

Dropper. After you select pick colour tool, you can see the selection tool through it where 

selection can be done from up or down. While using the "move tool" sometimes it stops at 

few selections where the colors are not visible. It is one type of color adjuster. 

Layers 

 
 
 
 
 
 
 

Screenshot 

When working in pencil, it's possible to create several different layer types. If you 

look at the timeline, you notice that the layers have different symbols and colored bars at the 

side to indicate layered type. For example, vector layers have a violet bar and colorful symbol 

on the left hand side. You can change the color of these layers by going to the program menu 

bar and select Edit > Preferences then from the Preferences panel, choose the Colored tab and 

select the colour you want to change. Also add or remove layers on timeline – Layers, click + 

/ - (+add / - remove).There are 4 types of Layers in the Time Line: 

1. Bitmap Layer 

2. Vector Layer 
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3. Sound Layer 4. 

Camera layer 

Bitmap Layer 
 
 
 
 
 
 

Screenshot 

Bitmap Layer is used for raster graphics. On the Bitmap Layer, we can work with 

different type of format like BMP, DIB, GIF, JPEG etc. It is important to note that, if bitmap 

image is condensed, the image look like blur and pixels. 

Vector Layer 
 

Vector layer is always used for vector graphics, because when we want to increase or 

decrease the vector files size it work without any quality changes. 

Sound Layer: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Adding Sound layer, first go to menu bar>Edit> Import sound file from your stock of 

sound files. When sound is added, a black triangle will appear on sound layer indicating 

where the sound will play during start. You can move this triangle as any other keys on the 

time line. 

 
 
 
 
 
 
 
 
 



 

 

 
 

Camera Layer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Camera layer puts limits on the height and width of video. Double click on the camera 

layer then choose the size. You could do 540 x 400 or whatever size you want. Set the height 

and width of your camera and go to file, then export the movie of that dimensions. Camera 

scan move the whole movie in one key frame if that makes any sense. For instance, if a new 

key frame is added in camera layer, youcan use the drag tool to drag it a little bit and add 

another key frame. Drag it a little bit more, then add another key frame and again drag it a 

little bit more and then you will have a moving thing. 

Add and delete Layers 
 
 
 
 
 
 
 

Screenshot 

If you need extra layers in timeline we can add or delete from the timeline. For 
 

adding a new layer, click + (plus) button next to ―Keys‖, it will show four types of new 

layers from them select any one new layer which you require, then add it in your time line. 

If you want to remove/delete any existing layer, select the particular layer from the 

timeline and click – (minus) buttons next to ―Keys‖. Then a warning dialogue box shows on 

screen. If you are sure to delete the selected layer, press OK. Then the layer is removed from 

the timeline. 

 



 

 

 
 

Rename Layer 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

If you want to rename the layer, doubleclick on the name of the layer in the timeline. 

A window will pop up, allowing you to edit the layer‘s name. Click OK when you have 

changed it to the name you want and the new name will appear in the timeline. 

Resize Image 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Through the Select Tool we can resize or move the image. Using the select tool, draw 
 

a rectangle in the region of the image. Use the arrow tool or move object tool for moving or 
 

resizing the image. To move an image select the image and click the mouse button on the 

image and drag, as per requirement. If you want to resize the photo, click on the select area 

corner point, press the mouse middle button and drag the select area. 

Import in Pencil 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

You can import a raster image at a particular frame in a bitmap layer by using the 

Import image command in the File Menu under Import. Alternatively, you can drag and drop 

bitmap images from an external window onto the canvas. A key is created for each imported 

image. This is particularly useful when you have a lot of images. By default, the center of 

each image is set to the center of the view. If you want to import your images at a particular 

location, use the select tool and drag a rectangle on the canvas. The images will be imported 

in the rectangle. If the images are larger than the rectangle, they will be rescaled. 

Animating 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

 
 
 
 

Key Frame is displayed as a rectangle at the time line. Grey colour specifies that the 
 

key frame is empty. Coloured frame indicate that here is an image in frame. Black colour 

indicates that frame is selected – you can move selected frame: click on a frame and drag it to 

the needed place. To shift more than one frame, hold down the Shift key. 

 
 
 
 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Onion Skin 
 

The traditional way of planning images for each key frame is to use the previous (or 

next) key image to guide the drawing of the current key image (essentially flipping through 

images when done by the paper method) by displaying the previous (or next) key images in a 

semi-transparent state. This is called Onion Skinning. You can use the Onion skin buttons to 

activate or deactivate the previous and next onion skins. 

Export 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

After the animation is made, the final output or film needs to be exported. For this go 

to the File Menu then select the export. As per the requirement, you can choose the formats 

such as X-Sheet, Image Sequence, QuickTime movie and Flash movie (swf). While exporting 

the final file, please remember to check the file size and the ratio. Adequate camera Layer 

must be created for exporting the final file 

Unit Summary 
 

In this unit, you have learned about the process and technique of 2Danimation. We 

also discussed about various tools and features of Pencil 2D animation software. 

 
 



 

 

 
 

Assessment 
 

1. Write down the tools appeared in tools bar of Pencil 2D 
 

2. In Pencil 2D, there are four types of Layers in the TimeLine 

3. Vector layer is always used for vector graphics 

4. Explain the basic techniques used in 2D animations 

5. Explain Animation process 

6. List the selection tools of animation 

7. What is free transform tool 

8. Explain what time line is 
 

9. List the different types of image format 

Resources 

• http://pencil-animation.org 

• http://google.com 

• https://wikipedia.co 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://pencil-animation.org/
http://google.com/
https://wikipedia.co/


 

 

 
 

Unit 4 2D Animation for portfolio 

Introduction 

A portfolio is a short video or film footage showcasing professionals or presenters 

previous work. For jobs in the fields like film, television, animation and games development. 

You will probably be asked to submit a portfolio as part of your application. Irrespective of 

whatever qualifications and academic degrees you have, the portfolio which is also known as 

Demo Reel, is an important factor in deciding whether a multimedia professional will get 

hired or not. It is a direct showcase for their work. Portfolios are of usually 2 to 3 minutes in 

length and showcase the artist's skill, talent, experience and past work. 

In this practical unit, we will discuss about animation portfolio, hardware and 

software required for making a portfolio. We will also discuss techniques of 2D animation 

portfolio, various techniques involved in 2D animation and how to apply 2D animation tools 

to create a basic 2D animation portfolio for you. 

Outcomes 
 

Upon completion of this unit you will be able to: 

• Understand Portfolio 

• Know the steps and rules to make aportfolio 

• Create an animated short movie 

• Describe the rules for making Portfolio 

Terminology 

2D animation: The formation of moving images in a two- dimensional condition. Images 

can be manual ―cel‖ animations or computer-aided drawings created with animation 

programs. 

Bitmap Image: Computer graphic consisting of ―pixels‖ on a grid. Each ―pixel‖ contains 

colour information for the image. 

Vector Image: An alternative to the bitmap image, vector images depend on mathematical 

equations defining the lines, forms and points that built an image. 

Xsheet: Also known as exposure sheet or a dope sheet. It is a worksheet that gives 

particular instructions for how the animation should be captured. It is used to plan the 

timing and action and includes the details on the field, camera and action. 

2D Animation PortfolioMaking 

Portfolio Making Rules 

For animation and visual effects artists, it's the portfolio that helps in grabbing 315



 

 

 
 

everyone's attention. It‘s a vital marketing tool for the professional. One must prepare the 

portfolio or demo reel with utmost care, highlighting his/her skill, expertise and creative 

ability. Please remember your show‐reel is the showcase of your work. Here are six 

important principles to keep in mind, while preparing your portfolio. 

1. Length 
 

Nobody has time to watch a 30-minute portfolio. It is recommended that the portfolio 

should be within 2 minute. Preferably, it can be shorter. In most cases, people get a good idea 

of what to expect within 30 seconds. Don‘t save the best until last.You need to grab people‘s 

attention instantly and keep it to watch it all. 

2. Content 
 

Only best works should be added to the portfolio. A 30-60 seconds portfolio with 

wonderful animation is better than a 3- minuteportfolio with poor animations. If you are not 

satisfied with something, do not put it. Always use the original shots you have done, never 

recreate the same. If you don‘t have a good reason to, don‘t repeat content. 

3. Order 
 

Since the portfolio should showcase the best of you, strongest and engaging work 

should appear first. It takes people a few seconds to decide if they want to keep watching your 

reel. There is no need of waiting and building the suspense. 

4. Audio/ Fx 
 

It is a very important part of Portfolio as many emotion and engagement comes 

through the music and editing choices made. Include the original audio for dialogue pieces. A 

simple music is the best BGM. The music should not be distracting and should act as a 

connector between the shots. 

5. Presentation 
 

Every piece should be given the time it deserves.You should not edit the music or get 

too creative. In an animation reel you want to present each shot separately (sometimes with a 

title card before each shot) to let the viewer understand what they are watching 

without confusing them. 

6. Numbering 
 

Write the proper information for each shot in the portfolio. 
 

Incomplete works should not be added in the portfolio. Include a head and tail slate 

with your name, phone number and email address on the reel. It should be like a complete 

package of your work and personal information. Never include examples of work that is not 

relevant to for the client or animation. 

A portfolio needs to tell a story. Showcase your personal strength and passion through 
 



 

 

 
 

the portfolio. Be clear on your style and what you do best. Also be honest about your work. 

When a piece of work doesn't match your experience or expertise, it might create doubts on 

your abilities. 

The person who reviews the portfolios has to view number of reels, one after another, 

so it is important to build an impact at the first impression. Think about the work with which 

you are confident, then include the same in the portfolio. Review again and again before 

finalising. 

How to make Animated Short Film 
 

Making animated movie from scratch involves many stages. The process of 

production for a typical animated short film can be divided into three stages: Pre-production, 

Production and Post- Production. 

In this section, we will discuss about step by step methods of animation short film 

making. Now we need the animation software to start. Lets select GIMP for imaging, 

Openshot for editing the video and pencil 2D for animation. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2D Animation Pipeline (Created by Author) 

Step 1: Select script 
 

One of the most important stages of any film production is Script. One can choose the 

best story or can write the story; for example an animation of simple bird as given here. Then 

it is important to make an outline of what you want to show. In animated films, visual 

scripting of the action and performance is important. 

If you write a script, it‘s better to make a perfect plan. But, if the story is not 

complete, then start the rough drawing and in the production process give the best direction 

tothe film. 

Step 2: Create the Character 
 

First develop the characters sketch in a perspective view. This rule implies that the 
 
 



 

 

 
 

characters aren‘t directly facing the viewer; they‘re angled 3/4ths to the left or right, like the 

example below. 

 

This view suggests that our characters aren't clearly standing up to the viewers; 
 

they're figured 3/4ths to the other side or perfect. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Step 3: Creating Storyboard 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title-Storyboard Attribution-Angela rees Source- 
 

Link-https://mooc.employid.eu/storyboarding-tutorial/ 
 

The Storyboard is a manual hardcopy version of the animation film and plan for the 

actions and dialogues for animation. It contains the shot locations, camera angle, sounds and 

all details of cinematic requirements. A storyboard does not need to be super realistic with 

good drawings. But all the key poses should be drawn. It will make the work easier. 

https://mooc.employid.eu/storyboarding-tutorial/


 

 

 
 

After completing and properly naming all the sheets, it should be scanned to have 

them in digital formats. After the scanning you can move them for editing. 

Step 4: Creating Animatics 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Simply put, animatic is an animated storyboard or rough cuts of animation. Making 

animatics is fun. In this process, all scanned image files are imported into the editing 

program. At this stage, we match the sound and scanned frames as per requirements and 

decide the length of animation. It acts as a reference for animators; here, we can see how our 

movie will look like and the story is built-up. 

Step 5: Creating Background Layout 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

A background layout is the pencil hand drawing for a scene. It is not the final 

background, just for reference of the scene. Here we start drawing in the right place and size 

as per our BG field guide. 

 



 

 

 
 

Since we know what our backgrounds look like as of now, we will draw as it is 

required to be in the shot. For instance, we don't have to draw a whole mountain when we 

might be utilizing section of trees. 

 

If we are re-utilizing the BG later in a different field size, we need to draw a large size 

background so that we can use it for both without losing any pixels. 

Step 6: Creating Exposure Sheets 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Exposure sheet is a very important thing in animation. A simple exposure sheet 

contains a table with some lines and column segments like Action, Dial, Cel Levels, 

Background, Camera, Scene, Sequence and Sheet Number. Each line signifies one frame of 

animation. A normal exposure sheet holds upto 4 seconds of activity (i.e. 4 seconds x 24 

frames = 96 rows). A well-prepared exposure sheet will help in maintaining the perfect 

timing. 

Step 7: Creating Rough Animation 
 

The initial step in traditional animation is the rough animation, which is its skeleton. 

We should always start the animation from the main action. For instance, to animate a walk 

cycle, we should begin with the body movement and the legs. Head, hand and clothes can be 

added later during the secondary animation. All the key poses on the storyboard should be 

made. 

For a perfect animation, always complete the main action before adding every other 

detail. If we start animating all the details right away, we may lose a lot of time. If you have



 

 

 
 

to make corrections, it will be difficult. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Step 8: Clean-up 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Once we finish the animation and are satisfied with the work, we can start the cleaning 

up of the images/drawings. We have to choose what kind of line we would use. 

There are various types of line art we can select. Normal lines are all of the same 

thickness while rough lines are not closed and make your animations look like they are 

dancing. Cartoony lines are thick around the border with thin lines on the inside. Cleaning up 

the rough animation is a repetitive work, but when we do it properly it will make the 

inbetweening and colouring easier. 

 



 

 

 
 

Step 9: Making In-between 
 

For smooth animation, in-betweens are important. Keys lead the animation but the in-

betweens smooth out the movements. This process is called inbetweening. A huge amount of 

in-betweens are not always required. When we animate an action shot, we can make with a 

few keys and two or three in-betweens. For fine animation, more in-betweens give us a 

smoother result. 

So now let's check the example below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

First we have put frame number 10 and frame 25 on a light box. Then label it with 

frame 25 to add in betweens this. Always it should be started from frame breakdown. Here 25 

number frames are at the centre in between 10 number frames and 40 number frames.Now 

start drawing right in between the two lines of those drawings and that is how we create the 

breakdown. When it's complete, we can go to frame number 25 and 40 and create the in-

between number 28. After we are done with that one, we take frame number 28 and 40 to 

create the last one in the scene number 32. 

Step 10: Backgroundsync and Paint 
 
 
 
 
 
 
 
 
 
 
 

Screenshot 

Background painting should be included behind our characters using inking. We can 

ink it the traditional way with the crayons or paint or we can scan the drawing and paint it 



 

 

 
 

through the paint program like GIMP. Our backgrounds are a mix of crayons, water paints 

and GIMP. 

 

It's important to mark all layers and keep them isolated because the animation will be 
 

placed in the middle of the layers to create depth. 
 

Step 11: Characters Ink and Paint



 

 

 
 

Screenshot 

When all our animation has been cleaned up, it is ready for colouring. When we begin 

this ink and paint, all our movement has been tidied up and prepared for paint. 

We can use specialised software to ink all the characters. 
 

Here, the hard work of clean-up that we did before truly pays off. With great line work 

and closed lines, colouring will be an easy walk. 

Step 12: Compositing 
 

When all the artworks and characters are painted, we can use any compositing 

software to composite it. Composting is the process of combining all the elements into a 

scene. 

Now we set up the entire film together and make it flow into one. 

Ideas for exercises 

Here are some suggestions for animation exercises. 

• Two leg character walk and run cycle 

• Tiger walk and run cycle 

• Man juggle 

• Throwing balls 
 

• Man hits a door with a briefcase 

• Baby chews food 

• Sword tussle 
 

• Kung Fu styles 

• Man cycling 

• man with diving board 
 

• character‘s happy and sad expression 

• Loudly smiling a man 

• dialogue 
 

• Underwater swimming •

 Walk and run transitions 

• Birds feathering 

Unit summary 
 

In this unit, you learned what portfolio is and how to prepare a 2D animation 

portfolio. We also discussed about the various steps in making animated short films. You 

need to prepare a good and impressive portfolio of you skill and work to draw the attention 

of your prospective employers or clients to start you professional 



 

 

 
 

career in multimedia. 

Assignment 

1. What thing should you keep in mind while creating a portfolio 

2. Explain the clean-up model sheet 

3. How to create a portfolio 
 

4. List the various steps in creating a 2D animationsportfolio 

5. What are animatics 

6. Explain uses of portfolio 7. 

What is an exposure sheet 

8. What is the requirement of portfolio 
 

9. List the different types of rows and columns as in the exposure sheet 

10. Evaluate the 2D animation portfolio 

 

Resources 
 

• https://google.com 
 

• http://wikipedia.com 
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